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1 Get Started with Cisco Optical Network Planner

Provides instructions for modeling and testing optical transport and DWDM
networks using the Cisco Optical Network Planner. It details supported hardware

Topics:

• Cisco Optical Network Planner platforms, network topologies, and security compliance features to help users
• Register a new user design, validate, and generate comprehensive reports for their network

infrastructure.• Log in to the Cisco ONP web
interface

• CSDL compliance enhancements in
Cisco ONP



Cisco Optical Network Planner
Describes the functionality of this web application for modeling and validating optical networks, encompassing supported
hardware platforms, various network topologies, protection schemes, service types, DWDM interfaces, and compatible
fiber types for comprehensive network design.
Cisco Optical Network Planner is a web application that
• models and tests Optical Transport Networks (OTN) and Dense Wavelength Division Multiplexing (DWDM) networks,

• provides a graphical environment for network design and validation, and

• supports creating and comparing multiple network instances.

Cisco ONP enables you to visualize their network designs. It allows you to generate bills of materials and access detailed
reports for network planning and validation.

Purpose

The primary purpose of Cisco ONP is to design and validate networks for the NCS 1001, NCS 1004, NCS 1010, NCS
2000, and NCS 4000 series.
With Cisco ONP, you can create multiple instances of a network, modify various parameters for each instance, and perform
comparisons. The tool generates a rack view of all the sites deployed in the network, highlights the differences between
instances, and provides a complete Bill of Materials (BoM).

Detailed network information

Cisco ONP models the network and generates the BoM. You can view detailed reports, including:
• Cabling report

• Optical report

• Device Configuration file

• Traffic matrix

Features and compliance

You can use the features of Cisco ONP, including protection scenarios, topology and service support, to support protection
scenarios, topology and service support, and compliance with the Cisco Secure Development Lifecycle (CSDL). You can
also set up the graphical display.

Additional resources

For more detailed information about Cisco ONP, see the data sheet.

Cisco Optical Network Planner | Updated March 10, 2026

| Get Started with Cisco Optical Network Planner | 12

https://www.cisco.com/c/en/us/products/collateral/optical-networking/network-convergence-system-1000-series/optical-network-planner-ds.html


Supported platforms
Lists the platforms and recommended software releases supported by Cisco Optical Network Planner (ONP), including
relevant feature history to help you determine hardware and software compatibility for your deployment.
Table 1: Feature History

Feature DescriptionRelease InformationFeature Name

This release supports the design of
C-bandNCS1001 networks. The NCS
1001 is a 1RU, DWDM line system
optimized for data center
environments. It includes support for
amplifiers, PSM modules, and various
colored add/drop modules such as
MD-32-EVEN, FLD-4, MD-48-ODD,
MD-48-EVEN, and MD-64.
Cisco ONP supports unprotected,
terminal section, and terminal path
protection over the NCS1001 network.
Also, the NCS 1001 network is
compatible with optical sources such
as NCS 1004, CIM8, Bright ZR, QDD,
and CFP2.

Cisco ONP Release 24.3.1Support for NCS 1001 Network
Creation

NCS 1020 is a 10RU optical line
system that supports the OLTs and
NCS1K14-CCMD-16-C card in the
NCS 1010 networks. The NCS 1020
chassis optimizes the NCS 1010
networks design, extending the reach
of NCS 1010 networks. With OLTs and
NCS1K14-CCMD-16-C, the NCS
1020 chassis provides a wide range of
configuration options to NCS 1010
networks.

Cisco ONP Release 24.3.1Addition of new NCS 1020 Chassis for
NCS 1010 Networks

Cisco ONP supports these platforms:
Table 2: Supported platforms and releases

Recommended and Supported ReleasesPlatforms

7.10.1, 25.4.1NCS 1001

24.3.1, 25.1.1, 26.1.1NCS 1014

7.10.1, 7.11.1, 24.3.1, 25.1.1, 26.1.1NCS 1010

11.1.0, 25.1.1, 26.1.1NCS 2000

6.5.33NCS 4000
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Supported topologies
Lists the supported network topologies, their configurations, and key benefits.
Cisco ONP supports several network topologies, each offering different configurations and benefits.
• Linear topology: In a linear topology, the nodes are arranged in a line and are connected to two adjacent nodes.

However, the first and last nodes are not connected to each other.

• Mesh topology: In a mesh topology, each node is connected to one or more nodes. This configuration provides
maximum redundancy to the network.

• Ring topology: In a ring topology, each node is connected to exactly two other nodes, forming a circular configuration.
It requires at least three nodes to form a ring.

Supported protection schemes
Lists and describes the supported protection schemes for Cisco network platforms, including their functions and
applicability.
Cisco ONP offers a variety of protection schemes to enhance network reliability and resilience.
Table 3: Feature History

Feature DescriptionRelease InformationFeature Name

The following protection schemes are
supported:
• 1+R: For each service, Cisco ONP

automatically finds one working
path. You can define the restoration
path.

• 1+1+R: For each service, Cisco
ONP finds one working path, and
one protected path. You can define
the restoration path.

• 1+1+R+R: For each service, Cisco
ONP finds one working path and
one protected path. You can define
the restoration paths.

Cisco ONP Release 4.1Protection Types Supported

Cisco ONP offers a variety of protection schemes to enhance network reliability and resilience.
Figure 1: Protection schemes

Supported protection schemes include:
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• Unprotected: In unprotected mode, the tool routes the service on the shortest path without any backup.

• 1+1: In this scheme, two client signals are transmitted to separate line cards or transponder cards, rather than using
a Y-cable to split one client signal into two. Client 1+1 protection allows the client system to control failure events
and to manage the switchover.
Figure 2: 1+1 protection

• 1+R: Supported on SSON networks, this scheme allows Cisco ONP to automatically find one working path for each
service. You can define the restoration path.

• 1+1+R: Also supported on SSON networks, this scheme involves Cisco ONP finding one working path and one
protected path for each service, and users can define the restoration path.

• 1+1+R+R: Supported on SSON networks, this scheme involves Cisco ONP finding one working path and one protected
path. You can define additional restoration paths.

• S+NS: Supported on both SSON and non-SSON NCS 4000 and NCS 2000 networks, Cisco ONP uses the shortest
path for the working service and the next shortest path for protection. The paths are span-disjoint but not node-disjoint

• Unprotected disjoint: Supported on both SSON and non-SSON NCS 4000-NCS 2000 network, this scheme provides
two cards following two completely disjoint paths in the network to reach their destination.

• PSM-Channel protection: This protection scheme is supported on NCS 2000 non-SSON networks.

Supported services
Lists the OTN, Ethernet, and STS service types supported by Cisco ONP platforms.
Cisco ONP supports these OTN, Ethernet, and STS services.
• ODU demands:

• ODU-1

• ODU-2

• ODU-3, and

• ODU-4

• Ethernet services:
• GE

• 10GE
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• 100GE

• 400GE
The 400GE service is supported on the NCS 1010 networks.

• Synchronous Transport Signal (STS) services:
• STS-3

• STS-12

• STS-48

• STS-192

• Virtual Container (VC) services:
• VC-4-4

• VC-4-16

• VC-4-64

• Synchronous Transport Module services such as STM-64.

Supported DWDM Channel Interfaces
Lists the DWDM channel interfaces supported by Cisco ONP, including compatibility features and location of comprehensive
interface details.
Cisco ONP supports several DWDM channel interfaces that provide high-capacity optical transport and are compatible
with industry-standard wavelengths. For more information about the DWDM channel interfaces supported by Cisco ONP,
see Supported Cards and Pluggables on page 357 and Supported Optical Sources on page 372.

Supported fiber types
Lists the standard single-mode, True Wave, and specialty fiber types supported by Cisco NCS 1010, including variants.
Cisco ONP supports these fiber types.
• Standard single-mode fibers:

• G652-SMF

• G652-SMF-28E

• SMF-28 ULL (only NCS 1010)

• SMF28-Ultra (only NCS 1010)

• True Wave fiber series:
• True Wave Reach

• True Wave RS

• True-Wave Plus

• True-Wave Minus

• True-Wave Classic

• Other type of fibers:
• Free-Light
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• Tera-Light

• Metro-Core

• ELEAF

• NDSF (only NCS 1010)

• ALLWave (only NCS 1010)

Register a new user
Instructs users on the registration process for creating a new account, which involves accessing the system URL, providing
credentials, and using system-generated password options to gain secure access to the application.
Use this procedure to register a new account on Cisco ONP. This enables you to create a username and password to gain
access to the system.
1. In the browser URL field, enter the IP address or hostname of the Cisco ONP instance.
2. Click Sign Up in the Login page.
3. Enter the Username, Email, Password, and Confirm Password, and click Submit.
4. If you want a system-generated password, clickGenerate, and click Submit. The system fills the Passwordand

Confirm Password fields with the generated password.
5. Click Ok in the Success dialog box.

Log in to the Cisco ONP web interface
Explains how to access administrative andmanagement functions by entering credentials, including specific troubleshooting
steps for handling browser security certificate warnings during the login process.
Provide access to the Cisco ONP web interface, enabling administrative and management functions.
1. In the browser URL field, enter the IP address or hostname of the Cisco ONP instance.

If you are a new user, sign up. See Register a new user on page 17.

Note

If the Google Chrome browser blocks your access to Cisco ONP due to self-signed certificate security, type
thisisunsafe to proceed to the Login page.

2. Enter the username and password in the Username and Password text boxes, and click Login.
You are granted access to the Cisco ONP web interface, where you can begin managing network resources.

Cisco ONP home page
Describes the functionality of the Cisco ONP home page interface and its key navigation elements. Explains how to access
account management features such as password resets and system sign-outs securely.
This topic helps you understand the layout, key navigation elements, user and network information displayed in the Cisco
ONP home page.
The Cisco ONP home page displays key elements that help users navigate and utilize the platform effectively.
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• Menu bar: Includes options such as File, Network, Export, Import, Manage, Logs, Job Monitor, Control Panel, and
Help. For more information about menu options, see Menu bar options and functions on page 335.

• Last login: Displays the last date and time of user login to Cisco ONP.

• Last login IP: Shows the IP address from which the user previously logged into Cisco ONP.

• User name: Indicates the current user (for example, ADMIN).

• Reports tabs: Provide access to various reports. The availability of reports depends on whether the network has been
analyzed. Reports are also accessible from site properties after network analysis.

• Network tree: Displays the network name and its elements, including Sites, Fibers, Waves or Media Channels, SRLGs,
and Subnets. For more information, see Network tree elements and features on page 343.

Tip

To expand the Cisco ONP workable area, click the horizontal and vertical arrows on the home page.
If the home page displays an empty grey window, update the browser to the latest version. For detailed hardware and
software requirements, refer to the Cisco ONP Installation Guide.

Change password
Teaches you how to change password. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to change your password.
1. Click the Login icon in the home page, then select Change Password.
2. In theChange Password dialog box, enter theOld Password, New Password, Repeat New Password,

then click Update.

Reset your password
Reset your Cisco ONP password if you forget it or need to change it for security reasons.
Use this procedure to reset your password for the Cisco ONP.
1. In the browser URL field, enter the IP address or hostname of the Cisco ONP instance.
2. Click Forgot Password? on the Cisco ONP Login page.

The Forgot Password page appears.
3. Enter your registered email address in the Forgot Password page, then click Continue.

A verification code is generated and sent to the registered email address.

4. Enter the verification code, new password, and confirmation of your new password, then click Continue.

Sign out from Cisco ONP
Sign out of Cisco ONP to end your current session and ensure your data is secure.
Use this procedure to sign out of Cisco ONP.
Click the Login icon in the top-right corner of the home page, and choose Sign Out to log out of the Cisco ONP tool.
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CSDL compliance enhancements in Cisco ONP
Explains security features implemented to meet CSDL standards, including login IP tracking, passphrase management,
and enhanced encryption options, which strengthen overall user management and system security.
A CSDL compliance enhancement is a set of security features in Cisco ONP that
• display the last login IP address of the client in the user interface,

• allow administrators to set a passphrase for encrypting credentials during the installation of the Live Network Import
(LNI) application and its database, and

• incorporate several Secure Development Lifecycle (CSDL) compliance measures to strengthen security and user
management.

Table 4: Feature History

Feature DescriptionRelease InformationFeature Name

The following CSDL compliance
enhancements are supported:
• Displays the last login IP address of

the client.

• Allows you to set a passphrase for
encryption of credentials during the
installation of LNI application and
database.

Cisco ONP Release 4.1CSDL Compliance Enhancements

Other security and user management improvements associated with CSDL compliance in Cisco ONP include:

Passphrase security features

• Ensure new passphrases do not match common passwords by checking against a dictionary.

• Notify users with pop-up alerts before passphrase expiration.

• Enable administrators or users with CONFIGURATION_MANAGEMENT permission to configure passphrase lifetime
and grace period in the system configuration tab.

• Require passphrases to be 8–127 characters and contain at least one lowercase letter, one uppercase letter, one
number, and one special character.

Passphrase management features

• Prompt administrators to change their passphrase upon first login.

• Allow setting a passphrase or encryption key for credentials during LNI application installation (using a default key if
unspecified).

• Permit users to set a passphrase between 8 and 64 characters during Cisco ONP and LNI database installation.

User login information features

• Display the last login date and time.

• Show the last login IP address in the Cisco ONP user interface.
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Additional security features

• Offer a “Generate Password” option, letting users create a password automatically.

• Display password strength as the user sets it.

• Provide improved feedback during password creation.



2 Manage Users and Roles

Provides administrators with procedures for managing user access, defining
roles and groups, and enforcing security policies within the Cisco ONP platform.

Topics:

• User roles in Cisco ONP It also details the steps for monitoring system and component activities through
log retrieval and analysis to ensure secure and efficient operations.• Create a new user group

• Set password expiration for
individual user

• Create a new role
• Retrieve system logs



User roles in Cisco ONP
Provides details about the predefined user roles available in Cisco ONP, including granting or removing access, deleting
users, and locking or unlocking individual user accounts.
Cisco ONP uses user roles to control access and assign responsibilities within the platform. This table outlines the default
roles, their capabilities, and any special group assignments.
Table 5: Roles and responsibilities

Capabilities and responsibilitiesRoles

• Activate new users and grant access.

• Assign roles to user groups.

• Manage predefined user groups (cannot edit or delete
these groups).

• Assign actions permissions to each group.

Administrator

• Create network topologies (manually or by import).

• Assign fibers between site.

• View reports shared by others.

Limitations: Designers cannot analyze networks but can
view reports shared by others after analysis.

Designer

• Design and analyze networks.

• Create sites, fiber spans, and service demands.

• Evaluate network performance.

Planner

View users, groups, roles, permissions, topology, layout,
connections, and BOM.
By default, users are assigned to the READ_ONLY_GROUP
with the role called READER_ROLE.

Reader

To create a new role, see Create a new role on page 27.
Under Control Panel > Roles and Control Panel > Permissions, you can view the permissions applicable for
each role and the actions that can be performed for each permission.

Grant access to a new user
Learn how to grant access to a newly registered user account. Activating an account allows the user to log in and start
using the platform based on their assigned role.
All users with the admin role receive an email notification about new user registration.
Follow these steps to assign a role to a user group:
Log in to the Cisco ONP web interface on page 17 as a user with Admin role.
1. Click Control Panel.

The Access Control Management page appears.
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2. You can change the state of a user from INACTIVE to ACTIVE in either of two ways.
• From the State field, click INACTIVE in the respective user row.

• Select a user row or multiple user rows and click Update.
• In the Update User dialog box, select the Group and State from the respective drop-down lists.

• Click Save.

3. Click OK in the Success dialog box.

Note

• After your access is granted by the admin, you receive an email notification at your registered email address.
ou can log in after you get this email.

• The admin assigns a Role and Group to a newly created user. These assignments determine what actions the
user can perform.

Remove access to a user
Learn how to remove access for a specific user. Deactivating an account immediately stops the user from accessing the
system without deleting their historical activity data.
This section helps you to securely revoke a user's access for security, compliance, or resource management reasons.
Follow these steps to remove Cisco ONP access to a user.
Log in to the Cisco ONP web interface on page 17 as a user with Admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Change the state of a user from ACTIVE to INACTIVE in either of two ways:
• In the State field, click ACTIVE in the user's row.

• Select a user row or multiple user rows, and click Update.
• In the Update User dialog box, select the Group and State from the drop-down lists.

• Click Save.

3. In the Success dialog box, click OK.

Delete a user
Learn how to permanently delete a user account from the system. Removing inactive accounts prevents unauthorized
access to the network and protects sensitive data.
Follow these steps to delete a user or multiple users.
Log in to the Cisco ONP web interface on page 17 as a user with admin role.
1. Click Control panel.

The Access Control Management page appears.
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2. Delete a user:
a) Select the user or multiple users to be deleted under the USERS tab, and click Delete.
b) Click Yes in theWarning dialog box.

The message User deleted successfully appears.

Lock and unlock an individual user account
Learn how to lock or unlock an individual user account. Locking an account prevents immediate access during security
checks, while unlocking restores standard login privileges.
This procedure enables administrators to ensure that only authorized users can access the system.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the USERS tab.
a) Select the user whose account you want to lock or unlock.
b) Click Lock to lock the user account, or click Unlock to unlock the account.

If your account is locked, contact your administrator to unlock your account.

Create a new user group
Learn how to create a new user group, apply an appropriate role, and assign a user to a specific user group to simplify
access management.
Follow these steps to create a new user group.
Log in to the Cisco ONP web interface on page 17 as a user with Admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the USER GROUPS tab.
3. Click Create.

a) In the Create Group dialog box, enter the Group Name.
b) Choose the appropriate role from the Role drop-down list. The available default roles are:

• ADMIN

• PLANNER

• DESIGNER

• READER

The Role drop-down list may also have user-defined roles listed under it.

c) Click Save to create the user group.
4. In the Successdialog box, click OK.

Cisco Optical Network Planner | Updated March 10, 2026

| Manage Users and Roles | 24



Assign a user to a user group
Learn how to assign a user to a user group. Grouping users allows administrators to organize accounts efficiently and
apply consistent permissions across multiple individuals.
This task guides an administrator to assign a user to a specific user group within the system. Organizing users into groups
with defined roles and permissions streamlines access management and enhances security controls.
Follow these steps to assign a user to a user group.
Log in to the Cisco ONP web interface on page 17 with Admin permission.
1. Click Control panel.

The Access Control Management page appears.

2. Under the USERS tab, select the user or users who are to be assigned to the new group, and click Update.
In the Update User dialog box:
a) From the Group drop-down list, select the appropriate group.
b) From the State drop-down list, select Active to activate the user in the group, or Inactive to deactivate the

user in the group.
c) Click Save.

3. In the Success dialog box, click OK.

Note

a. A user can belong to only one group.

b. Only one role can be assigned to any group.

c. All users in a group have the group's role.

d. By default, a new user is assigned to the Read_Only_Group.

Set password expiration for individual user
Learn how to configure a specific password expiration date for an individual account or all users, manually expire passwords,
and manage the password dictionary to enhance security.
This section explains how to set password expiration to help maintain user account security.
Follow these steps to set the expiration of the password set by the user.
Log in to the Cisco ONP web interface on page 17 with Admin or Configuration_Management permission.
1. Click Control Panel.

The Access Control Management page appears.

2. Select the user under the USERS tab., and click Update.
In the Update User dialog box:
a) Click the PASSWORD EXPIRY tab.
b) Enter values for the Lifetime,Warning and Grace fields.
c) Click Save.
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Note

The password expiry settings like lifetime, warning and grace time, take effect after the existing password is
changed by the user.

3. In the Success dialog box, click OK.

Set password expiration for all users
Learn how to configure a global password expiration policy. Forcing periodic password changes for all accounts minimizes
the risk of unauthorized access and ensures security compliance.
Establish password expiration settings for all user accounts to improve organization-wide security.
Setting a global password expiration policy helps maintain user account security by requiring users to change their
passwords at regular intervals.
Follow these steps to set the password expiration for all users.
Log in to the Cisco ONP web interface on page 17 with Admin or Configuration_Management permission.
1. Click Control Panel.

The Access Control Management page appears.
2. Click the System Configuration tab.

a) Enter values for the Lifetime,Warning, and Grace fields.
b) Click Update.

Note

The password expiry settings such as lifetime, warning, and grace time, take effect after the user changes their
existing password.

Expire the password set by an individual user
Learn how to manually expire a password set by an individual user. This action forces the user to create a new password
during their next login, which improves overall account security.
This task allows an administrator to manually expire the password of a specific user to enhance security by ensuring
compromised or outdated credentials are not used.
Follow these steps to expire the password set by an individual user.
Log in to the Cisco ONP web interface on page 17 with Admin permission.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the USERS tab.
a) Select the user whose password you want to expire.
b) Click Expire.
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Manage password through dictionary
Learn how to manage the password dictionary settings. Enabling a password dictionary prevents users from selecting
weak passwords, which significantly improves system security.
The dictionary rejects any new password that exists in the predefined list of passwords under the Content column in
the DICTIONARY tab.
The system performs this password verification check against the dictionary during these events:
• New user sign-up

• Password change

• Password reset using forgot password option

Use this task to verify whether the new password set by the user exists in the list of predefined passwords:
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the DICTIONARY tab.
a) Enable the Rejection Mode toggle button to verify the password against the dictionary.

By default, this toggle button remains disabled.

b) Enter the password in the Enter Passphrase text box.
c) To specify the maximum number of matching passphrases, enter the limit in the Enter Limit text box.
d) Click Search.

The system displays the matching passphrases.

Note

If you enter a limit, the system displays only that number of matching search results. If you do not enter a limit,
the system displays all matching passphrases.

Create a new role
Learn how to create a new role with specific permissions to maintain strict access control and assign the newly created
role to a user group.
This procedure guides an administrator in defining a new role, assigning appropriate permissions, and making the role
available for users.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the ROLES tab. Then click Create.
a) In the Create Role dialog box, enter the Role Name, select the Permissions for the role, and click Save.
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Note

You can select more than one permission.

b) In the Success dialog box, click OK.

Assign a role to a user group
Learn how to assign a role to a user group. This ensures that users within the group receive the correct access privileges
and can perform their designated actions within the system.
This procedure helps the administrator to assign or update a role for a user group in Cisco ONP, ensuring the group has
appropriate access permissions within the system.
Follow these steps to assign a role to a user group.
Log in to the Cisco ONP web interface on page 17 as a user with the Admin role.
1. Click Control Panel.

The Access Control Management page appears.

2. Click the USER GROUPS tab.
a) Select the user group you want to update, and click Update.
b) In the Update Group dialog box, select the desired role from the Role drop-down list, and click Save.
c) In the Success dialog box, click OK.

Retrieve system logs
Learn how to retrieve and filter system logs for a specific time interval and download component logs for diagnostic
purposes.
This task guides administrators or authorized users through the steps to retrieve, filter, and manage system logs for a
specified time interval on the System Logs page. For more information, see Logs on page 339.
Follow these steps to retrieve the system logs.
Log in to the Cisco ONPweb interface on page 17 as an admin, or a user with User Management and Network Management
permissions.
1. Click Logs.

a) Click Select Start Date, and choose the start date. Similarly, click Select End Date, and choose the end
date.

b) Choose the Logs Category.
c) Click FILTER to retrieve the logs.

2. Perform the required actions in the Logs page.

then...If you want to.…..

click the Export as CSV icon.export the system logs to an Excel sheet

click the Export Archive icon.export the system logs as a zip file

click the Import Archive icon.import the zip file

click the Refresh icon.refresh the system logs page
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then...If you want to.…..

click the Clear Logs
icon.

delete the existing logs

Retrieve component logs
Learn how to retrieve and download component logs for specific events. These logs offer vital diagnostic details that
assist administrators in troubleshooting network issues.
This task guides administrators or users with the appropriate permissions through the process of efficiently retrieving,
viewing, searching, and exporting critical logs related to specific system components from the Component Logs page.
Follow these steps to retrieve the critical logs for each event from theComponent Logs page. See Logs on page 339.
Log in to the Cisco ONPweb interface on page 17 as an admin, or a user with User Management and Network Management
permissions.
1. Choose Logs > Component Logs.
2. From the Component drop-down list, choose a component.

The logs for the chosen component appear. The available components are:
• BE

• GENE

• ODE, and

• PCE

3. In the Search field, enter the event to locate the event logs.
4. Perform the required actions in the Component Logs page.

then.…..If you want to.…..

click the Export icon.export the component logs as a text file

hover the Information icon.see the file path of the chosen component
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3 Design and Analyze Networks

Explains how to design, analyze, and upgrade optical network configurations
using Cisco ONP. It enables users to create network models manually or through

Topics:

• Cisco ONP network designs imports, perform what-if simulations, and generate device configuration files to
streamline deployment and optimize network performance.• Optical subnets and their role in

networks
• Share a network
• Split-Step Fourier simulation
• Analyze the network
• Upgrade the analyzed network
• Plan mode
• Line Rate Tuner mode
• Import optical sources
• Layout template for NCS 2000

network
• Network layout visualizations
• Add new pluggables, alarm cables

and 100G client bandwidth licenses
to BoM

• Spectrum utilization and path finder
capabilities

• COSM cards
• Export device NETCONF XML file

for NCS 1010 networks
• Export NCS 1010 network planning

data for Cisco Optical Network
Controller

• Download multiple networks



Cisco ONP network designs
Describes the functionality of network designs. Explains the benefits of this feature and how it contributes to efficient and
robust network planning.
A Cisco ONP network design is a network architecture planning approach that
• allows you to create a new design manually or import an existing design,

• supports integration with various sources and tools such as Excel sheets, live network import, Cisco Transport Planner,
or other Cisco ONPA instances, and

• provides flexibility in how network models are created and managed.

You can design a network in one of these ways:
• Manual design: Create a network design using the design palette.

• Import design: Import a network design from an Excel sheet, live network import, Cisco Transport Planner, or another
instance of Cisco ONP.

This dual approach enables network architects to choose the method that best fits their workflow, making Cisco ONPA
adaptable to various project requirements and existing data sources.

Manually design a network using Cisco ONP
Teaches you how to manually design a network using . Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
• Log in to the Cisco ONP web interface on page 17

• Create a user profile, if you want to apply the profile that contains predefined configurations, as a template.

.
Table 6: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP now provides an option to
run some operations in the background
involving database interaction, such as
Save As, Import CPZ, and Export
CPZ. You can continue to use the
Cisco ONP interface for other
operations when these operations are
running in the background.

Cisco ONP Release 5.2Database Operations Optimization

Table 7: Feature History

Feature DescriptionRelease InformationFeature Name

Now you can include the 4K-2K nodes
in both SSON and non-SSON networks
while designing the network. This helps
you to validate 4K-2K nodes in the
SSON design which has higher line
rates.

Cisco ONP Release 5.24K-2K SSON Network Creation
Support
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Table 8: Feature History

Feature DescriptionRelease InformationFeature Name

CiscoONP now supports the C+L-band
networks that help you plan NCS 1010
networks using the OLT-L and ILA-L
line cards to increase your network’s
bandwidth capacity. Enhanced with
L-band related properties, the UI
enables you to design a C+L-band
network for your ever-increasing
channel demands. These L-band types
are introduced to suit your design
needs:
• C+L: This band type adds more

channels to your network,
increasing its traffic carrying
capacity.

• C+L Futuristic: This band type
creates a network with C-band
edges and future provisions for
L-band edges that you can
cost-effectively upgrade after
exhausting the C-band capacity.

Cisco ONP Release 5.1NCS 1010 C+L Network Design

Table 9: Feature History

Feature DescriptionRelease InformationFeature Name

You can design and validate NCS1010
optical line system. This feature helps
to create OLT-C, OLT-R-C, ILA-C,
ILA-R-C, and ILA-2R-C based NCS
1010 networks using fixed grid
add/drop MD-32-ODD, MD-32-EVEN
and flex grid add/drop BRK-24,
BRK-16, and BRK-8 passive modules.

Cisco ONP Release 5.0Greenfield NCS 1010 Network Design
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Table 10: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to:
• Support NCS 4K-1K-2K

multiplatforms

• Visualize new layout for Txp and
SVO for NCS 2000 node

• Support different OTN service types
with protection

• Edit layout for NCS 4000 and NCS
1004 nodes

Cisco ONP Release 4.1Multi-Layer Platform (MLP) Greenfield
Design with NCS 4k-1k-2k

Use this procedure to create a network in the Cisco ONP.
You can create any of these network designs:
• Spectrum Switched Optical Network (SSON) that uses flexible spectrum allocation, where the required minimum

spectral resources are allocated adaptively based on traffic demand and network conditions.

• Non-SSON network that allocates single spectrum (fixed spectrum) irrespective of the traffic demand and network
conditions.

• NCS 1010 network

• NCS 1001 network

• NCS 1014 network

1. Choose File > New.
2. In the Create New Network dialog box, choose the required options to create a network.

a) From the L0 Network Platform drop-down list:

To create...Choose

a non-SSON network that contains NCS 2000 and NCS
4000 nodes, or an SSON network including NCS 2000,
NCS 1004, and NCS 4000 nodes

NCS 2000

a network that contains only NCS 1010 nodesNCS1010

a network that contains only NCS 1001 nodesNCS1001

a network that contains only NCS 1014 nodesNCS 1014

a) If you want to create an SSON network, check the SSON Network check box. Otherwise, do not check the
check box..
This option is not for the NCS 1010 network.

b) Choose NCS (4K_1K_2K) or NCS (4K_2K) from the Traffic Type drop-down list.
You can view the Traffic Type drop-down list, if you choose to create an SSON network in the previous step.
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Note

Once the network is created, you cannot change the Traffic type from 4K_1K_2K to 4K_2K, or the reverse.
Export the network to an Excel sheet, make the required modifications, and import it as a new network.

c) Choose the System Release for NCS 2K or NCS 1010 from the drop-down list.
You cannot change the system releases that are available for NCS 4K and NCS 1K.
The Band Type drop-down list appears for NCS 1010 networks from Release 7.9.1.

d) From the Band Type drop-down list for NCS 1010, choose:
• C-Band: Only C-band edges are created and ANS is generated based on C-band. For L-band upgrade, ANS

unlock is required.

• C+L Futuristic: Only C-band edges are created and ANS is generated based on C-band and L-band. For L-band
upgrade, ANS unlock is not required.

• C+L: Both C-band and L-band edges are created and ANS is generated based on C-band and L-band.

Note

After the creation of a NCS 1010 R7.9.1 network, if required, you can change the network band type under
the Network Application Configuration section in the Network Properties.

e) From the Profile drop-down list, select either the Default profile, which provides the default properties set by
Cisco ONP, or a user-defined profile. For more details on profiles, see Predefined user profiles on page 51.

f) Click Create.
The application displays a map and the design palette. For details, refer to Design Palette options on page 345.

3. Click the Drawing Tool icon (pencil and ruler crossed), and add sites and other network elements.
a) Add sites to the map using the drawing tool.

Zoom in on the map to the desired level. Click any of the site icons (ROADM,OLA, or Traffic(4K-1K-2K)), and
drag it to the sites on the map. Drag or click the map where a site has to be placed, when the cursor changes to
the site icon.

Note

• SRLG is not supported in the SSON networks.
Traffic node is not supported on the NCS 1010 network.

b) Click the Fiber icon and drag it to connect from one site to another site. Continue this for all sites.
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Note

By default, the fiber length is set as 1 kilometer for all the fibers. To update the length automatically based on
the x and y coordinates, enable the Use Coordinates Distance property in network properties.

c) Create services between the sites (only for SSON and non-SSON networks).
Cisco ONP provides only OTN service.

d) Click OTN Service (green) and add the service between the existing Traffic sites on the map.
e) Click Circuit (purple),Media channel (purple), orWaves (red), and add media channel, or waves between

the existing sites on the map.
In the left pane, you can view a network tree panel with a default network name. The network elements added are
displayed in the tree panel.

4. Choose File > Save As.
a) In the Give a Network Name dialog box, enter a network name and click Save.
b) If you want this operation to run in the background, click the Run in Background check box.

A notification pops-up after the background operation is completed. Go to Job Monitor to view the progress
of the operation running in the background.

Create shared risk link group
Teaches you how to create shared risk link group. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure to create Shared Risk Link Group (SRLG) using the Cisco ONP GUI. The SRLG feature enables routing
of protected services.

Note

SRLG is supported only for non-SSON networks that include traffic nodes.

Log in to the Cisco ONP web interface on page 17.
1. Open the network where you want to create the SRLGs.
2. Click the network tree panel.
3. Expand Fibers, and check the check box next to each fiber that should be in the same SRLG.
4. After selecting all fibers, right-click and choose Create SRLG.
Cisco ONP creates an SRLG with a unique name, which you can subsequently rename.

Import a network using an Excel sheet
Teaches you how to import a network using an Excel sheet. Instructs you on the necessary steps to perform this task
effectively and ensure proper network configuration.
Use this procedure to import a network into Cisco ONP, using an Excel sheet.
• Log in to the Cisco ONP web interface on page 17
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• Create a user profile, if you want to apply the profile that contains predefined configurations, into your Excel imported
network design.

.
Table 11: Feature History

Feature DescriptionRelease InformationFeature Name

The integration between CX Unified
Planning Tool (UPT) and Cisco ONP
enables you to import the networks
created and analyzed in CX UPT into
Cisco ONP. This helps you avoid
recreating the networks that are already
created in UPT. This feature allows you
to import networks having NCS 1010
and NCS 2000 nodes into Cisco ONP.

Cisco ONP Release 5.0CX Unified Planning Tool Network
Import

Table 12: Feature History

Feature DescriptionRelease InformationFeature Name

It is now possible to export the
topology data of an existing network
into an Excel file. You can easily modify
the exported data in Excel and import
it back into Cisco ONP to create a new
network or modify an existing network.
These are the supported Excel formats:
• xlsx—Standard Excel with multiple

sheets, each corresponding to a
network element such as Network,
Sites, Circuits, Spans,
OTNdemands, and so on.

• xlsm—Macros-enabled Excel file
that can filter out and display only
the applicable network element
sheets based on the platform
selected in the Network sheet.

Cisco ONP has the built-in intelligence
to automatically calculate the shortest
path between a source and a
destination, even if only a partial fiber
path is mentioned in the imported Excel
file.

Cisco ONP Release 5.1Export and Import of Network Topology
in Excel Format

Follow these steps to import a network into Cisco ONP, using an Excel sheet.
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Note

By default, the system release of the Excel-imported network is 11.0

Note

From Release 5.0, Cisco ONP supports import of networks created using UPT via Cisco ONP Import Excel option. UPT
does not populate the DWDMChannel Type and Add/Drop Type values in the Excel sheet. If the values are not found
in the Excel sheet, then Cisco ONP picks the default options. By default, DWDMChannel Type is
NCS1004_QPSK_SP_16QAM_200G_27%SDFEC_60GBd and Add/Drop Type is Colored. We recommend you to
check the DWDMChannel Type and Add/Drop Type values before importing the Excel sheet into Cisco ONP to avoid
any discrepancies.

From Release 5.1, in addition to exporting the template, you can export the entire network design data of an existing
network as an Excel sheet. Modify the network properties available in the Excel sheet and reimport. The network can be
exported in all modes and reimported on Design mode, Upgrade mode, and Release Upgrade mode.
Log in to the Cisco ONP web interface on page 17.
1. Choose Export > Excel .

a) Choose the Network Type as Template or Current Network.
b) Choose the File Type as xlsx or xlsm (Macros-enabled)

The Macros-enabled Excel sheet automatically customizes the tabs on the Excel sheet based on the platform that
you choose. It provides functionalities such as selection of fibers in the path selection, wavelength count validation
in case of regen selection.

c) Click Download.
The template has tabs and fields that you must fill in the Excel sheet. For details about these tabs and fields, refer to
Tabs available in the Excel sheet template on page 39.

2. Fill the network details in the template file or edit the current network file, and save the file.
3. Choose Import > Excel , and select the Import Type .

• New: Choose this option if you want to create a new network using the design data available in the Excel sheet.

• Existing: Choose this option if you want to update an existing network with the data available in the Excel sheet.
Open the network before you import the Excel sheet. Ensure the network is in Design mode, Upgrade mode, or
Release Upgrade mode.

You can view the data available in the Excel sheet before you import the network data. The View Data check box
remains checked by default. Uncheck it if you do not want to view the imported data.

4. Browse for the file, select it, and click Import.
During the import for the existing network, If the network is locked, Cisco ONP does not import the data. If the network
is unlocked and in upgrade mode, Cisco ONP updates the parameter. If the state is New, Cisco ONP adds parameters
from the Excel file as a new entry.
During a new network import, the system creates a new network design regardless of the state.

5. (Optional) After you successfully import the network design through Excel, choose a profile:
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a) Choose Network > Entity Editor.
b) Click the network name and select the required user profile from the Profile drop-down-list.

Note

Values specified in Excel take precedence over the profile. For properties not available in Excel and set to Auto,
they are updated according to the profile.

The selected network is imported.
If there are errors in the imported data, a pop-up error message is shown in case of new import, and the errors are
available under the Elements >Messages tabs in case of updating the existing network.

Tabs available in the Excel sheet template
Provides guidelines for tabs available in the Excel sheet template. Details the parameters required to understand this
component and apply it correctly within the network architecture.
This table lists the various tabs available in the Excel sheet template used to import a network.
Table 13: Tabs available in the Excel sheet template

DescriptionTabs

Label (name of the network), Platform (NCS2000(NON
SSON), NCS2000 (SSON), NCS1010, NCS 1001 , NCS
1014), Traffic Type, NCS1010 Line Card, NCS1010 Band
Type, Chassis Type, and System Release

Network

This is applicable for NCS 1010 network alone.
State (New, Locked, and Unlocked), NCS 1010 Line Card,
NCS 1010 Band Type, and Chassis Type

Network Property

Site Label, Type, X coordinates, Y
coordinates,X_Rearranged, Y_Rearranged, Pre Equip
Degree, Grooming Site, CLLI code, and Site Address,
Degree (Scalable upto degree), NCS1010 Line Card,
NCS1010 Band Type, Chassis Type, and State.

Sites

Span label, A (Source site name), Z (Destination site name),
Kms (Distance), Loss, Type, A_Edge, Z_Edge, AZ_Loss,
ZA_Loss, AZ_Kms , ZA_Kms, NCS1010 Band Type, Ageing
loss, and State.

Spans

Demand Label, A (Source), Z (Destination), Y (Tertiary
Source), B (Tertiary Destination), Type, Quantity, Protection,
Primary Path, Secondary Path, and State.
Note: Y and B can be used with Unprotected Disjoint
Service.

OTNDemands-4K-2K
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DescriptionTabs

Demand Name, Source, Destination, Service Group, Type,
A/D Type, Protection, Primary Wavelength, Secondary
Wavelength, Primary Path, Secondary Path, First Restoration
path, Second Restoration Path, Primary ODU Timeslot,
Secondary ODU Timeslot, Primary Regen, Secondary
Regen, Trunk Mode, Baud Rate, and State.

OTNDemands-4K-1K-2K

Channel Label, Source, Destination, Primary Wavelength,
SecondaryWavelength, Protection, Traffic Type, Card Type,
A/D Type, Primary Path, Secondary Path, Primary Regen,
Secondary Regen, and State.

MediaChannels

ServiceGroup Name, Demand Types, 4K Exclusive LC
Usage, 4K Symmetric Aggregation, 1K Exclusive LC Usage,
1K Symmetric AggregationChannel Label, and State.

ServiceGroup

PrimaryWavelength and SecondaryWavelength (Work and
Protect Wavelength for NCS2000 non-SSON waves),
Primary Path and Secondary Path (Work and Protect Path
for NCS2000Wave/Media Channel and NCS1010 circuit),
A/D Type (Colored/Colorless/Contentionless), Traffic Type,
Primary Regen Secondary Regen State, Channel label, A,
Z, Wavelength, Protection, and Type.

DWDMChannels

Service Name, Source, Destination, Type, Protection,
Primary Wavelength, Primary Path, Primary Regen, Card
Type, Trunk Mode, A/D Type, Band Type, and State.

Services-1K

Circuit Label, Source, Destination, Primary Wavelength,
Protection, Traffic Type, Card Type, A/D Type, Primary
Path, Primary Regen, Band Type, and State.

Circuits

Flex Optical Source Name.Flex Optical Source

SRLG Label, Spans, and State.SRLG

Network imports from Cisco Transport Planner
Describes the functionality of network imports from Cisco Transport Planner. Explains the benefits of this feature and how
it contributes to efficient and robust network planning.
The Cisco Transport Planner network import is a compatibility feature that
• allows you to import networks created and analyzed in Cisco Transport Planner into Cisco ONP, as .mpz files,

• prevents the need to recreate existing networks, and

• supports only networks from Release 11.0 or later for compatibility.

Supported hardware for CTP network import
Provides guidelines for supported hardware for CTP network import. Details the parameters required to understand this
component and apply it correctly within the network architecture.
Cisco ONP supports these hardware as part of CTP network import.
• Optical source files and transponders

See Supported Cards and Pluggables on page 357 and Supported Optical Sources on page 372.
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• Contentionless, colorless, and colored point-to-point demands

• Flex network

• Gain Equalizer

Note

The Gain Equalizer node converts to a ROADM node when you unlock the site after a release upgrade.

• ROADM-SMR-9 and SMR-20

• All flex supported amplifiers, controller cards, and chassis types

Import an mpz design file from Cisco Transport Planner
Teaches you how to import an mpz design file from Cisco Transport Planner. Instructs you on the necessary steps to
perform this task effectively and ensure proper network configuration.
Use this procedure to import an mpz file from Cisco Transport Planner to Cisco ONP.
• Log in to the Cisco ONP web interface on page 17 as a user with network creation permission.

• Import the required optical source files and layout template usingManage > Optical Source andManage >
Optical Source options. For more information, refer toManage Alien, andManage Layout .

• Delete the unsupported parameters for Cisco ONP from the mpz file. For example, mpz networks with P-Ring and
A2A demands are not supported for import. Delete these demands in Cisco Transport Planner, reanalyze the networks
in Cisco Transport Planner, and import the mpz file into Cisco ONP.

The network must be in design-analyzed or upgrade-analyzed mode.
1. Choose Import >MPZ.

The Import File (mpz) dialog box appears.
a) Browse to the mpz file stored on your computer.
b) From the Traffic Type drop-down list, choose 4K_1K_2K or 4K_2K.

You can view this drop-down list only if you select an SSON MPZ file.

c) Click Import.
The mpz file is imported to Cisco ONP.

Note

If you view a blank screen when you click waves in the network tree, refresh the browser.

2. ChooseNetwork > Upgrade orNetwork > Release Upgrade to make any changes on the imported network.
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Note

• You cannot go back to design mode on the imported mpz network.

• The wave label of imported mpz network in Cisco ONP is the service name present in the Cisco Transport Planner
properties window.

Export the CPZ file
Teaches you how to export the CPZ file. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Cisco ONP saves the network design file as a .cpz file in its database. Use this process to export the design file to your
computer.
The contents of the .cpz file depend on the network mode:
• In design mode, the .cpz file includes the design file, layout template, and optical source details.

• In analyze mode, the .cpz file contains several items: a design file, analyze file, ANS file, per-side ANS file, BOM,
error messages, trace files, layout template, mpz, and report.

• For networks in upgraded mode, you can only export the last child in the parent-child hierarchy.

Note

You can export only one network at a time.

Log in to the Cisco ONP web interface on page 17
1. Open the network whose design file that you want to export.

The network opens.

Note

If a blank screen appears when you open a network, refresh the browser or log in to Cisco ONP again.

2. Choose Export > CPZ.
3. Inside the Export .cpz file dialog box:

a) Rename the file if necessary.
b) If you want this operation to run in background, click the Run in Background check box.

A notification appears after the background operation is completed. Go to Job Monitor to view the progression
of the operation running in the background.

c) Click Export.
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The design file is stored on your computer. Starting with Release 26.1.1, the LUT version, and the user profile utilized in
the current network will be included during the export of the network CPZ file.

Import the CPZ file
Teaches you how to import the CPZ file. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to import the cpz network design files that are exported from another Cisco ONP instance.

Note

You can import only the networks that are exported from the current release.

• Log in to the Cisco ONP web interface on page 17

• Create a user profile, if you want to apply the profile that contains predefined configurations, into your cpz imported
network design.

.
1. Choose Import > CPZ.
2. In the Import .cpz file dialog box:

a) Click Choose file, and select a cpz network design file that you want to import into Cisco ONP, from your local
system.

b) If you want this operation to run in background, click the Run in Background check box.
After the background operation completes, you receive a notification. You can view the progress in JobMonitor.

c) Click Import.
If the names of the optical source and layout template files in the database and the imported network file match,
Cisco ONP prompts you to confirm whether you want to overwrite the existing file.

Note

The message "Network already exists in the system with another user. New network will be
created", you do not need to take any action. Cisco ONP automatically imports the network as a new network
for you without changing the existing network.

d) If you want to overwrite the existing file, check the Overwrite Network check box.
If you do not check the box, Cisco ONP saves the imported network as a new network.

e) Choose the optical source files and layout template that you want to replace.
If you do not choose the optical source or the layout template file, the files will not be imported.

f) Click Confirm.
The imported network is saved in the Cisco ONP database.

3. (Optional) After you successfully import the CPZ network, choose a profile:
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Note

If you had imported a CPZ network that was exported from Release 26.1.1, the user profile associated with that
network is included and remains active. Apply a profile only if you have imported a CPZ network from earlier releases
without an attached profile.

a) Choose Network > Entity Editor.
b) Click the network name and select the required user profile from the Profile drop-down-list.

The applied profile affects only entities added to the network after the import. Existing entities remain unchanged.

Live Network Import
Describes the functionality of live Network Import. Explains the benefits of this feature and how it contributes to efficient
and robust network planning.
The Live Network Import (LNI) feature is a network import capability that
• enables real-time import of deployed networks into Cisco ONP,

• supports import of networks and nodes with NCS 2000, NCS 1010, NCS 1001, NCS 1004, NCS 1014 shelves and
cards, and

• allows you to view comprehensive deployed network details after import.

Table 14: Feature History

Feature DescriptionRelease InformationFeature Name

The live network import feature now
offers the following enhancements:
• Supports the NCS 1001 platform.

• Includes all NCS 1004, and NCS
1014 native transponders (except
NCS1K14-2.4T-A-K9 and
NCS1K-OTN-XP) for NCS 2000,
NCS1010, and NCS1001
platforms.

• Imports network with mixed nodes
by grouping NCS2000, NCS1010,
and NCS1001 nodes into separate,
platform-specific Cisco ONP
networks.

These improvements enhance network
planning, boost automation, and ensure
consistent, error-free network
upgrades and configurations.

Cisco ONP Release 26.1.1Live network import enhancements
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Table 15: Feature History

Feature DescriptionRelease InformationFeature Name

CiscoONP nowdirectly communicates
with Cisco ONC to perform a live
network import, eliminating the need
for Cisco ONP to be directly connected
to a device or network. In addition to
the previously supported NCS 2000,
networks that include NCS 1010 nodes
contained within NCS 1010 and NCS
1014 shelves can also be imported.

Cisco ONP Release 25.1.1Live network import from Cisco ONC

Table 16: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to import a live
deployed network having NCS 1004,
NCS 2000, and NCS 4000 nodes into
Cisco ONP, using the LNI (Live Network
Import) import template. This feature
also allows you to view network
topology, BOM, and layout report.

Cisco ONP Release 4.1Live Network Import

The Map displays the network topology, and you can check the node, fiber, service, and circuit properties through the
Network Tree and the Entity Editor.
From Release 25.1.1, you can import a live network through Cisco ONC.
From Release 26.1.1, Cisco ONP supports these for all OLS platforms:
• NCS 1001 platform is supported.

• Upgrade and Release-upgrade are available for the imported network.

• Netconf generation and ANS are available after upgrading the imported network.

• LNI is supported for all NCS 1004, and NCS 1014 native transponders (except NCS1K14-2.4T-A-K9 and
NCS1K-OTN-XP) for NCS 2000, NCS1010, and NCS1001 platforms

• Mixed platform import:
Mixed platform import allows nodes from different OLS platforms to be imported. Cisco ONP groups nodes from the
NCS2000, NCS1010, and NCS1001 platforms into separate, platform-specific networks, because mixed-platform
nodes cannot coexist in a single network.
Each imported network uses a unique name in the format LNI__, which ensures clear distinction between platforms.

For more details on all hardware supported, see Configurations and hardware supported by LNI on page 47.

Perform live network import
Teaches you how to perform live network import. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure to perform live import of a network from Cisco ONC.
• Perform LNI only when the Cisco ONC is in a stable or running state. Do not perform LNI during the maintenance period

for software upgrade.
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• Ensure that the release version of Cisco ONC you are using for the network import is 25.1.1 or above.

• Cisco ONP removes any card that is not properly connected via IPC in Cisco Optical Site Manager during LNI. To retain
equipment, ensure that each card has at least one valid IPC connection in Cisco Optical Site Manager.

• Configure all the mandatory parameters on the circuit.

• Check the card label set for these NCS 2000 cards and update it if they are not aligned.

Card labelPID

AD-16-FSNCS2K-16-AD-CCOFS

SMR20-FS-CVNCS2K-20-SMRFS

SMR20-FSNCS2K-20-SMRFS-L

SMR9-17-FSNCS2K-9-SMR17FS

SMR9-24-FSNCS2K-9-SMR24FS

SMR9-34-FSNCS2K-9-SMR34FS

SMR9-34-FSNCS2K-9-SMR34FS-L

OPT-RAMP-COP15454-M-RAMAN-COP=

OPT-RAMP-CTP15454-M-RAMAN-CTP=

OPT-EDFA-35NCS2K-OPT-EDFA-35

• Log in to the Cisco ONP web interface on page 17

.
1. Choose Import > Live Import.
2. In the Import Live Network dialog box:

a) Enter CONC Server IP, Username, and Password.
b) Click Import.

The Import button will be enabled only when all the values entered are valid.

3. View the status of the LNI operation:
a) Click Job Monitor, to view the status of the IMPORT_LIVE_NETWORK task. Click Refresh to see the updated

status.
After LNI is completed, the job is removed from the Job Monitor page.

b) Click Logs to view the list of events that are related to the LNI operation, as logs.
4. After the completion of the LNI operation, choose File > Open.

The format of the LNI imported network filename is LNI_<Date>_<Time>.

5. Click the imported network name to view the network under theMap tab and its corresponding network tree in the
left panel.
You can view the tag Imported from Network in the interface.
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Note

• During the live import of a network with an optical source, if the configuration code of the optical source does
not match, it will default to NCS1004_SP_16QAM_300G_27%SDFEC_69GBd. You can update the optical
source in upgrade mode while the network is in a locked state.

• The configurations that are supported by Cisco ONC can only be imported into Cisco ONP. See Configurations
and hardware supported by LNI on page 47.

• Even if errors occur during the LNI operation, the operation is not canceled. In this case, when you open the
imported network, a warning message appears.

• You can view the errors under the Elements > Messages tab. See both critical and noncritical messages.
If you find unconnected equipment in theMessages tab, upgrade the imported LNI network and make the
necessary adjustments to reintegrate the removed equipment into Cisco ONP. However, note that the newly
created equipment UID may not match the one in Cisco Optical Site Manager. You can utilize the UID edit feature
to align the UIDs between Cisco ONP and Cisco Optical Site Manager. Refer to Edit the Unique ID of the chassis
on page 312

• Each user is permitted to initiate only one LNI process at a time. If a user tries to start an additional concurrent
LNI process, the system will terminate the new request and display an error message indicating the restriction.
This limitation is applied on a per-user basis, allowingmultiple users to run their own LNI processes simultaneously
on the same CONC server, as long as each user adheres to the rule of having only one active process.

• If both NCS and Non-NCS PIDS are present in the inventory, Cisco ONP enables the Enable NCS option. You
can edit this option during upgrade after unlocking the site, if necessary.

Click the BOM tab to view the BOM details of the network.

Note

The PIDs of prototype cards are shown as "NA" in the BOM details of the LNI network.

You can export the CPZ, import the CPZ, and share the imported network. Use the Entity Editor to view network
properties.

Configurations and hardware supported by LNI
Provides guidelines for configurations and hardware supported by LNI. Details the parameters required to understand
this component and apply it correctly within the network architecture.
The live network import from Cisco ONC supports the configurations and hardware listed in this table.
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Table 17: Configurations and hardware supported by LNI

ConfigurationsCardCard typeChassisPlatform

Contentionless
Unprotected circuits
Mixed configurations
Colored
configurations
Colorless
configurations

NCS2K-20-SMRFS-L
NCS2K-20-SMRFS=
NCS2K-20-SMRFS-CV=
NCS2K-9-SMR17FS=
NCS2K-9-SMR34FS=
NCS2K-9-SMR24FS-L=
NCS2K-9-SMR34FS-L=

ROADMNCS 2015
NCS 2006
NCS 2002

NCS 20001

NCS2K-16-AD-CCOFS
NCS1K-MD-64-C
15216-MD-48-ODD, and
15216-MD-48-EVEN
Mux/Demux
MF-MPO-16-LC
MF-MPO-8LC
MF-6AD-CFS

Add/Drop

NCS2K-OPT-EDFA-17=
NCS2K-OPT-EDFA-24=
NCS2K-OPT-EDFA-35=
15454-M-RAMAN-CTP=
15454-M-RAMAN-COP=
NCS2K-EDRA2-XX
NCS2K-EDRA1-XX

Amplifiers

Transponders
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ConfigurationsCardCard typeChassisPlatform

NCS2K-400GXP-L-K9
400G-CK-LC
200G-CK-C
200G-CK-C+10x10G-LC
NCS2K-200G-CK-LIC
NCS2K-200G-CK-LIC+
15454-M-10X10G-LC
NCS1K14-2.4T-K9
NCS1K14-2.4T-X-K9
NCS1K4-QXP-K9
NCS1K14-2.4TL-K9,
NCS1K4-2-QDD-C-K9
NCS1K4-1.2T-K9
NCS1K4-1.2TL-K9

1 Optical source interface import is not supported in NCS2000. By default, it is set to
NCS1004_SP_16QAM_300G_27%SDFEC_69GBd. You can manually edit the optical source interface to the correct one
during an upgrade, without unlocking the circuit.
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ConfigurationsCardCard typeChassisPlatform

Colored
Colorless
Unprotected Circuits

All OLT variants with Standard
and Enhanced faceplate

ROADMNCS 1010
NCS 1014

NCS 1010

CCMD16-C
MD-32-ODD
MD-32-EVEN
BRK-24
BRK-8
Direct LC

Add/Drop

All ILA variantsAmplifiers

NCS1K14-2.4T-K9
NCS1K14-2.4T-X-K9
NCS1K4-QXP-K9
NCS1K14-2.4TL-K9,
NCS1K4-2-QDD-C-K9
NCS1K4-1.2T-K9
NCS1K4-1.2TL-K9

Transponders

NCS1K-EDFA
NCS1K-PSM

AmplifiersNCS 1001 (Only
terminal nodes)

NCS 1001

NCS1K-MD-32E-CE and
NCS1K-MD-32O-CE
15216-FLD-4-XX.X

Add/Drop

NCS1K14-2.4T-K9
NCS1K14-2.4T-X-K9
NCS1K4-QXP-K9
NCS1K14-2.4TL-K9,
NCS1K4-2-QDD-C-K9
NCS1K4-1.2T-K9
NCS1K4-1.2TL-K9

Transponders

Configurations and hardware unsupported by LNI
Provides guidelines for configurations and hardware unsupported by LNI. Details the parameters required to understand
this component and apply it correctly within the network architecture.
This section outlines the configurations and hardware that are not supported by the Live Network Import from Cisco ONC.
LNI does not support these configurations and hardware
• NCS1K4-OTN-XP card

• These transponder modes are not supported: 50G, 150G, 250G, 350G, 450G, and 550G
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• Configurations with Inline amplifiers

• Regeneration and Protection circuits

• NCS 1014 as a platform and NCS1K14-EDFA2 card

• OTN cross-connects on the 400G-XP-LC module and OTN-XP card

• NCS 1010 Omni configurations and NCS 1010 C+L configurations

• Different Add/drop functionalities (Colored, Colorless, or Contentionless) at Source and Destination.

Limitations of LNI
Provides guidelines for limitations of LNI. Details the parameters required to understand this component and apply it
correctly within the network architecture.
These are the limitations, unsupported features, and known constraints of LNI, and scenarios where LNI may not function
as expected and the available workarounds.
• Simultaneous import of multiple live networks and scheduled import are not supported. LNI does not support importing

Non-SSON networks.

• If X, Y coordinates are not configured in the devices, nodes are overlapped in the Cisco ONP map.
Workaround: Configure X, Y coordinates before importing the network for a better view of the topology in Cisco
ONP map; otherwise, you can drag and drop the nodes in the Cisco ONP map and adjust the node position after
importing.

• Cisco ONP imports the proto-PID, if present in the inventory, and show as N/A PID in the Cisco ONP BOM. Duplicate
media channel labels are not supported. If multiple media channels with the same label exist in the network, only one
is imported; the rest are discarded.

• Fiber name, source, and destination names may not match between imports; source and destination site names may
interchange for bidirectional fibers. Fibers may not associate with the correct optical subnet if channel numbers differ
at source and destination, causing amplifier output power issues. Workaround: Correct channel numbers at both ends
and re-import or associate fibers with the correct optical subnet after upgrade.

• Transponder cards that are not utilized for any circuits will be removed in Cisco ONP.

• The NCS1000 BoM is not included for networks imported with NCS2000 and NCS1004/NCS1014. The NCS1000
BoM is populated following an upgrade analysis.

• A combination of BRK-8 and BRK-24 on the same node is not supported.

Predefined user profiles
Use this concept to understand predefined user profiles, their roles, and key properties. Predefined profiles standardize
user permissions and accelerate configuration in network management systems.
A predefined user profile is a user configuration template that
• saves all settings across both network and all entities such as sites, fibers, , services, and circuits into a unified profile

file,

• is stored securely in the Cisco ONP database and can be modified or exported as needed, and

• can be imported into the Cisco ONP environment to instantly apply the same configuration settings to designs.
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Table 18: Feature History

Feature DescriptionRelease InformationFeature Name

Now you can save all network and
site-level settings into a reusable
profile file, in the CONP database. You
can use this profile during network
designing ensuring consistent
configurations across different designs
and teams. This feature eliminates
repetitive manual setup, reduces
errors, and streamlines configuration
sharing and management within an
organization.

Cisco ONP Release 26.1.1Reusable predefined user profiles

Cisco ONP lets you create reusable settings profiles that capture all configuration details for your planned or deployed
networks. These profiles help you consistently apply, share, and manage settings across multiple platforms, including:
• NCS2000 (Releases 11.1.0, 25.1.1, 26.1.1) with SSON/Non-SSON modes and various traffic types

• NCS1010 (Releases 7.10.1 to 26.1.1)

• NCS1001 (Releases 7.10.1, 25.4.1)

• NCS1014 (Releases 25.1.1, 26.1.1)

By using profiles, you can eliminate repetitive manual configuration and reduce errors. Profiles are stored as JSON files
in the Cisco ONP database and include network-level, site-level, fiber, and media channel settings, each with platform
and version-specific compatibility.
Cisco ONP supports profiles for all key network entities, including:
• Networks

• Sides

• Sites (ROADM, OLA, TRAFFIC)

• Fibers

• Media Channels/Waves/Circuits

Note

Only newly created entities, such as sites and fibers, will be affected after applying the profiles. Existing entities that
were created before the profile application will not be impacted.

Create user profile
Teaches you how to create a user profile, define its properties, and share or export it. Instructs you on the necessary
steps to manage user profiles for your Cisco ONP environment.
Use this task to create a user profile that stores configuration properties you can reuse when building new networks. This
approach allows your organization to standardize network templates and share configurations easily.
Log in to the Cisco ONP web interface on page 17.
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1. ChooseManage > Profiles.
2. Create a new profile.

a) Click Create New Profile.
b) Enter the name of the profile.
c) Select the Profile Details such as platform and the Release number.
d) Click Fetch Default Properties to load the properties.
e) Under the Properties pane,select the settings you want to include for future networks. Then click Save.

Note

You cannot set optical subnet properties in the profile at this time.

Note

Ensure all necessary entity properties are updated before saving. You can navigate between different entities
to update properties and then save. Once saved, the profile cannot be modified. If changes are needed, users
can clone and edit the profile.

3. (Optional) Share the profile.
a) Click Share.
b) In the Share Profile window, select the groups and users you want to share the profile with and click Share.

4. (Optional) Export the profile to JSON file format:
a) Click Export, to download the profile file to your system.

Exported files can be edited externally, backed up, or shared across Cisco ONP instances.

5. (Optional) Import a profile.
a) Click Import, and select the JSON file.

The profile is imported to database and added to the user profile list.

6. Delete a profile if you are the owner of that profile:
a) Click Delete.

The system prompts an error message if the profile was already in use, else asks for confirmation to delete

b) Confirm to delete the profile.
7. (Optional) Set the user profile as a default one:

a) ClickManage Default Profiles and for each platform choose the Default Profile.

Limitations of user profiles
Describes the functionality of limitations of user profiles. Explains the benefits of this feature and how it contributes to
efficient and robust network planning.
User profiles are subject to these limitations:
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• User profiles must be finalized before saving, as they cannot be modified afterward. To make changes, update all
necessary entity properties while navigating between entities prior to saving. If further adjustments are required later,
clone the existing profile and edit the clone.

• If you import a CPZ network that was exported from Release 26.1.1, the user profile associated with that network is
included and remains active. If you import a CPZ network from earlier releases without an attached profile, you can
apply a profile using the Profile property at the network level. The applied profile affects only entities added to the
network after the import. Existing entities remain unchanged.

• When you upgrade a network that was designed in releases prior to 26.1.1, where no profile was attached, you can
apply a profile, but it will only affect new entities added to the network after the upgrade, not the existing ones.

• When creating a network using Excel, users can apply the profile. Values specified in Excel take precedence over the
profile. For properties not available in Excel and set to Auto, they are updated according to the profile.

Convert NCS 2000 network to NCS 1010 network
Teaches you how to convert NCS 2000 network to NCS 1010 network. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to convert an NCS 2000 network (both SSON and non-SSON) into an NCS 1010 network.
Table 19: Feature History

Feature DescriptionRelease InformationFeature Name

The newly introduced NCS 1010
Convert option under the Network
menu enables you to directly convert
an existing NCS 2000 network into an
NCS 1010 network. This conversion
eliminates the need to build an NCS
1010 network from scratch.

Cisco ONP Release 5.1Convert NCS 2000 network to NCS
1010 network

1. Open the NCS 2000 network that you want to convert to an NCS 1010 network.
Ensure that the network is in Design Mode, Upgrade Mode or Release Upgrade Mode.

2. Choose Network > NCS 1010 Convert, then click OK.
The network is not converted and shows an error message if
• the network contains traffic sites,

• the fiber type is LS or TWClassic,

• the network contains OTN services,

• the Traffic Type property is set to anything other than Optical Source or Pluggable Card, and

• the Traffic Type is 100G-SD-FEC or 200G-SD-FEC in non-SSON networks.

3. Choose File > Save.
These parameters are automatically updated after the conversion:
• Contentionless sides are deleted, and contentionless demands are automatically changed as colorless, and

• protected channels are converted to two unprotected channels. The path, wavelength, regeneration sites, and
cards that are configured are retained.
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Optical subnets and their role in networks
Describes the functionality of optical subnets and their role in networks. Explains the benefits of this feature and how it
contributes to efficient and robust network planning.
An optical subnet is a network structure that
• consists of a collection of spans with defined properties,

• is automatically created when a new network is set up in Cisco ONP, and

• must exist in at least one instance for every network.

When a new network is created, Cisco ONP links an optical subnet to it, ensuring that each network has its own optical
subnet for proper operation.

Create optical subnet
Teaches you how to create optical subnet. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to create an optical subnet in Cisco ONP for Non-SSON, SSON, or NCS 1010 networks.

Note

Check the Current Subnet check box in the properties window below the network tree, to make the subnet you
created as the current subnet. You cannot uncheck the Current Subnet check box.

Log in to the Cisco ONP web interface on page 17

Note

For NCS 1010 networks, both C-Band and L-Band optical subnets appear by default, from the Release 7.9.1. For
C-Band and C+L Futuristic networks, the L-Band optical subnet contains no fiber links unless upgraded or configured
with an L-Band edge.

1. Open the required network (Non-SSON, SSON, or NCS 1010) in which you want to create a subnet.
2. Expand Subnet in the network tree panel.
3. Click the Ellipsis icon available next to the Optical Subnet, and select Create Optical Subnet.
4. In the Create Optical Subnet dialog box:

Then...If you are creating optical subnet for...

From the Cband Rules drop-down list, choose the
C-band design rules for the new optical subnet, then click
Save.

non-SSON network
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Then...If you are creating optical subnet for...

• From the Band Type drop-down list, choose either
C-Band or L-Band.

• From theSpectral Density drop-down list, choose
the spectral density for the new optical subnet that
you want to create.
The selected spectral density determines the value of
Name, CBand Rules or LBand Rules, and
Maximum Number of Channels that appear in
the Create Optical Subnet dialog box.

• Click Save.

SSON network

• From the Band Type drop-down list, choose either
C-Band or L-Band.

• From theSpectral Density drop-down list, choose
the spectral density for the new optical subnet that
you want to create.
From Release 5.2, the range of spectral density has
increased from 30 to 100 units.
The selected spectral density determines the value of
Name, CBand Rules or LBand Rules, and
Maximum Number of Channels that appear in
the Create Optical Subnet dialog box.

• Click Save.

NCS1001, NCS 1010 and NCS1014 networks

5. (Optional) After the new optical subnet is created:

Then...If you want to...

select a new spectral density from the Spectral Density drop-down list
in the properties window displayed under the network tree.

select a new spectral density

add a fiber to a subnet from the Fiber links drop-down list in the properties
window.
The fiber now appears in the Fiber links field. When you select the optical
subnet, its corresponding fiber is highlighted in the map.

add a fiber to a subnet
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Then...If you want to...

• Click the Ellipsis icon available in the right side of the required optical
subnet and select Edit Fibers.

• In the Info dialog box, click OK.
The user interface will freeze to allow fiber selection from the map.

• Select the required fiber and click the Done button appearing near the
zoom icon.

Note

When a fiber is added to one of the subnets, it is automatically removed
from the other subnets. Only one subnet rule is associated with each fiber.

add a fiber to a subnet from the
network tree panel

select a new spectral density, and check theAuto checkbox in the properties
window displayed under the network tree.
Auto-SD automatically adjust the optimized spectral density based on the
Circuit Card type selected for the subnet spans.

enable Auto SD

Cisco ONP creates the new optical subnet with your selected properties and places it under OpticalSubnet in the
network tree panel.

Share a network
Teaches you how to share a network. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to share a network with one or more users or user groups.
Log in to the Cisco ONP web interface on page 17.
1. Open the network that you want to share.
2. Choose File > Share.
3. In the Share Network dialog box, select one or more users or user groups, and then click Share.

You can share the network with selected users or user groups in read-only mode.

Access a shared network
Teaches you how to access a shared network. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Use this procedure to open a network shared by another user and save an editable copy for your own work.
Log in to the Cisco ONP web interface on page 17.
1. Open a shared network.

a) Choose File > Open Shared.
b) In the shared network list, choose the network you want to open.

The shared network opens in read-only mode.
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2. Choose File > Save As.
3. Enter a name for your copy and click Save.

A copy of the shared network is saved.
You now have your own editable copy of the shared network. You can work on it according to the privileges of your
user role.

4. (Optional) If you want, share your updated network with other users.

Unshare a network
Teaches you how to unshare a network. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to remove user or user group access to a previously shared network, ensuring only authorized individuals
retain visibility and control of the network.
Log in to the Cisco ONP web interface on page 17.
1. Open the network you want to unshare.
2. Choose > Share.
3. In the Share Network dialog box, remove the name of one or more users or user groups from the list, then click

Share.
The shared network is no longer available to the users or user groups that are removed.

Split-Step Fourier simulation
Describes the functionality of split-Step Fourier simulation. Explains the benefits of this feature and how it contributes to
efficient and robust network planning.
A split-step Fourier (SSF) simulation is a computational method that
• calculates optical parameters such as OSNR and BER,

• improves simulation accuracy in complex optical network scenarios, and

• leverages GPU-based computation for intensive analysis.

SSF simulation is introduced alongside the e-GN algorithm to enhance the analysis of NCS 1010 networks, providing
improved accuracy for optical signal-to-noise ratio (OSNR) and bit error rate (BER) simulations.
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Limitations of SSF simulation
Table 20: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP Release 25.1.1Split-Step Fourier (SSF) Simulation
Method

Cisco Optical Network Planner | Updated March 10, 2026

| Design and Analyze Networks | 59



Feature DescriptionRelease InformationFeature Name

The Split-Step Fourier (SSF) method is
introduced to calculate optical
parameters in addition to the existing
e-GN algorithm for analyzing NCS
1010 networks. This enhancement:
• Improves the accuracy of the

simulations for OSNR and BER,
particularly in complex network
scenarios.

• Provides an SSF engine that
leverages GPUs to work on intense
calculations.

• Requests simulation generation
fromGENE (Generic Engine for NCS
1000 platforms)

• Monitors analysis progress on the
GPU server, and updates the user
through analysis notifications.

• Sends simulation results to GENE
for report generation after analysis
completion.

• Provides a Lookup Table that
contains the default optical
specification values for each
supported amplifier.

The new properties that enable the SSF
method for network analysis are.
• At network level, Advanced

Optical Settings > SSF
Simulation—Enables the SSF
simulation. Enable the Enable
Special Settings check box to view
the SSF Simulation check box

• At network level, Advanced
Optical Settings > LUT
version—Shows the default LUT
version to be used for network
analysis. Enable the Enable Special
Settings check box to view the LUT
version check box

• Preferences > General
Settings > SSF Server
Details—Allows to configure the
GPU server used for SSF simulation.

• Manage > Lookup
Table—Allows you to refer the
default optical specification of the
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Feature DescriptionRelease InformationFeature Name

supported amplifiers.

Cisco ONP has implemented the
following enhancements for network
design:
• ALC Phase II Device Parameters:

NETCONF XML files now include
additional ALC phase II parameters,
such as Raman amplification and
advanced optical settings for more
precise device configuration.

• Lookup Table (LUT) Improvements:
• Raman gain values are now

visible in LUT entries.

• LUTs can be imported/exported,
including CPZ data.

• Raman side amplification is
calculated from LUT entries for
better modeling accuracy.

• Tx connector loss is
user-configurable and factored
into PSD values.

• SSF simulation enhancements:
• Uses secure HTTPS protocol for

communicationwith SSF server.

• Supports parallel SSF analysis
from different servers when
multiple users trigger the
process

• Enables background analysis
without interrupting other tasks.

• Displays estimated simulation
timing in the analysis progress
bar.

These updates enhance the accuracy,
configurability, security, and usability
of optical network planning and
simulation for NCS 1010 networks.

Cisco ONP Release 26.1.1NCS 1010 network design
enhancements

From Release 26.1.1, the SSF analysis includes the following enhancements:
• The SSF analysis can now be executed in the background. To enable this feature, set the property

"conp.backgroundAnalysis.enable" to true in the filename.properties in the location /opt/cnp/conf folder in Cisco ONP
server. Once enabled, you can click the "Run in Background" button when starting the SSF analysis.
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• The analysis progress bar now displays the estimated remaining time for the analysis.

• The SSF simulation supports the analysis of networks with multiple point-to-point disjoint networks and uses the
HTTPS Protocol for communication with GPU-based SSF instances.

• If multiple users configure different SSF servers on the CONP server and initiate the analysis, multiple SSF analysis
can run concurrently in the background. However, if a single user starts two SSF analysis, the second analysis will
remain in the queue until the first one is completed. A message stating "waiting for current SSF analysis to be
completed" will be displayed in the analysis progress bar.

SSF simulation currently has these limitations:
• Supports only point-to-point networks

• Works only with CIM8 interfaces

• Supports only colorless add/drop

• Computation intensive than e-GN algorithm for better OSNR margins

How SSF simulation works
Describes the functionality of how SSF simulation works. Explains the benefits of this feature and how it contributes to
efficient and robust network planning.
SSF simulation uses the split-step Fourier method to analyze optical parameters in NCS 1010 networks by utilizing GPU
acceleration and integrating with the GENE engine.
The key components involved in the process are:
• SSF engine: Runs on GPUs to perform intensive optical calculations.

• GENE (Generic Engine for NCS 1000 platforms): Initiates and receives simulation jobs and results.

• GPU server: Handles the computational workload and notifies you about analysis progress.

• Lookup Table (LUT): Stores default optical specification values for each supported amplifier.

The process involves these stages:
1. The SSF engine requests simulation generation from GENE.

2. The GPU server executes intensive optical parameter calculations using the SSF method.

3. The system monitors analysis progress and sends you notifications.

4. When the analysis is complete, you can view the simulation results in GENE for report generation.

5. The system references the Lookup Table for default optical specification values as part of the analysis.

SSF simulation gives you accurate OSNR and BER simulations, especially for complex optical network scenarios, with
improved computational performance through GPU acceleration.

Set SSF server details
Teaches you how to set SSF server details. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Use this procedure to set the SSF server to run the SSF analysis.
Install the SSF component. See Install Cisco ONP.
1. Navigate to SSF Server Details.

a) Choose Preferences > General Settings
b) In the dialog box, select SSF Server Details.
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2. Enter the SSF server details.
• SSF Server IP: Enter the server IP address.

• API Key: This field is disabled.

• Proxy IP: Enter the customized proxy IP address.

• Proxy Port: Enter the proxy port of the server.

3. Click OK.
To reset the server details or close the dialog box, click Reset or Cancel.

Lookup tables
Describes the functionality of lookup tables. Explains the benefits of this feature and how it contributes to efficient and
robust network planning.
A lookup table is a configuration data structure that
• stores predefined values used by analysis and simulation processes,

• allows efficient retrieval of data without the need for recalculation, and

• supports versioning, enabling different simulation or network scenarios.

Cisco ONP uses lookup tables (LUTs) for analysis with SSF simulation and when SSF simulation is not active. Only NCS
1010 networks use LUT values. You can enable LUT functionality only after selecting theAdvancedSpecial Settings
check box at the network level.
This table explains the range of span loss for different fiber types. LUT calculations work only if the loss stays within these
ranges.

Max Span loss (dB)Min Span loss (dB)RamanFiber Type

26.55NoSMF

33.018YesSMF

22.95NoE-LEAF

32.918YesE-LEAF

20.35NoTW-C

3016YesTW-C

Manage amplifier gains using look up table
Teaches you how to manage amplifier gains using look up table. Instructs you on the necessary steps to perform this task
effectively and ensure proper network configuration.
Use this procedure to refer or to manage the amplifier gains in the look up table.
1. Open look up table.

a) ChooseManage > Lookup Table
TheManage Lookup Table dialog box opens displaying the list of supported amplifiers.

ActionsOptions

Allows you to type in the amplifier to filter the desired
lookup table.

Search
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ActionsOptions

Selects all amplifier tables or only the required amplifier
tables.

Check boxes

Turns to the desired page.Page numbers

Imports the customized tables.Import

Exports the selected tables.Export

Deletes the selected tables.Delete

Closes the dialog box.Cancel

When expanded, the table displays the optical specifications.
Table 21: Amplifier optical specifications

DescriptionParameter

Displays the list of supported fibers for the amplifier.Fiber Type

Displays total signal loss in dB.Total Loss (dB)

Displays the SD gain range.SD Range

Displays the status of Raman amplification in the amplifier.
You can select and filter the table based on Raman gain
value and whether Raman is applicable or not.

Raman Amplified

Displays the Raman amplifier gain. You can select and
filter the table based on the Raman gain value.

Ramna Gain

Displays the PSD value for the booster amplifier in dBm.
Raman gain is used in the calculation of the PSD.

BST PSD (dBm)

Contains an information button to check for additional
values.

More Parameters

2. (Optional) Customize the optical specifications in the Lookup table.
a) Select the required amplifier.
b) Click Export.

The amplifier value downloads in spreadsheet.
c) Edit the values in the downloaded spreadsheet and click Import.

The new values are added to the Lookup table.
3. (Optional) Delete the customized specifications in the Lookup table.

a) Select the required amplifier.
b) Click Delete.

Restriction

You cannot delete the default tables.
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Analyze the network
Teaches you how to analyze the network. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
After completing the network design, use this procedure to analyze the network.
Table 22: Feature History

DescriptionRelease InformationFeature Name

The See More Details option has
been introduced in the tooltip displayed
on hovering over Sites on theMap
view of an analyzed network. This
option shows the Amplifier data and
PSD (Power Spectral Density) profile
graph. TheSeeMoreDetails option
avoids navigating to the Entity Editor
to view these details.

Cisco ONP Release 5.1Detailed Tooltip for Sites on the Map
View

Log in to the Cisco ONP web interface on page 17.
1. Open the network that you want to analyze.
2. Analyze the network:

a) Choose Network > Analyze.
The analysis progress indicator shows the current analysis status. After successful analysis, the network goes to
Analyze Mode.

b) If you see the “Analysis Failed.” message, navigate to the Elements >Messages tab to see the list of error
details in the analyzed network.
By default, the system displays only the key messages when the Critical Only toggle button is enabled. If you
want to view the entire network message, disable the Critical Only toggle button.

c) Resolve the error and analyze the network again. Continue until you resolve all errors.

Note

You may see the error message 'Unexpected Situation 999' if incorrect property values are entered or changed
during network design. Contact Cisco TAC to identify the exact cause of the error. Afterwards, modify the suggested
property value so that the network analysis completes successfully.

3. If you want to view the details such as Amplifier Data and PSD Profile graph for a site in an analyzed network,
hover the mouse over a site and click See More Details.
Amplifier data includes output power, EOL gain, attenuator in and out, and Raman gain values. For NCS 1010 sites,
the amplifier data does not include attenuator details, and only these sites show the PSD profile graph.
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Bottom-up flow and network creation
Describes the functionality of bottom-up flow and network creation. Explains the benefits of this feature and how it
contributes to efficient and robust network planning.
A bottom-up flow is a network creation approach that
• enables incremental, step-by-step building of a network over several days,

• allows analysis and report generation at each phase without requiring all services or waves to be configured on the
first day, and

• provides flexibility in the order of adding network elements such as services and waves.

How bottom-up flows work
Describes the functionality of how bottom-up flows work. Explains the benefits of this feature and how it contributes to
efficient and robust network planning.
The bottom-up flow process enables gradual, phase-based network creation and analysis, giving users flexibility in
building and evaluating their network incrementally.
The key components involved in the process are:
• Network administrator: Builds and configures the network in stages.

• Network topology: Consists of sites and fibers initially added to form the network’s structure.

• Services and waves: Additional network components that can be added over time for increased functionality and
connectivity.

The process involves the following stages:
1. On Day 0, the administrator creates the network by adding all sites and fibers to define the topology. They can analyze

the network and view reports at this stage without configuring services or waves.

2. On Day 1, the administrator adds waves between sites (including both previously added and new sites/fibers), then
re-analyzes and reviews updated reports.

3. On Day 2, the administrator adds services and tags the waves created in the previous stage, as well as incorporates
additional sites and fibers as needed, with ongoing analysis and reporting.

4. After the initial topology is created, services or waves can be added in any order, without following a prescribed
sequence.

The bottom-up flow process supports flexible, staged network development and ongoing analysis, optimizing the
configuration and deployment of Non-SSON networks.

Idle timeout in the Analyze mode
Describes the functionality of idle timeout in the Analyze mode. Explains the benefits of this feature and how it contributes
to efficient and robust network planning.
An idle timeout in analyze mode is a session management feature that
• logs users out of Cisco ONP if the browser is inactive for a default duration of 15 minutes,

• allows system administrators to disable or adjust the timeout through server configuration options, and

• affects ongoing network analysis by running it in the background if logout occurs during an active analysis cycle.
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Idle timeout settings and session restoration behavior
Provides guidelines for idle timeout settings and session restoration behavior. Details the parameters required to understand
this component and apply it correctly within the network architecture.
The default idle timeout in Cisco ONP is 15minutes. System administrators can disable this timeout by setting the enabled
option to false in the configuration file, or adjust the timeout duration by editing the duration option.
If a session times out during an analysis, network analysis continues to run in the background. When the user logs in
again:
• If the analysis is ongoing, the progress bar appears and no actions are allowed.

• If the analysis is complete, the network opens in Analyze mode.

• If the analysis failed, the network opens in Design mode and the failure reason can be viewed under Elements >
Messages.

Upgrade the analyzed network
Teaches you how to upgrade the analyzed network. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
• Log in to the Cisco ONP web interface on page 17

• Create a user profile, if you want to apply the profile that contains predefined configurations, on a network that was
designed in releases prior to 26.1.1.

.
Table 23: Feature History

DescriptionRelease InformationFeature Name

After a network is analyzed, all the
network elements get locked. With this
feature, you can selectively unlock
certain network elements to upgrade
the network further. This helps in
preventing accidental updates to the
part of the network that does not need
any modification.

Cisco ONP Release 5.0NCS 1010 Network Upgrade Flexibility

Use this procedure to upgrade an existing network that is in analyzed mode. You can change specific properties of a
network element while keeping the network layout and design locked.
Upgrade is supported for NCS2K, NCS4K-2K, NCS4K-1K-2K, and NCS1010 networks.
1. Open the network that you want to upgrade.
2. Upgrade the network:

a) Choose Network > Upgrade.
b) Click Yes .
Themessage “Network Upgraded Successfully” appears. The network goes into upgrademode and network elements
such as sites, fiber, waves (for non-SSON), media channel (for SSON), and circuits (for NCS 1010) are locked.

3. To modify a network element in the network tree panel, click the Ellipsis icon next to element, and chooseUnlock.
Unlock individual elements at the node, side, add/drop card, or amplifier level in the network tree hierarchy.
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If you want to change only the add/drop between MD-32-ODD/Even or BRK_24/16/8 in the NCS 1010 network, you
can unlock the add/drop without unlocking the network elements that are higher in the hierarchy.
Make these modifications:
• Edit properties of network elements.

• Delete elements from the network.

• Add a new site, wave, service, demand, optical subnet, or fiber into the network map.

4. Choose File > Save.
The newly added elements are automatically displayed in the network tree panel, and by default, remain unlocked.

Note

To insert a node in upgrade mode, unlock the fibers connected to that node, then add the node to the network.

5. Choose Network > Analyze.
After the analysis is completed, the newly added elements are locked, and the optical reports and installation parameters
of the upgraded network are updated.
When you add services or fibers while upgrading a network with an applied layout template, the template updates to
include the new service or fiber. You can export the template, make changes, and reapply it to another network.

6. Choose Network > Design to further upgrade the newly upgraded network design.
Each time you upgrade the network, Cisco ONP saves the new version as a child network andmaintains the parent-child
relationship.

Upgrade LNI network
Teaches you how to upgrade LNI network. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to correct errors in your LNI network, modify ,and reanalyze it, and view updated BOM, layout,
connections, and optical results.
Table 24: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to upgrade and
modify the imported LNI (Live Network
Import) network as required. You can
also correct LNI errors, reanalyze the
network, and view the updated
parameters such as BOM, layout,
connections, and optical results.

Cisco ONP Release 4.1Upgrade LNI Network

Log in to the Cisco ONP web interface on page 17.
1. Open the network imported through LNI that you want to upgrade.
2. Upgrade the network:

a) Choose Network > Upgrade.
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b) Click Yes .
Themessage “Network Upgraded Successfully” appears. After you upgrade the network, it enters upgrademode,
which locks elements such as sites, fiber, OTN services, and media channels.

3. To modify a network element in the network tree panel, click the Ellipsis icon next to element, and chooseUnlock.
Unlock individual elements at the node, side, add/drop card, or amplifier level in the network tree hierarchy.
Make these modifications:
• Edit the properties of network elements.

• Delete elements from the network.

• Add a new site, wave, service, demand, optical subnet, or fiber into the network map.

4. Choose File > Save.
Each time that you upgrade the network, Cisco ONP saves the new version as a child network and maintains the
parent-child relationship.

5. Choose Network > Analyze.
Analysis succeeds only if the imported network is consistent and valid. For instance, in an NCS 2000 network imported
from Cisco ONC, if the device connections do not match with Cisco ONP rules, the upgrade analysis may fail with a
connection error. If the analysis fails, perform the listed steps:
a) Check the reports under Elements Messages for failure reasons.
b) Unlock the specific site to allow Cisco ONP to rebuild the connections according to its rules. Alternatively, correct

the connections on the device and re-import the network.
c) Reanalyze the network.

6. After analyzing the network:
a) Click the Layout tab and edit the layout manually to adjust chassis or card position for NCS 4000 and NCS 1004

platforms. See
b) Click the BOM tab and the Results tab to view the BOM and optical results.

Possible error scenarios and the workarounds
Provides guidelines for possible error scenarios and the workarounds. Details the parameters required to understand this
component and apply it correctly within the network architecture.
This table provides the workarounds for the errors that are shown under the Elements > Messages tab.
Table 25: Error scenarios and the workarounds

WorkaroundsError message

Unlock C-Band amplifiers for side A within Site4 in the
Network tree, and set the correct output power. If you are
unsure, choose Auto and analyze the result. Cisco ONP
chooses the best value based on the configuration.

In Site4.A, output power setting is not supported by the
amplifier.

For protected OTN or SSON services, ensure that at least
two contentionless sides are present on both the source
and destination sites. Add contentionless sides where
necessary, then analyze the network configuration.

Cannot Route demand! Did not find any valid
Omnidirectional Side.

Unlock the site and reanalyze.Cannot complete mesh connections at Site3.
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WorkaroundsError message

Unlock the corresponding fiber couple and update the
connector loss value so that it is greater than zero. The
typical value is 0.2.

Fiber between Node1.A and Node2.B has an invalid value
in connector loss value

Unlock the corresponding fiber couple and update the Tot
SOL Loss w/o Connectors value so that it is greater than
zero.

Fiber between Nod1.C and Node2.C has an invalid value
in Tot SOL Loss w/o Connectors.

Remove Raman forcing on the fiber, or force the path for a
service to ensure it travels through a Raman-enabled span.

Span Fiber-2 is forced as Raman but no traffic is present.

Force RAMAN-CTP or COP on the Fiber-2 connecting node
interface, or remove RAMAN forcing on the Fiber-2.

Couple Fiber-2 has Raman enabled on the duct but
corresponding Raman Forcing is missing.

Verify the optical source card type configured at the Circuit
or Media Channel Trail level. If it differs from the expected
type, perform a network upgrade of the imported network
and force the required card type at the Circuit or Media
Channel Trail level.

Circuit
[onc_BH-2_1002/1/PORT-3_BH-4_1002/5/PORT-2]
imported with default optical source card type

Forced/Locked wavelength is not feasible for spectrum
allocation for the demand. Choose an adjacent central
wavelength or frequency separated by 6.25 GHz. Set
Wavelength is not feasible for the card type or in the 3.125
GHz grid. In NCS2K, only 6.25 GHz width is supported. Try
setting the adjacent wavelength or Set Wavelength to Auto.

Error: Spectrum could not be assigned for the
demand/group.

Enable Ignore Raman Span Checks property at
network level or create P2P circuits on RAMAN-COP span.

Duct ots_Site-2-1_SIte-1-1 is a Raman amplified span
using RAMAN-COP: all circuits must be terminated in
Site-1.A and Site-2.A

Note

No specific action is required for noncritical messages. These are just information messages to the user.

Upgrade the software release of a network
Teaches you how to upgrade the software release of a CTP network to be compatible with Cisco NCS 2000 SVO. Instructs
you on the necessary steps to perform this task effectively and ensure proper network configuration.
Table 26: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to choose the
NCS 2000 system release to the
desired release (11.1.0, 12.0.1, or
12.1.0), while performing the release
upgrade of CTP network, Cisco ONP
network, network imported through
Excel, and LNI network.

Cisco ONP Release 4.1Release Upgrade
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You can upgrade the software version of networks that are imported from CTP, created in Cisco ONP, LNI Network, or
imported from Excel to any desired release version. The release upgrade is supported for both SSON and non-SSON
networks that have NCS 2000 nodes with ROADM, OLA, Traffic, or Passthrough functionality, and NCS 1010 networks.
Release upgrade is supported starting with NCS 2000 Release 11.1.0.

Note

NCS 2000 supports Cisco Optical Site Manager from 25.1.1.

See Supported upgrade paths for network system releases on page 71for the available upgrade releases for each network
type.
Log in to the Cisco ONP web interface on page 17.
1. Open the network in which you want to perform the system release upgrade.
2. Upgrade the software release of the network:

a) Choose Network > Release Upgrade.
b) From the New System Release drop-down list, choose the system release of NCS 2000 or NCS 1010, to

which you want to upgrade.
c) Click Submit.

The upgraded network is saved as a child network.

Note

If the PMD coefficient does not get updated with the expected value, update the fiber type first, followed by the PMD
value when you edit the fiber properties.

Unlock and modify network elements as needed.

Supported upgrade paths for network system releases
Provides guidelines for supported upgrade paths for network system releases. Details the parameters required to understand
this component and apply it correctly within the network architecture.
This table shows the available upgrade releases for each network type.
Table 27: Supported upgrade paths for network system releases

Upgrade ReleaseNetwork

• From 11.0.0 to 11.1.0, 25.1.1, and 26.11

• From 11.1.0 to 25.1.1 and 26.11

CTP network (.mpz)

• From 11.0.0 to 11.1.0, and 26.11

• From 11.1.0 to 26.1.1

Cisco ONP network
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Upgrade ReleaseNetwork

Note

Release upgrade is not supported for the LNI networks
in Release 25.1.1.

LNI network

• 7.10.1 to 7.11.1, 24.31, 25.1.1, and 26.1.1

• 7.11.1 to 24.31, 25.1.1, and 26.1.1

NCS 1010 Network

• 7.10.1 to 25.4.1NCS 1001 Network

• 25.1.1 to 26.1.1NCS 1014 Network

Plan mode
Describes the functionality of plan mode. Explains the benefits of this feature and how it contributes to efficient and robust
network planning.
Plan mode is a feature that
• enables what-if analysis on existing network designs,

• simulates network behavior under failure scenarios, and

• determines the ability to reroute services without providing guidance for expanding network infrastructure.

Table 28: Feature History

Feature DescriptionRelease InformationFeature Name

This feature extends the current
implementation of What-if analysis for
the OTN Services that are connecting
the aggregated nodes. The failure
report includes the number of failed
services, restored services, and
unrestored services. This feature is
supported forsworn (4K-1K-2K and
1K-2K) and non-SSON (4K-2K)
networks.

Cisco ONP Release 4.1What-if Analysis for OTN Services

Advantages of plan mode

The advantages of the plan mode are:
• Simulates and analyzes potential network issues and solutions,

• focuses on rerouting capabilities, and
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• avoids requiring physical changes to network infrastructure.

Supported network elements

Supported network elements in plan mode include:
• An NCS 2000 aggregated node that includes ROADM, OLA, and passthrough nodes

• Traffic nodes including1K-2K, 4K-2K, and 4K-1K-2K

• Nodes created in Cisco ONP

• Networks imported from Cisco Transport Planner in mpz format

• Networks imported from LNI

Limitations of plan mode

Plan mode has these limitations:
• Only users with PLANNER and ADMIN roles can access the Plan mode.

• Plan mode does not guide you in turning up new wavelengths or adding new network components.

Teaches you how to evaluate potential network failures and review restoration outcomes. Instructs you on the necessary
steps to simulate fiber and site outages in Plan mode.
Use this procedure to evaluate potential network failures and review restoration outcomes by simulating fiber and site
outages in Plan mode.
Log in to the Cisco ONP web interface on page 17 as a user with admin or planner role.
Follow these steps to perform a what-if analysis in Plan mode
1. Open the analyzed network.
2. Choose Network > Enter Plan Mode.

The network switches to Plan mode. In this mode, you can perform what-if analysis by failing fibers and sites.

3. Fail ne or more sites:
a) In the network tree, expand Sites.
b) Click the Ellipsis icon available in the right side of the site, and select Fail. Alternatively, right-click a site on the

map and select Fail.
c) To fail multiple sites, select them and choose Fail.

4. Fail one or more fibers:
a) In the network tree, expand Fibers.
b) Click the Ellipsis icon next to the fiber, and click Fail. Alternatively, right-click a fiber in the map and select Fail.
c) To fail multiple fibers, select them and choose Fail.

When a fiber fails, all media channels or waves, OTN services, and demands that pass through the failed fiber also
fail. Symbols on the map indicate these failures:
• Failed channels: Red cross

• Fibers impacted due to site failure: Yellow cross

• Restored channels: Green check

d) To undo the fiber failure, click the Ellipsis icon next to the fiber, and click Undo Fail.
5. (Optional) Create a failure set if you wish to group selected failures. SeeCreate a failure set.
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6. After testing, restore the failed fibers by choosing Restore.
The restored channels are indicated by a green check mark in the network tree and map.
All media channels or waves, and demands that pass through the restored fiber are also restored. The Path Computation
Element (PCE) restores OTN services based on optical feasibility and OTN constraints.

7. Export the failure report:
a) Choose Export > Failure Report to export the failure report as an Excel file. The failure report includes the

parameters described in Failure report on page 74.
b) Alternatively, click Export in the Failure Report area under the map.
Review unrestored channels and reasons for restoration failure in the Elements >Messages tab.

8. Exit Plan mode:
a) Choose Network > Exit Plan Mode.

The what-if analysis and failure report are completed and exported, providing insight into service impact and recovery.

Create a failure set
Teaches you how to create a failure set. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to create and manage failed fibers and sites as a failure set within a failure group. You can simulate
or track network outages efficiently in a single action.
1. Open a network and enter the Plan mode.
2. Click the Ellipsis icon next to the Failure Groups option in the network tree panel.
3. Click Add Failure Group.

A failure group gets created.

4. Add fibers and sites to the group.
a) Choose the Fibers and Sites to fail by selecting the check boxes next to them.
b) Click the Ellipsis icon next to the chosen Fibers and Sites, and click Fail.

5. Click the Ellipsis icon next to the network name and click Add Failure Set.
6. Select the failure group to which the failed fibers or sites must be added.

The system creates the failure set under the failure group and adds the failed fibers or sites to it.

Note

If a network has dark fibers that do not carry traffic, the system does not consider those paths for restoration.

Failure report
Provides guidelines for failure report. Details the parameters required to understand this component and apply it correctly
within the network architecture.
This table describes the various parameters of the failure report.
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Table 29: Failure report

DescriptionReport

Shows the failed fibers in the network.Failed Fibers

Shows the failed sites in the network.Failed Sites

Shows the fibers that are impacted due to the site failure.Impacted Fibers

Shows the total number of media channels in the network.Total Channels

Shows the total number of media channels that are passing through the failed ducts or
sites in the network.

Failed Channels

Shows the total number of media channels that are restored from the failure state.Restored Channels

Shows the total number of media channels that are not restored from the failure state due
to the unavailability of alternate paths.

Unrestored Channels

Shows the fibers that have utilized greater than or equal to 80% of the bandwidth. You can
modify the threshold by updating the value in the Feature.Properties file.
• Fiber: Shows the fibers that are listed under fiber hot zones.

• Utilization Before (%): Shows the percentage of bandwidth that is utilized before
the channel restoration.

• Utilization After (%): Shows the percentage of bandwidth that is utilized after the
channel restoration.

Fiber HotZones

Shows the total number of services going through the fiber that was failed.Total Services

Shows the number of failed services going through the fiber that was failed.Failed Services

Shows the number of restored services going through the fiber that was restored.Restored Services

Shows the number of unrestored services going through the fiber that was restored.Unrestored Services

Automatic suggestion for regeneration sites in Plan mode
Describes the functionality of automatic suggestion for regeneration sites in Plan mode. Explains the benefits of this
feature and how it contributes to efficient and robust network planning.
Automatic suggestion for regeneration sites in plan mode is a Cisco ONP feature that
• analyzes optical channels for high and marginal risk of failure,

• automatically proposes feasible regeneration sites in planning mode, and

• allows users to incorporate these sites to ensure network optical feasibility.

This feature operates in Plan mode within Cisco ONP, leveraging a regeneration suggestion algorithm run by the Path
Computation Element (PCE). It assesses network feasibility and presents suggested regeneration sites in the Feasibility
Report for optically risky channels, streamlining the process of making the network optically feasible.
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Table 30: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP displays feasibility report in
the Plan mode. This report
automatically suggests regeneration
sites for the channels with high and
marginal risk of failure. You can
incorporate these regeneration sites in
the optical network to make the
channel optically feasible. This feature
avoids multiple iterations required to
manually create the regeneration sites
and test the optical feasibility of large
networks.

Cisco ONP Release 5.0Automatic Suggestion for Regeneration
Sites

Supported scenarios for automatic regeneration site suggestion

Automatic regeneration site suggestion is supported for both SSON and non-SSON networks that have contentionless
channels or waves between these site types:
• NCS2K (ROADM) sites

• 4K-1K-2K (TRAFFIC) sites

If channels already have forced regeneration, suggestions are shown at the section level.

How automatic regeneration site suggestion works
Describes the functionality of how automatic regeneration site suggestion works. Explains the benefits of this feature and
how it contributes to efficient and robust network planning.
The automatic regeneration site suggestion process identifies channels at risk of optical failure and proposes suitable
regeneration sites to enhance network feasibility.
The key components involved in the process are:
• Cisco ONP: Assesses network feasibility and displays the Feasibility Report in Plan mode.

• PCE (Path Computation Element): Runs the regeneration suggestion algorithm to determine optimal regeneration site
locations.

• Feasibility Report: Presents the suggested regeneration sites and channel risk statuses for user review.

The process involves these stages:
1. Cisco ONP evaluates the optical feasibility of the network in Plan mode and identifies channels with high or marginal

risk of failure (indicated as red and orange in the Optical Results page).
•

2. Cisco ONP submits these channels to PCE, which executes a regeneration suggestion algorithm.•

3. The algorithm suggests regeneration sites for the identified channels.•

4. Upon entering Plan mode, Cisco ONP displays the recommended regeneration sites at the bottom of the map in
the Feasibility Report.

•

5. You can apply the suggested regeneration sites to improve optical feasibility or export the report for reference.•
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The process enables rapid identification and application of regeneration sites to ensure optical feasibility for complex
networks, minimizing manual intervention.

Apply the suggested regen sites
Teaches you how to apply the suggested regen sites. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17 as a user with admin or planner role.
Use this procedure to apply the suggested regeneration sites to make the network optically feasible.
1. Open an analyzed network.
2. Enter the plan mode.
3. Apply the suggested regen sites to the network.

a) Choose Network > Open Feasibility Report.
The Feasibility Report is displayed at the bottom of the map.

b) Select the channels that require regeneration and click Apply.
c) In the Suggested Regen Applied dialog box,click Ok .

4. Exit the Plan mode.
a) Choose Network > Exit Plan Mode.
b) Click Yes.
The network gets automatically upgraded and saved as a new network. Channels with applied regens are unlocked.
The Regen Sites property is automatically updated and becomes noneditable.

5. Analyze the network.
On theOptical Results page, he SOL and EOL fields become green. Channels do not appear in the feasibility report
again when you switch to plan mode.

Feasibility report
Provides guidelines for feasibility report. Details the parameters required to understand this component and apply it
correctly within the network architecture.
The Feasibility Report table encompasses several fields, which are crucial for assessing the optical feasibility of the
network.
Table 31: Feasibility report

DescriptionField

Displays the list of channels (trail and sections) that are not
optically feasible.

Channel Name

Displays the color of alarm (red, orange, or yellow)Alarm

Displays the actual path of the channel as hyperlink. If you
click the link, the path is highlighted in the map.

Paths

Displays the intermediate sites that can be used as regen
sites so that the channel becomes optically feasible.

Suggested Regens

The Suggested Regen field appears as NA in these situations:
• Channels display yellow alarms, meaning the loss is negligible.

• The loss is high and there are not enough available intermediate sites to compensate for the overall loss.

• Intermediate sites without added contentionless sides are not considered for regeneration sites.
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Export the feasibility report
Teaches you how to export the feasibility report. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Use this procedure to save the regeneration site suggestions and channel feasibility results for external use or
recordkeeping.
The Feasibility Report in Cisco ONP Plan mode includes regeneration site suggestions for channels at risk. You may need
to export this information.
1. In the Plan mode, locate the Feasibility Report at the bottom of the map.
2. Click Export.
The Feasibility Report, including suggested regeneration sites, is exported for reference or further analysis.

Line Rate Tuner mode
Describes the functionality of line Rate Tuner mode. Explains the benefits of this feature and how it contributes to efficient
and robust network planning.
Line Rate Tuner mode is a network planning feature that
• automates the calculation and selection of optimal optical sources for a network,

• reduces human errors by minimizing manual calculations, and

• streamlines the process of selecting the correct optical source from available resources.

Table 32: Feature History

Feature DescriptionRelease InformationFeature Name

You can now automate the calculation
of optical sources for your networks
using the new Line Rate Tuner Mode.
This mode reduces human errors while
finding the correct optical source for
your network from a set of network
resources.

Cisco ONP Release 5.2Automated Selection of Optimal
Wavelength Bitrate: Flexible Modeling

Note

Line Rate Tuner mode is available for NCS 2000 networks and NCS 1010 networks.

Optimize optical sources using Line Rate Tuner mode
Teaches you how to optimize optical sources using Line Rate Tuner mode. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to automate, simulate, and apply optimal optical source configurations to your network using the Line
Rate Tuner mode in Cisco ONP.
Log in to the Cisco ONP web interface on page 17
1. Open the network in Analyze mode.
2. Choose Network > Enter Line Rate Tuner Mode.
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You see a progress bar while the system switches to Line Rate Tuner mode.
The network opens in the Line Rate Tuner Mode.

3. Run the line rate tuner analysis on a section of media channel to create custom optical source that you can add to the
network. For steps, see the Create a custom optical source using tuner analysis on page 79 task.

4. Run the tuner analysis again for another new section of the media channel. For steps, see the Start a new tuner analysis
on page 82 task.

5. Open the tuner results and add them to the network. For steps, see the Add the custom optical source to the network
on page 82 task.

6. Exit the Line Rate Tuner mode.
a) Choose Network > Exit Line Rate Tuner Mode.

The Exiting Tuner dialog box appears.

b) Choose the appropriate action as required.

ActionsButton

Returns your network to its previous state and applies the changes.Previous State

Switches your network to Upgrade mode and applies the changes.Upgrade

Cancels the operation.Cancel

The network exits the Line Rate Tuner mode.

The network is updated with optimized optical sources and demand channels. Cisco ONP exits tuner mode, when required.

Create a custom optical source using tuner analysis
Teaches you how to create a custom optical source using tuner analysis. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure in Cisco ONP to simulate and configure a new custom optical source. You can also modify parameters
for media channel sections and save the results.
Log in to the Cisco ONP web interface on page 17
1. Open the network in Line Rate Tuner mode.
2. Click Open Tuner Input.
3. In the network tree, select the section of the media channel to which you want to add the tuner input.

The section you selected appears with default parameter values in Select Input Parameters.

4. Modify the Input Parameters as required.
See Input parameters for creating custom optical sources on page 80.

5. (Optional) Click Reset to reset the modified parameters to default values.
6. Click Add.

A confirmation message appears indicating the tuner input was added successfully. You can review the details of the
modified section.
Table 33: Select section parameters

DescriptionSection Parameters

Name of the modified section.Section Label

Site name for the optical channel source.Src Site

Cisco Optical Network Planner | Updated March 10, 2026

| Design and Analyze Networks | 79



DescriptionSection Parameters

Site name for the optical channel destination.Dst Site

Fiber paths in the section.Path

Icons to edit or delete the modified section.Actions

7. (Optional) Edit or delete the modified section.
To edit:
a. Click the pencil icon.

b. Modify the input parameters as required.

c. Click Update to save the changes.

To delete:
a. Click the trash bin icon.

b. Click Yes to confirm.

8. Click Run Tuner to start the simulation.
The progress bar appears and notifies you when the analysis completes.

9. In Tuner Result, click Export to export the results as an Excel file for reference.
The custom optical source is created, tuner analysis is completed, and results are available for export and review.
Add the custom optical source to the network.
Input parameters for creating custom optical sources
Provides guidelines for input parameters for creating custom optical sources. Details the parameters required to understand
this component and apply it correctly within the network architecture.
This table describes the input parameters that are required for creating custom optical sources.
Table 34: Input parameters for creating custom optical sources

DescriptionPlatformProperty

Choose the optical family. Cisco ONP
shows options based on the network
analysis and the optical family you
select. Based on the optical family you
select, the remaining parameters
provide related options.

NCS 2000 SSON
NCS 1010

Optical Family

Choose the optical source. Cisco ONP
shows a list of optical sources you have
already imported.

NCS 2000 SSON
NCS 1010

Optical Source

Choose the data rate. Based on the
optical family you select, Cisco ONP
displays options to choose the channel
capacity for the new section.

NCS 2000 SSON
NCS 1010

Data Rate
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DescriptionPlatformProperty

Choose the bit data rate. Based on the
optical family you select, Cisco ONP
shows options to choose the speed of
data transfer in the new section.

NCS 2000 SSON
NCS 1010

Bit Rate Range

Choose the baud rate range. Based on
the optical family you select, Cisco
ONP shows options to set theminimum
signal width for each new channel.

NCS 2000 SSON
NCS 1010

Baud Rate Range

Choose the FEC type. Based on the
optical family you select, Cisco ONP
shows a list of supported FEC types.

NCS 2000 SSON
NCS 1010

FEC Type

Choose the Result Type. The available
options are:
• Best OSNR: shows results based

on maximum OSNR margin.

• Maximum Capacity: shows results
based on the maximum capacity of
the channels.

• Maximum DataRate Maximum
Capacity: show resulsts based on
maximum data rate per maximum
capacity.

• Maximum DataRate Best OSNR:
show resulsts based on maximum
data rate per maximum OSNR
margin.

NCS 2000 SSON
NCS 1010

Result Type

Choose optical feasibility for the new
section. The available options are:
• Green

• Yellow

• Orange

• Red

Each color represents the severity of
alarms that may arise in the new
section.

NCS 2000 SSON
NCS 1010

Optical Feasibility

Choose the sigma number from 0 to 3.
The sigma number is used in the
calculation of the OSNR margin.

NCS 2000 SSON
NCS 1010

Sigma Number

Choose the number of optical source
results required for the new section
The default value is 5, but you can
select up to 15 results.

NCS 2000 SSON
NCS 1010

Number of results
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Start a new tuner analysis
Teaches you how to start a new tuner analysis. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Use these steps to start a fresh tuner analysis for the new section.
Log in to the Cisco ONP web interface on page 17
1. Open the network in Line Rate Tuner mode.
2. Click Start New.

The Start New Tuner dialog box appears and asks for confirmation.

3. (Optional) Check the Retain the tuner inputs check box to keep the previous input values.
4. Click Yes.

The message Started new tuner successfully appears.

5. Modify the input parameters of the new section as needed, and click Update to save the parameters.
6. Click Run Tuner to trigger the simulation.

The Running Tuner Analysis progress bar appears. The message, Tuner analysis completed successfully appears.

The analysis for the new section is completed successfully using the updated input parameters. The results are available
for review.
Add the tuner results to the network.
Add the custom optical source to the network
Teaches you how to add the custom optical source to the network. Instructs you on the necessary steps to perform this
task effectively and ensure proper network configuration.
Use this procedure to add custom demand channels and their associated optical sources generated from a Tuner Result.
Log in to the Cisco ONP web interface on page 17
1. Open the network in Line Rate Tuner mode.
2. Click Open Tuner Result.

The Tuner Result pane appears and displays the new sections and their demand channels.

3. To add the optical source to the network, perform one of these actions:
To add manually:

Note

For some custom optical source results, the download icon becomes disabled. In such cases, go toManage >
Optical Source to download the optical result as explained in Download Optical Sources.

a. Click the Download Optical Source icon.
The Downloading Optical Source message appears. The Excel sheet contains data in Cisco ONP format.

b. Open the Excel sheet to review the data.

c. Import optical sources as explained in Import Optical Sources.

To add automatically:
a. Click the Add Demand to Network icon.
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The No. of demands pop-up appears asking for the number of demands to add to the network.

b. Enter the demands number and click Add.
When the Demand is added successfully message appears, confirm that the new demand appears in the network
tree.
Cisco ONP automatically adds the required optical source to the server.

The custom optical source and its demand are successfully added to the network. You can review the new demand and
associated optical source in the network tree.

Import optical sources
Teaches you how to import aliensoptical sources. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure to import an optical source
An Optical source wavelength is a way to connect a DWDM interface from any external element to a third-party optical
network.
.
Log in to the Cisco ONP web interface on page 17.
Create an optical source from an Excel template on page 84
1. ChooseManage > Optical Source.

TheManage Optical Source dialog box appears.
The default optical sources available in the server include:
• OpticalSources_NCS2K_400GXP-LC_NCS4K-4H-OPW-QC2

• NCS1004_OpticalSources_V3

• ONS-CFP2D-400G-C-OpticalSources-V2.mxd

• QDD-400G-ZRP-S-OpticalSources-V2.mxd

Note

By default, all existing optical source files are loaded in the server.

2. Import the optical source as a .mxd file.
a) Click Add.
b) Choose Optical Source (.mxd)

The Import Optical Source (.mxd) dialog box appears.

c) Click Choose File and browse to the .mxd file stored on your local system, and click Import.
After the optical source is imported, a list of related interfaces appears.

3. Import the optical source from an Excel spreadsheet.
a) Click Add.
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b) Choose Optical Source (.xlsx)
The Import Optical Source (.xlsx) dialog box appears.

c) Click Choose File and browse to the .xls file (optical source template) saved in your local system, and click
Import.

d) Choose the Release Version of the NSC2K network.

Note

Selected release version is applicable only for NCS2K network. For NCS 1010, NCS 1001, and NCS 1014
networks, the imported optical source is available for all supported release versions, regardless of the selected
NCS 2000 release version.

e) Select the interface.
If you want all the interfaces, then click Select All.

f) Click Create.
After the optical source is imported, a list of related interfaces appears.

4. Select the check box next to each interface you want to import.
After you import the optical sources and their interfaces, they appear in the Type drop-down list in the properties window
of the network tree. Use these interfaces when you create waves in your network design.
Go to Download optical sources on page 88 to download the optical source for Cisco ONC.

Create an optical source from an Excel template
Teaches you how to create an optical source from an Excel template. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to create an optical source with an optical source template downloaded from Cisco ONP.
Table 35: Feature History

Feature DescriptionRelease InformationFeature Name

You can create an optical source by
defining the details of interfaces and
the corresponding optical classes in an
Excel template. This feature provides
you with the flexibility to create any
required optical source based on
existing or new traffic resources.

Cisco ONP Release 5.0Create Optical Source using Excel
Sheet

1. Choose Export > Optical Source Template.
The downloaded Excel template includes two sheets:
• Interface: Contains details specific to each interface.

• Class: Contains information that can be mapped to multiple interfaces.

For the list of the required Optical Parameters, refer to Optical Parameters Available in the Excel Sheet for Optical
Sources Creation.
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The downloaded sheet contains data for one existing interface as a reference. You can edit or delete this data from
the sheet.

2. Enter all required parameters from the specification sheet.
There are some hidden columns that are not mandatory for Optical Source Creation. However, you can expand those
columns and enter the details.

3. Fill in all information, then save the Excel file using the optical source name.
The optical source Excel file is ready for import.
Go to Import Optical Sources to import the optical source from an Excel file.

Optical Parameters Available in the Excel Sheet for Optical Sources Creation
Provides guidelines for optical Parameters Available in the Excel Sheet for Optical Sources Creation. Details the parameters
required to understand this component and apply it correctly within the network architecture.
The following parameters are available in the Excel sheet template for creating optical sources.
Table 36: Optical Parameters for Creating Optical Sources

DescriptionParameters

The name of the interface. It should be unique for all the
interfaces that are added in the file.

Interface Name

The name of the vendor.Vendor Name

The vendor IDs.Vendor IDs

The name of the platform.Platform

The PID of the pluggable.Pluggable PID

It is the combination of the Data Rate and Open Config
Code. For example: R400G#5000.

Name

The forward error correction type for the given interface.FEC

The line rate for the given interface.Data Rate

The modulation format to be used for the interface.Mod Format

The baud rate for the given interface.Baud rate

The speed of data transfer (bits per symbol) for the given
interface.

BPS

The unique code assigned to the interface as specified by
the Open Industry Standard for optical networks. For
example: 5000.

Open Config Code

Enter the sub-mode if there are any associated with the
interface. If not, leave it blank.

Sub Mode

The trunk rate of the transponder.Trunk Rate

The bit Rate for the interfaceNominal Bit Rate

The post FEC BER Target for the interfaceBER Target

Cisco Optical Network Planner | Updated March 10, 2026

| Design and Analyze Networks | 85



DescriptionParameters

The minimum and maximum Tx Power for the interface.Power Min and Power Max

The overload power limit for the interfaceOvl

The Rx power sensitivity for the interface.OL Power

The Rx OSNR sensitivity for the interface.OL OSNR

The extended Rx power sensitivity.PL Power

The Rx OSNR sensitivity at the extended Rx power
sensitivity.

PL OSNR

The variance in power in the Txp.Variance

The optical class to which the interface will be mapped.Opt Class

The Tx OSNR contribution due to laser instability inside the
Txp.

InBand OSNR

The Tx OSNR contribution due to Add/Drop at 80% and
100% channel spectral density.

Out of Band OSNR

The Software release of CiscoONC fromwhich this interface
will be supported.

ONC Release

It is the same as the name of the interface.Interface Type

The operating frequency range of the interface.Min and Max Frequency

Table 37: Optical Class Parameters

DescriptionClass Parameters

The name of the interface. Enter the same name of the
interface, if you are doing one to one mapping with the
interface.

Interface Type

You can create the optical classes for different optical
sources. Certain optical parameters are added in the optical
class. Based on interface properties, multiple interfaces
can be mapped to the same class.
Enter a unique alphanumeric name for the Optical class.
While creating new optical classes, we recommend using
the name starting with “X” to avoid overlapping in the
existing classes.

Opt Class

The bit rate for the given interface.Bit Rate

The baud rate for the given interface.Baud Rate

The modulation guard band coefficient.ModGB Coeff

The modulation OSNR penalty.Modulation OSNR Penalty

The filtering GuardBand at different OSNR penalties.GBf
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DescriptionClass Parameters

Enter the mux/demux filtering penalty value, if there are
any.

Mux/Demux Filtering Penalty

The chromatic dispersion limit at different OSNR penalties.Chromatic Dispersion

Find optical sources faster
Teaches you how to find optical sources faster. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17
Use these steps to find the optical sources faster.
1. ChooseManage > Optical Source.

TheManage Optical Source dialog box appears.

Note

By default, all existing optical source files are loaded in the server.

2. To find the customized optical sources:
a. Check Show only line rate tuner generated sources.

The dialog box displays only the customized optical sources.

3. To filter the required optical source:
a. Enter the optical source name in the Search box.

The dialog box displays the optical sources matching the typed keyword.

b. In the Search by drop-down, choose the required parameter to narrow down the search results.
Table 38: Search parameters

DescriptionParameter options

Name of the optical sourceFile Name

Name of the cardCard Name

Type of FEC modeFEC mode

Bit rate of the optical sourceBit rate

Baud rate of the optical sourceBaud rate

Operating mode of the cardSub mode

Modulation format of the optical sourceModulation Format

Product ID of the optical sourcePID
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DescriptionParameter options

Vendor ID of the optical sourceVendor ID

Open configuration code of the optical sourceOpen Config Code

Download optical sources
Teaches you how to download alienoptical sources. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure to download an optical source.
1. ChooseManage > Optical Source.

TheManage Optical Source dialog box appears.

2. Select one or more optical sources to download.
3. Click Download and select one of these options to download the optical sources.

• .mxd: Downloads the selected optical sources as an .mxd file.

• .xlsx: Downloads only the optical sources that were created and added using the Excel template as an .xlsx file.
Optical sources added directly as an .mxd file are not included in the .xlsx file.

• .xml: Downloads the optical source data as a .xml file. This contains:
• Application codes for circuit provisioning in Cisco ONC,

• Optical parameters of the interfaces, and

• Product IDs (PIDs) and Vendor ID information.

You can load the .xml file into Cisco ONC to create circuits with these interfaces. See Alien Import.
After the import is successful, the optical source will be present under theApplication Code tab in theService
Manager screen of the Cisco ONC application. See Service Manager.

The selected optical source data is downloaded in the chosen format.

Delete optical sources
Teaches you how to delete aliensoptical sources. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure to permanently remove unwanted optical sources from Cisco ONP.
Log in to the Cisco ONP web interface on page 17.
1. ChooseManage > Optical Source.

TheManage Optical Source dialog box appears.

2. Choose one or more optical sources to delete.
3. Click Delete.
Cisco ONP permanently removes the selected optical sources or aliens.
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Layout template for NCS 2000 network
Describes the functionality of layout template for NCS 2000 network. Explains the benefits of this feature and how it
contributes to efficient and robust network planning.
A layout template is a reusable configuration model that
• enables the design of consistent layout configurations for the NCS 2000 network,

• applies fixed layout rules to multiple nodes, and

• saves time, reduces effort, and minimizes configuration errors.

Layout templates are especially useful when deploying NCS 2000 networks that require identical configuration across
several nodes. Defining the layout once allows network engineers to ensure uniformity and compliance with network
design standards during deployment.

Note

Layout templates do not support configurations where there is a mix of TXP and Real card labels for transponders.

Export layout template
Teaches you how to export layout template. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Table 39: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to export the
layout template for an individual site or
for all the sites. The layout template
export is possible only if the network
is analyzed in Cisco ONP Release 4.1.
The export of layout template is
supported on 4K, 4K-1K-2K, and 2K
nodes.

Cisco ONP Release 4.1Layout Template Enhancement

Use this procedure to export the layout template for a specific site or for all sites.
1. Open the network to export the network layout template.
2. Choose Network > Analyze.

Note

Network must be successfully analyzed to proceed further.

3. Click the Layout tab.
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4. Click the name of a site in the left side panel to download the layout template.
5. Hover the mouse pointer over the Export icon and click Layout Template for current site or all Sites.

The Export Layout Template dialog box appears.

6. Click Export.

Note

• Export the layout template only in the analyze mode. If you export layout templates in upgrade or release upgrade
modes, the results may be inaccurate.

• You can export the layout template for nodes of type 4000 and 1000. However, the exported layout template
includes only the layout for NCS 2000 nodes. To export the layout template for the node types NCS4K-1K-2K
and NCS1K-2K, complete these steps:
• Right-click the site name in the Layout panel, and click Export.

• Click OK to export the layout template in text format.

• The layout template for NCS 2000 is provided in XML format.

Import layout template for NCS 2000 network into Cisco ONP database
Teaches you how to import layout template for NCS 2000 network into database. Instructs you on the necessary steps
to perform this task effectively and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to import a template for the NCS 2000 network into the Cisco ONP database.
1. ChooseManage > Layout Templates.
2. Click Add in theManage Layout Template dialog box.
3. Click Choose Files and select a template from your local system.
4. Click Import.

The template is imported to the Cisco ONP database.

Download a layout template for NCS 2000 network
Teaches you how to download a layout template for NCS 2000 network. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to download a template from the Cisco ONP database:
1. ChooseManage > Layout Templates.
2. Choose the template that you want to download and click Download.

You can also choose multiple templates.

The selected layout template is saved to your local system.
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Delete Layout Template for NCS 2000 Network
Teaches you how to delete Layout Template for NCS 2000 Network. Instructs you on the necessary steps to perform this
task effectively and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to delete a NCS 2000 Network template from the Cisco ONP database:
1. ChooseManage > Layout Templates.
2. Choose the template that you want to download, and clickDelete to delete the template from the Cisco ONP database.

You can also choose multiple templates.

Apply NCS 2000 layout template into a site
Teaches you how to apply NCS 2000 layout template into a site. Instructs you on the necessary steps to perform this
task effectively and ensure proper network configuration.
Use this procedure to configure the layout of the NCS 2000 section for a site. Although the site can be NCS4K-2K,
NCS1K-2K-4K, or NCS1K-2K, you should apply the template only to the NCS 2000 section.
Log in to the Cisco ONP web interface on page 17.
1. Open a network that contains the site where you want to apply the layout template.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, expand Sites and choose the site.
4. In the Layout Template drop-down list, choose the required template.

Note

Ensure that the other properties under theLayout section, such asChassis Type,Power Supply,Controller
Card,NodeProtection,Redundant Controller Card, andMF-Unit are set to Auto. Otherwise, theLayout
Template drop-down list remains disabled.

The NCS 2000 layout template is applied to the NCS 2000 section of the selected site.

Import layout templates into NCS1K-2K and NCS4K-1K-2K sites
Teaches you how to import layout templates into NCS1K-2K and NCS4K-1K-2K sites. Instructs you on the necessary
steps to perform this task effectively and ensure proper network configuration.
Use this procedure to add exported layout templates for NCS 1000 and NCS 4000 into 4K-2K and 4K-1K-2K sites.

Note

If you modify an exported template, rename it before reapplying in upgrade mode to ensure changes are visible in the
layout view.

Log in to the Cisco ONP web interface on page 17.
1. Open the network that has the site to which you want to apply the layout template.
2. Click the Layout tab.
3. Click Edit to enable the edit mode.
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4. Right-click the site where you want to import the layout template, then click Import.
5. Choose the layout template that you want to import into the site and click OK.
Cisco ONP applies the chosen layout template to the specified site.

Network layout visualizations
Describes the functionality of network layout visualizations. Explains the benefits of this feature and how it contributes to
efficient and robust network planning.
A network layout visualization is a graphical feature that
• displays the arrangement of racks, chassis, and cards in a network designed using Cisco ONP,

• allows you to interact with and highlight specific hardware components, and

• enables zooming in and out for detailed or broad views.

Table 40: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to view and
adjust the position of NCS 4016 and
NCS 1004 chassis and cards in the
layout. This feature is supported only
on 4K-1K-2K and 1K-2K aggregated
nodes and not supported on
stand-alone NCS 2000 node.

Cisco ONP Release 4.1Layout Visualization and Edit

When you click a particular rack, chassis, or card in theLayout panel, the corresponding hardware component is
highlighted in the layout image. This feature enhances the ability to understand and manage complex network physical
topologies.

View network layout
Teaches you how to view network layout. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to view the network layout.
Log in to the Cisco ONP web interface on page 17.
1. Open the network for which you want to view the layout.
2. Choose Network > Analyze.

Note

The network must be successfully analyzed to proceed further.

3. Click the Layout tab.
4. In the Layout panel, click the site.
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Note

The OLA sites are highlighted in green, ROADM sites are highlighted in blue, and Aggregated nodes are highlighted
in purple.
Passthrough sites are not listed in the layout.
Aggregated nodes are not available for the NCS 1010 network.

5. Click any rack under a site to view the rack view of the network under the Layout tab.
6. Click any chassis under a rack to view the chassis view of the network.

Note

When you click the Aggregated node under Layout panel, NCS 1004, NCS 2000, and NCS 4000 series chassis
are placed in separate racks.
You can click the screenshot icon to capture images of all rack layouts of the selected site.

Edit the layout manually
Teaches you how to edit the layout manually. Instructs you on the necessary steps to perform this task effectively and
ensure proper network configuration.
Use this procedure to position the NCS 4016, NCS 2000, and NCS 1004 chassis and cards by manually adjusting the
layout.
Log in to the Cisco ONP web interface on page 17.
1. Open the network where you want to edit the layout.
2. Choose Network > Analyze.

Note

To proceed, make sure the network has been successfully analyzed.

3. Click the Layout tab.
4. Click Edit to enter the Edit mode.
5. Select a chassis (4K-1K-2K and 1K-2K) or card from a rack.
6. Drag and drop the selected chassis or card from a particular rack to an empty slot in the same chassis, a different

chassis, or a different rack.
7. Add pluggables to a card.
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Note

Make sure to add the required cards.

a) Select the Rack.
The cards available in the rack are displayed.

b) Select the card to which you want to add pluggables.
The ports available in the card are displayed.

c) Select the pluggable for each port.
These pluggables are displayed:

Supported PluggablesCard

• ONS-QSFP8-LR4=

• QSFP-110G-SR4-S=

• ONS-QSFP-4*10-MLR=

NCS4K-4H-OPW-QC2

• ONS-QSFP8-LR4=

• QSFP-100G-SR4-S=

• ONS-QSFP-4*10-MLR=

NCS4K-4H-OPW-LO

• ONS-QSFP8-LR4=

• QSFP-100G-SR4=

• ONS-QSFP28-LR4-S=

• QSFP-100G-CWDM4-S=

• QSFP-100G-SM-SR=

NCS1K4-1.2T-K9=

d) Click the check mark.
8. Click Done.
Your changes are saved in the layout. You can view any new chassis or card that has been added to the layout in the
BOM tab.
After you manually edit the layout, you can view the regenerated BOM.

Manually edit the layout for NCS 1010 networks
Teaches you how to manually edit the layout for NCS 1010 networks. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to adjust the position of NCS 1010 chassis and patch panels within network layouts.
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Table 41: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco has introduced NCS 1010 as a
new optical line system to meet the
growing optical network needs. Using
Cisco ONP you can visualize and edit
layouts for NCS 1010 chassis and
patch panels.

Cisco ONP Release 5.0Layout Edit Support for NCS 1010
Networks

Log in to the Cisco ONP web interface on page 17.
1. Open an NCS 1010 network.

Note

You can also create a new NCS 1010 network. For more information, see Manually design a network using Cisco
ONP on page 32.

2. Choose Network > Analyze.

Note

Ensure the network is successfully analyzed before proceeding.

3. Click the Layout tab.
4. Click Edit to enter the Edit mode.
5. Select a site.
6. Select a unit (NCS 1010 chassis or patch panel) :

Choose one of these methods:
• Expand the rack under a site in the left panel and select a unit.

• Or, in the Rack view, click a chassis or patch panel.

7. Adjust the position of the selected units using one of these methods:

Note

If necessary, click the +New Rack button to create more racks.

• In the Rack view, drag and drop the selected chassis or panel from one rack to the empty slot in the same or
different rack.

• Swap units in the Rack view:
• Click a transponder or NCS1K14-CCMD-16 card; the Swap with button appears.
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• Click Swap with and select a slot to swap from the drop-down list.

Note

The Swap with button appears only for NCS 1014 and NCS 1020 chassis.

• Cut and Paste unit in the left panel:
• Click Cut above the Rack view.

• Right-click on an empty slot in the same or different rack and click Paste.
Cisco ONP disables the Paste option if you try to paste the unit in the prohibited slots.
Cisco ONP disables the Cut option if an existing cut unit is not pasted.

• Cut and Paste unit in the Rack view:
• Right-click the selected chassis or panel and click Cut.

• Right-click on an empty slot in the same or different rack and click Paste.
Cisco ONP disables the Paste option if you try to paste the unit in the prohibited slots.
Cisco ONP disables the Cut option if an existing cut unit is not pasted.

• Move the unit in the left panel:
• Go toMove to > Site-X > Rack-X above the Rack view to move the chassis to the same or different rack.

Or go toMove to > Site-X > + New rack above the Rack view to move the chassis to a new rack.

• Move the unit in the Rack view:
• Right-click the selected chassis or panel and go toMove to > Site-X > Rack-X to move the chassis to

the same or different rack. Or go toMove to > Site-X > + New rack to move the chassis to a new rack.

Note

TheMove to option moves the unit automatically to the immediate empty slot. TheCut and Paste option moves
the unit to the selected empty slot.

8. Click Done to save the changes in the Layout.
A warning message appears when empty racks are present in the layout.

9. Click OK to remove the empty racks.

View layout details using tooltip
Teaches you how to view layout details using tooltip. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Use this procedure when you need to quickly access hardware and port information in the Rack display.
1. Hover over a rack, chassis, or card in the Rack display to view summary details in a tooltip.
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2. Click See More Details in the tooltip to view information such as port number, type, pluggables, and rates.
Cisco ONP displays the detailed information for the selected rack, chassis, or card.

View internal node connections in the NCS 1010 network
Teaches you how to view internal node connections in the NCS 1010 network. Instructs you on the necessary steps to
perform this task effectively and ensure proper network configuration.
Use this procedure to visualize the functional and detailed internal node connections for each site in an analyzed NCS
1010 network. These connections include port labeling and precise component interconnections.
Table 42: Feature History

Feature DescriptionRelease InformationFeature Name

The Node diagram tab displays a
functional view that includes precise
connections and port labeling of each
component such as OLT or ILA,
NCS1K-BRK-8/16/24, AAWG-32-O,
and AAWG-32-E, for each site in an
analyzed NCS 1010 network.

Cisco ONP Release 5.0View Internal NodeConnections of NCS
1010 Network

Log in to the Cisco ONP web interface on page 17.
1. Open an NCS 1010 network.
2. Choose Network > Analyze.

Note

Network must be successfully analyzed to proceed further.

3. Click the Layout > Node Diagram tabs.
4. For each site, click its name in the left panel and select a side to display the functional view.

The functional view displays both physical and logical connections, including:
• degree interconnections between NCS1010 (OLT or ILA) and NCS1K-BRK-8

• add/drop connections between NCS1010 and colorless add/drop units (NCS1K-BRK-8, NCS1K-BRK-16, or
NCS1K-BRK-24), and colored add/drop units (AAWG-32-O or AAWG-32-E)

5. To view port names and cable ID details, hover over any cable.
The functional view for each site displays all internal node connections, including port labeling, degree interconnections,
and add/drop relationships between NCS 1010 components and related units. You can review port and cable details for
precise analysis.

Copy configurations from one node to another
Teaches you how to copy configurations from one node to another. Instructs you on the necessary steps to perform this
task effectively and ensure proper network configuration.
Use this procedure to copy the configurations of a specific node to a node at a different site.
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You can copy the configuration only during a manual 4K-1K layout movement. It is not supported for NCS1010 layout
movement.
Log in to the Cisco ONP web interface on page 17.
1. Open the network from which you want to copy the configuration.
2. Choose Network > Analyze.

Note

Network must be successfully analyzed to proceed further.

3. Click the Layout tab.
4. Select the rack, chassis, or card of a particular site.
5. Select the site that will receive the configurations from the Copy To drop-down list.
6. Click New Rack to add a new rack. Cisco ONP copies the configuration to the new rack
7. Click Done to save the changes in the layout.

Note

You can also cut, copy, and delete racks, chassis, and cards in the layout.

Export the IPC report
Teaches you how to export the IPC report. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to export the connections of a current site or all sites to an Excel sheet.
Log in to the Cisco ONP web interface on page 17
1. Open the network from which you want to export the connections of a current site or all sites to an Excel sheet.
2. Choose Network > Analyze.

Note

The network must be successfully analyzed to proceed further.

3. Click the Layout > IPC tabs.
You can view the patches that are listed in the left pane. Click each patch to view the details such as position, card,
and port of the source and destination sites.
The patches that you click are highlighted in the rack.

4. Hover over the Export icon, and click Current site or All Sites option.
The Export IPC dialog box appears.
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5. Click Continue to export the connections of the current site or all sites.
The cable-type and Cable ID are included in the report only for the NCS 1010 network.

Export port usage of an LNI network
Teaches you how to export port usage of an LNI network. Instructs you on the necessary steps to perform this task
effectively and ensure proper network configuration.
Use this procedure to export the port usage details of an LNI network.
Table 43: Feature History

Feature DescriptionRelease InformationFeature Name

This feature provides the connection
trace of a service across various
interfaces in a network. This feature
allows you to export the following:
• Consolidated port usage report

based on network in addition to the
internal port details which you can
view by hovering themouse pointer
over the tooltip

• Port usage report based on sites

• Port usage report only for LNI
imported networks

Cisco ONP Release 4.1Multi-Layer Connections Phase 1

Log in to the Cisco ONP web interface on page 17.
1. Open the LNI network whose port usage you want to export.
2. Choose Network > Analyze.

Note

To proceed, make sure the network has been successfully analyzed.

3. Click the Layout tab.
4. Select the site for which you want to export port usage.
5. Hover the mouse over the Export icon and select Port Usage for either Current site or All Sites.

The Export Port dialog box appears.

6. Click Continue.
Cisco ONP exports the port usage details in Excel format.
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Note

• If you modify any services in the NCS 4000 node after upgrading the LNI network, the changes in the port usage
details will not update.

• The demand labels shown for the trunk ports of the NCS4K-DWDM line card in the port mapping report are not
logically related to the NCS 4000 trunk ports. They are related to NCS 1004 client ports.

Define multilayer connections for an SSON network
Teaches you how to define multilayer connections for an SSON network. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to define the Multilayer Connections (MLC) such as cards and pluggables for 4K-1K-2K and 1K-2K
aggregated nodes in an SSON network.
Table 44: Feature History

Feature DescriptionRelease InformationFeature Name

You can define Multilayer Connections
(MLC) such as cards and pluggables
for NCS 4K-1K-2K and NCS 1K-2K
aggregated nodes in an SSON network.
This new tab in the Layout page helps
to view end-to-endMLC trace for OTN
service starting from NCS4K IN until
NCS2K Add/Drop for LNI network.
Also, it helps to define new traces for
the newly added service and maintain
the network design and deployment.

Cisco ONP Release 4.2NCS4K-1K-2K Multilayer Connection
Trace

Log in to the Cisco ONP web interface on page 17
1. Open the network where you want to define multilayer connections.
2. Define the MLC:

a) Click the Layout tab.
b) Click theMLC tab.

Alternatively, you can navigate to theMLC page by clicking the Ellipsis icon available in the right side of the
service name in the network tree and clicking View in MLC
You can view the service properties in a table. See MLC details on page 102.

c) Click the service name to switch to the layout view.
You will view the layout and the service details in the right pane.

d) Select the rack, shelf, card, and ports from the drop-down lists for NCS4K In, NCS4K Out, NCS 1K In, and NCS
1K out, for both Source and Destination sites.
The NCS 2000 chassis details appear automatically.
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Note

For an LNI imported network, all details appear automatically. If you add a new service, you can update its
details.

e) Click the check icon to save your changes.
Click the refresh icon to remove changes you made after saving.
The updated details are included in the BOM.

3. To export the MLC details, perform these steps:
a) Click the table icon to switch to the table view.
b) Choose Export >MLC Tracesto export all the details available in the MLC table.
c) ChooseExport >LMP/TTI Connections to export the details of LinkManagement Protocol (LMP) connections,

which are between NCS 1004 and NCS 2000 cards, and Trail Trace Identifier (TTI) connections, which are between
NCS 4000 and NCS 1004 cards.
All these connections are included in the BOM.

4. To filter the services displayed in the left pane, click the Filter icon and choose one of these options:
• Source Site

• Destination Site

• Type of the traffic

• Trace Origin
• LNI: imported through Import Live Network option

• User Created: created through Cisco ONP UI

• Trace Status
• Completed: User has defined all MLC details,

• Partial: User has defined only partial MLC details, and

• Empty: User has not defined any MLC details.

5. Click the three vertical dots and choose the option you need.
• Enable Multi Select: You can select up to the card level for different OTN.

• Expand All: Expands the service tree.

• Collapse All: Collapses the expanded service tree.

• Show Trace Status: Shows the trace status icon next to the service name.

6. Click the three horizontal dots next to the service trace and choose the option you need.
• Delete Trace: Deletes the respective trace.

• Locate in Map: Shows the service in the map view.
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Note

You can enable the same port number on the primary and secondary NCS4K IN nodes for Client 1+1 and other
protection scheme.

MLC details
Provides guidelines for mLC details. Details the parameters required to understand this component and apply it correctly
within the network architecture.
This section describes the various fields available in the MLC tab in the Layout view of a network.
The MLC tab includes these fields.
Table 45: MLC details

DescriptionProperties

Name of the serviceName

Name of the group to which the service belongsGroup Name

Traffic typeType

Source siteSrc Site

Details of the rack, slot, card, port in the input side of the
NCS 4000 chassis in the source site

Src NCS4K In

Details of the rack, slot, card, port in the output side of the
NCS 4000 chassis in the source site

Src NCS4K Out

Details of the rack, slot, card, port in the output side of the
NCS 1004 chassis in the source site

Src NCS1K In

Details of the rack, slot, card, port in the output side of the
NCS 1004 chassis in the source site

Src NCS1K Out

Add/Drop multiplexer and demultiplexer connected to the
NCS 2000 chassis in the source site

Src NCS2K AddDrop

Media channel between the source and destination sitesSrc NCS2K MPO

Details of the rack, slot, card, port in the input side of the
NCS 4000 chassis in the destination site

Dst NCS4K In

Details of the rack, slot, card, port in the output side of the
NCS 4000 chassis in the destination site

Dst NCS4K Out

Details of the rack, slot, card, port in the input side of the
NCS 1004 chassis in the destination site

Dst NCS1K In

Details of the rack, slot, card, port in the output side of the
NCS 1004 chassis in the destination site

Dst NCS1K Out
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DescriptionProperties

Add/drop multiplexer and demultiplexer that is connected
to the NCS 2000 chassis in the destination site

Dst NCS2K AddDrop

MPO cable connecting the NCS 2000 chassis in the
destination site

Dst NCS2K MPO

Media channel between the source and destination sitesMedia Channel

Additional notes, if applicableNotes

Indicates whether the service connections are user-created
or imported through LNI.

Trace Origin

Add new pluggables, alarm cables and 100G client bandwidth licenses to BoM
Teaches you how to add new pluggables, alarm cables and 100G client bandwidth licenses to BoM. Instructs you on the
necessary steps to perform this task effectively and ensure proper network configuration.
Use this procedure to add new pluggables, alarm cables, and 100G client bandwidth licenses to an existing BoM for the
NCS 1004 and NCS 4000 platforms.
Log in to the Cisco ONP web interface on page 17.
1. Open the network you want to update.
2. Analyze the network by choosing Network > Analyze.

Note

Ensure the network is successfully analyzed before proceeding.

3. Click the BOM tab.
4. Start adding new items:

a) Click Add.
The New dialog box opens.

5. Specify the details:
a) Enter the Cisco part number of the pluggable, alarm cable, or 100G bandwidth license in theCisco Part Number

field.
b) Click Add to confirm the additions.
The new pluggables, alarm cables, or 100G bandwidth licenses are now listed in the BoM.

Spectrum utilization and path finder capabilities
Describes the functionality of spectrum utilization and path finder capabilities. Explains the benefits of this feature and
how it contributes to efficient and robust network planning.
A spectrum utilization and path finder are network visualization features that
• streamline the identification of available and used optical spectrum across network sites and fibers,
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• enable interactive path selection and custom route planning, and

• provide tools for both comprehensive and minimal network mapping.

Table 46: Feature History

Feature DescriptionRelease InformationFeature Name

The spectrum utilization and path finder
introduces theMinimal Map, a
streamlined network visualization tool
focusing on essential data points like
Sites and Fibers, enhancing usability
and performance.General Settings
now allow individual customization,
including default map views and
spectrum utilization colors. The Path
Finder/Selector enables interactive
path selection with options for manual
and custom path finding for multiple
routing options. The Spectrum
Utilization provides a comprehensive
visualization of used spectrum, while
the Spectrum Finder helps locate
and apply available spectrum across
fibers, offering dual-view capabilities
and multiple selection methods. These
enhancements collectively improve
network management, planning, and
resource optimization.

Cisco ONP Release 24.3.1Spectrum Utilization and Path Finder

Key components

The spectrum utilization and path finder feature introduces several key components to enhance network visualization,
planning, and resource optimization:
• Minimal map: A visualization tool that focuses on sites and fibers, presenting a simplified network map for easier

navigation and analysis.

• Path finder/selector: An interactive feature that lets users select network paths, supporting both manual and
customized route finding to optimize network planning.

• Spectrum utilization: A visualization function that displays the usage status of optical spectrum, helping operators
assess how spectrum resources are allocated.

• Spectrum finder: A utility that locates available optical spectrum on fibers and applies this information for provisioning
circuits or media channels.

Find a custom path
Teaches you how to find a custom path. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Use this procedure to customize a fiber path on the map.
TheCustomPath Finder is accessible exclusively through the minimal map. When you choose the custom path finder,
the detailed map automatically switches to the minimal map.
Limitations
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• This feature applies only to circuits (NCS1010/NCS1001), waves (NCS2000 NON-SSON), and media channels
(NCS2000 SSON).

Log in to the Cisco ONP web interface on page 17.
1. In the network tree, select the section of the media channel or circuit that you want to add a new path.
2. Click the Ellipses icon and select Custom Path Finder.

The Custom Path Finder for the selected section opens.

3. In the Visualization area, choose the required map view.
ResultMap View

Shows a complete network map of the selected path with
other sites.

Complete Map

Shows only maps with chosen sites and fiber.Sub Map

4. In the Options area, choose the required parameters to calculate the Path Finder.
DescriptionOption

Routes using the minimum number of hop counts,
regardless of the fiber length.

Minimum Hop

Routes using the minimum fiber length, regardless of hop
count.

Minimum Length

Provides a distinct set of fibers, ensuring that the same
fiber is not used in other paths.

Distinct Fiber Set

Calculates the number of paths according to the specified
value.

Number of Path Count

5. Click Calculate.
The system displays the list of paths calculated using the chosen parameters.
The calculated paths table contains the path parameters.
Table 47: Path Parameters

DescriptionParameter

Displays the serial number.S.No

Shows the fiber path direction based on the selected Options parameters.Path

Filters the path based on fiber labels.Funnel icon

Displays the hop count.Hops

Displays the total length of the fiber path.Total Length

6. Click Export to export the chosen fiber path.
7. In the Selected Service and Path area, check the service and path information and click Apply Path to apply

the selected path.
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Select path manually
Teaches you how to select path manually. Instructs you on the necessary steps to perform this task effectively and ensure
proper network configuration.
Log in to the Cisco ONP web interface on page 17.
The manual path selector is accessible exclusively through the minimal map. When you choose the manual path selection,
the detailed map automatically switches to the minimal map.
Limitations
• Available in Design and Upgrade modes where circuits path can be updated.

• Applies to only Circuits (NCS1010/ NCS1001), Waves (NCS2000 NON-SSON), media channel (NCS2000 SSON).

• Applies to regen circuits/waves/media channel.

• Additional options are applicable for Section under Network Tree.

The procedure to select a path manually on the map is as follows:
1. In the network tree, select the section of the media channel that you want to add a new path.
2. Click the Ellipses icon and selectManual Path Selection.
3. In the Search field, enter the site or fiber to focus on it.
4. Select the required the fibers to create a path.

The selected fibers appear on the Operation Modes pop-up pane under Fibers area.

5. Click Apply.

View spectrum utilization and find available spectrum
Teaches you how to view spectrum utilization and find available spectrum. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to analyze the availability of network fiber spectrum and to apply the selected spectrum to a planned
service.
The spectrum finder is accessible exclusively through the minimal map.When you choose the spectrum finder, the detailed
map automatically switches to the minimal map.
Use the spectrum finder for the network in Design/Upgrade/Release Upgrade mode and view the spectrum utilization in
Analyze mode.
Log in to the Cisco ONP web interface on page 17.
1. In the network tree, select the section of the media channel to view the spectrum utilization for each fiber.
2. Click the Ellipsis icon and select Spectrum Finder.

The spectrum finder for the selected section opens.

3. In the Selected Fibers area, click +Add Fiber and choose the required fibers from the drop-down list.
4. In the Visualization area, choose the required map view.

ResultMap View

Shows a complete network map of the selected path with
other sites.

Complete Map

Shows only the maps with chosen sites and fiber.Sub Map

5. In the Spectrum Finder area, modify the parameters as required.
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DescriptionOption

Similar to Spectrum Utilization View.Tabular View

Displays multiple fibers in a vertical orientation (Y-Axis)
and the spectrum on the horizontal axis (X-Axis).

Detailed View

Enable Spectrum Selection to modify the subsequent
parameters.

Spectrum Selection

Enter the bandwidth (GHz) that is required for the network
circuit.

Spacing

Provides Distinct set of fibers. This makes sure the same
fiber is not repeated in other paths.

Distinct Fiber Set

Calculates the number of paths based on the number
provided.

Number of Path Count

Allows you to select overlapping wavelengths with
selected fibers, when enabled.

Allow Overlap

Zooms in and out of detailed view to granular view. Click
Default reset zoom.

Zoom

Displays the labels. Enable to view the labels. You can
also view the labels of existing occupied circuits.

View Labels

Shows the start, end, and central wavelengths (THz) of
the hovered spectrum when moving across the view.

Hovered Spectrum

Shows the start, end, and central wavelengths (THz) of
the selected spectrum when selecting across the view.

Selected Spectrum

Toggle to view the C-band spectrum usage.C-Band

Toggle to view the L-band spectrum usage.L-Band

Displays the frequency utilized in a fiber for each span in
continuation in a vertical axis. Each square block is

Fiber Utilization Graph

3.125GHz. The frequency range starts from the left and
continues towards the right, increasing 3.125GHz per
block for both C- and L-band.
For C-band, the first row has the starting frequency as
191.325 THz. A single row contains 53 blocks, totaling
0.165625 THz ( 53*3.125 GHz). The starting frequency
of subsequent rows increment at 0.165625 GHz.

Color tone of the blocks varies in the fiber utilization graph.

Indicates overlap of same spectrum across multiple
waves.

Dark red

Indicates less spectrum usage.Light red

6. In theApply Properties to Existing Service area, check the service parameters and clickApplyWavelength
and Apply Path.
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Click Apply Wavelength and Apply Path to revert the changes.

7. Select Apply to Service.

COSM cards
Describes the functionality of COSM cards. Explains the benefits of this feature and how it contributes to efficient and
robust network planning.
A COSM card is a network hardware component that
• provides licenses based on functionality for features such as alarm correlation, performance monitoring, connection

verification, and OTDR,

• serves as the primary card for all networks starting from Release 12.1.0, and

• can be deployed in both ROADM and TRAFFIC nodes as part of network designs.

From Release 25.1.1, SVO card is referred as COSM card.

Features of the COSM card:

The COSM card offers these key features and configuration options:
• Occupies two slots in the chassis.

• Serves as the primary card for all networks beginning with Release 12.1.0.

• For high availability, a node can be equipped with two COSM cards, but they cannot reside in the same chassis.

• Two 10G SFP+ pluggables can be used to connect two COSM cards within a node.

• A Cisco ASR 920 switch can be connected to COSM cards during network design.

• The COSM solution can operate either as a physical card or as a UCS-based solution.

COSM licenses:

From 25.1.1, one COSM license, OAS-COSM-MLCL, is required for each active card present in the chassis, such as
M15, M6, M2, 1010, 1020, 1014, or 1004.

SVO licenses

SVO licenses are applicable for NCS 2000 networks until Release 12.3.1.
• SVO cards require either a Base License or an SVO Full License which covers High Availability, Connection Verification,

and Flex Spectrum. If the SVO Full License is not selected, the SVO Base License and High Availability are enabled
by default.

• Types of SVO licenses include:
• Cisco NMS: Features High Availability, Connection Verification, Flex Spectrum, and OTDR.

• Third-Party NMS: Includes North Bound Interface (NBI), Alarm Correlation, Performance Monitoring, and Circuit
Provisioning.

Chassis licensing:

• Every chassis added to the network must be licensed from Release 12.1.0 onwards. For networks upgraded to Cisco
ONP Release 4.0 or higher, a new chassis license is required after analysis.
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• Chassis licenses come in variants such as 1-chassis, 5-chassis, 10-chassis, 20-chassis, 50-chassis, and others,
chosen based on cost optimization.

• A license is required for each chassis added to the network after the first chassis.

• Chassis License Flush Out allows you to replace existing chassis licenses with new ones. The current license remains
active if the site is unlocked. However, you can use flush out only during network upgrade mode.

• You can continue using existing licenses with changes to the chassis unless you opt for the Chassis License Flush Out
option.

Note

Chassis Licensing and SVO Licenses are applicable until Release 12.3.1.

Cisco Optical Site Manager associations
Describes the functionality of sVO Cisco Optical Site Manager associations. Explains the benefits of this feature and how
it contributes to efficient and robust network planning.
A Cisco Optical Site Manager association is a network configuration mechanism that
• enables a ROADM or Traffic node equipped with an COSM card to manage OLA, DGE, Traffic, and other ROADM

nodes that may not have their own COSM card

• allows both manual and automatic association of secondary nodes to a primary node based on network topology and
configuration, and

• supports a range of High Availability options to enhance resiliency and dynamic association in NCS 2000 networks.

From Release 25.1.1, Cisco ONP has been enhanced to support COSM line card connectivity from ROADM or Traffic
nodes to various site types. The node with the COSM card becomes the primary node.The number of nodes managed by
the primary node depends on the total applicationmemory of the primary node and the RAM size of the individual associated
nodes. You can configure these two properties under the COSM properties of site properties.
Table 48: Feature History

Feature DescriptionRelease InformationFeature Name

COSM application memory and COSM RAM Size are
considered for COSM association through COSM
Application Memory and COSM RAM size properties at
site level.

Cisco ONP Release 26.1.1COSM enhancements

Cisco ONP has been enhanced to support COSM line card
connectivity from ROADM nodes to various site types. A
ROADM node equipped with a COSM card can now
manage up to 14 additional OLA and ROADM nodes.
Previously, this was limited to OLA-to-ROADM
associations. The node with the COSM card acts as the
primary node.
The new COSM High Availability options available
under the Site properties, such as Auto, Local HA,
None,OnlyActive, andGeoHA enablemore dynamic
and rule-based association in the NCS 2000 network.

Cisco ONP Release 25.1.1Cisco Optical Site Manager
enhancements
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Methods of association

• Automatic COSM associations:
• Cisco ONP automatically selects a primary node if the fiber property DCN Extension is enabled or if a node has

the highest number of degrees.

• You can associate up to 15 nodes with one primary node. In networks with more than 15 nodes, Cisco ONP
chooses another primary node to manage the excess nodes.

• Manual association (Network Tree and Map): You can manually associate OLA, DGE, Traffic, and ROADM nodes with
a ROADM or Traffic node (equipped with a COSM card) using the network tree or topology map interface.

• Association through COSM High Availability property: The association options under the High Availability drop-down
list (Auto, Local HA, None, Only Active, Geo HA) can be directly applied for both SSON and non-SSON NCS 2000
networks for rule-based and resilient configurations.
• Auto: Based on the analysis and default behavior.

• Local HA: The active and standby COSM cards are both on the same node.

• None: No COSM card present.

• Only Active: This option does not provide High Availability. Only the primary COSM card is added.

• Geo HA: COSM cards are placed in two sites next to each other in different geographical locations.

• From Release 25.1.1, Traffic nodes may also act as primary nodes if equipped with a COSM card.

• High Availability options support both switched optical networks (SSON) and non-SSON environments.

• These enhancements allow for more scalable and flexible management of optical site nodes in the NCS 2000 platform.

If your network contains more than 15 nodes, Cisco ONP divides the associations such that another primary nodemanages
the additional nodes.
• Using the network map, you can manually group OLA and DEG nodes without SVO cards to a ROADM node with an

SVO or COSM card for centralized management.

• Selecting "Geo HA" under High Availability lets you deploy pairs of COSM cards in geographically separate locations,
increasing protection against local failures.

Associate sites with COSM cards
Teaches you how to associate OLA or DGE sites with SVOCOSM cards. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to associate OLA and ROADM sites with the COSM cards:
1. In the network tree panel, click the Ellipsis icon available next to any ROADM or Traffic site with COSM card.
2. Click Edit COSM Associations.
3. Select thesites on the map to toggle the COSM connections. To confirm your selection, click Done at the top-right

corner.
You can associate up to 14 nodes with a single ROADM or Traffic node equipped with an COSM card. To associate
more than 14 nodes, you will need an additional primary node to manage the extra nodes. You can open widgets in
the map and select the top section to view the association.

Cisco Optical Network Planner | Updated March 10, 2026

| Design and Analyze Networks | 110



Note

You can also right-click any ROADM or Traffic site from the map and click Edit COSM Associations. For the
DGE sites, the Edit COSM Associations option is not displayed.
During network analysis, the tool automatically associates the sites you do not associate with the COSM card.

Export Cisco Optical Site Manager NETCONF XML file for NCS 2000 network
Teaches you how to export Cisco Optical Site Manager NETCONF XML file for NCS 2000 network. Instructs you on the
necessary steps to perform this task effectively and ensure proper network configuration.
Use this procedure to export the Cisco Optical Site Manager NETCONF XML files for NCS 2000 network from the Cisco
ONP GUI.
This feature has limited scope in this release.
The network must be in Analyze mode.

Note

This procedure applies to all NCS 2000 networks from R25.1.1 only to upload NETCONF file to Cisco Optical Site
Manager.

1. In the network tree panel, click the three dots.
A pop-up list appears.

2. In the list, click Generate COSM NetConf XML.
Export window appears with network name.

3. Click Export.
The message "Success. COSM NetConf exported successfully" appears.
Download the zip file that contains the COSM NETCONF XML files of individual sites.
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Note

You can choose the destination folder to save the downloaded Cisco Optical Site Manager NETCONF XML files of
individual sites.

Note

NCS 2000 Cisco Optical Site Manager NETCONF XML file does not support the MD-32O-CE and MD-32E-CE card
configurations.

Note

• For the ROADM and OLA nodes, the device name is the same as the Site Name.

Ensure that you align the device name in COSM to match the specified format.
If the Site Name contains any special character, the XML file replaces the special character with its ASCII value
in the COSM XML device name, providing a seamless experience with the COSM data backup workflow.

Export NeUpdate XML file for NCS 2000 networks
Teaches you how to export NeUpdate XML file for NCS 2000 networks. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to export the NeUpdate XML files for all network sites or the entire network from the Cisco ONP GUI.
This supports device configuration, automation, and network provisioning using the latest supported parameters.

Note

This procedure applies to all NCS 2000 networks till R11.1.x to upload in CTC. For NCS 2000 networks from R25.1.1,
see Export Cisco Optical Site Manager NETCONF XML file for NCS 1001/1010/1014 networks on page 119 to export
NETCONF XML to upload in Cisco Optical Site Manager UI.

The network must be in Analyze mode.
Log in to the Cisco ONP web interface on page 17.
1. In the network tree panel, click the three dots.

A pop-up list appears.

2. In the list, click Generate Device NetConf XML.
The Export window appears displaying the network name.
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3. Click Export.
The message "Success. Device NetConf exported successfully" appears.
You can download a zip file that contains the NETCONF XML files for individual sites.

Note

You can choose the destination folder for saving the downloaded NETCONF XML files of individual sites.
This feature has limited scope in this release.

Export device NETCONF XML file for NCS 1010 networks
Teaches you how to export device NETCONF XML file for NCS 1010 networks. Instructs you on the necessary steps to
perform this task effectively and ensure proper network configuration.
Use this procedure to export the NETCONF XML files for all network sites or the entire network from the Cisco ONP GUI.
This supports device configuration, automation, and network provisioning using the latest supported parameters.

Note

NETCONF device XML is not supported for NCS1004 and NCS1014 devices.

The network must be in Analyze mode.
Log in to the Cisco ONP web interface on page 17.
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Table 49: Feature History

Feature DescriptionRelease InformationFeature Name

The NETCONF XML file exported for
the analyzed NCS 1000 network
designs now include this parameter
when the config mode, card type, and
client type are configured.
• mode

NCS 1010 designs now include these
parameters.
Parameters based on Enable Special
Settings:
• Patchcord Loss Threshold

(applicable for C+L band device)

• Ots Rx Low Threshold (applicable
for C+L Raman device)

• Bidirectional span-loss mismatch
threshold

• Payload OSC Min Deviation

• Payload OSC Max Deviation

Parameters based on Raman LUT and
ALC2 and LUT:
• Raman-tuning with-payload

• Raman-turn-up <enable/disable>

• Raman-safety-trigger dfb-los

• Raman-safety-trigger osc-los

• Raman-safety-trigger osc-osnr-los

Cisco ONP Release 26.1.1Export Device and Cisco Optical Site
Manager NETCONF XML file for all NCS
1000 networks
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Table 50: Feature History

Feature DescriptionRelease InformationFeature Name

The NETCONF XML file exported for
the analyzedNCS1010 network design
with Microsoft configuration now
includes a new parameter.
• OTDR-ScanMode-Expert

If you enable the Enable Special
Settings check box under Network
level properties, the generated XML file
contains the OTDR-ScanMode-Expert
parameter that is set to multi-region.
If you do not enable the Enable
Special Settings check box, then
the scan mode configuration is not
added to the device Netconf XML file.

Cisco ONP Release 25.1.1ALC2 Enhancements

Table 51: Feature History

Feature DescriptionRelease InformationFeature Name

The NETCONF XML file exported from
the NCS 1010 network design now
includes these new parameters to
support seamless Day-0 provisioning
and the setup of a new node added to
the network.
• Optical cross-connects

• Gain range margin

• Tone Rates

• Raman tuning configurations

• Slot reserve

• Dmux WSS attenuation

• Unused CCMD-16 ports shutdown

• Span baseline-deviation

• OTDR Thresholds

• APCSpan-loss correction threshold

Cisco ONP Release 24.3.1NewParameters Included in NCS 1010
NETCONF XML file
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Table 52: Feature History

Feature DescriptionRelease InformationFeature Name

You can export the NETCONF XML files
for all the NCS 1010 nodes, and upload
them to the NCS 1010 nodes through
the YANG suite. This enables automatic
bring up of the NCS 1010 nodes using
the NETCONF data.

Cisco ONP Release 5.0Export NETCONF File from NCS 1010
network

1. In the network tree panel, click the three dots.
A pop-up list appears.

2. In the list, click Generate Device NetConf XML.
The Export window appears displaying the network name.

3. Click Export.
The message "Success. Device NetConf exported successfully" appears.
You can download a zip file that contains the NETCONF XML files for individual sites.

Note

You can choose the destination folder for saving the downloaded NETCONF XML files of individual sites.
This feature has limited scope in this release.

Note

For C+L Network, the partner band configurations are not included in the Cisco ONP-generated XML file. Manually
configure the partner bands on the devices while bringing up the NCS 1010 C+L network.

Note

NETCONF device XML is not supported for NCS1004 and NCS1014 device.

From Release 24.3.1, these new parameters are available in the NETCONF file exported from the NCS 1010 network
design:
• OSC TX Power

• Optical Cross Connect

• OTS tone rate

• OMS tone rate
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• OTS tone pattern expected

• OTS tone detect OOB

• OTS tone pattern

• OTS tone frequency

• Raman pump configurations

• Line port attenuation

• Raman dual safety

These parameters are available only if you enable the Enable Special Settings check box under the Network
properties.
• Raman turnup

• OTS ports shutdown

• OTDR autoscan

• Gain range margin

• OTDR excess attenuation threshold

• OTDR end of fiber threshold

• Slot reserve

• Dmux WSS attenuation

• Unused CCMD-16 ports shutdown

• Span baseline-deviation

• OTDR Thresholds

• APC Span-loss correction threshold

• OTDR-ScanMode-Expert

Note

From R25.1.1, the Cisco ONP-generated XML file for the analyzed NCS 1010 networks include the
OTDR-ScanMode-Expert value. The value is set to
• multi-region if you enabled the Enable Special Settings check box.

• auto if you did not enable the Enable Special Settings check box.

From Release 26.1.1, these new parameters are available in the NETCONF file exported from the NCS 1010 network
design. These parameters are available only if you enable the Enable Special Settings check box under the
Network properties.
• Patchcord Loss Threshold (applicable for C+L band device)

• Ots Rx Low Threshold (applicable for C+L Raman device)

• Bidirectional span-loss mismatch threshold
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• Payload OSC Min Deviation

• Payload OSC Max Deviation

Parameters based on Raman LUT and ALC2 and LUT:
• Raman-tuning with-payload

• Raman-tuning manual

• Raman-tuning Raman-gain-target

• Raman-turn-up <enable/disable>

• Raman-safety-trigger dfb-los

• Raman-safety-trigger osc-los

• Raman-safety-trigger osc-osnr-los

• Raman Pump Configuration such as Raman-tx-power-instance and Raman-tx-power-value

Export device NETCONF XML Files for individual sites
Teaches you how to export device NETCONF XML Files for individual sites. Instructs you on the necessary steps to perform
this task effectively and ensure proper network configuration.
Use this procedure to export device NETCONF XML files for individual sites from the Cisco ONP GUI.
Log in to the Cisco ONP web interface on page 17.
1. Click the Ellipsis icon next to the site.
2. In the list, click Generate Device NetConf XML.

Export window appears with network name.

3. Click Export.
The message, "Success. Device NetConf exported successfully" appears.
You can download a zip file containing device NETCONF XML files of individual sites.

Upload NETCONF files to NCS 1010 device using NETCONF client
Teaches you how to upload NETCONF files to NCS 1010 device using NETCONF client. Instructs you on the necessary
steps to perform this task effectively and ensure proper network configuration.
Use this procedure to upload the NETCONF files that you downloaded from Cisco ONP, into the NCS 1010 device using
a NETCONF client.
Log in to the Cisco ONP web interface on page 17.
1. Log in to the YANG suite that has access to the NCS 1010 device.
2. Connect to the NCS 1010 device.
3. Copy the NETCONF XML file content that is downloaded from Cisco ONP, and paste it into the Protocol NETCONF Run

RPC block.
4. Append this commit code at the end of the NETCONF XML file content.

<rpc xmlns="urn:ietf:params:xml:ns:netconf:base:1.0" message-id="102">
<commit/>
</rpc>
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Export Cisco Optical Site Manager NETCONF XML file for NCS 1001/1010/1014 networks
Teaches you how to export Cisco Optical Site Manager NETCONF XML file for NCS 1001/1010/1014 networks. Instructs
you on the necessary steps to perform this task effectively and ensure proper network configuration.
Use this procedure to export the Cisco Optical Site Manager NETCONF XML files for all the individual sites in a network,
from the Cisco ONP GUI.
Table 53: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco Optical Site Manager XML
supports NCS 1001 and NCS 1014
networks. NCS 1004 configurations
are added to the XML file.
NCS 1010 designs now include these
parameters.
Parameters based on Raman LUT and
ALC2 and LUT:
• Raman-tuning manual

• Raman-tuning Raman-gain-target

• Raman PumpConfiguration such as
Raman-tx-power-instance and
Raman-tx-power-value

Cisco ONP Release 26.1.1Export Device and Cisco Optical Site
Manager NETCONF XML file for all NCS
1000 networks

Table 54: Feature History

Feature DescriptionRelease InformationFeature Name

The newGenerateCOSMNetConf
XML option allows you to export from
the Cisco Optical Network Planner, the
Cisco Optical Site Manager NETCONF
XML files for all the NCS 1010 nodes.
You can then upload these files to the
NCS 1010 nodes through the Cisco
Optical Site Manager, enabling
automatic bring-up of the NCS 1010
nodes.

Cisco ONP Release 5.2Export Cisco Optical Site Manager
(COSM) NETCONF File fromNCS 1010
network

This feature has limited scope in this release.
The network must be in Analyze mode.
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Note

From R26.1.1, export of COSM XML for NCS 1001 and NCS 1014 platforms are supported with these limitations.
• Analysed NCS1001 and NCS1014 networks in R25.1.1 must be reanalysed in R26.1.1 before generating Cisco

Optical Site Manager XML for NCS 1001 and NCS 1014 networks.

• Cisco Optical Site Manager XML is not supported for NCS 1001 networks with PSM-Path protection configuration.

1. In the network tree panel, click the three dots.
A pop-up list appears.

2. In the list, click Generate COSM NetConf XML.
Export window appears with network name.

3. Click Export.
The message "Success. COSM NetConf exported successfully" appears.
Download the zip file that contains the COSM NETCONF XML files of individual sites.
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Note

You can choose the destination folder to save the downloaded Cisco Optical Site Manager NETCONF XML files of
individual sites.

Note

• For the ROADM OLT node, the device name is generated in the Site Name-Side Name format.

• For the OLA node, the device name is the same as the Site Name.

Ensure that you align the device name in COSM to match the specified format.
If the Site Name contains any special character, the XML file replaces the special character with its ASCII value
in the COSM XML device name, providing a seamless experience with the COSM data backup workflow.

Note

L-Band Configuration is not certified in Cisco Optical Site Manager XML. A future release will be considered for the
L-Band configuration.

Note

From R26.1.1, the Cisco ONP-generated XML file for the analyzed NCS 1000 networks include theMode value.
The value is set to
• MXP-1K if you set Config Mode as Muxponder or Bundle.

• MXP-SLICES-1K if you set Config Mode as Slice.

This value appears only when you set the Card Type, Config Mode, and Client Type properties.

Upload a NETCONF XML to NCS 1010 device through COSM web interface
Teaches you how to upload a NETCONF XML to NCS 1010 device through COSM web interface. Instructs you on the
necessary steps to perform this task effectively and ensure proper network configuration.
Use this procedure to upload Cisco Optical Site Manager NETCONF XML files, generated by the Cisco ONP, to an NCS
1010 device using the Cisco Optical Site Manager web interface.
• Download the required COSM NETCONF XML files for the target NCS 1010 device. If you want to configure cross

connects, download two files:
• one without optical cross connect (OXC)
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• and one with optical cross connect (OXC).

• If the devices are already onboarded on COSM, verify that the device name and unique identifier (UID) in COSM are
identical to those in the COSM generated XML files. If the device name or UID does not match, remove the device
from the interface. Alternatively, update the device name, UID, and rack position in the XML to align with COSM and
then upload the updated file.

• If the devices are not onboarded on COSM, upload the COSM XML without onboarding the devices. The device name
and UIDs configured in the XML file will be assigned during device onboarding.

1. Log in to the Cisco Optical Site Manager UI that has access to the NCS 1010 device.
2. Click Optical Setup in the left panel.
3. Click the Node Setup tab.
4. Click Select an XML configuration file.

a) Navigate to the location where the COSM XML file without OXC is present and select it.
b) Click Yes.
c) Click Upload.

A confirmation message appears after the upload is complete.
Important

Manually configure the IP address details of the device, as they are not part of the COSMXML file generated through
Cisco ONP.

5. Create an authorization group for the device added through the imported XML.
a) Click Devices in the left panel.
b) In the Devices tab, click the Authorization Group section to expand it.
c) Click the Add Auth Group button.
d) In the Add Authorization Group dialog box, enter the Auth Group Name, Remote User Name, and

Remote Password in their respective fields.
e) Click Add

The new auth group is added to the table.

6. Edit the device details:
a) In the Devices tab, click the Devices section to expand it.
b) Select the device and update its IP Address and Auth Group.
c) Click Apply.
d) Wait until Sync Status to shows sync-completed, and alarm-synchronized.

7. Go toOptical Configuration > ANS parameter and verify whether the respective configurations are complete.
8. After you load the Cisco Optical Site Manager XML file without optical cross connect, load the file with optical cross

connect and edit the device details.
9. After adding the Cisco Optical Site Manager XML file with optical cross connect, go to the Optical Cross

Connections tab and verify whether the respective configurations are complete.
Both COSMXML files (without and with OXC) are successfully uploaded to the NCS 1010 device, and device configurations
are updated according to the planned parameters.
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Export NCS 1010 network planning data for Cisco Optical Network Controller
Teaches you how to export NCS 1010 network planning data for Cisco Optical Network Controller. Instructs you on the
necessary steps to perform this task effectively and ensure proper network configuration.
Use this procedure to export NCS 1010 network-planning data from Cisco ONP as a JSON file. You can upload the
exported JSON file to Cisco Optical Network Controller to enable efficient bulk configuration and management of NCS
1010 devices.
Table 55: Feature History

Feature DescriptionRelease InformationFeature Name

You can export the planning data of
NCS 1010 network, in the form of a
JSON file. This JSON file can be
uploaded into Cisco ONC to configure
the managed devices in bulk.

Cisco ONP Release 5.0Export NCS 1010 Network Planning
Data for Cisco Optical Network
Controller (Cisco ONC)

You can export the planning data of NCS 1010 network only for releases 7.7.1 and 7.9.1.
1. In the network tree panel, click the Ellipsis icon next to the network name, and select Generate CONC JSON .
2. In the Export File dialog box, enter the name of the JSON file, and click Export to download the JSON file to your

local system.

Upload planning data into Cisco ONC
Teaches you how to upload planning data into Cisco ONC. Instructs you on the necessary steps to perform this task
effectively and ensure proper network configuration.
Use this procedure to upload the network planning data (JSON file) downloaded from Cisco ONP to efficiently transfer
network design and configuration information into Cisco ONC.
1. Log in to Cisco ONC.
2. Hover over the Import icon in the left panel and click Planning Data Import.
3. Click Import.
4. Browse and select the JSON file you downloaded from Cisco ONP.

You can use the planning data to configure the devices managed by Cisco ONC.

Download multiple networks
Teaches you how to download multiple networks. Instructs you on the necessary steps to perform this task effectively
and ensure proper network configuration.
Cisco ONP allows you to download multiple networks as CPZ zip file.
Follow these steps to download multiple networks.
Log in to the Cisco ONP web interface on page 17.
View details of layout and internal connections on page 313
1. Choose File > Download Networks.

The Select Network(s) to Download window appears.

2. Choose a network using one of the options.
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DescriptionOption

Enter the network name and click search icon.Search bar

Enable Select All to select maximum 10 networks.Select All

Use the file list check box to select the required networks.File list

3. Click Download.
Info panel appears.

4. (Optional) Enter zip folder name to download the selected networks.
5. (Optional) Disable Run in Background to monitor the download progress else go to step 7 on page 124.
6. Click Download.

After the zip file is successfully generated, the Download Networks notification appears. Choose Download
7. Leaving Run in Background enabled, click Download.

It is recommended to run the network downloads in background for larger networks. Go to Job Monitor to see the
download progress in the background and click Download.

Note

Download Networks job will be automatically removed from Job Monitor after 7 days.

The zip folder containing the selected networks downloads in the local folder.



4 Modify Network Properties

Provides comprehensive instructions for updating network configuration
properties, including site, fiber, service, and hardware parameters. It enables

Topics:

• Modify network properties users to customize deployment settings, manage licensingmodels, and optimize
• Modify site properties optical performance to ensure accurate network planning and bill of materials

generation.• Modify fiber properties
• Modify fiber couple properties
• Modify service properties
• Service aggregations
• Modify wave properties
• Modify media channel properties
• Modify circuit properties
• Modify trail properties
• Modify section properties
• Modify side properties
• Modify C-band amplifier properties
• Modify L-BandAmplifier Properties
• Modify Add/Drop multiplexer

properties
• Modify L-Band Add/Drop

multiplexer properties
• Modify client properties
• Sort the Network Elements
• Modify Flexgrid properties
• Regenerator sites
• Multidegree ROADM



Modify network properties
Teaches you how tomodify network properties. Update the network configuration properties to accommodate deployment,
licensing, simulation, and advanced optical requirements.
Update the network configuration properties to accommodate deployment, licensing, simulation, and advanced optical
requirements.
Table 56: Feature History

DescriptionRelease InformationFeature Name

Two new network-level properties,
CONC License Package and
CONC Term Preference, have
been introduced to the Network
application configuration category.
Depending on the selected properties,
the following licenses may be included
in the BOM:CONCRTMESSSM,CONC
RTM SPC SM, CONC RTM API SM,
CONC RTM ESS LG, CONC RTM SPC
LG, and CONC RTM API LG. This
feature allows you to identify and order
the necessary COSM and CONC
licenses for your comprehensive
Optical Automation Software (OAS)
solution based on the network
configuration.

Cisco ONP Release 26.1.1CONC licenses support

Cisco ONP introduces a network-level
Licensing Model option within the Bill
of Materials category. You can select
between Smart Licensed and
Perpetual licensing models for your
deployment. This feature is available
on the NCS 1010, NCS 1014, NCS
1001, NCS 2000 4K-1K-2K SSON
networks.
The generated BoM will accurately
represent the hardware, software, and
licenses that can be ordered for the
chosen Authorize-to-Order (ATO)
bundle. This enhancement ensures that
the BoM aligns with your specific
licensing needs, allowing for flexible
and precise license selection within
Cisco ONP. Consequently, order
accuracy and compliance with
Ciscoâ€™s licensing models are
enhanced, offering greater flexibility
and transparency when configuring
solutions in Cisco Commerce
Workspace (CCW).

Cisco ONP Release 26.1.1Cisco ONP BoM based on license offer
structure
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DescriptionRelease InformationFeature Name

The new NCS1K14-FAN-P
programmable fan reduces power use
and improves cooling efficiency by
adjusting its speed to match the card
load in the NCS 1014 chassis. It
increases speed automatically when
the chassis drives higher bandwidth or
thermal demand, keeping airflow
aligned with power requirements.
Choose the programmable fan from the
new NCS1014 Chassis Fan field
at the network level.

Cisco ONP Release 26.1.1NCS1K14-FAN-P progrmmable fan for
NCS 1014

Table 57: Feature History

DescriptionRelease InformationFeature Name

Cisco ONP introduces theStatistical
Simulation Sigma, Statistical
Simulation Margin Sigma, and
OSNR Resolution Bandwidth
properties in this release. When the
ideal OSNR values calculated by Cisco
ONP are not feasible to be used at the
time of deployment, you can modify
the values for these properties to
customize OSNR margin, power
margin, and G-OSNR values to fix the
fiber span issues.

Cisco ONP Release 5.1New Bandwidth Properties
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DescriptionRelease InformationFeature Name

Three new Network Level properties
are introduced to enable you to
customize the core operations of an
NCS 2000 Network. These operations
ran in the background in the earlier
releases. The new properties available
under Core Operations as check
boxes are:
• Enable LOGO Algorithm—It

runs the Local Optimization Global
Optimization (LOGO) algorithm to
find the efficient output power
setpoint for booster amplifiers. By
default, this Enable LOGO
Algorithm check box is enabled.

• Log Enabled—It generates, and
stores logs only for selected
network topologies. This saves a
lot of storage space compared to
previous implementations in which
logs were automatically generated
and saved for all topologies.

• Ignore Raman Span
Checks—It ignores the analysis of
Raman spans between ROADM
sites. This is useful when designing
nonstandard network topologies
with more than two Raman
amplifiers between ROADM sites.
Selecting the check box prevents
Cisco ONP from raising an error
message when analyzing such
topologies.

Cisco ONP Release 5.1New Network Level Properties

From this release onwards, the BOM
does not include any UCS-based SVO
server information. It is expected that
you add the server PID and quantities
manually. Cisco ONP prompts you to
add the server by displaying the
message "UCS server is not billed in
BoM, please add it as needed." in the
Messages tab of theElements tab.

Cisco ONP Release 5.1BOMCustomization for the UCS-based
SVO Server Application
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Table 58: Feature History

DescriptionRelease InformationFeature Name

The new network-level properties
introduced improve the accuracy of the
optical results.
• Ignore APC Penalty: When

enabled, the APC penalty is not
considered while calculating the
OSNR and power margin.

• SOL Optimized PSD: When
enabled, an optimum PSD value is
calculated by considering the SOL
Span losses.

Also, Cisco ONP sets PSD and drop
attenuation to specific values for the
CCMD-16 LC card connected to the
ports of the OLT-E-C, to achieve
optimal RX power for the circuits.

Cisco ONP Release 24.3.1Improved Optical Results

A new Continue Analysis On
Routing Failure check box is
introduced to improve network analysis
reliability for larger NCS 2000
networks. When a routing failure
occurs, this enhancement moves the
network to Partially Analysed
mode, and move the network to
Design or Upgrade mode to edit
properties and correct routing.
After the analysis,
• successful routing paths appear in

the BOM and Optical Reports
tabs.

• failed routing paths are not listed in
these tabs.

• error messages for the individual
routing failures appear in the
Messages tab.

• red cross marks appear next to the
failed routing paths.

This approach prevents a single failure
from failing the entire analysis, isolating
specific issues to enhance
troubleshooting.

Cisco ONP Release 24.3.1Skip Routing Failures in NCS 2000
Network Analysis
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Table 59: Feature History

DescriptionRelease InformationFeature Name

New Network Level properties are
introduced underAdvancedOptical
Settings for NCS 1010 network. You
have the flexibility to define custom
values for the following properties for
the Raman span and validate the optical
circuit feasibility.
• Amplifier Gain Range

• Connector Loss

• Minimum OSNR Margin

• Minimum Span Loss for
Raman Amplifiers

• Percentage of Fibers with
Higher Aging Loss

• Generate Cross-Connect

• Maximum OSC Reach for
NCS 1010Raman Amplifiers

• Retain Auto Placed Raman
Spans for Failure

• Freq Allocation Order

• Link Power Control

• Gain Estimator

• OTDR

Cisco ONP Release 5.2New Network Level Properties

Follow these steps to modify the properties of the network.
Log in to the Cisco ONP web interface on page 17.
1. Open the network where you want to modify the network properties.
2. Choose Network > Entity Editor.

Alternatively, click the network name in the network tree, and click Show Advanced Properties displayed under
the network tree.

3. In the Entity Editor window, click the Site tab.
4. Click the network name, and modify the properties in the right pane. For the property descriptions, refer to:

• General properties of a network on page 131

• System release properties on page 134

• Network-level bill of materials properties on page 135

• Network application configuration properties on page 136

• Core operations properties on page 141
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• Optical algorithm and traffic algorithm options properties on page 139

• Advanced Optical Settings properties on page 142

5. Click Update.

General properties of a network
Provides guidelines for general properties of a network. Lists the essential reference information, key parameters, and
specific guidelines needed to support your daily network configuration tasks.
This table describes various general properties of a network.
Table 60: General properties of a network

Default
option

Available optionsDescriptionPlatformProperty

——Displays the network name.
You can modify the name.

NCS 2000
NCS 1010
NCS 1014
NCS 1001

Name

——This check box allows you to
quickly analyze the network by
using a less accurate algorithm.
The quick analysis option does
not optimize the DCU and
amplifier placement algorithm,
resulting in an approximate
BoM.
For an accurate BoM, uncheck
the Quick Analysis check
box.

NCS 2000Quick Analysis

—• 100G: The entire network
chooses the 100G
wavelength for
transmission.

• 200G: The entire network
chooses the 200G
wavelength for
transmission.

If you enable both 100G and
200G options, by default, the
entire network chooses the
200G wavelength for
transmission. If the 200G
wavelength is not optically
feasible, then it selects 100G
automatically for transmission.

Cisco ONP supports 100G and
200G transceivers as DWDM
interfaces.
This option is applicable only
for automatically created
waves, when OTN services are
present.

NCS 2000DWDM Interfaces
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Default
option

Available optionsDescriptionPlatformProperty

——Enter the customer name.NCS 2000
NCS 1010
NCS 1014
NCS 1001

Customer Name

DefaultDefault
List of profiles already created.

Select the user-defined profile.NCS 2000
NCS 1010
NCS 1014
NCS 1001

Profile

ANSI• ANSI

• ETSI

ANSI networks do not allow you
to define SDH (ETSI) service
demands. ETSI networks do not
allow you to define SONET
(ANSI) service demands.

Allows you to choose the
project type.

NCS 2000Project

——Displays the type of the project,
ANSI, or ETSI. You cannot edit
it.

NCS 1010
NCS 1014
NCS 1001

km• km

• miles

The unit of measurement of
span length.

NCS 2000
NCS 1010
NCS 1014
NCS 1001

Measurement Unit

NCS 1010• NCS 1010

• NCS 1020

Choose the type of chassis.
The available options are:

Note

When you check theEnable
Special Settings check
box, NCS 1020 is selected
as Chassis Type by default.

NCS 1010Chassis Type

——This property groups all
NCS1K14-CCMD-16 cards of
a site in NCS1014 shelf.

NCS 1010NCS1014 Grouping

——This property groups all the
NCS 1000 transponder cards
of a site in NCS1014 shelf.

NCS 1014
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Default
option

Available optionsDescriptionPlatformProperty

A2A_None• A2A_None

• A2A_FAST

Allows you to choose A2A (Any
to Any) mode.

NCS 2000A2A Mode

——The power output value is
based on the chosen A2A
mode.

NCS 2000A2A Power Output

——The demand type is based on
the chosen A2A mode.

NCS 2000A2A Demand Type

Contentionless• Contentionless: This
property enables an
N-degree ROADM node to
accommodate N
wavelengths of the same
frequency from a single add
or drop device.

• Colorless: The colorless
property enables tuning of
channel wavelengths
without changing the optical
interface of the port.

• Colored: The Colored
property dedicates a
separate port for each
wavelength.

The type of channel. You can
choose multiple types.

NCS 2000A2A Channel Type

——Indicates whether the network
is an SSON network.

NCS 2000SSON

——This check box to enables the
Pay As You Grow feature on the
client cards.
The PAYG feature provides a
cost-effective solution for
fewer wavelength
requirements. A standard card
is configured to work on
maximum supported
wavelengths, whereas a PAYG
license comprises license
restricted cards and a base
license. So, instead of
purchasing a standard card,
you can purchase a PAYG
license.

NCS 2000Use client Payg
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Default
option

Available optionsDescriptionPlatformProperty

——(Display only.) By default, the
Naming Convention Enabled
option is enabled for the
networks that are created in
Cisco ONP, and you cannot edit
it. By default, the sides are
named from T, S, R, Q, P, O,
N, M, L, K, J, I, H, G, F, E, and
index, depending upon the
used Scalable Upto parameter.
• You can import a mpz

network without naming
convention enabled, but the
Cascaded SMR option
remains disabled.

• You cannot edit the label
name of the side.

NCS 2000Naming Convention
Enabled

System release properties
Provides guidelines for system release properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
The table provides details about different system release properties of a network.
Table 61: System release properties

Default
option

Available optionsDescriptionPlatformProperty

——Displays the system release of
the NCS 1001 node in the
network.

NCS 1001NCS 1001

——Displays the system release of
the NCS 1010 node in the
network.

NCS 1010NCS 1010

——Displays the system release of
the NCS 4000 node in the
network.

NCS 4000NCS 4K

——Displays the system release of
the NCS 2000 node in the
network.

NCS 2000NCS 2K

——Displays the system release of
the NCS 1004 node in the
network.

NCS 1004NCS 1K (Available
only on the SSON
network)
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Default
option

Available optionsDescriptionPlatformProperty

——Displays the system release of
the NCS 2000 node in the
network, before the Release
upgrade.

NCS 2000Previous NCS 2K
(Available only on the
Release upgraded
network)

——Displays the system release of
the NCS 1010 node in the
network, before the Release
upgrade.

NCS 1010Previous NCS 1010
(Available only on the
Release upgraded
network)

——Line Card is the only option. You
cannot edit this property.

Note

In Release 25.1.1, only Line
card option is available.

NCS 2000COSM

——Choose the required equipment
to add to the restricted list.

NCS 2000Restricted Equipment

Network-level bill of materials properties
Provides guidelines for network-level bill of materials properties. This table details the configurable properties for
network-level bills of materials for supported platforms.
This table details the configurable properties for network-level bills of materials for supported platforms.
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Table 62: Network-level bill of materials properties

Default
option

Available optionsDescriptionPlatformProperty

Smart
Licensed

Note

When you
enable the
special
settings,
Perpetual
becomes
the default.

• Smart Licensed

• Perpetual

Select the required licensing
model. You can select from:
• the fully open flexible

consumption model (FCM)
ATO with Smart Licensing
included.

• the restricted perpetual ATO
without Smart Licensing
included.

See Licensed PIDs available in
the BOM report on page 296for
the PIDs that are added to BoM
based on the license model that
you choose.

NCS 1010
NCS 1014
NCS 1001
NCS 2000

Licensing model

Licensed• Licensed

• Unlicensed

Select whether the line card is
licensed or not.

NCS 1010
NCS 1014
NCS 1001
NCS 2000

Line Card Licensing
Type

Network application configuration properties
Provides guidelines for network application configuration properties. Lists the essential reference information, key
parameters, and specific guidelines needed to support your daily network configuration tasks.
This table describes various network application configuration properties.
Table 63: Network application configuration properties

Default optionAvailable optionsDescriptionPlatformProperty

——This check box enables you to
see software license for COSM
file for R7.11.1 networks.

NCS 1010Install with
COSM

Local HA• Local HA

• Geo HA

Select the type of high
availability.

NCS 2000
SSON

COSM High
Availability
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Default optionAvailable optionsDescriptionPlatformProperty

None• None

• ESS

• ESS+SPC

• ESS+API

• ESS+SPC+API

Choose the type of CONC
license.
This property will be enabled,
only when you enable the Install
with COSM check-box.
This property can be edited in
both Release Upgrade and
Upgrade modes without
unlocking the network.

NCS 2000
NCS 1010
NCS 1001
NCS 1014

CONC
License
Package

36 to 60 months• 12 to 35 months

• 36 to 60 months

• 61 to 84 months

Choose the required CONC
license term.
This property can be edited in
both Release Upgrade and
Upgrade modes without
unlocking the network.
This property will be enabled,
only after you select CONC
License Package other than
None .
Based on the CONC license you
select, Cisco ONP will count
these shelves as small chassis:
1001, 1010, and 2002.
The same count will
automatically be added to these
licenses in the BOM page:
• CONC-RTM-ESS-SM

• CONC-RTM-SPC-SM

• CONC-RTM-API-SM

Cisco ONP will count these
shelves as large chassis: 1004,
1014, 1020, 2006, and 2015.
The same count will
automatically be added to these
licenses in the BOM page:
• CONC-RTM-ESS-LG

• CONC-RTM-SPC-LG

• CONC-RTM-API-LG

NCS 2000
NCS 1010
NCS 1001
NCS 1014

CONC Term
Preference

——This check box enables the use
of x and y coordinates to
calculate the fiber length.

NCS 2000
NCS 1010
NCS 1001

Use
Coordinates
Distance
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Default optionAvailable optionsDescriptionPlatformProperty

——This check box enables the
Raman tuner.

NCS 1010Raman-Tuner

Shortest Path First.—Displays , the spectrum
utilization. This field is
non-editable.

NCS 1010Spectrum
Utilization

C-Band• C-Band

• C+L Futuristic

• C+L

Note

After creating a network,
you can change the
network band type if
required.

The type of band.NCS 1010
NCS 1001

Band Type

Enhanced Faceplate• Standard Faceplate

• Enhanced Faceplate

For R7.10.1 networks,
Cisco ONP supports
Enhanced NCS 1010 Line
Cards. For R7.11.1
networks, Cisco ONP
supports Enhanced NCS
1010 Line Cards and
NCS1K14-CCMD-16-C/L
cards.

The type of Line Card faceplate.NCS 1010NCS 1010
Line Card

HOP• HOP

• LENGTH

The default routing priority for
circuits based on minimum
distance or minimum number of
hops.

NCS 1010Routing
Strategy

Enhanced Faceplate• Standard Faceplate

• Enhanced Faceplate

The line card variant that will be
applied to all edge sides in the
network.

NCS 1010NCS1010
Line Card

0—Based on the number that you
enter, Cisco ONP will
automatically generate up to that
many Omni Edges and run the
analysis. There is no need for
manual creation by the user.

NCS 1010Max Auto
Allowed
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Default optionAvailable optionsDescriptionPlatformProperty

DP01QSDD-ZT5-A1• DP01QSDD-ZT5-A1

• None

Note

You can force the
selected probe channel
option at the network
level only. The selected
option applies to all the
edges of all sites in the
network and remains
disabled at the edge and
site levels.

The coherent probe pluggable to
enable the probe functionality.
The available options are:

NCS 1014Probe
Channel

ONS-QSFP-OTDR• ONS-QSFP-OTDR

• None

Note

You can force the
selectedOTDR pluggable
option at the network
level only. The selected
option applies to all the
edges of all sites in the
network and remains
disabled at the edge and
site levels.

The pluggable to enable OTDR
functionality.

NCS 1014OTDR
Pluggable

Auto• Auto

• NCS1K14-FAN

• NCS1K14-FAN-P

Note

Auto fan type chooses
NCS1K14-FAN-P when
NCS 1014 is set to
R26.1.1.

List the type of fans.NCS 2000
NCS 1010
NCS 1014
NCS 1001

NCS1014
Chassis Fan
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Optical algorithm and traffic algorithm options properties
Provides guidelines for optical algorithm and traffic algorithm options properties. This table describes various optical
algorithm and traffic options properties of a network.
This table describes various optical algorithm and traffic options properties of a network
Table 64: Optical algorithm and traffic algorithm options properties

Default optionAvailable optionsDescriptionPlatformProperty

3• 1

• 2

• 3

The Statistical Simulation
Sigma (Stat Sim Sigma) value
is used in calculating the SOL
G-OSNR, EOLG-OSNR, SOL
Power, EOL Power, SOL
OSNR margin, EOL OSNR
margin, SOL Power margin,
and EOL Power margin
displayed in the Optical
Results page. Choosing a
lower value improves both
OSNR and power margins.
You can edit this value in
Design mode, and Upgrade
mode (after unlocking the
network). Analyze the
network and check the
Optical Results page to
view the updated OSNR and
Power values.

NCS 2000
NCS 1010
NCS 1001

Stat Sim Sigma

3• 1

• 2

• 3

You can edit the Stat Sim
Margin Sigma value in all
modes (Design, Analyze
(locked state), Upgrade, and
Release Upgrade). To view
the OSNR margin and power
values that get updated
based on the value you
selected, reopen the
Optical Results page.

NCS 2000
NCS 1010
NCS 1001

Stat Sim Margin
Sigma
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Default optionAvailable optionsDescriptionPlatformProperty

——This check box skips routing
demand failures. Passed
demands are listed in the
Optical Reports tab, while
failed demands are excluded.
Failed demands are marked
with red crosses in the
network tree, with error
messages displayed in the
Messages tab. If any
demand fails, the network
switches to Partial Analysis
mode.

Note

If any non-routing issue is
present in the network,
then the design network
will not move to the Partial
Analysis mode

NCS 2000Continue Analysis
On Routing Failure

Core operations properties
Provides guidelines for core operations properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various core operations properties of a network.
Table 65: Core Operations properties

Default optionAvailable optionsDescriptionPlatformProperty

——This property is enabled by
default. If you are using a
non-SSON network, you can
edit it; however, in an SSON
network, it remains
non-editable.
This algorithm enables the
Cisco ONP to automatically
find the optimal output power
setpoint for booster
amplifiers within a fiber span.

NCS 2000Enable LOGO
Algorithm

——This check box enables
automatic grouping of optical
subnet and assigns optimal
spectral density to each
subnet.

NCS 2000
NCS 1010

Enable
Advanced
Auto Optical
Subnet
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Default optionAvailable optionsDescriptionPlatformProperty

——This check box enables
generation and storage of
network logs.

NCS 2000
NCS 1010
NCS 1001

Log Enabled

——When enabled, network
analysis ignores Raman span
checks.

NCS 2000Ignore Raman
Span Checks

Advanced Optical Settings properties
Provides guidelines for advanced Optical Settings properties. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table describes various Advanced Optical Settings properties.
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Table 66: Advanced Optical Settings properties

Default optionAvailable optionsDescriptionPlatformProperty

——This check box enables these
properties and sets their default
values.
• Amplifier Gain RangeMargin

• Connector Loss

• Minimum OSNR Margin

• Minimum Span loss for
Raman Amplifiers

• Percentage of Fibers with
Higher Ageing Loss

• Freq Allocation Order

• MC Routing Order

• Ignore APC Penalty

• SOL optimized PSD

If you check the Enable
Special Settings check box,
these parameters are added to
the Device Netconf XML file.
• Slot reserve

• Unused CCMD-16 ports
shutdown

• Span baseline-deviation

• OTDR Thresholds

• Dmux WSS slice attenuation

• APC span-loss correction
threshold

NCS 1010Enable
Special
Settings

3 dB—Enter the amplifier gain range
margin.

NCS 1010Amplifier Gain
Range Margin

0.50.25 - 0.5Enter the connector loss value.NCS 1010Connector
Loss

1 dB—Enter theminimumOSNRmargin
required for the amplifier.

NCS 1010Minimum
OSNR Margin

27 dB—This is the minimum required
span loss for fiber to be
considered for Auto Raman
placement.
This value is calculeted based on
the LUT and fiber type.

NCS 1010Minimum
Span Loss for
Raman
Amplifiers
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Default optionAvailable optionsDescriptionPlatformProperty

• Percentage of
Fibers with Higher
Aging Loss: 40%

• Ageing Loss for
Top Fibers: 3 dB)

• Ageing Loss for
Bottom Fibers:
0.75 dB

• Percentage of Fibers with
Higher Aging Loss

• Ageing Loss for Top Fibers

• Ageing Loss for Bottom
Fibers

When you click the field and a
Fiber Sorting Settings window
opens:

NCS 1010Percentage of
Fibers with
Higher Aging
Loss

——Check this check box to add
Cross connect details in the
COSM XML

NCS 1010Generate
Cross-Connect

User Forced• Auto

• User Forced

The type of Raman amplification.NCS 1010Raman
Amplification

5• 1

• 2

• 3

• 4

• 5

• All

The maximum number of Raman
enabled links on an end-to-end
circuit path.

NCS 1010Maximum
Auto Ramans

The default value is 33
dB.

—The maximum span loss for
which fiber can be considered
for Auto Raman placement.
This value is calculeted based on
the LUT and fiber type.

NCS 1010Maximum
OSC Reach
for Raman
Amplifiers

The default option is
On-Request-Enabled,
when the Enable
Special Settings
check box is checked,
and the
Automatic-Enabled
check box is
unchecked.

• Automatic-Enabled

• Force-Disabled

• On-Request-Enabled

Choose how to enable the Link
Tuner.

NCS 1010Link Tuner
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Default optionAvailable optionsDescriptionPlatformProperty

——By default, this check box
remains checked, when the
Enable Special Settings
check box is checked.
Automatic Power Control (APC)
penalty occurs due to the
inherent error in regulating the
set-point for power. This penalty
is considered while calculating
the OSNR and power margin.
When this property is enabled,
this penalty is ignored during the
calculation and thus providing
accurate optical results.

NCS 1010Ignore APC
Penality

——In general, automatically placed
Raman will be retained only if the
circuit becomes feasible with
those Raman placements.
Otherwise, it will be removed
automatically. If you want to
retain it, check this check box.
It is disabled by default.

NCS 1010Retain Auto
Placed Raman
Spans for
Failure

No-calibration• Automatic

• Automatic-On-request

• No-calibration

Choose how to calibrate the
Raman gain.

NCS 1010Raman Gain
Auto Tuner

——By default this check box
remains checked, when the
Enable Special Settings
check box is checked. When
enabled, an optimum PSD value
is calculated by considering the
SOL Span losses.

NCS 1010SOL
Optimized
PSD

FROM-HIGHER-FREQ• FROM-LOWER-FREQ

• FROM-HIGHER-FREQ

The Freq Allocation Order.NCS 1010Freq
Allocation
Order

The default option is
On-Request-Enabled
, when the Enable
Special Settings
check box is checked,
and
Automatic-Enabled
when the check box is
unchecked.

• Automatic-Enabled

• Force-Disabled

• On-Request-Enabled

Choose how to enable the Link
Power Control.

NCS 1010Link Power
Control
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Default optionAvailable optionsDescriptionPlatformProperty

The default option is
On-Request-Enabled
, when the Enable
Special Settings
check box is checked,
and
Automatic-Enabled
when the check box is
unchecked.

• Automatic-Enabled

• Force-Disabled

• On-Request-Enabled

Allows you to choose how to
enable the Gain Estimator.

NCS 1010Gain Estimator

——Enables or disables the OTDR.
By default, this is enabled.

NCS 1010OTDR

CREATION• CREATION: Based on the
Freq Allocation Order
chosen, the tool allocates
frequency based on order
carrier creation.

• NO-OF-CARRIERS: Based
on the Freq Allocation
Order chosen, the tool
allocates frequency to
circuits based on the
number of carriers.

Routing order for the
multicarriers.

NCS 1010MC Routing
Order

——This check box enables optical
simulation using Split-Step
Fourier(SSF) algorithms for better
OSNR margins.

NCS 1010SSF
Simulation

1.2.2• 1.2.2

• 1.1.4

• 1.1.3

• None

• For NCS 1010, the network
analysis can be done with or
without LUT. If you check
Enable Special Settings
check box, then LUT is
enabled. You can set LUT to
None. Otherwise, it will be
non-LUT-based analysis.

• For NCS 1014, the network
analysis is always LUT-based
analysis. Look-Up Table is
non-editable. You cannot
unselect LUT.

NCS 1010
NCS 1014

LUT Version

Modify site properties
Teaches you how to modify site properties. Follow these detailed step-by-step instructions carefully to ensure the specific
configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
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Table 67: Feature History

Feature DescriptionRelease InformationFeature Name

You can now create a Multi-Carrier circuit for the NCS 1010
networks. You can add central wavelength and path to all
the carriers in colorless configurations. You can export
optical reports and Netconf XML files with Multi-Carrier
Circuits information for device updates. Upgraded networks
treat the unlocked Multi-Carrier Circuits as new circuits,
allowing edits to the circuits. Create Multi-Carrier Circuits
to achieve a 38-channel plan using NCS1K14-CCMD-16-C
card.
Cisco ONP introduces two properties to create Multicarrier
circuits in NCS 1010 networks.
• No of Carriers: In this trail level property, enter the

value to add the required number of carriers in a fiber
path in the network.

• MCRoutingOrder: In this site level property, choose
CREATION or NO-OF-CARRIERS to create multiple
carriers based on the Frequency Allocation Order.

Cisco ONP Release 24.3.1Multicarrier Creation for NCS
1010 Networks

Table 68: Feature History

Feature DescriptionRelease InformationFeature Name

You can now select M2 Chassis as Chassis Type under
the site properties for the NCS 2000 ROADM and OLA
nodes in SSON and non-SSON networks. This is in
addition to the M6 and M15 chassis that were supported
previously.
M2 chassis is suitable for small sites where only two slots
are sufficient to meet the networking requirements. It
provides a compact and efficient solution for locations
with limited space or lower capacity needs.

Cisco ONP Release 25.1.1M2 chassis support

Table 69: Feature History

Feature DescriptionRelease InformationFeature Name

This enhancement allows you to extend
the contentionless sides in a ROADM
site, increasing the number of
provisioned contentionless sides in the
NCS 2000 networks. New
contentionless sides increase the
number of traffic channels in the NCS
2000 networks. The new Reserve
Cascaded SMR Port property
reserves more SMR ports to extend the
Layer-2 contentionless sides in a
ROADM site.

Cisco ONP Release 5.2Layer-2 SMR Enhancement to Support
Second and Third Port Extension
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Table 70: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP now supports the new PIDs from the NCS 1000
family. This allows you to plan your NCS 1010 network
while leveraging the LC connector interfaces of NCS 1010,
NCS1K14-CCMD-16-C, and NCS1K14-CCMD-16-L line
cards.
The new properties that support the new PIDs are:
• NCS 1010 Line Card—Allows you to select a line

card; these options are available:
• Standard Faceplate-NCS1K-OLT-C,NCS1K-OLT-L,

NCS1K-ILA-C, NCS1K-ILA-L, NCS1K-OLT-R-C,
NCS1K-ILA-R-C, NCS1K-ILA-2R-C

• Enhanced Faceplate- NCS1K-E-OLT-C,
NCS1K-E-OLT-L, NCS1K-E-ILA-C,
NCS1K-E-ILA-L, NCS1K-E-OLT-R-C,
NCS1K-E-ILA-R-C, NCS1K-E-ILA-2R-C,
NCS1K-E-ILA-R-C-2, NCS1K14-CCMD-16-C,
NCS1K14-CCMD-16-L

• Degree Priority—Allows the choice of LC and MPO
ports for degree interconnection.

• Direct LC Add/Drop—Allows to choose the number
of LC ports for direct Add/Drop connection.

• Add/Drop Connector—This circuit-level property
allows you to choose a specific add/drop type for
individual circuits. Available options — Direct OLT,
OLT+BRK-8/16/24, OLT+CCMD-16

• Colorless Add/Drop:
UnderMPOConnector Add/Drop, you can choose
a breakout module.
Under LC Connector Add/Drop, you can choose
NCSK14-CCMD-16-C or NCSK14-CCMD-16-L.

Cisco ONP Release 5.2NCS 1010 New Hardware
Support

Table 71: Feature History

Feature DescriptionRelease InformationFeature Name

You can enable the Colored
Add/Drop property. This feature
supports the use of contentionless and
colored demands that are connected
to the same port of an SMR card. With
the Shared SMR Port enabled, you
can create and validate the
contentionless and colored
configuration on a 16-degree SMR-20
node.

Cisco ONP Release 4.2Shared SMR Port

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 148



Use this procedure to modify the properties of the site.
1. Open the network where you want to modify the site properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, navigate to Sites > Site
4. Choose the site and modify the properties in the next pane. For the property descriptions, refer to:

• General site properties on page 149

• C-Band properties on page 153

• Layout properties on page 158

• Cisco NMS properties on page 163

• Map properties on page 164

• Bill of materials properties on page 165

• COSM properties on page 167

• Enhanced face plate properties on page 167

5. Click Update.

General site properties
Provides guidelines for general site properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the descriptions of various general properties for sites.
Table 72: General site properties

DefaultAvailable optionsDescriptionPlatformProperty

——Enter the site name, either
alphanumeric or numeric.

NCS 2000
NCS 1010
NCS 1001

Name
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DefaultAvailable optionsDescriptionPlatformProperty

The site type that you chose
while designing.

• ROADM

• OLA

• Traffic

• Passthrough

Note

• You can add a
passthrough site as a
place holder. You
cannot add services or
waves to this site and
therefore cannot
generate the report.
Later, you can convert
the passthrough site to
a ROADM, OLA, or the
Traffic site in the
design mode.

• OLA is an optical line
amplifier site that is
used only for
amplification. You
cannot add service or
waves on this site.

Choose the type of site.NCS 2000Type

ROADM• ROADM

• OLA

• Traffic

• Passthrough

Choose the type of site.NCS 1010

——Displays the type of site.NCS 1001

Auto• Auto

• 16MPO-MPO

• 24MPO-MPO

Choose the type of MPO
cable.

NCS 1010MPO Cable

FLEX NG-DWDMFLEX NG-DWDMThis field is noneditable.NCS 2000Node Type
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DefaultAvailable optionsDescriptionPlatformProperty

Large CO - NCS 4016• Large CO - NCS 4016

• Small Site - NCS 4016

• Small Site - NCS 4009

Choose the configuration
from the drop-down list. This
option is available only for
the Traffic site.
• Large CO - NCS 4016

• Small Site - NCS 4016

• Small Site - NCS 4009

NCS 2000Equipment
Configuration

• 4K_1K_2K (for SSON)

• 4K_2K (non- SSON)

• 4K_1K_2K (for SSON)

• 1K_2K (for SSON)

• 4K_2K (non- SSON)

Choose the traffic type.NCS 2000Traffic Type
(only for
Traffic site)

——Indicates whether the
network is an SSON network.

NCS 2000SSON

——This property is noneditable
at site level. This property
chooses COSM card as
Server or Line card at the
network level.

NCS 2000COSM

——Enter a string holding the
CLLI code.

NCS 1004
NCS 2000
NCS 4000

CLLI Code

——Enter the site address.NCS 2000
NCS 1010
NCS 1001

Site Address

This option remains
unchecked.

—By default, this option is
unchecked.When you enable
this feature on the network,
it is automatically enabled on
the associated sites of the
network.

NCS 2000EvolvedMesh

——Displays the status of the
network. It shows whether
the network isUp orDown.

NCS 2000Status

Same shelf• Same shelf

• Separated shelves

Choose the Node Protection.NCS 2000Node
Protection
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DefaultAvailable optionsDescriptionPlatformProperty

MF-MPO-16LCMF-MPO-16LC
The MPO-16 to 16-LC
fan-out module is a double
slot module with one
MPO-16 connector (COM)
and eight LC duplex
connectors. The MPO-16
connector is compatible with
the SMR20 FS EXP and
16-AD-CCO FS units.

Displays the fan-out module.NCS 2000Mpo16Lc

MPO16ToMPO8Cable• MPO16ToMPO8Cable

• MF-2MPO_ADP

Choose the required Mpo16
to Mpo8 converter.

NCS 2000Mpo16ToMpo8

Auto• Auto

• 16MPO-MPO

• 24MPO-MPO

Choose the required Mpo
cable.
• Auto

• 16MPO-MPO

• 24MPO-MPO

NCS 1010MPO Cable

——Enable this option to add
Layer-2 contentionless
sides.

NCS 2000Cascaded
SMR

1• 1, 2, and 3 if Scalable
Upto Degree is 12 and
16.

• 1 and 2 if Scalable Upto
Degree is 8.

• 1 if Scalable Upto Degree
is 12 and 4.

Note

This property becomes
available when you enable
Cascaded SMR for NCS
2000 networks from
Release 11.1.x.

Choose the number of ports
to reserve for the cascaded
SMR.

NCS 2000Reserve
Cascaded
SMR Port

This check-box remains
checked for a newly created
network.

—You cannot edit this option.NCS 2000Flex
Spectrum

——When you enable this option,
it indicates that OTN traffic
can be groomed at this site.

NCS 2000
NCS 4000

GroomingSite
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DefaultAvailable optionsDescriptionPlatformProperty

——Check this check box to use
the ONS-MPO-MPOLC-10
breakout cable to
interconnect the client ports
of the MR-MXP card with the
NCS2K-MF-MPO-20LC
passive module.

NCS 2000MR-MXP
BreakOut
Cable

——Check this check box to use
the NCS2K-MF-8X10G-FO
passive module only for 10G
on the client-side of the
NCS2K-400G-XP card. By
default, this passive module
is enabled.

NCS 20008X10G-FO

C-Band• C-Band

• C+L futuristic

• L-band

Choose the required band
type for NCS 1010 R7.9.1.

NCS 1010
NCS 1001

Band Type

Enhanced Faceplate• Enhanced Faceplate

• Standard Faceplate

Choose whether the Line
Card faceplate is Standard
Faceplate or Enhanced
Faceplate.

Note

If you assigned a
ScalableUptoDegree
value that is supported for
both standard and
enhance at the site level,
then you can select
Standard Faceplate in one
side and Enhanced
Faceplate in another side.

NCS 1010NCS 1010
Line Card

C-Band properties
Provides guidelines for c-Band properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes the descriptions of various C-Band properties under sites.
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Table 73: C-band properties

DefaultAvailable optionsDescriptionPlatformProperty

LineThe available options for
ROADM and Traffic sites
are:
• Multi-degree

• Line

• Terminal

For OLA and
PASSTHROUGH, it is Line,
and you cannot edit it.

Choose the type of the site.NCS 2000Structure

LineThe available options for
ROADM sites are:
• Multi-degree

• Line

• Terminal

For OLA and
PASSTHROUGH, it is Line,
and you cannot edit it.

Choose the type of the site.NCS 1010

Terminal• Terminal

• Terminal-Section

• Terminal-Path

Choose the type of the site.NCS 1001

TerminalTerminalChoose the type of the site.NCS 1014
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the site
functionality.
The functionalities available
for each type of site are:
• Optical Cross Connect

(OXC) for ROADM and
traffic site

• Auto or Line Amplifier for
OLA site, Cisco ONP
downgrades OLA site to
passthrough if OLA is
not required.

• Passthrough for
passthrough site

NCS 2000Functionality

——Displays the site
functionality. ROADM is the
default functionality for all
site types.

NCS 1010

——Displays site functionality.NCS 1001
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DefaultAvailable optionsDescriptionPlatformProperty

4• None

• Auto

• 4

• 8

• 12

• 16

The network is scalable up
to 16 degrees for ROADM
and Traffic sites. Choose 2
to have a LINE ROADM site.
For OLA, the value is 2 and
is noneditable.

This parameter determines
the maximum number of
degrees, ducts, or line sides
that can be supported by the
site.

NCS 2000Scalable up to
Degree

7• 7

• 9

• 15

• 17

• 23

• 25

• 31

If you choose Line Card
Faceplate as Enhanced
Faceplate, for NCS 1010
site, the available options
are 3Ã¢â‚¬Â¦15, 23, and
31.

NCS 1010

Auto• Auto
When you choose Auto,
the default option is
SMR-20.

• SMR-20

• SMR-9

Choose the type of site.
The Site type is Line for the
OLA site.

NCS 2000Site Type

——For NCS 1010 site, the only
option is OLT, and it is not
editable.

NCS 1010

——Displays the type of site,
and it is noneditable.

NCS 1001
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the platform. For
example, NCS 1010 , NCS
1001, or NCS 2000.

NCS 2000
NCS 1010
NCS 1001

L0 Platform

——Check this check box to
connect Contentionless unit
16-AD-CCOFS andColored
unit MD-48-ODD/Even to
the same MPO port of
SMR-20.WhenShared SMR
port is enabled,
MD-48-ODD/EVEN unit
connects to the specific side
of SMR-20 through
MPO-8LC and UPG-4
instead of directly
connecting to SMR-20
through MPO-16LC.

Note

Shared SMR port
becomes disabled, if
• Degree Mesh

Type property is
PPMESH8-5AD

• Or, Site Type
property is SMR-9
and Scalable Upto
Degree property is
8

NCS 2000Shared SMR Port

DEG-5/UPG-4• DEG-5/UPG-4

• PPMESH8-5AD

Choose the mesh type for
the Flex NG-DWDM site.

NCS 2000Degree Mesh
Type

——Displays the type of degree.
For example, BRK-8.

NCS 1010Degree Type
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DefaultAvailable optionsDescriptionPlatformProperty

None
If you choose None, only the
sides that are present in the
Cisco ONP GUI are shown.
The values in the drop-down
list are populated based on
the value of Scalable
Upto Degree parameter.

• None

• Auto

• 4

• 8

• 12

• 16

This parameter determines
the number of degrees to be
considered for the site
hardware placement on day
0.

NCS 2000Pre Equip Degree

——For NCS 1010 site, the
options available are Yes
and No.

NCS 1010

Layout properties
Provides guidelines for layout properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes the descriptions of various layout properties under sites.
Table 74: Layout properties

DefaultAvailable optionsDescriptionPlatformProperty

Auto• M2 Chassis
M2 chassis does not
support multichassis and
multidegree system.

• M6 Chassis

• M15 Chassis

• Auto
M15 is the default option
when you choose Auto.

The chassis type is
supported for all the sites
except the passthrough.

Choose the type of chassis.NCS 2000Chassis Type

NCS 1010• NCS 1010

• NCS 1020

NCS 1010

——Enable this property to group
all NCS1K14-CCMD-16
cards of a site in NCS1014
shelf.

NCS 1010NCS1014
Grouping

——Enable this property to group
all the NCS 1000
transponder cards of a site
in NCS1014 shelf.

NCS 1014
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DefaultAvailable optionsDescriptionPlatformProperty

—Cables are listed based on
the country type and the
Chassis type selected.

Choose the type of cables to
be used for the AC power
supply.

NCS 2000
NCS 1010
NCS 1001
NCS 1014

UTS AC
Power Cables

AutoFor an NCS 2000 site, the
available options are based
on the chassis type:
• Auto for all types of

chassis

• AC Power, DC power for
M15 and M2 chassis

• AC Power, DC Power,
AC2 Power, DC40
Power, and DC20 Power
for M6 chassis

Choose the type of Power
Supply.

NCS 2000Power Supply

Auto• Auto

• AC Power

• DC Power

NCS 1010
NCS 1001
NCS 1014
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DefaultAvailable optionsDescriptionPlatformProperty

AutoFor an NCS 2000 site, the
default controller card is
TNCS-2. The available
options are based on the
chassis type chosen. By
default, controller cards that
are supported by M15
chassis are listed.
• Auto

• TNC/TSC, TNC-E/TSC-E,
TNCS, TNCS-0, TNCS-2,
and TNCS-20 for M2
chassis

• TNC/TSC, TNC-E/TSC-E,
TNCS, TNCS-0, TNCS-2,
and TNCS-20 for M6
chassis

• TNCS, TNCS-0 TNCS-2,
TNCS-20 for M15
chassis

Choose the type of the
controller card.

Note

For NCS 1010, if you
enable Advanced
Optical Settings, Cisco
ONP takes the default
controller card as
NCS1010-CNTRL-B-K9,
else
NCS1010-CNTRL-K9.
However, you can still
change the controller
later.

NCS 2000Controller
Card

Auto• Auto

• NCS1010-CNTRL-K9

• NCS1010-CNTRL-B-K9
NCS1010-CNTRL-B-K9
appears for networks
from R7.11.1.

NCS 1010

NCS1K-CNTLR2NCS1K-CNTLR2NCS 1001

NCS1K14-CNTLR-K9• NCS1K14-CNTLR-K9

• NCS1K14-CNTLR-B-K9

NCS 1014

——Choose whether to use a
redundant controller card.

Note

When you selectChassis
Type as NCS1020, you
can force Redundant
Controller Card to Yes.

NCS 2000
NCS 1010
NCS 1001

Redundant
Controller
Card

NCS 2000Layout
Template
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DefaultAvailable optionsDescriptionPlatformProperty

Choose the required layout
template.

Note

After the chosen layout
template is applied, all
layout properties will be
reset and disabled.

Note

After design analysis, if
the applied layout
template is not considered
for card placement in the
layout, check for the error
message (non-critical)
under the Elements >
Messages tab. If you
see a template-related
error which indicates that
there is a mismatch
between the cards that are
defined in the template
and the cards that are
created on the site,
perform the following:
• Export the template

from the Layout
page, and modify it as
required.

• Import the modified
template using the
Manage > Layout
Template option.

• Switch to Designmode
and apply the template
to the site using the
Entity Editor.

• Reanalyze the network
to get the correct
layout populated.
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DefaultAvailable optionsDescriptionPlatformProperty

UTS AC
Power Cables

—Cables are listed based on
the country type and the
Chassis type selected.

Choose the type of cables to
be used for the AC power
supply.

NCS 2000
NCS 1010
NCS 1001
NCS 1014

3+1 is the default
redundancy power scheme
for M15 DC chassis and 2+2
is the default redundancy
power scheme for M15 AC
chassis. For example, if you
choose 3+1 redundant
power scheme, there are 3
working power units and 1
protected power unit.

For an NCS 2000 site, the
options available are based
on the chassis type. For M15
chassis, the options available
are 1+0, 1+1, 2+0, 2+1,
3+0, 3+1, 2+2.

Choose the redundant power
scheme from the drop-down
list to configure the number
of working and protected
power units for the chassis.
For an M6 chassis, the
options available are Auto,
Yes, and No.

NCS 2000Redundant
Power
Scheme

Auto• Auto

• 1+0

• 1+1

The options available are
Auto, .

NCS 1010
NCS 1001
NCS 1014

By default, this check box
remains checked.

—This option is available only
for the OLA site. This option
indicates that MF-2LC-ADP
can be shared with EDRA
amplifiers and not with
RAMAN amplifiers
irrespective of the default
selection.

NCS 2000Raman
Adapter Share

Auto• Auto

• ECU—Has 12 USB 2.0
ports and supports
IEEE1588v2 PTP,
time-of-day (ToD), and
pulse-per-second (PPS)
inputs.

• ECU-S—Similar to ECU
except that it has eight
USB 2.0 ports and two
USB 3.0 ports.

• ECU60-S—Variant of
ECU-S introduced for the
NCS2006when the shelf
is powered at â€“60VDC
nominal input voltage.

ECU-S and ECU60-S are
supported only for M6
chassis.

Choose the External
Connection Unit (ECU) type
from the drop-down list.

NCS 2000ECU Type
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DefaultAvailable optionsDescriptionPlatformProperty

Auto• Auto

• MF-6RU/MF-10RU

• MF-1RU

• The NCS2K-MF-1RU has
four slots for the passive
optical modules.

• The NCS2K-MF-6RU
supports up to 14
single-slot passive
optical modules such as
any combination of
NCS2K-MF-DEG-5,
CS2K-MF-UPG-4, or
Connection Verification
(CV) units.

• The NCS2K-MF10-6RU
supports up to 10
double-slot passive
optical modules such as
NCS2K-MF-MPO-16LC=.

Choose the mechanical
frame for the passive optical
modules from the drop-down
list.

NCS 2000MF Unit

MF-1RU• Auto

• MF-4RU

• MF-1RU

NCS 1010

MF-1RUMF-1RUNCS 1001
NCS 1014

——If you check this check-box,
hardware populates from the
bottom in the Layout tab.

NCS 2000Populate
Shelves From
Bottom

Cisco NMS properties
Provides guidelines for cisco NMS properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the descriptions of various Cisco NMS properties under sites.
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Table 75: Cisco NMS properties

DefaultAvailable optionsDescriptionPlatformProperty

——Choose the high
availability options:
• Auto: Based on

analysis and
default behavior.

• Local HA: Both
active and standby
COSM cards are
placed on the
same node.

• None: No COSM
card present.

• Only Active: No
High Availability.
Only Primary
COSM card is
added.

• Geo HA: COSM
cards are placed in
two different sites
located at different
geographical
locations, but
adjacent to each
other. See Rules
and Behavior that
are applicable for
the selection.

NCS 2000COSMHigh Availability

——Enable this check box
to add the High
Availability feature to
the license package.

NCS 2000Primary HA

Map properties
Provides guidelines for map properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes the descriptions of various map properties under sites.
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Table 76: Map properties

DefaultAvailable optionsDescriptionPlatformProperties

——It represents the
longitudinal location of
the site. Longitude can
be positive or negative
(-180 to 180).
Negative is west of
Greenwich, and
positive is eastward.

NCS 2000
NCS 1010
NCS 1001

X Coordinate

——It represents the
latitudinal location of
the site. Latitude can
be positive or negative
(- 90 - 90), north and
south of the Equator.

NCS 2000
NCS 1010
NCS 1001

Y Coordinate

——Check this check box
to lock the site
position on the map.

NCS 2000
NCS 1010
NCS 1001

Position Lock

Bill of materials properties
Provides guidelines for bill of materials properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the descriptions of various layout properties under sites.
Table 77: Bill of materials properties

DefaultAvailable optionsDescriptionPlatformProperty

Choose whether the
License Suite is
Essential (RTU + SIA3)
or Advanced (RTU +
SIA3).

NCS 1010License Suite

——The default option is
RTU + SIA3. It is
noneditable.

NCS 1014

Essential (RTU + SIA3)• Essential (RTU +
SIA3)

• Advanced (RTU +
SIA3)

• Essential (RTU +
SIA5)

• Advanced (RTU +
SIA5)

Choose the License
Suite.

NCS 1010NCS1k Line card
license
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DefaultAvailable optionsDescriptionPlatformProperty

——This feature enables
NCS features on all
sites in the network.

NCS 2000Enable NCS

——TheÂ Pay As You
Grow (PAYG)
functionality
significantly reduces
the initial setup cost
and enables the
purchase of another
wavelength capacity
on a need basis.
PAYG enables
port-based cost or
licensing for SMR-9
and SMR-20 cards.

NCS 2000Use PAYG

——Enable this check box
to:
• Validate the

correct optical
interconnection
between the
optical cards
inside a Flex
ROADM.

• Measure the
insertion loss of
the external
passive path.

• Validate the quality
of the connections
to the patch panel.

• Check if the
insertion loss is
within the
expected value.

The following cards
support connection
verification:
• SMR20 FS CV

• MF-DEG-5-CV

• MF-MPO-16LC-CV

• MF-UPG-4-CV

NCS 2000Connection
Verification
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DefaultAvailable optionsDescriptionPlatformProperty

This check-box
remains checked for
newly created
network.

—You cannot edit this
option. This option
enables displaying of
the new SMR-20 PID
in the BOM page.
You can enable this
option when you
unlock anmpz network
where SMR-20 is
selected, during an
upgrade or release
upgrade.

NCS 2000New FS-SMR PID

Enhanced face plate properties
Provides guidelines for enhanced face plate properties. Lists the essential reference information, key parameters, and
specific guidelines needed to support your daily network configuration tasks.
This table describes the descriptions of various Enhanced face plate properties under sites.
Table 78: Enhanced face plate properties

DefaultAvailabe optionsDescriptionPlatformProperty

LC Ports• LC Ports

• MPO Group

Choose the port type
for interconnect
degree priority.

Note

This field appears
only when you
select NCS 1010
Line Card as
Enhanced
Faceplate.

NCS 1010Degree Priority

——This property is
noneditable and
appears for networks
from R7.11.1.

NCS 1010Add/Drop Shelf Type

COSM properties
Provides guidelines for sVOCOSM properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the descriptions of various COSM properties of a site.
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Table 79: COSM properties

DefaultAvailable optionsDescriptionPlatformProperties

Auto
When you choose
Auto,
ONS_SC+-10G_SR is
the default option.

• Auto

• ONS-SC +-
10G-SR

• ONS-SC
+-10G-LR

Choose the pluggable.

Note

The COSM
pluggables are not
applicable for
UCS-based COSM
network design.

NCS 2000COSM Pluggables

Auto

Note

When set to Auto,
this will use either
Geo HA or Local
HA, depending on
the COSM High
Availability property
configured at the
network level.

• Auto

• Local HA

• None (No COSM)

• Only Active

• Geo HA

Click Edit and select
the type COSM high
availability

NCS 2000 (SSON)COSMHigh Availability

322.1 to 32Enter the value for the
total application
memory of the primary
node having theCOSM
card.

NCS 2000 (SSON)COSM Application
Memory

4 for the nodes with
scalable upto degree
8 or more.
2.1 for nodes with
scalable upto degree
4 or less.

2.1 to 8Select the RAM size of
the individual
associated node.

NCS 2000 (SSON)COSM RAM size

Add contentionless side to a site
Teaches you how to add contentionless side to a site. Contentionless functionality on a site refers to the contentionless
add or drop ability of an N-degree ROADM node to accommodate N wavelengths of the same frequency from a single
add or drop device.
Log in to the Cisco ONP web interface on page 17.
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Contentionless functionality on a site refers to the contentionless add or drop ability of an N-degree ROADM node to
accommodate N wavelengths of the same frequency from a single add or drop device. A ROADM is contentionless when
the number of drop units equals the number of ROADM degrees.
Use the following procedure to add contentionless sides to a ROADM or traffic site.
1. Open the network in which you want to add contentionless sides to a site.
2. Choose Network > Entity Editor.
3. Click the site to which you want to add contentionless sides.
4. Click the Add Contentionless Side icon.
5. Enter the appropriate value in the Enter number of contentionless sides field.

The number of contentionless sides you can add to a site depends on the site type and the Scalable Upto Degree
property.

Then..If you want to add contentionless sides to

Enter the appropriate value in the Enter number of
contentionless sides field.

Layer-1 SMR site

• Check the Evolved Mesh check box.

• Select Site Type as SMR-20 or Auto.

• Check the Cascaded SMR check box.

• Select Degree Mesh Type as DEG-5/UPG-4.

• Click Update.

• Enter the appropriate value in the Enter number of
contentionless sides field.
See Contentionless sides for Layer-1 SMR on page
170.

Layer-2 SMR-20 site

• Choose theReserve Cascaded SMRPort value.

Note

TheReserveCascadedSMRPort drop-down
property is available for NCS 2000 networks from
R11.1.x.
Based on the N-degree and Layer-2 SMR, you can
add more contentionless sides on each site for the
extended layer-2 SMR, but this will reduce the
number of Layer-1 contentionless sides.

• Click Update.

• Enter the appropriate value in the Enter number of
contentionless sides field.
See Contentionless sides for extended Layer-2 SMR
on page 170.

Extended Layer-2 SMR-20 site
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6. Click OK.

Contentionless sides for Layer-1 SMR
Provides guidelines for contentionless sides for Layer-1 SMR. This table explains how many contentionless sides you
can add to a site based on the site type, and the Scalable Upto Degree property.
This table explains how many contentionless sides you can add to a site based on the site type, and the Scalable Upto
Degree property.
Table 80: Contentionless sides for Layer-1 SMR

Number of contentionless sidesScalable upto degreeSite type

164SMR-20

128SMR-20

812SMR-20

416SMR-20

8LineSMR-20

8TerminalSMR-20

54SMR-9

18SMR-9

Contentionless sides for extended Layer-2 SMR
Provides guidelines for contentionless sides for extended Layer-2 SMR. This table shows howmany contentionless sides
you can add to each site for the extended layer-2 SMR site.
This table shows howmany contentionless sides you can add to each site for the extended layer-2 SMR site. The number
depends on the N-degree and Layer-2 SMR configuration
Table 81: Contentionless Sides for extended Layer-2 SMR

No. of
contentionless
sides with 3rd
Port Layer-2

No. of
contentionless
sides with 2nd
Port Layer-2

No. of
contentionless
sides with 1st
Port Layer-2

No. of
contentionless
sides for Layer-1
side

Scalable
upto
degree

Site
type

Reserve
cascaded
SMR
port

Not supportedNot supported20164SMR-201

Not supportedNot supported20128SMR-20

Not supportedNot supported20812SMR-20

Not supportedNot supported20416SMR-20

Not supportedNot supportedNot supportedNot supported4SMR-202

Not supported2020118SMR-20

Not supported2020712SMR-20

Not supported2020316SMR-20
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No. of
contentionless
sides with 3rd
Port Layer-2

No. of
contentionless
sides with 2nd
Port Layer-2

No. of
contentionless
sides with 1st
Port Layer-2

No. of
contentionless
sides for Layer-1
side

Scalable
upto
degree

Site
type

Reserve
cascaded
SMR
port

Not supportedNot supportedNot supportedNot supported4SMR-203

Not supportedNot supportedNot supportedNot supported8SMR-20

202020612SMR-20

202020216SMR-20

Modify the number of contentionless side ports at a site
Teaches you how to modify the number of contentionless side ports at a site. Follow these steps to modify the number
of contentionless ports for a side in a ROADM site.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to modify the number of contentionless ports for a side in a ROADM site.
1. Open the network in which you want to modify the number of contentionless ports for a side in a site.
2. Choose Network > Entity Editor.
3. Expand a ROADM site, and select a contentionless side.

The properties of the side are displayed in the right panel.

4. From the Contentionless Ports drop-down list, select the required number of ports.
Click Update.

Modify contentionless side to a site in upgrade mode
Teaches you how to modify contentionless side to a site in upgrade mode. Open the network, upgrade it, and set these
site properties in the Entity Editor window.
Open the network, upgrade it, and set these site properties in the Entity Editor window.
1. Enable Evolved Mesh.

2. Set Site Type to SMR-20 or Auto.

3. Enable Cascaded SMR.

4. Set Degree Mesh Type to DEG-5/UPG-4.

5. Set Scalable Upto Degree property to the appropriate value.

If these prerequisites are not met, you must unlock the site to modify the contentionless sides.
Limitations
• This feature supports networks running software release version 11.1.x or later.

• NCS 2000 networks have the limitation of Passive units count up to 126. When you add the second and third L2
contentionless sides, the passive units count goes beyond the limit. In such cases, the tool allows the analysis and
notifies the limitation through an error message, The passive units in this design (count) has exceeded the maximum
supported passive units on the NE SW (126). Please review the design with Cisco before proceeding for deployment.

Follow these steps to modify contentionless sides to a ROADM or traffic site in upgrade mode.
1. Choose Network > Entity Editor.
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2. Click the site where you want to modify the contentionless sides.
3. Check the Cascaded SMR check box if not enabled already.

The Reserve Cascaded SMR Port drop-down appears.

4. Choose the SMR port value in Reserve Cascaded SMR Port.
To reduce the Layer-2 SMR sides:
a. Choose a lower value.

b. Click Update.
If SMR ports are available, the update becomes successful. Else, an error message appears. Perform the following
actions:
1. Unlock the site.

2. Start over from Step 1.

To increase the Layer-2 SMR sides:
a. Choose a higher value.

b. Click Update.
If SMR ports are available, the update is successful. Else, an error message appears. Perform these actions:
1. Unlock the site.

2. Delete the lowest contentionless side from the Layer-1 SMR site.

3. Start over from Step 1.

5. Click the site to which you want to add contentionless sides.
6. Click the Add Contentionless Side icon.
7. Enter the appropriate value in the Enter number of contentionless sides field.

The number of contentionless sides that can be added to a site depends on the type of site and the Scalable Upto
Degree property.

8. Click OK.

Add L-Band side to a site
Teaches you how to add L-Band side to a site. Follow these steps to add L-Band sides to an NCS 1010 R7.9.1 site.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to add L-Band sides to an NCS 1010 R7.9.1 site.
1. Open the network in which you want to add the L-Band sides to a site.
2. Choose Network > Entity Editor.
3. To add the L-Band sides:

• Click the site to which you want to add the L-Band sides.
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Note

If you add an L-Band side to a site, the corresponding attached sides on other sites also receive L-Band sides
automatically.

• Expand the site and click on a side to add L-Band to the selected side only.

4. Click the Add L-Band icon.
The L-Band side appears under the required site or side.

Note

If ILA or pass-through sites are present in the APC domain, the end-to-end path in the L-band is enabled
automatically.

Add omni-directional sides to a site
Teaches you how to add omni-directional sides to a site. Follow these detailed step-by-step instructions carefully to
ensure the specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
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Table 82: Feature History

DescriptionRelease InformationFeature Name

You can now include both colorless and
colored omnidirectional configurations
when designing an NCS1010 network.
New Properties Added:
• Add Omni-Directional icon

(under Entity Editor): Use this icon
to add the required number of
omnidirectional sides.

• Omni Variant (under Side
Properties): Select the desired
Add/Drop stage, such as Dual OLT
or 4x4 COFS.

• Max Auto Omni Allowed
(under Network Properties): Cisco
ONP automatically generates the
omni edges based on the number
entered.

This omnidirectional setup enhances
the flexibility of the multidegree
topology, allowing channels to be
routed through any optical degree
during a fiber cut without needing
physical fiber reconnections.

Cisco ONP Release 24.3.1Omnidirectional Configuration Support
for NCS 1010 Network

The omnidirectional configuration allows you to add or drop traffic to any of the node directions in a multidegree topology.
This configuration provides flexibility, enabling channels to be routed through any of the optical degrees during a fiber
cut without needing to change the physical fiber connections.

Note

Omni edges are not supported on a Terminal site.

Follow these steps to add omnidirectional sides to an NCS 1010 site.
1. Open the network in which you want to add omnidirectional sides to a site.
2. Choose Network > Entity Editor.
3. Click the site to which you want to add omnidirectional sides.
4. Click the Add Omni-Directional icon.
5. Enter the appropriate value in the Enter number of Omni Directional sides field.

The number of omnidirectional sides that can be added to a site depends on the Scalable Upto Degree property.

6. Click OK.
The omnidirectional sides are created under the site and labeled as omni-1, and omni-2 and so on. A tag called Omni
is added to the Omni side to indicate that it as an omnidirectional side.
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To add L-band functionality to the side, click the Add L-Band icon.

Note

Cisco ONPwill automatically generate up to the number of Omni Edges specified in theMaxAutoOmni Allowed
field under Network properties. Manual creation by the user is not required.

Modify fiber properties
Teaches you how to modify fiber properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Use this procedure to modify the properties of a fiber.
Log in to the Cisco ONP web interface on page 17
1. Open the network where you want to modify the fiber properties.

When you click a fiber on the map, it will be highlighted in orange

2. Choose Network > Entity Editor.
3. Click the Fiber tab in the Entity Editor window.
4. Choose the fiber and modify the required properties. For the property descriptions, refer to:

• General fiber properties on page 175

• Physical and Raman amplification properties of fiber on page 182

• Factors properties of fiber on page 180

• Extended and totals properties of a fiber on page 180

5. Click Update.

General fiber properties
Provides guidelines for general fiber properties. This table describes various general properties of the optical fiber
connected between the sites.
This table describes various general properties of the optical fiber connected between the sites.
Table 83: General fiber properties

DefaultAvailable optionsDescriptionPlatformProperty

——By default, the name
of the fiber is based on
the number of fibers
between the source
and destination sites.
You can edit the name.

NCS 2000
NCS 1010
NCS 1001

Name

——Displays the source
site name. This field is
noneditable.

NCS 2000
NCS 1010
NCS 1001

Source
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the
destination site name.
This field is
noneditable.

NCS 2000
NCS 1010
NCS 1001

Destination

——Indicates whether a
standard single fiber is
used to transmit the
data in both directions.

NCS 2000
NCS 1010
NCS 1001

Bidirectional
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DefaultAvailable optionsDescriptionPlatformProperty

G652-SMF• G652-SMF

• G652-SMF-28E

• True Wave Reach

• True Wave RS

• True-Wave Plus

• True-Wave Minus

• True-Wave Classic

• Free-Light

• Tera-Light

• Metro-Core

• ELEAF

• NDSF

• ALLWave

• SMF-28 ULL

• SMF28-Ultra

Select the fiber type.
supports the following
fibers, and the default
fiber type is .

NCS 2000Fiber Type

G652-SMF• G652-SMF

• G652-SMF-28E

• True Wave Reach

• True Wave RS

• True-Wave Plus

• True-Wave Minus

• True-Wave Classic

• Free-Light

• Tera-Light

• Metro-Core

• ELEAF

• NDSF

• ALLWave

• SMF-28 ULL

• SMF28-Ultra

Select the fiber type.NCS 1010

Select the fiber type.NCS 1001
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DefaultAvailable optionsDescriptionPlatformProperty

• G652-SMF

• G652-SMF-28E

• True Wave Reach

• True Wave RS

• Free-Light

• Tera-Light

• ELEAF

——Displays the span
length of the fiber
connecting a source
and destination site. If
necessary, change the
span length manually.
• The Cisco ONP tool

automatically
updates the fiber
length to 1 km or 1
mile. If you change
the fiber length,
then the tool
updates the same
in the network tree
and the map
accordingly.

• In the network tree
pane, expand
Fiber and select
the fiber couple,
A-Z and Z-A. The
properties pane
displays the fiber
couple name,
source side,
destination side, its
span length, loss,
and, Polarization
Mode Dispersion
(PMD) value.

• You can enter the
different span
length and loss
values for the
individual fibers in
a fiber couple.

NCS 2000
NCS 1010
NCS 1001

Length
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the status of
the network, whether
the network is being
deployed or not. If the
network is not
deployed, it shows the
status as
UNDISCOVERED.

NCS 2000
NCS 1010
NCS 1001

Network
status

——Displays the status of
the fiber in a business
perspective view. If
fiber is not deployed,
it shows the status as
FUTURE. This field is
noneditable.

NCS 2000
NCS 1010
NCS 1001

Business
status

Km• Km

• Miles

Choose the
measurement unit .You
can set the
measurement unit only
for the duct, but not for
the fiber pair (couple)
or fiber.

NCS 2000
NCS 1010
NCS 1001

Measurement
Units

• 0—When Enable
Special Settings is
disabled.

• 3—When Enable
Special Settings is
enabled.

—Enter the aging loss
value for the fiber.

NCS 2000
NCS 1010
NCS 1001

Ageing Loss
[dB]

——Check this check box
to enable the default
use of data connection
network (DCN)
extension on each
span in the project.
This setting implies
that the optical service
channel (OSC) channel
is not used to connect
the two nodes.

NCS 2000
NCS 1010
NCS 1001

DCN
Extension

Auto• Auto

• OC3 Frame

• GE Frame

• FE Frame

Choose the OSC frame
type.
When set in Auto,
Cisco ONP uses FE
Frame as the preferred
frame type.

NCS 2000OSC
FrameType
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DefaultAvailable optionsDescriptionPlatformProperty

——Enter the number to
fiber aging factor.

NCS 2000
NCS 1010
NCS 1001

Ageing Factor

Factors properties of fiber
Provides guidelines for factors properties of fiber. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various factors properties of the optical fiber.
Table 84: Factors properties of fiber

DefaultAvailable optionsDescriptionPlatformProperty

——Loss is calculated based on
the loss coefficient.

NCS 2000
NCS 1010
NCS 1001

Loss
Coefficient
[dB/km]

——Displays the PMD coefficient.NCS 2000
NCS 1010
NCS 1001

PMD
Coefficient

——Displays the secondary order
dispersion for C-band.

NCS 2000
NCS 1010
NCS 1001

QD C-Band

——Displays the secondary order
dispersion for L-band.

NCS 2000
NCS 1010
NCS 1001

CD C-Band

——Displays the random
dispersion value.

NCS 2000
NCS 1010
NCS 1001

RD Factor

Extended and totals properties of a fiber
Provides guidelines for extended and totals properties of a fiber. This table describes various extended and totals properties
of the optical fiber.
This table describes various extended and totals properties of the optical fiber.
Table 85: Extended and totals properties

DefaultAvailable optionsDescriptionPlatformProperty

Extended
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the effective mode
area [Âµm^2]

NCS 2000
NCS 1010
NCS 1001

Effective
Mode Area

——Displays the Stimulated
Raman Scattering tilt
coefficient on the band.

NCS 2000
NCS 1010
NCS 1001

SRS tilt
coefficient

——Displays the Rayleigh
Scattering capture
coefficient.

NCS 2000
NCS 1010
NCS 1001

DRBS
coefficient

——Nonlinear index of refraction
[1e-16 cm^2/W]

NCS 2000
NCS 1010
NCS 1001

N2

——Length of individual fibers for
sigmaDSP [Km]

NCS 2000
NCS 1010
NCS 1001

LFBR

Totals
(The properties under Totals are noneditable)

——Displays the total loss EOL
calculation.

NCS 2000
NCS 1010
NCS 1001

Loss EOL

——Displays the total loss SOL
calculation.

NCS 2000
NCS 1010
NCS 1001

Loss SOL

——Displays the total chromatic
dispersion for the C-band.

NCS 2000
NCS 1010
NCS 1001

CD C-Band

——Displays the secondary order
dispersion for C-band.

NCS 2000
NCS 1010
NCS 1001

QD C-Band

——Displays the random
dispersion value.

NCS 2000
NCS 1010
NCS 1001

RD
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the Polarization
Mode Dispersion (PMD)
value.

NCS 2000
NCS 1010
NCS 1001

PMD

Physical and Raman amplification properties of fiber
Provides guidelines for physical and Raman amplification properties of fiber. This table describes various physical and
Raman amplification properties of the optical fiber.
This table describes various physical and Raman amplification properties of the optical fiber.
Table 86: Physical and Raman amplification properties of fiber

DefaultAvailable optionsDescriptionProperty

Physical

——The fiber loss value is
automatically calculated
based on length and loss
coefficient, when you check
this option.

Length-Based Loss

——Enter the start of life fiber
loss value for each span,
excluding the connector
concentrated loss.

Tot SOL Loss w/o
connectors

——Connector Loss at Source
Site [dB]

Connector Loss A

——Connector Loss at
Destination Site [dB]

Connector Loss B

Raman Amplification

——Enable Raman Amplification
on the ducts.

Note

When you enable Raman
amplification, the side
property Enable C+L Band
S/C is automatically
disabled.

Raman Amplified

DescriptionPlatformProperty

Physical
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DescriptionPlatformProperty

——The fiber loss value is
automatically calculated
based on length and loss
coefficient, when you check
this option.

NCS 2000
NCS 1010
NCS 1001

Length-Based
Loss

——Enter the start of life fiber
loss value for each span,
excluding the connector
concentrated loss.

NCS 2000
NCS 1010
NCS 1001

Tot SOL Loss
w/o
connectors

——Connector Loss at Source
Site [dB]

NCS 2000
NCS 1010
NCS 1001

Connector
Loss A

——Connector Loss at
Destination Site [dB]

NCS 2000
NCS 1010
NCS 1001

Connector
Loss B

Raman Amplification

——Enable Raman Amplification
on the ducts.

Note

When you enable Raman
amplification for NCS
2000 system release
12.2, the side property
Enable C+L Band S/C is
automatically disabled and
vice versa.

NCS 2000Raman
Amplified

Modify fiber couple properties
Teaches you how to modify fiber couple properties. Follow these detailed step-by-step instructions carefully to ensure
the specific configuration is applied correctly and securely within your network.
Use this procedure to modify the properties of a fiber couple.
Log in to the Cisco ONP web interface on page 17
1. Open the network where you want to modify the fiber couple properties.
2. Choose Network > Entity Editor.
3. Click the Fiber tab in the Entity Editor window.
4. Choose the fiber and drill down to the fiber couple, and modify the required properties. For the property descriptions,

refer to:
• General properties of a fiber couple on page 184
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• Physical and factors properties of a fiber couple on page 185

• Totals properties of a fiber couple on page 185

5. Click Update.

General properties of a fiber couple
Provides guidelines for general properties of a fiber couple. This table describes various general properties of an optical
fiber couple.
This table describes various general properties of an optical fiber couple.
Table 87: General fiber couple properties

DefaultAvailable optionsDescriptionPlatformProperty

——General

——By default, fiber couple is
named based on the fiber
name followed by
COUPLE-AZ or COUPLE-ZA.
The sides that are connected
by the fiber couple are
indicated inside brackets.
The name is noneditable.

• NCS
2000

• NCS
1010

• NCS
1001

Name

——Displays the source side
name. This field is
noneditable.

• NCS
2000

• NCS
1010

• NCS
1001

Source Side

——Displays the destination side
name. This field is
noneditable.

• NCS
2000

• NCS
1010

• NCS
1001

Destination
Side

——Automatically displays the
span length of the fiber
connecting a source and
destination side. Change the
span length manually, if
necessary.
You can enter the different
span length and loss values
for the individual fibers in a
fiber couple.

• NCS
2000

• NCS
1010

• NCS
1001

Length
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Physical and factors properties of a fiber couple
Provides guidelines for physical and factors properties of a fiber couple. This table describes various physical and factors
properties of an optical fiber couple.
This table describes various physical and factors properties of an optical fiber couple.

DescriptionPlatformProperty

Physical

Enter the start of life fiber loss value for each span,
excluding the connector concentrated loss.

• NCS 2000

• NCS 1010

• NCS 1001

Tot SOL Lossw/o connectors

Connector Loss at Source Site [dB]• NCS 2000

• NCS 1010

Connector Loss A

Connector Loss at Destination Site [dB]• NCS 2000

• NCS 1010

Connector Loss B

Factors

Displays the PMD coefficient.• NCS 2000

• NCS 1010

• NCS 1001

PMD coefficient

Enter the value of the SOL fiber loss per kilometer used to
calculate the loss of each span in the network.

• NCS 2000

• NCS 1010

• NCS 1001

Loss coefficient [dB]

Totals properties of a fiber couple
Provides guidelines for totals properties of a fiber couple. This table describes various Totals properties of an optical fiber
couple.
This table describes various Totals properties of an optical fiber couple. The properties under Totals are noneditable
Table 88: Totals properties

DefaultAvailable optionsDescriptionPlatformProperty

——Displays the total loss EOL
calculation.

NCS 2000
NCS 1010
NCS 1001

Loss EOL

——Displays the total loss SOL
calculation.

NCS 2000
NCS 1010
NCS 1001

Loss SOL
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the total chromatic
dispersion for the C-band.

NCS 2000
NCS 1010
NCS 1001

CD C-Band

——Displays the secondary order
dispersion for C-band.

NCS 2000
NCS 1010
NCS 1001

QD C-Band

——Displays the random
dispersion value.

NCS 2000
NCS 1010
NCS 1001

RD

——Displays the Polarization
Mode Dispersion (PMD)
value.

NCS 2000
NCS 1010
NCS 1001

PMD

Modify service properties
Teaches you how to modify service properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Table 89: Feature History

DescriptionRelease InformationFeature Name

Cisco ONP enables the 2x100GE
muxponder mode on the
NCS1K14-2.4T-X-K9 transponder
card when designing networks for the
NCS 1010, NCS 1014, NCS 1001,
and NCS 2000 (1k-2K traffic site)
platforms. This mode supports trunk
rates ranging from 400G to 1.2T
(excluding 700G) for both slice-0 and
slice-1, and is compatible with client
pluggables QDD-2X100-CWDM4-S
andQDD-2X100-LR4-S. The 2x100G
mode provides flexible and efficient
aggregation of 100GE traffic,
optimizing resource utilization and
simplifying service provisioning within
each platform's design.

Cisco ONP Release 26.1.12x100G muxponder mode support on
NCS1K14-2.4T-X-K9 transponder
card
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Table 90: Feature History

DescriptionRelease InformationFeature Name

In addition to the previously supported
C-band, the NCS1K14-2.4T-X-K9
transponder card now also supports
the L-band under the Service and
Trail properties for the NCS 1010
network.
The 2.4TX card's support for the
L-band increases capacity and spectral
efficiency by utilizing both the L-band
and C-band. C-band and L-band
circuits can now use the same cards
with different trunks for propagation.

Cisco ONP Release 25.1.1L-Band support for 2.4TX transponder
card in NCS 1010 network

Table 91: Feature History

Feature DescriptionRelease
Information

Feature Name

You can now create optical services for the NCS 1010 network. You
can include cards such as NCS1K14-2.4T-K9, NCS1K14-2.4T-X-K9,
and NCS1K4-QXP-K9 as native transponder instead of optical sources
and check the feasibility of the network. You can generate the traffic
report and BoM with the exact count of cards and pluggables based on
the requirements, along with licensing details for the OLT card and the
transponders.

Cisco ONP Release
24.3.1

Transponder Support
on NCS1010Network

Use this procedure to modify the properties of the service.
1. Open the network where you want to modify the service properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Service tab.
4. Choose the service under theServices tab, andmodify the properties in the right pane. For the property descriptions,

refer to:
• General service properties on page 188

• Primary and secondary paths forcing properties on page 191

• NCS1K domain properties on page 200

• Primary path service properties on page 193

• Primary channel service properties on page 195
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Note

• Force both primary and secondary path fiber or channel to enable protected service. Ensure the wave type
matches for both paths.

• Apply path forcing end-to-end, from the source to the destination. If you force only a partial path, the analysis
fails.

• Force the wave path tagged to the service.

• For protection types 1+1+R+R, 1+1+R, and 1+R, you can force a path in restoration path1 or restoration path2.
Fiber can also be forced in the primary or secondary path.

5. Click Update.

General service properties
Provides guidelines for general service properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
Table 92: General service properties

DefaultAvailable optionsDescriptionPlatformProperty

——The service name is based
on the source and
destination sites and the
number of services between
them. You can edit the name.
For example, if there are two
services between site 1 and
site 2, the names of the
services are Site-1-Site-2-1
and Site-1-Site-2-2,
respectively.

NCS 1010
NCS 2000
NCS 1001
NCS 1014

Name

100GEFor NCS 2000 (1K-2K-4K):
• 10GE

• 100GE

• STM-64

For other platforms:
• OTU4

• 100GE

• 400GE

Choose the types of service.NCS 1010
NCS 2000
NCS 1001
NCS 1014

Type

400GE• 100GE

• 400GE

• OTU4

Client traffic typeNCS 1010
NCS 1001
NCS 1014

Client type
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DefaultAvailable optionsDescriptionPlatformProperty

1+1• Unprotected

• 1+1

• Disjoint

• S+NS

• 1+R

• 1+1+R

• 1+1+R+R

Note

For platforms other than
NCS 2000 (4K-1K-2K)
sites, the only available
option is Unprotected.

Choose the protection type
from the drop-down list.

NCS 1010
NCS 2000
NCS 1001
NCS 1014

Protection

1+11+1Displays the source site
name.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Source

——Displays the destination site
name.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Destination

—Lists the available sitesFrom the drop-down list,
select the possible site as a
tertiary source.

NCS 2000Tertiary
Source
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DefaultAvailable optionsDescriptionPlatformProperty

—Lists the available sitesFrom the drop-down list,
select the possible site as a
tertiary destination.
Tertiary source and tertiary
destination are enabled only
when you select the
protection scheme as
Unprotected Disjoint.
You can select either tertiary
destination or both tertiary
source and tertiary
destination.
• If you select only the

tertiary destination, the
demand is created
between the source and
destination and between
the source and tertiary
destination. These do not
have common fibers in
the path, which are
disjoint.

• If you select both tertiary
source and tertiary
destination, two
unprotected demands are
created between the
source to destination,
and tertiary source to
tertiary destination. The
demands are disjoint to
each other.

NCS 2000Tertiary
Destination

NCS 1KNCS 1KChoose the service type.NCS 2000
(1K-2K)

Service Type
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DefaultAvailable optionsDescriptionPlatformProperty

——Check this check box to
enable encryption on the
service.
Encrypted and
non-encrypted services will
not be aggregated. They use
separate trunks.

Note

Encryption is supported
only for
NCS1K14-2.4T-X-K9and
NCS1K4-QXP-K9

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Encryption

Primary and secondary paths forcing properties
Provides guidelines for primary and secondary paths forcing properties. Lists the essential reference information, key
parameters, and specific guidelines needed to support your daily network configuration tasks.
These tables describe the primary and secondary paths forcing properties for services. Secondary path is available only
for (1+1) .
Table 93: Primary path forcing properties

DescriptionPlatformProperty

——Cisco ONP automatically
selects the shortest path as
working path and also allows
you to force the path
manually.

NCS 2000Path

——Primary path fiber is forcing
path for working trail.

NCS 2000Fiber

——Displays the platform of the
regeneration site

NCS 2000Regeneration
Platform

—Lists the available sites.Choose the regeneration site.NCS 2000Regen Sites

—Lists various wavelengthsClick Edit to choose the
wavelength. The default
option is Auto.

NCS 2000Wavelength

——Enter the ODU timeslot value.NCS 2000ODU Timeslot

——Displays the selected
Wavelength.

NCS 2000Section
Wavelength(s)
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DescriptionPlatformProperty

Auto• Auto: Auto option is the
contentionless demand.

• Contentionless

• Colorless

• Colored

Choose the type of source
channel.

NCS 2000Src Channel
Type

Same as the Src channel
type.

• Auto: Auto option is the
contentionless demand.

• Contentionless

• Colorless

• Colored

Auto-populated based on the
Src channel type. You can
still change the type. When
you change the Dst channel
type, Src channel type also
changes to the same.

NCS 2000Dst Channel
Type

DefaultAvailable optionsDescriptionPlatformProperty

——Secondary path is the
protected path when the
primary path fails. This path
is the second best path after
the primary path.

NCS 2000Path

——Secondary path fiber is for
protected service, forcing
path for the protected trail.

NCS 2000Fiber

——Displays the platform of the
regeneration site

NCS 2000Regeneration
Platform

—Lists the available sites.Choose the regeneration site.NCS 2000Regen Sites

—Lists various wavelengthsClick Edit to choose the
wavelength. The default
option is Auto.

NCS 2000Wavelength

——Enter the ODU timeslot value.NCS 2000ODU Timeslot

——Displays the selected
Wavelength.

NCS 2000Section
Wavelength(s)

Auto• Auto: Auto option is the
contentionless demand.

• Contentionless

• Colorless

• Colored

Choose the type of source
channel.

NCS 2000Src Channel
Type
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DefaultAvailable optionsDescriptionPlatformProperty

Same as the Src channel
type.

• Auto: Auto option is the
contentionless demand.

• Contentionless

• Colorless

• Colored

Choose the type of
destination channel.

NCS 2000Dst Channel
Type

Primary path service properties
Provides guidelines for primary path service properties. Lists the essential reference information, key parameters, and
specific guidelines needed to support your daily network configuration tasks.
This table lists the primary path service properties.
Table 94: Service properties for primary path

DefaultAvailable optionsDescriptionPlatformProperty

——Displays the path of the
service.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Path

—Displays the available fibers.Select the fiber.NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Fiber

—Displays the possible
regeneration site.

Select the regeneration site.NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Regen Sites
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DefaultAvailable optionsDescriptionPlatformProperty

Auto• Auto:The system
automatically chooses
whether to create a new
circuit or use an existing
one.

• Create New: A new
circuit is created, and no
existing circuits are used.

• Existing circuits (shows
the names of the circuits
that are already created):
Select an existing circuit
to use. To specify a
particular circuit, choose
one from the drop-down
list.

Choose whether to create a
new circuit or use an existing
circuit.

Note

When you select an
existing circuit with the
following conditions:
• Traffic Type is set

to Transponder
Card under the circuit
properties.

• Trunk Mode and
Baud Rate are
already defined under
the Trail properties

You will not be able to
select Trunk Mode and
Baud Rate under the
Service properties. To edit
these properties change
the traffic type and change
the Channel property to
Auto or Create New.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Channel

——Displays whether it is a
C-band type or L-band type.
If you choose
NCS1K14-2.4T-X-K9 as the
Card Type, you can select
the band as C-band or
L-band.

NCS 1010
NCS 1001
NCS 1014

Band Type

AutoDisplays multiple fixed grid
wavelengths

Choose the wavelength for
the regen site that is
selected.

NCS 1010
NCS 2000
(1K-2K)
NCS 1014

Section
Wavelengths

AutoFor NCS1K14-2.4T-K9 and
NCS1K14-2.4T-X-K9, the
trunk rate ranges from 400G
to 1200G.
For NCS1K4-QXP-K9, the
trunk rate ranges from 100G
to 400G.

Choose the trunkmode of the
line card.

NCS 1010
NCS 1014

Trunk mode
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DefaultAvailable optionsDescriptionPlatformProperty

AutoThe baud rates that are
suitable for the trunk rate
chosen are displayed.

Select the baud rate.NCS 1010
NCS 2000
(1K-2K)
NCS 1014

Baud Rate

Auto• Auto

• Fixed Grid(64 Chs)

Click Edit to choose the
wavelength.

NCS 1010Wavelength

Primary channel service properties
Provides guidelines for primary channel service properties. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table lists the primary channel service properties.
Table 95: Service properties for primary channel

DefaultAvailable optionsDescriptionPlatformProperty

Primary Channel Source

Auto• Auto

• NCS1K14-2.4T-K9

• NCS1K14-2.4T-X-K9

• NCS1K4-QXP-K9

• NCS1K4-OTN-XP

• NCS1K14-1.2T-K9

• NCS1K14-2.4T-A-K9

• NCS1K4-2-QDD-C-K9

Select the card for the
service.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Card Type

Slice• Bundle

• Slice

• 2x100G

• Muxponder

Select the configuration
mode
The list of options displayed
depends on the traffic type,
platform, and the card
selected.
.

NCS 1010
NCS 2000
(1K-2K)
NCS 1014

Config mode
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DefaultAvailable optionsDescriptionPlatformProperty

Displays option based on
Trunk Mode selction.

Choose a client port from the
list.

Select the port to share the
client data between trunks.

Note

This property appears only
when Config Mode is
Bundle.

NCS 1010Split Port

Auto• Auto

• NCS1014: Supports only
NCS1K14-2.4T-A-K9,
NCS1K14-2.4T-K9,
NCS1K14-2.4T-X-K9,
NCS1K4-1.2T-K9,
NCS1K4-QXP-K9,
NCS1K4-2-QDD-C-K9

• NCS1004: Supports only
NCS1K4-1.2T-K9,
NCS1K4-QXP-K9,
NCS1K4-2-QDD-C-K9,
NCS1K4-OTN-XP-K9

Choose the transponder
chassis for the service.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

TXP Chassis

——Displays the type of
modulation.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Modulation

AutoThe options for trunk mode
changes based on the
selected card type.

Select a trunk mode from the
drop-down list.
The list of options displayed
depends on the traffic type,
config mode, and card
selected.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Trunk Mode

1_E
—

• 1_E

• 0_S

This field is applicable only
for the NCS1K4-QXP-K9
card. Choose the required
sub mode.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Sub Mode
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DefaultAvailable optionsDescriptionPlatformProperty

——Displays the type of FEC
supported on the chosen
card.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

FEC

Auto• Auto

• Colored

• Colorless

• Contentionless (only for
NCS 2000)

• Omni-colored

• Omni-colorless

Select the Add/drop type.NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Src Add/Drop
Type

Auto• Auto

• QDD-400G-FR4-S

• QDD-400G-AOC1M

• QDD-400G-DR4-S

• QDD-400G-LR4-S

• QDD-4X100G-LR-S

• QDD-4X100G-FR-S

• QDD-2X100-CWDM4-S

• QDD-2X100-LR4-S

Choose the client pluggable
for the selected card. The list
of pluggable displayed
depends on the traffic type,
config mode, and card
selected.
For more client pluggable
options, see Supported
transponder cards and
pluggables on page 358.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Client
Interface

Auto• Auto

• 1

• 2

• 3

• 4

• 5

• 6

• 7 till 12

This property is enabled only
when a trunk mode is
selected. Choose the client
port.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Client Port

AutoSee Supported Cards and
Pluggables on page 357

The trunk pluggables that are
applicable for the selected
card are displayed. Choose
the required trunk pluggable.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Trunk Type
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DefaultAvailable optionsDescriptionPlatformProperty

Primary Channel Destination

Auto• Auto

• NCS1K14-2.4T-K9

• NCS1K14-2.4T-X-K9

• NCS1K4-QXP-K9

• NCS1K14-2.4T-A-K9

• NCS1K4-2-QDD-C-K9

Select the card for the
service.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Card Type

Slice• Bundle

• Slice

• 2x100G

• Muxponder

Select the configuration
mode
The list of options displayed
depends on the traffic type,
platform, and the card
selected.
.

NCS 1010
NCS 2000
(1K-2K)
NCS 1014

Config mode

Displays option based on
Trunk Mode selction.

Choose a client port from the
list.

Select the port to share the
client data between trunks.

NCS 1010
NCS 1014

Split Port

Auto• Auto

• NCS1014: Supports only
NCS1K14-2.4T-A-K9,
NCS1K14-2.4T-K9,
NCS1K14-2.4T-X-K9,
NCS1K4-1.2T-K9,
NCS1K4-QXP-K9,
NCS1K4-2-QDD-C-K9

• NCS1004: Supports only
NCS1K4-1.2T-K9,
NCS1K4-QXP-K9,
NCS1K4-2-QDD-C-K9,
NCS1K4-OTN-XP-K9

Select the transponder
chassis for the service.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

TXP Chassis

——Displays the type of
modulation.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Modulation
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DefaultAvailable optionsDescriptionPlatformProperty

AutoThe options for trunk mode
change based on the
selected card type.

Select a trunk mode from the
drop-down list.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Trunk Mode

1_E• 1_E

• 0_S

This field is applicable only
for the NCS1K4-QXP-K9
card. Choose the required
sub mode.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Sub Mode

——Displays the type of FEC
supported on the chosen
card.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

FEC

Auto• Auto

• Colored

• Colorless

• Contentionless (only for
NCS 2000)

• Omni-colored

• Omni-colorless

Select the Add/drop type.NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Dst Add/Drop
Type

Auto• Auto

• QDD-400G-FR4-S

• QDD-400G-AOC1M

• QDD-400G-DR4-S

• QDD-400G-LR4-S

• QDD-2X100-CWDM4-S

• QDD-2X100-LR4-S

Choose the client pluggable
for the selected card. The list
of pluggable displayed
depends on the traffic type,
config mode, and card
selected.
For more client pluggable
options, see Supported
transponder cards and
pluggables on page 358.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Client
Interface

——This property is enabled only
when a trunk mode is
selected. Choose the client
port.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Client Port
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DefaultAvailable optionsDescriptionPlatformProperty

AutoSee Supported Cards and
Pluggables on page 357

The trunk options that are
applicable for the selected
card are displayed. Choose
the required trunk pluggable.

NCS 1010
NCS 2000
(1K-2K)
NCS 1001
NCS 1014

Trunk Type

NCS1K domain properties
Provides guidelines for nCS1K domain properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the various NCS1K domain properties for services.
Table 96: NCS1K domain properties

DefaultAvailable optionsDescriptionPlatformProperty

——Displays the client
type. By default, client
type is OTU4.

NCS 2000Client Type

——Displays the interface
type. By default,
interface type is BH.

NCS 2000Interface Type

200G• 200G

• 300G

Choose the trunk
mode.

Note

Based on the
selected trunk
mode, Baud rates
are filtered.

NCS 2000Trunk Mode

60GBd• 60GBd

• 69GBd

Choose whether the
Baud rates mode as
60 or 69GBd.

NCS 2000Baud Rate

Service aggregations
Describes the functionality of service aggregations. Explains the specific benefits and underlying principles of this essential
feature for improving overall system efficiency and operational management.
A service aggregation is a network feature that
• enables two or more services to share the same trunk port or channel,
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• automatically groups services into a DefaultGroup within the network tree for efficient management, and

• provides the ability to export aggregation reports for monitoring and analysis.

Table 97: Feature History

Feature DescriptionRelease InformationFeature Name

The services aggregation feature allows
two or more services to share the same
trunk port or channel. By default, the
services are added to the
DefaultGroup. You can export
aggregation reports.

Cisco ONP Release 4.1Services Aggregation

You can use services aggregation to allow multiple services to share the same connection point, such as a trunk port or
channel. This ability to share is determined by the characteristics defined in their Service Group.
Specifically, when you add services to a 1K-2K-4K Traffic site within an SSON network, the system automatically
creates aDefaultGroup underServices in the network tree. All the services you add are then automatically associated
with DefaultGroup.

Create a new service group
Teaches you how to create a new service group. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17
Follow these steps to create a new service group.
1. Open the network where you want to create a new service group.
2. Click the Ellipsis icon on the right side of Services under the network tree and chooseCreate Service Group.

A new service group appears under Services.

Modify service group properties
Teaches you how to modify service group properties. Follow these detailed step-by-step instructions carefully to ensure
the specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to modify the properties of a service group.
1. Open the network where you want to modify the service group properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab, and click a service group.
4. Modify the service group properties as required.

See Service group properties on page 201.

5. Click Update.

Service group properties
Provides guidelines for service group properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various service group properties.
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Table 98: Service group properties

Default optionAvailable
options

DescriptionPlatformProperty

General

By default, the service
name is based on the
source and
destination sites and
the number of
services between
them.
For example, if there
are two services
between site 1 and
site 2, the name of the
services are
Site-1-Site-2-1 and
Site-1-Site-2-2,
respectively.

—Displays the group name. Edit the
name if needed.

NCS 2000Name

——Select the demand type. For default
group all demand types are available,
and you cannot edit them.

NCS 2000Demand Types

——Indicates whether the service group
is a default group or a user created
group.

NCS 2000Default Group

NCS 4 K

——Indicates whether the services
belonging to this group must have an
exclusive Line Card (LC).
For example, when you check this
check box, neither the Client LC nor
the Trunk LC of the services belonging
to this group can be shared by
services belonging to any other
groups.

NCS 4000Exclusive LC
Usage
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Default optionAvailable
options

DescriptionPlatformProperty

——Indicates whether this group allows
aggregation of only symmetric
services. Services are symmetric if
they have same protection scheme.
Following are the various protection
schemes:
For Example, all "1+1" services are
symmetrical.
If you check this check box, this
service group allows aggregation of
only symmetrical services.
For example, "Unprotected" can be
aggregated only with "Unprotected",
"1+R" only with "1+R", "1+1" only
with "1+1", and so on.
If this check box is unchecked, this
service group allows aggregation of
symmetrical and unsymmetrical
services together.
For example, "Unprotected" can be
aggregatedwith either "Unprotected",
"1+R", "1+1" "1+1+R" or
"1+1+R+R".
See Rules for aggregating services on
page 203.

NCS 4000Symmetric
Aggregation

NCS 1 K

——Same as NCS 4 K.NCS 1004Exclusive LC
Usage

——Same as NCS 4 K.NCS 1004Symmetric
Aggregation

Rules for aggregating services
Describes the functionality of rules for aggregating services. These rules must be satisfied for any two services, whether
symmetrical or non-symmetrical, to be aggregated:.
These rules must be satisfied for any two services, whether symmetrical or non-symmetrical, to be aggregated:
1. Both services must have identical source and destination points.

2. The paths of the two services must align for the same path types.
• Example for symmetric aggregation:

When aggregating two "1+1" services, the working path of the first service must match the working path of the
second service, and similarly, the protection paths of both services must also match.

• Example for non-symmetric aggregation:
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When aggregating a "1+1" service with a "1+1+R" service, the working path and protection path of the first
service must match the corresponding paths of the second service. However, the restoration path of the second
service can differ.

3. Both services must use the same wavelength for the same path types.
• If the wavelength is set to "auto," it can be aggregated with either another "auto" wavelength or a fixed wavelength.

4. Both services must have the same trunk mode configuration for the same path types.

5. The regeneration sites for both services must align for the same path types.

6. The demand type is not a constraint for aggregation, except when considering trunk capacity availability.

Associate a service with the newly created group
Teaches you how to associate a service with the newly created group. By default, the services are associated with the
DefaultGroup.
Log in to the Cisco ONP web interface on page 17.
By default, the services are associated with the DefaultGroup. However, you can change the group.
Follow these steps to associate a service to the newly created group.
1. In the network tree, click the service that you want to associate to a group.

You can view the properties of the network at the bottom of the network tree.

2. Selct the group from the Service Group drop-down list.
3. Click Update.

Note

For an LNI-imported network, all services are in the Default group by default. When you upgrade the LNI-imported
network for the first time, you canmove the services to other newly created Service Groups without unlocking them.
For later upgrades, unlock the services before moving them between Service Groups. The Service Groups stay
locked during upgrade mode unless you perform a complete network-level unlock.

Export aggregation reports
Teaches you how to export aggregation reports. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to export the service aggregation reports.
1. Open an analyzed network to export the aggregation reports.
2. Choose Export > Service Aggregation.
3. Save the aggregation report as an Excel file to your local system.
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Modify wave properties
Teaches you how to modify wave properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Table 99: Feature History

Feature DescriptionRelease InformationFeature Name

The PSM-channel option is now
available as a Protection Type
under the Wave properties for NCS
2000 non-SSON networks. This option
allows you to use PSM channel trunk
protection with the PSM card during
network design, in addition to existing
client protection. You can verify the
optical feasibility for both working and
protection paths, providing all
necessary parameters and connections
for deployment.

Cisco ONP Release 24.3.1PSM Support on Non-SSON Network

Follow these steps to modify the properties of the wave.
1. Open the network where you want to modify the wave properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab, and click a wave.
4. Modify the wave properties as required.

See Wave properties on page 205.

5. Click Update.

Wave properties
Provides guidelines for wave properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes various wave properties.
Table 100: Wave properties

Default optionAvailable optionsDescriptionPlatformProperty

General
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Default optionAvailable optionsDescriptionPlatformProperty

By default, the wave is
named based on the source
and destination sites and the
number of waves between
them.
For example, if there are two
waves defined between site
1 and site 2, the waves are
named as Site-1-Site-2-1
and Site-1-Site-2-2,
respectively.
Edit the name if needed.

—Displays the name of the
wave.

NCS 2000Label

——Displays the source site
name.

NCS 2000Source Site

——Displays the destination site
name.

NCS 2000Destination
Site

Optical Source• Optical Source

• 100GE

• 10GE LAN PHY

• 40GE LAN PHY

• Fiber Channel 10G

• Fiber Channel 16G

• Fiber Channel 8G

• OC-192/STM-64

• OTU2

• OTU2e

• OTU4

• Pluggable Card

Select the traffic type.NCS 2000Traffic Type
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Default optionAvailable optionsDescriptionPlatformProperty

Unprotected• Unprotected

• Client 1+1

• PSM-Channel

The PSM-channel option is
available only for non-SSON
networks. PSM-channel is
not supported with the
colorless Add/Drop
MF-6AD-COFS.
When you select the
PSM-Channel option, the
Protection Switch Module
(PSM) for the Cisco
ONS15454 Multiservice
Transport Platform (MSTP)
(15454-PSM card) is placed
in the network to provide
protection at the trunk level.
The PSM card splits the
traffic originated by
transponder trunk across the
working and protected TX
ports.

Select the protection type.NCS 2000Protection
Type

——Check this check box to
change a present wave to a
forecast wave.

NCS 2000Forecast

——Check this check box to
enable encryption.

NCS 2000Encryption

Modify media channel properties
Teaches you how to modify media channel properties. Follow these detailed step-by-step instructions carefully to ensure
the specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to modify properties of the media channel.
1. Open the network where you want to modify the media channel properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab, and click a media channel.
4. Modify the media channel properties as required.

See Media channel properties on page 208.

5. Click Update.
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Media channel properties
Provides guidelines for media channel properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various media channel properties.
Table 101: Media channel properties

Default optionAvailable optionsDescriptionPlatformProperty

General

By default, themedia channel
is named based on the
source and destination sites
and the number of media
channels between them.
For example, if there are two
media channels between site
1 and site 2, they are named
as Site-1-Site-2-1 and
Site-1-Site-2-2,
respectively.
Edit the name if required.

—Displays the media channel
name.

NCS 2000Label

——Displays the source site
name.

NCS 2000Source Site

——Displays the destination site
name.

NCS 2000Destination
Site

Optical Source• Optical Source

• 100GE

• 10GE LAN PHY

• 40GE LAN PHY

• Fiber Channel 10G

• Fiber Channel 16G

• Fiber Channel 8G

• OC-192/STM-64

• OTU2

• OTU2e

• OTU4

• Pluggable Card

Select the traffic type.NCS 2000Traffic Type
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Default optionAvailable optionsDescriptionPlatformProperty

Unprotected• Unprotected

• Client 1+1

Select the protection type.
For Client 1+1, ensure that
the sites have contentionless
sides for the analysis to be
successful. By default, Cisco
ONP finds both span and
node disjoint path for
Client1+1 protected waves,
but allows you to force span
and node disjoint path.

NCS 2000Protection
Type

——Check this check box to
change a present wave to a
forecast wave.

NCS 2000Forecast

——Check this check box to
enable encryption.

NCS 2000Encryption

Modify circuit properties
Teaches you how to modify circuit properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to modify the properties of the circuit in an NCS 1010 network.
1. Open the network where you want to modify the circuit properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab, and click a circuit.
4. Modify the circuit properties as required.

See Circuit properties on page 209.

5. Click Update.

Circuit properties
Provides guidelines for circuit properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes various circuit properties.
Table 102: Circuit properties

Default optionAvailable optionsDescriptionPlatformProperty

General
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Default optionAvailable optionsDescriptionPlatformProperty

By default, the circuit is
named based on the source
and destination sites and the
number of circuits between
them. \
For example, if there are two
circuits defined between site
1 and site 2, the circuits are
named as Site-1-Site-2-1
and Site-1-Site-2-2
respectively.
Edit the name if required.

—Displays the name of the
circuit.

NCS 1010
NCS 1001

Label

——Displays the name of the
source site.

NCS 1010
NCS 1001

Source Site

——Displays the name of the
destination site.

NCS 1010
NCS 1001

Destination
Site

Optical Source• Optical Source

• Pluggable Card

• Transponder Card

Select the traffic type.NCS 1010
NCS 1001

Traffic Type

UnprotectedCurrently, we support only
Unprotected.

Select the protection type.NCS 1010
NCS 1001

Protection
Type

——Check this check box to
change a present circuit to a
forecast wave.

NCS 1010
NCS 1001

Forecast

——The Encryption property is
enabledwhen you select Line
card as the Traffic Type.

NCS 1010Encryption

Modify trail properties
Teaches you how to modify trail properties. Follow these detailed step-by-step instructions carefully to ensure the specific
configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Table 103: Feature History

Feature DescriptionRelease InformationFeature Name

Added support for the
NCS1K14-2.4TA-K9 transponder card
that operates in Bundle and Slice
modes.

Cisco ONP Release 26.1.1Support for NCS1K14-2.4TA-K9
transponder card
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Table 104: Feature History

DescriptionRelease InformationFeature Name

The Bright ZR+ pluggable can now be
included in the network design by
choosing them as Card Type or
Client Interface under the Trail
properties. This selection is available
for all types of sites. The Bright ZR+
pluggable has high transmit optical
power up to 0dBm, high transmit
OSNR, and high-densityQSFP-DD form
factor.

Cisco ONP Release 5.1Bright ZR+ Pluggable Support

Table 105: Feature History

DescriptionRelease InformationFeature Name

You can now choose from the full array
of supportedCard Types andClient
Interfaces under the Trail
properties option for the multilayer
nodes. Previously, only a limited set of
cards were available for selection.With
this enhancement, you can design
diverse networks leveraging the unique
functionalities of all types of cards.

Cisco ONP Release 5.1Multilayer Nodes Enhancements

Follow these steps to modify the properties of the trail.
1. Open the network where you want to modify the trail properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab.
4. ExpandWaves,Media Channels or Circuits.
5. Navigate to the required trail and click it.
6. Modify the trail properties as required. See

• General trail properties on page 211

• OTN trail properties on page 214

• Source and destination trail properties on page 214

7. Click Update.

General trail properties
Provides guidelines for general trail properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various general trail properties.

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 211



Table 106: General trail properties

Default optionAvailable optionsDescriptionPlatformProperty

——Displays the name of the
trail.

NCS 2000
NCS 1010
NCS 1001

Label

——Select a fiber.NCS 2000
NCS 1010
NCS 1001

Path of Wave

——Select the regeneration site.NCS 2000
NCS 1010

Regen Sites

——Displays the source site
name.

NCS 2000
NCS 1010
NCS 1001

Source Site

——Displays the destination site
name.

NCS 2000
NCS 1010
NCS 1001

Destination
Site

Auto—Click Edit to choose the
wavelength.

NCS 2000
(Non-SSON)

Wavelength

AutoMultiple C-band and L-band
wavelengths are listed.

Note

If you select L-Band as
Band Type, the L-band
wavelength options appear
along with C-band
wavelengths for NCS
1010 R7.9.1.

Click Edit to select the
central wavelength.

NCS 2000
NCS 1010
NCS 1001

Central
Wavelength
[nm]

——Indicates whether the
transmission is a multicarrier
transmission.

NCS 2000
NCS 1010

Multicarrier
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Default optionAvailable optionsDescriptionPlatformProperty

AutoSee Supported Cards and
Pluggables on page 357

The trunk mode can be
edited only when you choose
400G-XP-LC as Card
Type.

NCS 2000Trunk Mode

AutoSee Supported Cards and
Pluggables on page 357

The trunk mode can be
edited only when theTraffic
Type is set to Line card
under the circuit properties.

NCS 1010

——Trunk mode is noneditable.NCS 1001

12-16

Note

If you select Colorless or
Omni-Colorless as
Add/Drop Type and
Auto or OLT/LC/AddDrop
as Add/Drop
Connector, this property
becomes editable.

Note

When you enable bundle
mode in line circuit, this
value is 2 and
non-editable.

Enter the to add the required
number of carriers to the
channel.

NCS 1010Number Of
Carrier(s)

——Select the baud rate that is
suitable for the selected trunk
rate.

NCS 1010Baud Rate

——Displays the value of the
penalties that are caused by
the different filter types
(OADM, and ROADM).

NCS 2000
NCS 1010

Filtering
Penality

——Displays the forward optical
signal to noise ratio.

NCS 2000
(non-SSON)

OSNR
Forward [dB]

——Displays the reverse optical
signal to noise ratio.

NCS 2000
(non-SSON)

OSNR
Reverse [dB]

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 213



Default optionAvailable optionsDescriptionPlatformProperty

Auto• Auto

• L-band

• C-band

Select the required band type
for the circuit.

Note

When you select L-Band
as Band Type, then the
Add/Drop Type field
automatically selects
Colorless and becomes
disabled.

NCS 1010Band Type

C-bandThis property is noneditable.
C-Band is the default option.

NCS 1001

OTN trail properties
Provides guidelines for oTN trail properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table lists and defines OTN trail properties.

Default optionAvailable optionsDescriptionPlatformProperty

——OTN (non-SSON)

——Displays the Optical Data Unit
timeslot.

NCS 2000
(non-SSON)

ODUTimeslot

——Displays the SRLGs
associated with the trail.

NCS 2000
(non-SSON)

SRLGs

——Displays the number of OTN
hops.

NCS 2000
(non-SSON)

OTN Hops

——Displays the number of OTN
services on the trail.

NCS 2000
(non-SSON)

Quantity

Source and destination trail properties
Provides guidelines for source and destination trail properties. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table lists and defines various source and destination trail properties.

Default optionAvailable optionsDescriptionPlatformProperty

Source
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Default optionAvailable optionsDescriptionPlatformProperty

200G-SD-FECSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.
From Release 5.1, Bright ZR+
pluggables are supported for
all the types of sites. Also,
there are no limitations on the
type of cards that can be
chosen for the multilayer
nodes.

Note

• Non-SSON
• Colored and

colorless—Baud rates
less than 42 are
supported and
listed.

• Contentionless—Mean
power less than 4.4
is supported and
listed.

• SSON
• Colored—Baud rates

less than 65 are
supported and
listed.

• Colorless—All
interfaces supported
and listed.

• Contentionless—Mean
power less than -4.4
are supported and
listed.

Mean power =
(ochData.txRange.max +
ochData.txRange.min)/2
If contentionless is selected
for the source channel type,
the QDD interfaces are not
supported.

Select the card used in the
source site.

NCS 2000
NCS 1010

Card Type
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Default optionAvailable optionsDescriptionPlatformProperty

NCS1004_QPSK_SP_16QAM_
200G_27%SDFEC_60GBd

See Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Select a card type from the
drop-down list.

NCS 1001

AutoSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Note

Available trunk mode
options are based on the
selected card type.

Select a trunk mode from the
drop-down list.

NCS 1010
NCS 1014
NCS 1001
NCS 1014
NCS 2000

Trunk
Mode

Slice• Slice

• Bundle

Note

Bundle mode is referred
as MXP mode in COSM
XML.

• 2x100GE

• Muxponder

Select a configuration mode
from the drop-down list.

NCS 1010
NCS 1014

Config
Mode
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Default optionAvailable optionsDescriptionPlatformProperty

AutoThe pluggables suitable for the
chosen card type are
displayed.
See Supported Cards and
Pluggables on page 357 for
more information on the list of
supported pluggables.
From Release 5.1, Bright ZR+
pluggables are supported for
all the types of sites. Also,
there are no limitations on the
type of cards that can be
chosen for the multilayer
nodes.
The pluggable
FR-1(QSFP-100G-FR-S) is
supported on the client ports
of the 400G-XP LC starting
from NCS 2000 Release
11.1.0.
The pluggable ERL
(QSFP-100G-ERL-S) is
supported on the client ports
of the 400G-XP LCwith 100G
traffic type starting from NCS
2000 Release 11.1.3.

Note

When you export the NCS
2000 R11.1.3 network, the
Cisco ONP exports the NCS
2000 R11.1.0 report. You
must edit the exported
report for R11.1.3.

Select a pluggable from the
drop-down list.

NCS 2000
NCS 1010

Client
Interface

Auto—This property is noneditable.NCS 1001
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Default optionAvailable optionsDescriptionPlatformProperty

AutoThe available options are:
• Auto

• Colorless

• Colored

• Contentionless

Select the type of Add/Drop.NCS 2000Add/Drop
Type

AutoThe available options are:
• Auto

• Colorless

• Colored

• Omni-Colorless

• Omni-Colored

Select the type of Add/Drop.NCS 1010

Colored—This property is noneditable.
Colored is the default option.

NCS 1001

AutoThe available options are:
• Auto—Auto is

OLT/LC/AddDrop.

• OLT/LC/Add/Drop—Combination
of OLT LC ports and
CCMD-16 LC ports

• OLT/LC—Direct OLT LC
ports

• OLT/MPO/Add/Drop—Combination
of OLT LC ports and break
out units such as BRK-8,
BRK-16, BRK-24 MPO
ports

Note

This property is applicable
only for Enhanced NCS
1010 line cards from
R7.11.1.

Note

This property appears when
you select Add/Drop
Type as Colorless.

Select the type of Add/Drop
Connector.

NCS 1010Add/Drop
Connector

——Displays the type of
modulation.

NCS 1010Modulation
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Default optionAvailable optionsDescriptionPlatformProperty

1_EThe available options are:
• 1_E

• 0_S

This field is applicable only for
the NCS1K4-QXP-K9 card.
Select the required sub mode.

NCS 1010Sub Mode

OFECThe available options are:
• OFEC

• CFEC

Displays the type of FEC
supported on the chosen card.

NCS 1010FEC

AutoSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Select the trunk type from the
drop-down list.

NCS 2000
NCS 1010

Trunk Type

Auto—This property is noneditable.NCS 1001

AutoDisplays the available
contentionless sides.

Select the contentionless side
from the drop-down list.

NCS 2000Contentionless
Side

Auto—Enter a launch power value. DNCS 1010
NCS 1001

Launch
Power

Destination

——The destination card type is
auto populated based on the
source card type chosen.

NCS 2000
NCS 1010

Card Type

NCS1004_QPSK_SP_16QAM
_200G_27%SDFEC_60GBd

See Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Select the card type from the
drop-down list.

NCS 1001

AutoSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards..
The list of trunk modes
available is based on the based
on card selection.

Select a trunk mode from the
drop-down list.

NCS 1010
NCS 1014
NCS 1001
NCS 2000

Trunk
Mode

Slice• Slice

• Bundle

• 2x100GE

• Muxponder

Select a configuration mode
from the drop-down list.

NCS 1010
NCS 1014

Config
Mode
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Default optionAvailable optionsDescriptionPlatformProperty

AutoSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Select a pluggable from the
drop-down list. The
pluggables suitable for the
chosen card type are
displayed.

NCS 2000
NCS 1010

Client
Interface

Auto—This property is noneditable.NCS 1001

AutoSee Supported Cards and
Pluggables on page 357 and
Supported Optical Sources on
page371 formoredetails about
the list of supported cards.

Select the trunk type from the
drop-down list.

NCS 2000
NCS 1010

Trunk Type

Auto—This property is noneditable.NCS 1001

AutoThe available options are:
• Auto

• Contentionless

• Colorless

• Colored

Select the type of the
Add/Drop.

NCS 2000Add/Drop
Type

AutoThe available options are:
• Auto

• Colorless

• Colored

• Omni-Colorless

• Omni-Colored

Select the type of the
Add/Drop.

NCS 1010

Colored—This property is noneditable.NCS 1001

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 220



Default optionAvailable optionsDescriptionPlatformProperty

AutoThe available options are:
• Auto—Auto is

OLT/LC/AddDrop.

• OLT/LC/Add/Drop—Combination
of OLT LC ports and
CCMD-16 LC ports

• OLT/LC—Direct OLT LC
ports

• OLT/MPO/Add/Drop—Combination
of OLT LC ports and break
out units such as BRK-8,
BRK-16, BRK-24 MPO
ports

Note

This property appears when
you select Add/Drop
Type as Colorless.

Select the type of Add/Drop
Connector.

Note

This property is applicable
only for Enhanced NCS
1010 line cards.

NCS 1010Add/Drop
Connector

——Displays the type of
modulation.

NCS 1010Modulation

1_EThe available options are:
• 1_E

• 0_S

This field is applicable only for
the NCS1K4-QXP-K9 card.
Select the required sub mode.

NCS 1010Sub Mode

——Displays the type of FEC
supported on the chosen card.

NCS 1010FEC

AutoSee Supported Cards and
Pluggables on page 357

Select the trunk pluggable.
FromR25.1.1, newpluggables
are supported on the
NCS1K4-QXP-K9 card.

NCS 1010Trunk Type

AutoDisplays the available
contentionless sides.

Select the contentionless side
from the drop-down list.

NCS 2000Contentionless
Side

Auto—Enter a launch power value.NCS 1010
NCS 1001

Launch
Power

Modify section properties
Teaches you how to modify section properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to modify properties of the section.
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1. Open the network where you want to modify the section properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, click the Services tab.
4. ExpandWaves,Media Channels or Circuits.
5. Navigate to a trail and select a section within the trail.
6. Modify the section properties.

The section and the trail have the same properties. See these references for descriptions of the properties.
• General trail properties on page 211

• OTN trail properties on page 214

• Source and destination trail properties on page 214

7. Click Update.

Modify side properties
Teaches you how tomodify side properties. Follow these detailed step-by-step instructions carefully to ensure the specific
configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Table 107: Feature History

Feature DescriptionRelease InformationFeature Name

In addition to the SMR-20 card, the
colorless Add/Drop configuration can
now be added to both SSON and
non-SSON networks using the SMR-9
card, providing more flexibility to use
the available SMR-9 ports for add/drop
functionality.

Cisco ONP Release 24.3.1Colorless Add/Drop Configuration with
SMR-9 Card

Table 108: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP now supports the passive
module, NCS2K-RMN-CTP-C+L (C-
and L-band counterpropagating Raman
amplifier), starting from the NCS 2000
system release 12.3.1 for SSON and
non-SSON networks.

Cisco ONP Release 5.0NCS2K-RMN-CTP-C+L support
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Table 109: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP supports the passive
module, NCS2K-MF-CL-SC (C and
L-band combiner and splitter), starting
from the NCS 2000 system release
12.2 for SSON and non-SSON
networks. This feature enables
combining C and L band wavelengths.

Cisco ONP Release 4.2Support for NCS2K-MF-CL-SC (C and
L-band combiner and splitter)

Use this procedure to modify the properties of a side in a site.
1. Open the network where you want to modify the side properties of a site.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, navigate to Sites > Site > Side.
4. Modify the side properties as required. See these references for the property descriptions.

• General side properties on page 223

• Bill of materials and layout properties for sides on page 228

• Enhanced face plate properties for sides on page 230

5. Click Update.

General side properties
Provides guidelines for general side properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes various general properties for the sides of a site.

DescriptionPlatformOptions

——Displays the label of the
side.
Editable for NCS 1001.

Note

For L-band nodes, the
suffix L is added to the
side label.

NCS 2000
NCS 1010
NCS 1001

Label

——Displays the type of the side.
You cannot edit this
property.

NCS 2000
NCS 1010
NCS 1001

Type
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DescriptionPlatformOptions

Dual OLT• Dual OLT

• 4x4 COFS (supports only
C-band Omni colorless)
You can choose 4x4
COFS only if the
Structure under the
Sites properties is Line.

Note

In a site, all Omni edges
must have the same Omni
Variant. Changing the
Omni Variant for one edge
updates the variant for all
edges.

Select the type of
omnidirectional add/drop
stage.

NCS 1010Omni Variant

——Enter the number of
omnidirectional ports.
It is applicable only for the
4x4COFS Omni variant. The
available values range from
1 through 4, with a default
value of 4.

NCS 1010Omni
Directional
Ports

——Enter the node addressNCS 1010
NCS 1001

Node
Address

Auto• Auto

• 16MPO-MPO

• 24MPO-MPO

Choose the MPO cable.NCS 1010MPO Cable

——Enter the number of
colorless ports.
From Release 24.3.1, this
property is enabled for the
SMR-9 card.

NCS 2000Colorless
Ports
(Displayed
for Line side)

161-16Choose the number of
contentionless ports.

NCS 2000Contentionless
Ports
(Displayed
for
Contentionless
side)
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DescriptionPlatformOptions

——NCS 2000Enable C+L
Band S/C
(Displayed
for Line side
type)
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DescriptionPlatformOptions

Cisco ONP supports the
following passive modules:
• NCS2K-MF-CL-SC (C

and L-band combiner
and splitter), starting
from the NCS 2000
system release 12.2 for
SSON and non-SSON
networks. Check this
check box to enable the
NCS2K-MF-CL-SCcard.
This card is supported
for ROADM, OLA, and
traffic nodes, but not on
the passthrough node.

Note

When you enable this
option on a side:
• It is automatically

enabled on the
side that is
connected to the
selected side
through a fiber.

• The fiber property
Raman Amplified
is automatically
disabled, and the
opposite way.

• This card
introduces a
certain amount of
attenuation and
insertion loss that
is reflected in the
ANS parameters.

The
NCS2K-MF-CL-SC
module does not
appear in the layout.

• NCS2K-RMN-CTP-C+L
(C- and L-band
counterpropagating
Raman amplifier),
starting from the NCS
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DescriptionPlatformOptions

2000 system release
12.3 for SSON and
non-SSON networks.
Check this check box to
enable the
NCS2K-RMN-CTP-C+L
card.

Note

When you enable this
option on a side:
• If you enable the

fiber property
Raman Amplified,
then the
NCS2K-RMN-CTP-C+L
card is
automatically
forced.

• If you disable the
fiber property
Raman Amplified,
then the
NCS2K-MF-CL-
SC card is
automatically
forced.

• Fiber property
Raman Amplified
is automatically
disabled for NCS
2000 system
release 12.2.

The
NCS2K-RMN-CTP-C+L
module appears in the
layout.

C-Band• C-Band

• C+L Futuristic

Choose the required band
type.

NCS 1010
NCS 1001

Band Type

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 227



DescriptionPlatformOptions

Standard Faceplate• Standard Faceplate

• Enhanced Faceplate

Choose whether the Line
Card faceplate is Standard
Faceplate or Enhanced
Faceplate.

Note

If you assigned a
Scalable Upto
Degree value that is
supported for both
standard and enhance at
the site level, then you
can select Standard
Faceplate in one side and
Enhanced Faceplate in
another side.

NCS 1010NCS 1010
Line Card

——The Probe channel pluggable
option that you selected at
the network level applies to
all the edges of all sites in
the network. This field is
noneditable.

NCS 1014Probe
Channel

——The OTDR pluggable option
that you selected at the
network level applies to all
the edges of all sites in the
network. This field is
noneditable.

NCS 1014OTDR
Pluggable

CWDM-SFP-1510• CWDM-SFP-1510

• CWDM-SFP-1610

• ONS-SC-Z3-1510

• ONS-SC-Z3-1610

• ONS-SE-155-1510

Choose the type of OSC
pluggable.

NCS 1001OSC
Pluggable

ONS-SC-PTP-1510ONS-SC-PTP-1510Choose the type of OSC
pluggable. The available
option is:

NCS 1014

Bill of materials and layout properties for sides
Provides guidelines for bill of materials and layout properties for sides. This table describes various bill of materials and
layout properties for the sides of a site.
This table describes various bill of materials and layout properties for the sides of a site.
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Table 110: Bill of materials and layout properties for sides

DescriptionPlatformOptions

Bill of Material

Choose whether the License Suite is Essential (RTU +SIA3)
or Advanced (RTU +SIA3).

NCS 1010License Suite

The default option is RTU + SIA3. It is noneditable.NCS 1014

Layout

Choose the type of Power Supply. The available options
are Auto, AC Power, and DC Power.
The default option is Auto.
With the Auto option, the default power supply is selected
as DC Power.

NCS 1010
NCS 1001

Power Supply

Choose the type of chassis. The available options are:
• NCS 1010

• NCS 1020

NCS 1010Chassis Type

This check box is enabled by default. If you enabled NCS
1014 grouping at the site level, then this check box
becomes noneditable.

NCS 1014NCS1014 Grouping

Choose the type of the controller card. The available options
are:
• Auto

• NCS1010-CNTRL-K9

• NCS1010-CNTRL-B-K9

NCS 1010Controller Card

NCS1K-CNTLR2 is default.NCS 1001

Displays the redundant controller card, if any. Else displays
No.

NCS 1010
NCS 1001

Redundant Controller Card

Choose the type of cables to be used for the AC power
supply. You can choose the cables when the Power
Supply is set as AC Power or DC Power.

NCS 1010
NCS 1001

UTS AC Power Cables

Choose the redundant power scheme from the drop-down
list to configure the number of working and protected power
units for the chassis. The available options are Auto, 1+0,
and 1+1.

NCS 1010
NCS 1001

Redundant Power Scheme

Choose the mechanical frame for the passive optical
modules from the drop-down list. The options available are
Auto, MF-1RU, and MF-4RU.

NCS 1010
NCS 1001

MF Unit
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DescriptionPlatformOptions

Choose the number of LC ports to reserve for Direct
Add/Drop connection. The range of values is 0—14. This
property appears for networks from R7.10.1.
The chosen option will not be used for Degree Connection.

NCS 1010Direct LC Add/Drop

Enhanced face plate properties for sides
Provides guidelines for enhanced face plate properties for sides. This table describes various enhanced face plate
properties for the sides of a site.
This table describes various enhanced face plate properties for the sides of a site.
Table 111: Enhanced face plate properties for sides

DefaultAvailable optionsDescriptionPlatformOptions

LC Ports• LC Ports

• MPO Group

Choose the port type
for interconnect
degree priority.

Note

This field appears
only when you
select NCS 1010
Line Card as
Enhanced
Faceplate.

NCS 1010Degree Priority

The range of values is
0—14.

Choose the number of
LC ports to reserve for
Direct Add/Drop
connection. This
property appears for
networks from
R7.10.1.
The chosen option will
not be used for
Degree Connection.

NCS 1010Direct LC Add/Drop

Modify C-band amplifier properties
Teaches you how tomodify C-band amplifier properties. Use this procedure to modify the properties of C-band amplifiers
in a site.
Use this procedure to modify the properties of C-band amplifiers in a site.
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Table 112: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to edit the
crosstalk values of the Raman COP
amplifier in the SSON network, starting
from NCS 2000 Release 11.1.

Cisco ONP Release 4.1Manual Editing of Raman COP values

Table 113: Feature History

Feature DescriptionRelease InformationFeature Name

The Inline Amplifier option allows
you to enable an inline amplifier in the
network. You can simulate the optical
feasibility of the network with and
without an inline amplifier. Based on
the colorless or colored add/drop type
selected and the QSFP-DD pluggable
status, a default inline amplifier is
enabled for the network.

Cisco ONP Release 4.2Inline Amplifier

Note

Make sure that SMR card is forced on the site before you update the c-band amplifier properties.

Log in to the Cisco ONP web interface on page 17
1. Open the network where you want to modify the C-band properties.
2. Choose Network > Entity Editor.

Alternatively, click the network name in the network tree, and click Show Advanced Properties displayed under
the network tree.

3. In the Entity Editor window, click the Site tab.
4. Choose Sites > Site > Site domain > Side > C-Band.
5. Click C-Band Amplifier and modify the properties. For detailed property descriptions, refer to:

• General properties of a C-band amplifier on page 231

• C-band amplifier and attenuator options on page 235

• Raman amplification properties of a C-band amplifier on page 239

General properties of a C-band amplifier
Provides guidelines for general properties of a C-band amplifier. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table lists the general properties of a C-band amplifier.
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DefaultAvailable optionsDescriptionPlatformOptions

Auto—Enter a value.NCS 1010PSD Shape

Auto—Enter a value.NCS 1010Dual Band
PSD Shape

Auto—Enter a value.NCS 2000Raman COP
Tilt

Auto—Enter a value.NCS 2000
NCS 1010

Pre Tilt

Auto—Enter a value.NCS 2000
NCS 1010

Raman Tilt

Auto—Enter a value.NCS 2000
NCS 1010

Booster Tilt
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DefaultAvailable optionsDescriptionPlatformOptions

Auto• Yes—EDFA17 or EDFA35
amplifier is chosen as the
default amplifier when
you choose colored
add/drop module
MD-64-C or colorless
add/drop MF-6AD-CFS,
respectively. SeeModify
Add/Drop multiplexer
properties on page 242.

• No—No amplifier can be
forced.

• Auto
• EDFA17 amplifier is

chosen as the default
amplifier when any
one of the demands
aggregated in
MD-64-C has low
launch power optical
resource orQSFP-DD
pluggable is forced.

• EDFA35 amplifier is
chosen as the default
amplifier when any
one of the demands
aggregated in
MF-6AD-CFS has
low launch power
optical resource or
QSFP-DD pluggable
is forced.

NCS 2000Inline
Amplifier
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DefaultAvailable optionsDescriptionPlatformOptions

Choose whether inline
amplifier can be forced.

Note

When you configure
MF-6AD-CFS+EDFA35 in
an SSON or non-SSON
network, the optical
results show system error
for the demands of the
same or different types.
This error affects the
what-if analysis. Hence
we recommend choosing
the appropriate channel
and client attenuators so
that the inline amplifier
works at the proper gain
range.

You can view the amplifier
added in the IPC, BOM,
and Layout tabs, after the
successful analysis.

Note

• When you add a QDD
demand while
upgrading a network
where the Inline
Amplifier property is
set as no, the inline
amplifier can be
included in the
network only if you
unlock the side and
set the Inline amplifier
property as Auto or
Yes.

• Default colorless
configuration does not
require inline amplifier.

• When there are no
demands passing
through the colored or
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DefaultAvailable optionsDescriptionPlatformOptions

colorless Add/Drop
device, the forced
Inline amplifier is not
placed.

C-band amplifier and attenuator options
Provides guidelines for c-band amplifier and attenuator options. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table describes the various C-band amplifier and attenuator options you can choose in the C-band proeprties.
Table 114: C-band amplifier and attenuator options

DescriptionPlatformOptions

From Fiber
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DescriptionPlatformOptions

Choose a preamplifier from
the drop-down list. The
default value is Auto. To
enable this field for ROADM
and Traffic nodes, you must
choose SMR-9 or SMR-20
from the Site Type
drop-down list under the
Site properties.
If you choose SMR-9, the
available options are:
• SMR9-FS-EDFA17-PRE

• SMR9-FS-EDFA24-PRE

• SMR9-FS-EDFA24-PRE

If you choose SMR-20, the
available options are:
• SMR20-FS-EDFA17-PRE

• SMR20-FS-EDFA24-PRE

For the OLA site, the
available options are:
• EDFA35-35-PRE

• EDFA35-24-PRE

• OPT -EDFA-17

• OPT -EDFA-24

NCS 2000Pre Amp

The options available for
NCS 1010 are:
• Auto

• Normal

• Extended

NCS 1010

AutoThe options available for
NCS 1001 are:
• Auto

• NCS1001-PRE-1

• NCS1001-PRE-2

NCS 1001

NCS 1014
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DescriptionPlatformOptions

The Pre Amplifier value is
decided based on the launch
power of the optical source.
The default option is Auto. It
is noneditable.

The Pre PSD value is picked
from LUT.
The default option is Auto. It
is noneditable.

NCS 1014Pre PSD

The default value is Auto.
You can enter a value.

NCS 2000
NCS 1001

Output
Power

This field is enabled only
when you choose a
preamplifier. Choose an
attenuator from the
drop-down list. The available
options are:
• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

NCS 2000Attenuator In

ATT-LC-12• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

This field is enabled only
when you choose a
preamplifier. Choose an
attenuator from the
drop-down list.

NCS 2000Attenuator
Out

To Fiber
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DescriptionPlatformOptions

AutoIf you choose SMR-20, the
default booster is
20SMR-FS-BST.
If you choose SMR-9,
default booster is
SMR9-FS-EDFA-BST.
For the OLA node, the
available options are:
• EDFA35-35-BST

• EDFA35-24-BST

• OPT -EDFA-17

• OPT -EDFA-24

To enable this field for
ROADM and Traffic nodes,
you must choose SMR-9 or
SMR-20 from the Site
Type drop-down list under
the Site properties.

NCS 2000Booster

OLT-C-EDFA-BstOLT-C-EDFA-BstFor NCS 1010, it is
OLT-C-EDFA-Bst

NCS 1010

OLT-C-EDFA-BstOLT-C-EDFA-BstThe option available for NCS
1001 is OLT-C-EDFA-Bst

NCS 1001

Normal• Normal

• Extended

Choose the boosterNCS 1014First Booster

The default option is Auto. It
is noneditable.

NCS 1014Second
Booster

The Pre PSD value is picked
from LUT.
The default option is Auto. It
is noneditable.

NCS 1014Second
Booster PSD

The default value is Auto.
You can enter a value.

NCS 2000
NCS 1001

Output
Power

ATT-LC-12• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

This field is enabled only
when you choose a booster.
Choose an attenuator from
the drop-down list.

NCS 2000Attenuator In
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DescriptionPlatformOptions

ATT-LC-12• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

This field is enabled only
when you choose a booster.
Choose an attenuator from
the drop-down list. The
available options are:

NCS 2000Attenuator
Out

Raman amplification properties of a C-band amplifier
Provides guidelines for raman amplification properties of a C-band amplifier. Lists the essential reference information,
key parameters, and specific guidelines needed to support your daily network configuration tasks.
This table describes the Raman amplification properties of a C-band amplifier.
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Table 115: Raman amplification properties of a C-band amplifier

DescriptionPlatformOptions

AutoThe available options for
NCS 2000 ROADM and
Traffic sites are:
• Auto

• RAMAN-CTP

• RAMAN-COP-CTP
Raman Amp can be
forced only between two
nodes.

The available options for the
OLA site are:
• Auto

• EDRA1-26

• EDRA1-35

• EDRA2-26

• EDRA2-35

• RAMAN-CTP

Choose the Raman amplifier
from the drop-down list.

Note

To force the RAMAN
amplifier on NCS 2000
node, you must enable
RAMAN amplified on
the fiber, else theRaman
Amp is disabled, and
network analysis fails.

Note

When you enable the fiber
property Raman
amplified and the side
property Enable C+L
Band S/C for NCS 2000
node, Raman Amp is
automatically forced as
RAMAN-C+L.

NCS 2000Raman Amp

Auto• Auto

• None

• Raman

Choose the Raman amplifier
from the drop-down list.

Note

For NCS 1010 network,
when Raman is forced on
one side, Raman is
automatically forced on all
connected sides (APC
Domain). If there are
passthrough nodes
connected, Raman will be
automatically enabled on
both sides of the
passthrough nodes.

NCS 1010
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DescriptionPlatformOptions

Raman CTP
Gain

——Enter a value.NCS 2000

——Enter a value. This field is
enabled only when you
choose RAMAN-COP-CTP.

NCS 2000Raman COP
Gain

——Displays the Raman gain.NCS 1010Raman Gain

——By default, this option is
disabled. Enable it to edit the
crosstalk values of the
Raman COP amplifier.

Note

Static data is supported
from Release 11.1 for
SSON network.

NCS 2000Static Data

Edit the value of average
linear crosstalk.

NCS 2000Linear XT
Avg

Edit the value average linear
crosstalk sigma.

NCS 2000Linear XT Six

Edit the value of average
nonlinear crosstalk.

NCS 2000NonLinear XT
Avg

Edit the value of average
nonlinear crosstalk sigma.

NCS 2000NonLinear XT
Sig

Note

Raman crosstalk values are present in the ANS file under logoparameters section.

Modify L-Band Amplifier Properties
Teaches you how to modify L-Band Amplifier Properties. Use this task to modify the properties of an L-band amplifier in
a site.
Log in to the Cisco ONP web interface on page 17
Use this task to modify the properties of an L-band amplifier in a site.
1. Open the network where you want to modify the L-band properties.
2. Choose Network > Entity Editor.
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Alternatively, click the network name in the network tree, and click Show Advanced Properties displayed under
the network tree.

3. In the Entity Editor window, click the Site tab.
4. Choose Sites > Site > Site domain > Side > L-Band.
5. Click L-Band Amplifier to modify the properties.

See L-band properties on page 242.

6. Click Update.

L-band properties
Provides guidelines for l-band properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes various L-band properties.
Table 116: L-band properties

DescriptionPlatformOptions

General

——Enter a Power Spectral
Density (PSD) value.

NCS 1010PSD Shape

——Enter Central PSD and Tilt
values.

NCS 1010Dual Band
PSD Shape

Auto—Enter a value.NCS 1010Pre Tilt

Auto—Enter a value.NCS 1010Raman Tilt

Auto—Enter a value.NCS 1010Booster Tilt

From Fiber

• Normal

• Extended

Choose the pre amplifierNCS 1010Pre Amp

To Fiber

OLT-L-EDFA-Bst—Displays the Booster
amplifier.

NCS 1010Booster

Modify Add/Drop multiplexer properties
Teaches you how to modify Add/Drop multiplexer properties. Follow these detailed step-by-step instructions carefully
to ensure the specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
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Table 117: Feature History

Feature DescriptionRelease InformationFeature Name

NCS 2000 R11.x networks now
supportMD-32 add/drop configuration.
All NCS2000 networks supportMD-48
add/drop configurations.

Cisco ONP Release 26.1.1Configuration gaps in NCS 2000
networks

Table 118: Feature History

DescriptionRelease InformationFeature Name

The new property, Colorless Port
Distribution is introduced under the
Add/DropMultiplexer properties.
This property allows you to select the
number of CCMD cards to connect to
the LC ports of the enhanced OLT and
determine the number of channels for
each chosen CCMD card. It provides
the flexibility to choose the desired
number of CCMD cards and distribute
the colorless ports across them.

Cisco ONP Release 24.3.1User-Defined Colorless Ports
Distribution for CCMD Card in NCS
1010 Network

Table 119: Feature History

Feature DescriptionRelease
Information

Feature Name

You can create and validate network designs by choosing colored and
colorless add/dropmultiplexers and demultiplexers, and interlever under
C-Band > Add/Drop. The following options are supported in this
release:

Cisco ONP Release
4.2

Modify Properties of
Add/Drop Multiplexer
and Demultiplexer

Network SupportedOptionsType of Add/Drop

• SSON

• Non-SSON

• Direct SMR

• MF-6AD-CFS

Colorless

• SSON

• Non-SSON

• MD-64-C

• MD-48-ODD

• MD-48-EVEN

• MD-48-ODD +
MD-48-EVEN

Colored

• Non-SSON• MpoCable

• MD-48-CM

Interlever

Use this procedure to modify the properties of the add/drop multiplexer in a site.
1. Open the network where you want to modify the Add/Drop multiplexer properties.
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2. Choose Network > Entity Editor.
3. In the Entity Editor window, navigate to Sites > Site > Site domain > Side > C-Band
4. Click Add/Drop and modify the properties in the next pane. For the property descriptions, refer to:

• General Add/Drop multiplexer properties on page 244

• MPO connector properties on page 249

• LC connector properties on page 250

5. Click Update.

General Add/Drop multiplexer properties
Provides guidelines for general Add/Dropmultiplexer properties. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table describes the general properties of the Add/Drop multiplexers.
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Table 120: General Add/Drop multiplexer properties

DefaultAvailable optionsDescriptionPlatformOptions

Auto• MD-64-C: Passive optical
multiplexer and
demultiplexer module (for
SSON network)

• None

• Auto

Cisco ONP adds some options
automatically based on the
colored demands created and
the wavelengths you configure
in the non-SSON network.
These options include:
• MD-48-ODD

• MD-48-EVEN

• MD-48-ODD +
MD-48-EVEN

• MD-32-ODD

• MD-32-EVEN

• MD-32-ODD +
MD-32-EVEN

Choose the colored add/drop
multiplexer and demultiplexer.
To mix 16-AD-CCOFS and
MD-48-ODD/EVEN on the
same MPO port of SMR-20
and connect
MD-48-ODD/EVEN toSMR-20
via MPO-8LC and UPG-4,
enable the Shared SMR port
and select the required colored
Add/Drop.
The MD-32 and MD-48
add/drop configuration with
MD-64-C are supported for all
NCS 2000 network version in
CONP 26.1.1.
MD-32 configuration is
• MD-32-ODD refers to

NCS1K-MD-32O-CE at
150 GHz spacing

• MD-32-EVEN refers to
NCS1K-MD-32E-CE at
150 GHz spacing

• MD-32-ODD+EVEN refers
to both ODD and EVEN at
75 GHz spacing

MD-48 configuration is
• MD-48-ODD refers to

15216-MD-48-ODD at
100 GHz spacing

• MD-48-EVEN refers to
15216-MD-48-EVEN at
100 GHz spacing

• MD-48-ODD+EVEN refers
to 15216-MD-48-ODD
and 15216-MD-48-EVEN
at 50 GHz spacing

NCS
2000

Colored
Add/Drop

AutoChoose the colored add/drop
multiplexer and demultiplexer
for NCS 1010.

NCS
1010
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DefaultAvailable optionsDescriptionPlatformOptions

• Auto

• None

• MD-32-EVEN

• MD-32-ODD

• MD-32-
ODD+MD-32-EVEN

Auto• Auto

• MD-64

• MD-32-EVEN

Note

In pre-R2511 networks,
MD-32-EVEN refers to
N1K-MD-32E-C patch
panel. In R2511
networks,
NCS1K-MD-32E-CE
replaces
N1K-MD-32E-C. For
pre-R2511 networks
with MD-32E-C
add/drop option, you
need to reset the
add/drop option to Auto
and then to
MD-32-EVEN and
reanalyze the network to
add the new
MD-32E-CE PID.

• MD-32-ODD

• MD-48-EVEN

• MD-48-ODD

• MD-48-ODD+MD-48-EVEN

• FLD-4 (10 variants)

Choose the colored add/drop
multiplexer and demultiplexer
for NCS 1001.

Note

Choose an Add/Drop type
with a Baud rate that
matches the Optical Source
Baud rates.

NCS
1001

AutoChoose the colored add/drop
multiplexer and demultiplexer
for NCS 1014.

NCS
1014
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DefaultAvailable optionsDescriptionPlatformOptions

• Auto

• NCS1K-MD-32O-CE

• NCS1K-MD-32E-CE

• MD-32-ODD+MD-32-EVEN—
Combination of both
MD-32-CE add/drop
panels.
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DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• Direct SMR: SMR-20 and
SMR-9 cards that are
directly connected to the
colorless channels through
MF-MPO-16-LC and
MF-MPO-8-LC
respectively.

• MF-6AD-CFS: 6 Port
Add/Drop Module
(supported only for ROADM
starting from NCS 2000
system release 11.0, and
traffic site).

Note

If you choose
MF-6AD-CFS for a side,
choose the same for
other sides of the site.

Choose the colorless add/drop
multiplexer and demultiplexer
for NCS 2000.

NCS
2000

Colorless
Add/Drop

Auto• Auto

• None

• BRK-8

• BRK-16

• BRK-24

Choose the colored add/drop
multiplexer and demultiplexer
for NCS 1010.

Note

QDD optical sources are not
supported (both as optical
source and pluggable) with
colorless BRK-8, BRK-16,
or BRK-24 configurations.

NCS
1010

Auto• Auto

• MpoCable

• MD-48-CM

NCS
2000

Interlever
Type
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DefaultAvailable optionsDescriptionPlatformOptions

Choose the interlever type
from the drop-down list.

Note

Interlever Type property
is visible and editable only
for Line sides of
Multi-Degree nodes having
Site Type property as
SMR-9 and Scalable
Upto Degree property as
8 under the C-Band tab at
the Site level.

MPO connector properties
Provides guidelines for mPO connector properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the properties of MPO connectors that are used in Add/Drop multiplexers.
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Table 121: MPO connector Add/Drop properties

DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• None

• BRK-8

• BRK-16

• BRK-24

Note

MPO Connector
Add/Drop appears for
networks from R7.10.1.

Note

You cannot use QDD optical
sources (as either an optical
source or pluggable) with
colorless BRK-8, BRK-16,
or BRK-24 configurations.

NCS
1010

Colorless
Add/Drop

0
If you keep the default value,
Cisco ONP automatically
calculates the number of
colorless ports based on the
number of circuits you added
and colorless add/drop units
you have configured.

—Enter the number of colorless
ports.

Note

For the R7.10.1 network,
you can assign a maximum
of 48 colorless ports. The
assigned ports are
applicable to theMPO ports.
For the R7.11.1 network,
you can assign a maximum
of 128 colorless ports.

NCS
1010

Colorless
Ports

LC connector properties
Provides guidelines for LC connector properties. Lists the essential reference information, key parameters, and specific
guidelines needed to support your daily network configuration tasks.
This table describes the properties of LC connectors that are used in Add/Drop multiplexers.
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Table 122: LC connector Add/Drop properties

DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• None

• NCS1K14-CCMD-16C

Note

LC Connector
Add/Drop appears for
networks from R7.11.1.

NCS
1010

Colorless
Add/Drop

0
If you keep the default value,
Cisco ONP automatically
calculates the number of
colorless ports based on the
number of circuits you added
and colorless add/drop units
you have configured.

—Enter the number of colorless
ports.

Note

For the R7.10.1 network,
you can assign a maximum
of 48 colorless ports. The
assigned ports are
applicable for the LC ports.
For the R7.11.1 network,
you can assign a maximum
of 128 colorless ports.

NCS
1010

Colorless
Ports

—NCS
1010

Colorless
Ports
Distribution
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DefaultAvailable optionsDescriptionPlatformOptions

• Click the field to open the
Colorless Ports
Distribution pop-up
window.

• Choose the
NCS1K14-CCMD-16C for
each of the LC ports, A/D
4 to A/D 17.

• Select the number of ports
for each CCMD card,
ensuring the total does not
exceed 128.

• Click Submit.

When allocating LC ports,
consider these priorities:
1. Degree connection

2. Direct LC ports

You can allocate CCMD cards
only to LC ports that remain
after other allocations.
If the Degree Priority under Site
Properties is set to LC Ports,
the number of CCMD cards
that can be forced on the line
side edges depends on the
number of degrees (including
omni and line degrees,
depending on the scalable
degree) and the Direct LC
ports.
This is explained in this
formula:
Maximum number of CCMDs
Allowed = 14 -
(scalableUptoDegree - 1) -
Direct LC add/drops - Number
of Omni Edges
The number of ports that you
have selected is displayed in
the field.
When the Enable Special
Settings under the Network
properties is enabled, and if
the Colorless Ports
Distribution has not been
set previously, the property
defaults to 16, 16, 0. In this
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DefaultAvailable optionsDescriptionPlatformOptions

case, three LC ports are
already used for CCMD card.

Note

For omnidirectional sides,
you can select the CCMD
card for every LC port.

After successful analysis of the
network, you can view the port
distribution under the Layout
> Node Diagram tab.
Currently, this property is
supported only for the
enhanced plate.

Modify L-Band Add/Drop multiplexer properties
Teaches you how to modify L-Band Add/Drop multiplexer properties. Follow these detailed step-by-step instructions
carefully to ensure the specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Use this procedure to modify the properties of the Add/Drop multiplexer in a site.
1. Open the network where you want to modify the L-band Add/Drop multiplexer properties.
2. Choose Network > Entity Editor.
3. In the Entity Editor window, navigate to Sites > Site > Site domain > Side > L-Band.
4. Click Add/Drop and modify the properties in the next pane. Refer to L-band Add/Drop multiplexer properties on

page 253 for property descriptions.

L-band Add/Drop multiplexer properties
Provides guidelines for l-band Add/Drop multiplexer properties. Lists the essential reference information, key parameters,
and specific guidelines needed to support your daily network configuration tasks.
This table describes the properties of L-band Add/Drop multiplexers.
Table 123: L-band Add/Drop multiplexers properties

DefaultAvailable optionsDescriptionPlatformOptions

General
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DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• None

• BRK-8

• BRK-16

• BRK-24

Note

Only L-band optical sources
are supported. Pluggables
are not supported in L-band
networks.

NCS
1010

Colorless
Add/Drop

MPO Connector Add/Drop
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DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• None

• BRK-8

• BRK-16

• BRK-24

Note

MPO Connector
Add/Drop appears for
networks from R7.10.1.

Note

QDD optical sources are not
supported (both as optical
source and pluggable) with
colorless BRK-8, BRK-16,
or BRK-24 configurations.

NCS
1010

Colorless
Add/Drop

0
If you keep the default value,
Cisco ONP automatically
calculates the number of
colorless ports based on the
number of circuits you added
and colorless add/drop units
you have configured.

Note

For the R7.10.1 network,
you can assign a maximum
of 48 colorless ports. The
assigned ports are
applicable for a combination
of LC and MPO ports.
For the R7.11.1 network,
you can assign a maximum
of 128 colorless ports.

—Enter the number of colorless
ports.

NCS
1010

Colorless
Ports

LC Connector Add/Drop
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DefaultAvailable optionsDescriptionPlatformOptions

Auto• Auto

• None

• NCS1K14-CCMD-16L

Note

LC Connector
Add/Drop appears for
networks from R7.11.1.

NCS
1010

Colorless
Add/Drop

Note

For the R7.10.1 network,
you can assign a maximum
of 48 colorless ports. The
assigned ports are
applicable for a combination
of LC and MPO ports.
For the R7.11.1 network,
you can assign a maximum
of 128 colorless ports.

—Enter the number of colorless
ports.

NCS
1010

Colorless
Ports

——NCS
1010

Colorless
Ports
Distribution
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DefaultAvailable optionsDescriptionPlatformOptions

• Click the field to open the
Colorless Ports
Distribution pop-up
window.

• Choose the
NCS1K14-CCMD-16C for
each of the LC ports, A/D
4 to A/D 17.

• Select the number of ports
for each CCMD card,
ensuring the total does not
exceed 128.

• Click Submit.

When allocating LC ports,
consider these priorities:
1. Degree connection

2. Direct LC ports

You can allocate CCMD cards
only to LC ports that remain
after other allocations.
If the Degree Priority under Site
Properties is set to LC Ports,
the number of CCMD cards
that can be selectd on the line
side edges depends on the
number of degrees (including
omni and line degrees,
depending on the scalable
degree) and the Direct LC
ports.
This is explained in this
formula:
Maximum number of CCMDs
Allowed = 14 -
(scalableUptoDegree - 1) -
Direct LC add/drops - Number
of Omni Edges
The number of ports that you
have selected is displayed in
the field.
When the Enable Special
Settings under the Network
properties is enabled, and if
the Colorless Ports
Distribution has not been
set previously, the property
defaults to 16, 16, 0. In this
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DefaultAvailable optionsDescriptionPlatformOptions

case, three LC ports are
already used for CCMD card.

Note

For omnidirectional sides,
you can select the CCMD
card for every LC port.

After successful analysis of the
network, you can view the port
distribution under the Layout
> Node Diagram tab.
This property is supported only
for the enhanced plate.

Modify client properties
Teaches you how to modify client properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Table 124: Feature History

Feature DescriptionRelease InformationFeature Name

You can set up channel attenuators for
QSFP-DD demands. You can choose
different channel attenuators based on
the specific configuration and check
for the optical feasibility of the channel.

Cisco ONP Release 4.2Channel Attenuators

Log in to the Cisco ONP web interface on page 17
Use this task to modify the properties of a client-side attenuator in a site.
1. Open the network where you want to modify the client properties.
2. Choose Network > Entity Editor.

Alternatively, click the network name in the network tree, and click Show Advanced Properties displayed under
the network tree.

3. In the Entity Editor window, click the Site tab.
4. Choose Sites > Site > Site domain > Side > Clients > Channel-Attenuators.
5. In the right pane of the Entity Editor window, modify properties of the client-side attenuator.

See Client properties on page 259 for the descriptions.
6. Click Update.
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Client properties
Provides guidelines for client properties. Lists the essential reference information, key parameters, and specific guidelines
needed to support your daily network configuration tasks.
This table describes various System Release properties under the Network properties.

Default optionAvailable optionsDescriptionPlatformProperties

General

——This column displays the
selected wavelength.

NCS 2000Wavelength
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Default optionAvailable optionsDescriptionPlatformProperties

——Click Edit to select a Flex
Grid or Fixed Grid
wavelength.

Note

Select Fixed Grid
(64-Chs) for SSON
network with
NCS1K-MD-64-C card.

Note

NCS1K-MD-64-C card
has First Channel limitation
for Colored sites. First
Channel (196.1 THz) in
Fixed Grid (64-Chs)
wavelength supports only
Terminal Add/Drop sites
and not ROADM sites.

NCS 2000New
Wavelength -
Auto

Auto• Auto

• None

• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

Choose an RX-Attenuator
from the drop-down list.

Note

You must select a
wavelength to edit this
field.

NCS 2000RX-Attenuator

AutoNCS 2000TX-Attenuator
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Default optionAvailable optionsDescriptionPlatformProperties

• Auto

• None

• ATT-LC-2

• ATT-LC-3

• ATT-LC-5

• ATT-LC-7

• ATT-LC-10

• ATT-LC-12

• ATT-LC-15

• ATT-LC-18

Choose a TX-Attenuator from
the drop-down list.

Note

You must select a
wavelength to edit this
field.

Click Add to select a
wavelength.

NCS 1001New
Wavelength

Sort the Network Elements
Teaches you how to sort the Network Elements. Follow these steps to sort the network elements in the network tree.
You can sort the sites, services, fibers, waves, and SRLG in ascending or descending order. This feature is useful for
huge networks, making it quick to locate the required site, fiber, wave, or SRLG names.
Follow these steps to sort the network elements in the network tree.
1. Open the network where you want to sort the network elements.
2. Click the Ellipsis icon available in the right side of the network element in the network tree, such as Sites, and

choose Ascending or Descending.
The network elements are sorted based on the alphabets, numbers, and, alphanumeric.

Modify Flexgrid properties
Teaches you how to modify Flexgrid properties. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Follow these steps to modify the properties of the optical subnet.
Log in to the Cisco ONP web interface on page 17.
1. Open the network where you want to modify the optical subnet properties.
2. In the network tree, choose Subnet > OpticalSubnet and select the required Flexgrid.
3. Click the optical subnet name, and modify the properties.

This table describes various general properties of an optical subnet.
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Table 125: General properties of an optical subnet

DescriptionPlatformProperty

Name of the optical subnetNCS 2000
NCS 1010

Name

Same as the name of the optical
subnet

NCS 2000
NCS 1010

Ð¡Band Rules

Spectral Density of the optical subnetNCS 2000
NCS 1010

Spectral Density

Displays based on network demand.NCS 2000
NCS 1010

Max Number Of Channels

Available fibers in the networksNCS 2000
NCS 1010

Fiber links

Check box for the current subnetNCS 2000
NCS 1010

Current subnet

Displays the band type for the subnetNCS 2000
NCS 1010

Band Type

Check box to enable Basic Auto SD
selection for the optical subnet.

NCS 2000
NCS 1010

Auto

Regenerator sites
Describes the functionality of regenerator sites. Explains the specific benefits and underlying principles of this essential
feature for improving overall system efficiency and operational management.
A regenerator site is a network location that
• restores and amplifies weakened optical signals affected by attenuation and dispersion,

• converts degraded optical signals to electrical signals and back through Optical-Electrical-Optical (OEO) conversion,
and

• enables efficient long-distance signal transmission by maintaining signal integrity across the optical fiber.

In optical networks, as fiber length increases, unavoidable issues such as attenuation (signal power loss) and dispersion
(signal spreading) degrade signal quality. These effects can significantly impact network performance over long distances,
making it necessary to use regenerators to ensure reliable and efficient transmission.

Ensuring signal quality through regeneration sites

Cisco ONP supports establishing regeneration sites within optical networks. These sites are essential for maintaining
signal integrity over long distances, as they utilize regenerators to enhance overall network performance. A regeneration
site can be configured only as a ROADM site within Cisco ONP.

Cisco Optical Network Planner | Updated March 10, 2026

| Modify Network Properties | 262



Create a regeneration site
Teaches you how to create a regeneration site. Follow these detailed step-by-step instructions carefully to ensure the
specific configuration is applied correctly and securely within your network.
Log in to the Cisco ONP web interface on page 17.
Table 126: Feature History

Feature DescriptionRelease InformationFeature Name

This feature enables you to assign
distinct wavelengths to various sections
of the Regen sites

Cisco ONP Release 4.1Wavelength Forcing at the Section
Level

Follow these steps to create a regeneration site in the network.
1. Open the network where you want to create a regeneration site.
2. In the network tree, expandWaves, select a wave and drill down to its trail.

Note

If the network is an SSON network or an NCS 1010 network, you seeMedia Channels orCircuits respectively.
instead of waves. ExpandMedia Channels or Circuits , and drill down to its trail.

3. Click the trail to view its properties.
4. From the Regen Sites drop-down list, select a regeneration site.

Note

If you select a fiber from the Path of Wave drop-down list, you cannot select any regeneration site to force a
path. Similarly, if you select a regeneration site, you cannot force a path for the wave. However, if you want to force
a fiber, select the fiber from the Path of Wave drop-down list available under the section properties.

5. If required, select the wavelength of each section in the properties for non-SSON network.

Note

For the SSON network, you can select the wavelength only at the trial level.

6. Click Update.
Whenever a regeneration site is created, a new section is added along with the existing section under the trail.
Regeneration can be performed using any two cards back-to-back or with a dedicated regenerator card.

7. Click Analyze to analyze the network.
After analysis, if you click trail or section in the network tree, the map highlights the trail in orange color and the section
in green color.
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Note

You can assign different wavelengths for different sections. TheWavelength property under trail is denoted as
"*", when different wavelengths are assigned for different sections.

You can also add a regeneration site when you are designing a new network or upgrading a network.

Multidegree ROADM
Describes the functionality of multidegree ROADM. Explains the specific benefits and underlying principles of this essential
feature for improving overall system efficiency and operational management.
A multidegree ROADM is a network node configuration that
• enables a site to connect to two or more fiber spans,

• allows flexible routing of wavelengths across multiple paths in a mesh network, and

• supports higher degrees than simpler ROADMs, which typically connect only two directions.

You can design a multidegree ROADM configuration in Cisco ONP using cascaded SMR .

Design a multidegree ROADM site using cascaded SMR
Teaches you how to design a multidegree ROADM site using cascaded SMR. Use this procedure to design a multidegree
ROADM site in your network, using cascaded SMR modules.
Use this procedure to design a multidegree ROADM site in your network, using cascaded SMR modules.
When designing a multidegree ROADM site using cascaded SMR, be aware of these limitations:
• The configuration only supports contentionless add/drop demands.

• Layer-2 SMR is supported only for the SMR-20 card.

Log in to the Cisco ONP web interface on page 17.
1. Design a network. For detailed instructions, see the Manually design a network using Cisco ONP on page 32 task.
2. Modify these site properties.

• Set the Structure to Multidegree in the C Band section.

• Set the Site Type to SMR-20 in the C Band section.

• Set Degree Mesh Type to Auto or to DEG-5/UPG-4 in the C Band section.

• Check the Evolved Mesh and Cascaded SMR check boxes in the General section.

• Set theMpo16TOMpo8 to MPO16To2MPO8 cable in the General section.

3. Add a contentionless side to the site. For detailed steps, see the Add contentionless side to a site on page 168 task.
4. Modify the number of contentionless side ports for the site as needed. For detailed steps, see the Modify the number

of contentionless side ports at a site on page 171 task.



5 Configure a Network

Provides step-by-step procedures for configuring various network functionalities,
including colorless, colored, and contentionless options, across Cisco NCS 1000

Topics:

• Configure an NCS 2000 network for
contentionless functionality

and 2000 platforms using the Cisco ONP web interface. Users can effectively
design and analyze optical networks, manage transponder aggregation, and
integrate specific hardware components for optimized performance.• Configure an NCS 2000 network for

colorless functionality



Table 127: Feature History

Feature DescriptionRelease InformationFeature Name

• Configure an NCS 2000 network for
colored functionality

• Configure a network with mixed
Add/Drop multiplexers and
demultiplexers Cisco ONP Release

25.1.1
MOLS 2.0 Support

• Configure an NCS 1010 network for
colorless functionality

• Configure an NCS 1010 network for
colored functionality

• Configure an NCS 1010 network
with mixed add/drop multiplexers
and demultiplexers

• Configure an NCS 1010 C+L-Band
network with mixed Add/Drop
multiplexers and demultiplexers

• Configure an NCS 1010 network for
Omnidirectional functionality

• Configure an NCS 1001 network for
colored functionality

• Configure an NCS 1014 network for
colored functionality

• Configure an NCS 1001/1010/1014
networkwithNCS 1000 transponders

• Configure an NCS 2000 network
with NCS 1000 transponders
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Feature DescriptionRelease InformationFeature Name

CONP now supports the
latest Metro DCI Open
Line System, MOLS 2.0,
which is hosted on the
NCS 1014 chassis. This
includes support for:
• new EDFA amplifier

that hosts
• a new OTDR

pluggable
(ONS-QSFP-OTDR),

• a new coherent
probe pluggable
(DP01QSDD-ZT5-A1),
and

• an existing OSC
pluggable
(ONS-SC-PTP-1510),
and

• a pair of new
32-channel colored
add/drop passive
modules
• NCS1K-MD-32O-CE

• NCS1K-MD-32E-CE

Select the NCS 1014
platform during network
creation to create MOLS
2.0 networks. You can
design the new MOLS
2.0 networks through the
properties.
• Probe Channel and

OTDR Pluggable at
the nework level,

• OSC Pluggable
property at the edge
level,

• the MOLS 2.0
colored add/drop
modules (default
option is odd + even
cards) at add/drop
level, and

• noneditable Pre Amp,
Pre PSD, Second
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Feature DescriptionRelease InformationFeature Name

Booster, Second
Booster PSD at the
C-band amplifier
level.
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Feature DescriptionRelease InformationFeature Name

Cisco ONP Release
25.1.1

Transponder Aggregation
Service
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Feature DescriptionRelease InformationFeature Name

This release introduces
the transponder
aggregation service,
which provides
comprehensive support
for transponder service
aggregation across NCS
1000 line cards on all L0
platforms. Key features
include:
• Support for

transponder service
creation and
network-wide
analysis, considering
transponder services
in both greenfield and
brownfield
deployments.

• Compatibility with
NCS 2000, NCS
1001, NCS 1010,
and NCS 1014
platforms, with
specific add/drop
support for each
platform.

• Force update the
transponder
properties, with
support for service
control, property
override, and UI
configurations.

• Update Optical,
Traffic, BOM,
Installation
Parameters, and
Cabling Reports to
include transponder
parameters.

• Placement of
transponder cards in
NCS1004 and
NCS1014 chassis,
with NFV view
including
Transponder
connections.

• Draw services
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Feature DescriptionRelease InformationFeature Name

between
ROADM/Terminal/Traffic
sites, force
transponder
properties, and view
updated BOM and
reports after network
analysis.

This chapter describes the various ways of configuring the network designed
through Cisco ONP .
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Configure an NCS 2000 network for contentionless functionality
Configure an NCS 2000 network for contentionless functionality, optimizing network resources and supporting flexible
service allocation.
Use this procedure to enable contentionless functionality within the NCS 2000 network, allowing for dynamic and automatic
channel assignment to support flexible network demands.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Add contentionless sides to the required sites. See Add contentionless side to a site on page 168.
3. Set the channel type for the demands:

a) In the Entity Editor window, click the Services tab.
b) Click the service connecting the site and set the Src Channel Type property as Auto or Contentionless. Then,

click the trail under the wave (for non-SSON) or Media Channel (for SSON) and set the Src Channel Type
property to Auto or Contentionless.

Note

Contentionless is the default option when you select Auto.

c) Click Update.
4. Analyze the network by choosing Network > Analyze.

Configure an NCS 2000 network for colorless functionality
Configure your NCS 2000 optical network to enable colorless functionality and support flexible service assignment.
This procedure guides you through the process of enabling colorless functionality in the NCS 2000 optical network,
allowing flexible channel assignment and efficient resource utilization.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the channel type for the demands:

a) In the Entity Editor window, click the Services tab.
b) Click the service connecting the site. Set the Src Channel Type property as Colorless. For non-SSON click the

trail under the wave. For SSON, click the Media Channel (for SSON). Set the Src Channel Type property as
Colorless.

c) Under theSite > Side properties, choose the Line type side fromwhich you want to create the colorless demand,
and enter the number of Colorless Ports.
From Release 24.3.1, you can select the colorless ports for the SMR-9 card.
The number of colorless ports for MF-6AD-CFS depends on theScalable Upto Degree property. See Colorless
ports for SSON and Non-SSON networks on page 273.

d) Click Update.
3. Under the C-Band properties, choose MF-6AD-CFS or Direct SMR as the Colorless Add/Drop.
4. Click Update..
5. Analyze the network by choosing Network > Analyze.

You can see the colorless Add/Drop unit getting added in the layout and BOM.
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Colorless ports for SSON and Non-SSON networks
Lists the maximum number of colorless ports supported on MF-6AD-CFS cards for different site types and scalability in
SSON and non-SSON networks.
This table explains the maximum number of colorless ports that can be added based on the Scalable Upto Degree
property for the MF-6AD-CFS card.
Table 128: Colorless ports for SSON and Non-SSON networks

Maximumnumber of colorless
ports for non-SSON

Maximumnumber of colorless
ports for SSON

Scalable upto
degree

Site type

72724SMR-20

72728SMR-20

242412SMR-20

242416SMR-20

9696LineSMR-20

96120TerminalSMR-20

Configure an NCS 2000 network for colorless functionality

Configure an NCS 2000 network for colored functionality
Configure colored functionality on an NCS 2000 optical network to support wavelength services.
This procedure guides you through the process of configuring colored functionality in an NCS 2000 optical network.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32 .
2. Set the channel type for the demands:

a) In the Entity Editor window, click the Services tab.
b) Click the service connecting the site and set the Src Channel Type property asColored. For non-SSON click

the trail under the wave. For SSON, click the Media Channel (for SSON). Set the Src Channel Type property
as Colored.

c) Click Update.
3. For an SSON network, complete these steps.

a) Under the C-Band properties, chooseMD-64-C as the Colored Add/Drop.

Note

MD-64-C is supported from NCS 2000 Release 12.x.

b) Click Update..
By default, the system addsMD-48-ODD orMD-48-EVENas theColored Add/DropwhenShare SMRPort
is not enabled.

Cisco Optical Network Planner | Updated March 10, 2026

| Configure a Network | 273



Note

If you chooseMD-48-EVEN orMD-48-ODD, select an even wavelength for theWavelength property under
Trail.

4. When Share SMR Port port is enabled, you can select the Colored Add/Drop by using these steps:
a) Under theC-Band properties, chooseMD-48-ODD,MD-48-EVEN, orMD-48-ODD+MD-48-EVEN as

the Colored Add/Drop.

Note

These Add/Drop units are supported from NCS 2000 Release 11.x.

b) Click Update.
5. Analyze the network by choosing Network > Analyze.

The colored Add/Drop unit appears in the layout and BOM.

Configure a network with mixed Add/Drop multiplexers and demultiplexers
Configure a network to support mixed wavelengths using combinations of colored, colorless, and contentionless Add/Drop
multiplexers and demultiplexers.
Use this procedure to enable support for advanced optical networking scenarios by combining different types of Add/Drop
(A/D) multiplexers and demultiplexers, allowing flexible wavelength management.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
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Table 129: Feature History

Feature DescriptionRelease InformationFeature Name

You can configure different functionalities
in the network created in Cisco ONP.
Mixed wavelengths such as colorless and
contentionless, colored and
contentionless, can be added/dropped on
the same side or direction. The following
mixed configurations are supported:
• Colored (MD-48-ODD/MD-48-EVEN)

and Contentionless (16-AD-CCOFS)
without shared SMR port

• Colored andContentionless (MD-64-C
and 16-AD-CCOFS)

• Colored (MD-64-C) and Colorless
(Direct SMR)

• Colored (MD-48) and Contentionless
(16-AD-CCOFS) with Shared SMR
Port

• Colorless and
MD-48-ODD/MD-48-EVEN

• Colorless and 16-AD-CCOFS

Cisco ONP Release 4.2Support for Mixed Add/Drop
Configuration

1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the properties of the network under the Entity Editor for different combinations of the functionalities, as described

in Supported and unsupported mixed configurations on page 275.

Note

You cannot mix the MF-6AD-CFS colorless configuration with any other configuration.

Supported and unsupported mixed configurations
Lists the mixed add/drop configurations that are supported and unsupported for SSON and non-SSON networks in Cisco
optical solutions.
This section describes the list of mixed configurations that are supported and unsupported by Cisco ONP.
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Table 130: Supported mixed Configurations

Properties to be setPossible mixed configurationsSupported
network type

• Add required number of contentionless sides.

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colored for one wave. Set the Src
Channel Type and Dst Channel Type
to beContentionless for the secondwave
created on the same site. Both wavelengths
must add/drop in the same side or direction.

• By default, MD-48-ODD or MD_48-EVEN is
added as the Colored Add/Drop in the BOM
and layout when you set theChannel Type
as Colored and when Shared SMR Port
is disabled.
By default, 16-AD-CCOFS is added in the
BOM and layout when you set the Channel
Type as Contentionless.

Colored (MD-48-ODD/MD-48-EVEN) and
Contentionless (16-AD-CCOFS) without shared
SMR port

Non-SSON

• Add required number of contentionless sides.

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colored for onemedia channel. Set theSrc
Channel Type and Dst Channel Type
to be Contentionless for the second
media channel created on the same site. Both
channels must add/drop in the same side or
direction.

• Colored Add/Drop―MD-64-C under the
side.

Colored and Contentionless (MD-64-C and
16-AD-CCOFS)

SSON

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colored for onemedia channel. Set theSrc
Channel Type and Dst Channel Type
to be Colorless for the second media
channel created on the same site. Both
channels must add/drop in the same side or
direction.

• Enter the number ofColorless Ports under
the Line Side properties.

• Colored Add/Drop―MD-64-C
Colorless Add/Drop―Direct SMR

Colored (MD-64-C) and Colorless (Direct SMR)SSON
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Properties to be setPossible mixed configurationsSupported
network type

• Add required number of contentionless sides.

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colored for one wave. Set the Src
Channel Type and Dst Channel Type
to beContentionless for the secondwave
created on the same site. Both wavelengths
must add/drop in the same side or direction.

• Check the Shared SMR Port check box,
under the Site properties.

• Colored Add/Drop―MD-48-ODD,
MD-48-EVEN, or MD-48-ODD and
MD-48-EVEN

• If you chooseMD-48-EVEN, make sure to
select an even wavelength for the
Wavelength property under Trail.

Colored (MD-48) and Contentionless
(16-AD-CCOFS) with Shared SMR Port

Non-SSON

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colorless for the wave.

• Enter the number ofColorless Ports under
the Line Side properties.

•
•
• By default, MD-48-ODD/MD-48-EVEN is

added as colored Add/Drop in the BOM and
layout, when any colored demand is added in
the non-SSON network.

Colorless and MD-48-ODD/MD-48-EVENNon-SSON

• Add required number of contentionless sides.

• Channel Type―Set the Src Channel
Type and Dst Channel Type to be
Colorless for the wave or media channel.

• Channel Type―Colorless for one wave
and Contentionless for another wave
created on the same site. Both wavelengths
must add/drop in the same side or direction.

Colorless and Contentionless (16-AD-CCOFS)SSON

Table 131: Unsupported mixed configurations

Mixed configurationsNetwork type

Colored (MD-64-C) and Colorless (MF-6AD-CFS)SSON

Contentionless and Colorless (MF-6AD-CFS)SSON
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Mixed configurationsNetwork type

Colored (MD-64-C), Contentionless, and Colorless
(MF-6AD-CFS)

SSON

Colored (MD-64-C) and Layer-2 ContentionlessSSON

Contentionless and Colorless (MF-6AD-CFS)Non-SSON

Colored (MD-48) and Colorless (MF-6AD-CFS)Non-SSON

Colorless (Direct SMR) and Colorless (MF-6AD-CFS)Non-SSON

Colored, Contentionless, and Colorless (MF-6AD-CFS)Non-SSON

Note

Different Add/drop functionalities (Colored, Colorless, or Contentionless) at Source and Destination is not supported.

Configure an NCS 1010 network for colorless functionality
Configure colorless functionality on NCS 1010 network devices to support flexible add/drop operations.
Use this procedure to configure the colorless functionality in an NCS 1010 network.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32 .
2. Set the channel type for the demands.

a) In the Entity Editor window, click the Services tab.
b) Click the trail under the circuit, set the Src Channel Type property to Colorless.
c) Click Update.

3. Under the C-Band properties, choose BRK-8, BRK-16, or BRK-24 as the Colorless Add/Drop.
The Maximum number of colorless ports depends on the scalable upto degree. See Colorless ports for NCS 1010
networks on page 279.
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Note

Colorless configuration is not supported for scalable upto degree 31.

Note

NCS1K14-CCMD-16 add/drop is not supported with OLT standard faceplate.
Enhanced OLT add/drop ports AD-2 and AD-3 are not used for Direct LC (Direct Optical Source or Transponder)
connection. MD-32-ODD connects to AD-2 and MD-32-EVEN connects to AD-3 ports.

4. Click Update.
5. Analyze the network by choosing Network > Analyze.

The colorless Add/Drop unit is added in the layout and BOM.

Colorless ports for NCS 1010 networks
Lists the maximum number of colorless ports supported by NCS 1010 networks based on scalable up to degree and MPO
port usage.
This section describes the maximum number of colorless ports based on the scalable up to degree.
Table 132: Colorless ports for NCS 1010 networks

Maximum number of colorless ports supportedMPOport used for
degree
interconnect

Scalable upto
degree

BRK-8BRK-16BRK-24

24487247

22446619

1632483, 415

1428421, 217

816242, 3, 423

612181, 2, 325

0001, 2, 3, 431

306090NATerminal

2448724Line
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Configure an NCS 1010 network for colored functionality
Configure colored functionality in an NCS 1010 optical network by specifying demand channels and adding NCS 1000
Add/Drop units.
Use this procedure to configure the colored functionality in an NCS 1010 network.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the channel type for the demands:

a) In the Entity Editor window, click the Services tab.
b) Click the trail under the circuit and set the Src Channel Type property as Colored.
c) Click Update.

3. Under theC-Band properties, chooseMD-32-EVEN, MD-32-ODD, or MD-32- ODD+MD-32-EVEN as theColored
Add/Drop.

4. Click Update.
5. Analyze the network by choosing Network > Analyze.

The colored Add/Drop unit appears in the layout and the BOM.

Configure an NCS 1010 network with mixed add/drop multiplexers and demultiplexers
Configure mixed wavelength add/drop channels using multiplexers and demultiplexers in an NCS 1010 network.
Use this procedure to configure mixed wavelengths in an NCS 1010 network:
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the properties under the Entity Editor for different combinations of the functionalities.

For example, set the source Add/Drop Type and destination Add/Drop Type to Colored for one circuit. Set the
Src Channel Type and Dst Channel Type to Colorless for the second circuit created on the same site. Both
channels must add or drop in the same side or direction.
You can select any combination of colored or colorless add/drop channels.

Note

When the Scalable Upto Degree is 31, you cannot use the colorless configuration. Therefore, you cannot use
mixed configuration when Scalable Upto Degree is set to 31.

Configure an NCS 1010 C+L-Band network with mixed Add/Drop multiplexers and
demultiplexers

Configure mixed wavelengths in an NCS 1010 C+L-Band network using colored and colorless add/drop multiplexers and
demultiplexers.
Use this procedure to configure mixed wavelengths in an NCS 1010 C+L-Band network:
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
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1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the properties under the Entity Editor for different combinations of the functionalities.

For example, set the sourceAdd/Drop Type and destinationAdd/Drop Type toColored orColorless for the
C-band circuit. Set Band Type to L-band for the second circuit that is created on the same site. Both channels
must add/drop on the same side or in the same direction.
You can choose any combination of colored or colorless add/drop for C-band circuits. However, for L-band circuits,
colorless add/drop is the default value.

Note

WhenScalable Upto Degree is 31, only C-band colored configuration is supported. You cannot create colorless
if all colorless ports are exhausted, so a mixed configuration is not supported for Scalable Upto Degree 31.

Configure an NCS 1010 network for Omnidirectional functionality
Configure omnidorectional functionality in an NCS 1010 optical network by specifying demand channels and adding NCS
1010 Add/Drops.
Use this procedure to configure colored and colorless omnidirectional functionalities in an NCS 1010 network:
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32 .
2. Add Omnidirectional sides to the required sites. See Add omni-directional sides to a site on page 173. You can also

use theMax Auto Omni Allowed property under the network properties. When you enter a number, Cisco ONP
automatically generates the same number of Omni Edges and runs the analysis.

3. Select the Omni variant and type of omnidirectional add/drop stage.
a) In the Entity Editor window, click the Sites tab.
b) Choose the omnidirectional side under the required site, and set these properties.

Omni Variant: Select the type of omni variant as Dual OLT or 4x4 COFS. The available options are:
Omni Directional Ports: Enter the number of omnidirectional ports.

4. Select the type of omnidirectional add/drop stage.
a) In the Entity Editor window, click the Services tab.
b) Choose the required service and set the Src Add/Drop Type and Dst Add/Drop Type as omni-colored or

omni-colorless.
c) Choose the trail under the service, and set the Add/Drop Type as omni-colored or omni-colorless.

5. Click Update.
6. Analyze the network by choosing Network > Analyze.

You can see the Omni Add/Drop unit getting added in the layout and BOM.

Configure an NCS 1001 network for colored functionality
Configure colored functionality in an NCS 1001 optical network by specifying demand channels and adding NCS 1000
Add/Drop.
This procedure guides you through the process of configuring colored functionality in an NCS 1001 optical network.
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Log in to the Cisco ONP web interface on page 17 as a user with the admin role.

Note

Deployment of more than two OLA nodes between two Terminal Sites is not supported.

1. Create a network design. See Manually design a network using Cisco ONP on page 32 .
2. Set the channel type for the demands:

a) In the Entity Editor window, click the Services tab.
b) Click the trail under the circuit and set the Src Add/Drop Type property as Colored.
c) Click Update.

3. Under the C-Band properties, choose MD-32-EVEN, FLD-4, MD-48-ODD, MD-48-EVEN,
MD-48-ODD+MD-48-EVEN, or MD-64 as the Colored Add/Drop.

4. Click Update.
5. Analyze the network by choosing Network > Analyze.

The layout and BOM display the added colored Add/Drop unit.

Configure an NCS 1014 network for colored functionality
Configure colored functionality in an NCS 1014 optical network by specifying demand channels and adding NCS 1000
transponders.
Use this procedure to configure colored functionality in an NCS 1014optical network.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.

Note

Deployment of more than two OLA nodes between two terminal sites is not supported.

1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the channel type for each demand.

a) In the Entity Editor window, click the Services tab.
b) Click the trail under the circuit and set the Src Add/Drop Type property as Colored.
c) Click Update.

3. Under theC-Band properties, select MD-32-EVEN, MD-32-ODD, or MD-32- ODD+MD-32-EVEN as theColored
Add/Drop.

4. Click Update.
5. Analyze the network by choosing Network > Analyze.

The colored Add/Drop unit is added in the layout and BOM.
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Configure an NCS 1001/1010/1014 network with NCS 1000 transponders
Configure an optical network by adding NCS 1000 transponders to an NCS 1001, NCS 1010, or NCS 1014 system.
Use this procedure to add NCS 1000 transponders to an NCS 1001, NCS 1010, or NCS 1014 optical network.

Note

NCS 1000 transponders with colored add/drop funtionality do not support all trunk and baud rate combination.

Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.
2. Set the TXP Chassis and Card type for the transponders.

a) In the Entity Editor window, click the Service tab.
b) At the service level, set the Client Type.
c) Select the Band Type.
d) At the circuit or media channel level, set Traffic Type as Transponder Card.

At the trail level, Card Type and TXP Chassis properties appear.
e) Click the trail under the sections, and then set the TXP Chassis and Card Type properties.
f) Click the service and set the TXP Chassis and Card Type properties.

Refer to this table for the required chassis and card type.
Table 133: Supported transponders

Card TypeTXP Chassis

• Auto

• NCS1K14-2.4T-K9

• NCS1K14-2.4T-X-K9

• NCS1K4-QXP-K9

• NCS1K14-1.2T-K9

• NCS1K14-2.4T-A-K9

• NCS1K4-2-QDD-C-K9

NCS 1014

• Auto

• NCS1K4-QXP-K9

• NCS1K4-OTN-XP

• NCS1K14-1.2T-K9

• NCS1K4-2-QDD-C-K9

NCS 1004

g) Set the relevant properties. See Supported transponders and their trunk modes.
h) Click Update.
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3. Under the C-Band properties, select the required multiplexer and demultiplexer.
4. Click Update.
5. Analyze the network by choosing Network > Analyze.

Configure an NCS 2000 network with NCS 1000 transponders
Configure your NCS 2000 optical network by adding NCS 1000 transponders using Cisco Network Planner.
Use this procedure to add NCS 1000 transponders to an NCS 2000 optical network.
Log in to the Cisco ONP web interface on page 17 as a user with the admin role.
1. Create a network design. See Manually design a network using Cisco ONP on page 32.

a) Enable the SSON Network check box and choose Traffic type as NCS (4K_1K_2K).
b) In the design palette, use the drawing tool to add traffic sites to the network.

2. Set Traffic Site and Traffic Type.
a) In the Entity Editor window, click the Site tab and expand the sites.
b) Select a site.

On the right pane, the General tab opens.
c) Under the General tab, set Type as Traffic and Traffic Type as 1K-2K.

3. Set the TXP Chassis and Card type for the transponders.
a) In the Entity Editor window, click the Service tab.
b) At the circuit or media channel level, set Traffic Type as Transponder Card.

At the trail level, Card Type and TXP Chassis properties appear.
c) Click the trail under the sections, and then set the TXP Chassis and Card Type properties.
d) Click the service and set the TXP Chassis and Card Type properties.

Select the required chassis and card type as mentioned in this table.
Table 134: Supported transponders

Card TypeTXP Chassis

• Auto

• NCS1K14-1.2T-K9

• NCS1K14-2.4T-A-K9

• NCS1K4-2-QDD-C-K9

• NCS1K14-2.4T-K9

• NCS1K14-2.4T-X-K9

• NCS1K4-QXP-K9

NCS 1014

• Auto

• NCS1K4-QXP-K9

• NCS1K4-OTN-K9

• NCS1K14-1.2T-K9

• NCS1K4-2-QDD-C-K9

NCS 1004
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e) Click Update.
4. Under the C-Band properties, choose the required multiplexer and demultiplexer.
5. Click Update.
6. Analyze the network by choosing Network > Analyze.

Cisco Optical Network Planner | Updated March 10, 2026

| Configure a Network | 285





6 View Network Reports

Explains how to access and interpret network reports within Cisco ONP, including
dashboard summaries, bills of materials, optical results, and cabling

Topics:

• Network reports configurations. Users can leverage these tools to analyze network performance,
• View the results of analyzed network evaluate sustainability metrics, and generate detailed documentation for

deployment and debugging.• Confidential banner in exported
reports



Table 135: Feature History

Feature DescriptionRelease InformationFeature Name

• Edit the Unique ID of the chassis
• Export the Link Availability report
• View details of layout and internal

connections
Cisco ONP Release
24.3.1

Deployability and
Debuggability
Enhancements
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Feature DescriptionRelease InformationFeature Name

Cisco ONP enhances the
debuggability and
deployability of the
network with the
following improvements
in Optical sources, and
various reports available
in the Results page:
• Optical Sources:

Including new optical
parameters such as
vendor name, vendor
ID, and submode in
the downloaded
optical souce Excel
file to improve
inperoperability with
Cisco Optical
Network Controller.

• BOM: The exported
Excel file includes
these updates:
• Sales BOMSheet:

Providing
information
tailored for sales
personnel.

• Net BOM Sheet:
Providing the
site-wise BOM
count and
categories of
elements such as
Chassis,
Controllers,
Mux-Demux
units, Line Cards,
Fillers, and more,
offering a
comprehensive
overview of all
network elements
in the analyzed
network.

• IPC:
• Consolidating the

IPC Cabling
Report and the
IPC Patch Report
into a unified view
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Feature DescriptionRelease InformationFeature Name

with additional
columns,
streamlining
connection details
and eliminating
the need to
access multiple
sources.

• Highlighting
patches when
clicked.

• Optical Reports:
Filtering results by
any column available
in the report for more
precise data analysis.

• Elements >
Messages:
Providing links to
navigate to the
respective object in
the network tree,
allowing users to take
the necessary action
to correct errors.
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Table 136: Feature History

DescriptionRelease InformationFeature Name

Cisco ONP now provides
a simplified approach to
navigate to the Results
tab to view reports for
analyzed multinode
network topologies with
the following
enhancements:
• Click the Ellipsis

icon available in the
right side of a
particular site in the
network tree to view:
• BOM details

• Optical Reports

• Click the Ellipsis
icon available in the
right side of a
particular
circuit/media/wave in
the network tree to
view:
• Optical Report

• Traffic Report

• New IPC tab —The
IPC tab is introduced
inCablingReports
to intuitively view the
internal patch
connections for a
site.

• Search Box—The
Results tab is
enhanced with a
Search Box at the
top. You can use this
search box to find a
particular site in the
topology by entering
the site name.

Cisco ONP Release 5.1Simplified Navigation to
Results Tab
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Network reports
Describes the functionality of viewing network reports. Explains how the home page provides multiple tabs to access and
analyze reports for specific sites, fibers, and wave properties.
The Cisco ONP home page has multiple tabs to access the reports of the analyzed network. You can also view the reports
for specific site, fiber, or wave properties by clicking the respective report in the Network Tree pane. The tabs are:
• Dashboard

• Elements

• Map

• BOM

• Layout

• Results

View reports in the Dashboard tab
Teaches you how to view reports in the Dashboard tab. Instructs you on accessing the sustainability report to continually
monitor the environmental impact of your deployment.
Log in to the Cisco ONP web interface on page 17.
Enable Sustainability report on page 293 to view the sustainability report.
Table 137: Feature History

Feature DescriptionRelease InformationFeature Name

The Sustainability Insights tab in the Cisco ONP
Dashboard presents these sustainability metrics for a
network designed in Cisco ONP:
• Energy Consumption Distribution (kWh)

• CO2 Emission (Kg)

• Energy Efficiency (kWh/GHz)

• CO2 Emission Equivalent: This shows the number of
miles traveled by a car, bus, and airplane that would
produce the same amount of CO2 emissions.

• Number of Trees Needed: Indicates the number of
trees that would need to be planted to absorb the
network's carbon emissions.

This report helps you understand the environmental impact
of the optical networks you design.

Cisco ONP Release 25.1.1View sustainability report

From Release 25.1.1, Cisco ONP uses the Energy Management Capability (EMC) API to display sustainability reports.
The EMC API calculates sustainability metrics by considering the power consumption and the geographical location of
the site. See Formulas for sustainability calculation on page 293 to know how the EMC API does the calculation.
Follow these steps to view various reports of an analyzed network under the Dashboard tab.
1. Open the analyzed network for which you want to view the network summary.
2. Click the Dashboard tab.

Cisco Optical Network Planner | Updated March 10, 2026

| View Network Reports | 292



By default, the Network Summary tab will appear and display this information about the network:
• Total count of sites

• Total count of fibers

• Total count of SRLGs (Shared Risk Link Groups)

• Total count of services

• Total count of waves/media channels/circuits

• Total count of messages

3. Click the Sustainability Insights tab to view the sustainability metrics for a network designed in Cisco ONP.
• Energy Consumption Distribution (kWh)

• CO2 Emission (Kg)

• Energy Efficiency (kWh/GHz)

• CO2 Emission Equivalent: This shows the number of miles traveled by a car, bus, and airplane that would produce
the same amount of CO2 emissions.

• Number of Trees Needed: Indicates the number of trees that would need to be planted to absorb the network's
carbon emissions.

a) Click the Bypass EMCAPI radio button to display default values for the metrics regardless of the site's location
or its power consumption.

Enable Sustainability report
Teaches you how to enable the sustainability report. Instructs you on configuring the necessary settings to accurately
track and analyze environmental impact metrics.
Use this task to enable the Sustainability Insights tab under the Cisco ONP Dashboard.
1. Log in to the server where Cisco ONP is installed.
2. Use the cd command to go to the cnp directory and then to the conf directory.

root#cd /opt /cnp / conf

3. use the vi feature.properties command to open the feature.properties file in the vi editor.

root:/opt/cnp/conf# vi feature.properties

4. Edit the file.
a) Change SustainabilityInsights.enabled=false to SustainabilityInsights.enabled=true.
b) Press the w and q keys to save and exit the vi editor.

:wq

View reports in the Dashboard tab on page 292

Formulas for sustainability calculation
Provides guidelines for the formulas for sustainability calculation. Lists the essential reference information explaining how
the EMC API calculates vital sustainability metrics.
The EMC API calculates sustainability metrics using these formulas:
1. Energy Consumed (kWh)

Cisco Optical Network Planner | Updated March 10, 2026

| View Network Reports | 293



Formula:
EnergyConsumed = PowerUtilizedByNode * ObservationPeriodicity / 60
PowerUtilizedByNode: The total power consumed by the optical node (in Watts).
ObservationPeriodicity: The observation duration, fixed at 300 seconds (approximately 5 minutes).

2. Carbon Emission (kg)
Formula:
CarbonEmission = EnergyConsumed * CarbonIntensity
CarbonIntensity: The value obtained from the EMC API. If the EMC API does not return a value, a default constant
value of 442 is used.

3. Energy Efficiency (kWh/GHz)
Formula:
EnergyEfficiency = EnergyConsumed / TrafficServed
EnergyConsumed: The result from the first formula.
TrafficServed: The total traffic passing or reserved in the network

View reports in the Elements tab
Teaches you how to view reports in the Elements tab. Instructs you on evaluating comprehensive insights into network
elements and associated messages.
Log in to the Cisco ONP web interface on page 17.
The Elements tab provides comprehensive reports of network elements and any associated messages.
Follow these steps to view the network elements report and messages.
1. Open the analyzed network for which you want to view the network summary.
2. Click the Elements tab.

You can view the reports described in this table.
Table 138: Reports under Elements

DescriptionReport

Shows the site information, which consists of the name of the sites, their types,
and their X and Y coordinate values.

Sites

Shows the information about the fiber length between the source and the destination
for the corresponding sites.
You can sort and filter the fiber details available in each column of the table.

Fibers

Shows the service type, source and destination sites for particular service, quantity,
protection type, and status.
For each service, the report shows the primary path, secondary path, and their
status.

Services
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DescriptionReport

The Waves report shows the number of waves available in the network and the
wave utilization. Click each wave to view the following details:
• Wave: Consists of a wave UID and its source and destination sites.

• Wave Details: Provides details of wave OSNR, channel path, OTN services
associated to wave and excluded channels.

• Channels: Port details of the source and destination cards, the wavelength that
is used, and its utilization demands.

• Optical Results: Provides details of optical parameters such as OSNR, SOL,
EOL, power margin, CD, and PMD.

Waves

Lists the names of created SRLGs and their fiber details. Click Export at the bottom
to export the report in .xlsx format.

SRLGs

Shows messages that relate to errors that occurred while analyzing the network.
By default, only critical messages for the analyzed network are listed here. You
can disable the Critical Only toggle button to view all messages.
Click the link in the Target column to navigate to the respective object in the network
tree and take the necessary action to correct the error.

Messages

3. Click each tab to view the respective report.
4. Click the Pop-up icon to view the reports in a larger, resizable window.

View details of the BOM report
Teaches you how to view details of the BOM report. Instructs you on accessing and analyzing billing of materials information
to accurately assess network equipment.
Log in to the Cisco ONP web interface on page 17.
Table 139: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to perform the
following:
• Compare the BOMs of two or more

LNI imported networks.

• Upgrade brownfield network.

• Upgrade the Cisco ONP network
with traffic sites.

Cisco ONP Release 4.1MLP Brownfield with Diff BOM

The Bill of Materials (BOM) report includes these components:
• Detailed price lists for each site.

• Categories of elements such as Chassis, Controller, Mux-Demux, Line Card, Filler, and more.

• The overall BOM for the entire network.
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Follow these steps to view the BOM report for an analyzed network.
1. Open the analyzed network for which you want to view the BOM.
2. Click the BOM tab.

The BOM details are displayed.
To view the BOM details for OTN and DWDM separately, click each site. See Licensed PIDs available in the BOM report
on page 296for the list of licensed PIDs added into the BOM report.
See for the list of licensed PIDs added into the BOM report.

3. View the BOM details for any particular site.
a) In the network tree, expand Site and click the Ellipsis icon available in the right side of the required site.
b) Click Open BOM

Cisco ONP opens the BoM tab and provides the BoM details of the selected site.
c) Expand the Site to view the PID information.

4. Click Export to export the BOM details in the form of a spreadsheet, and save it into your local system.
We recommend that you export the BOM report only in analyze mode. Exporting the reports in the upgrade and release
upgrade modes may lead to inaccuracies..
From Release 24.3.1, the exported Excel file includes these updates:
• Sales BOM Sheet: Contains information tailored for sales representatives.

• Net BOM Sheet: Now includes the sitewide BOM count, providing a comprehensive overview of all network
elements in the analyzed network.

5. Compare the BOM of the existing network with other networks:
a) Click Compare with: Other Networks.
b) From the Other Networks dialog box, choose the network that you want to be compared with.
You can view both BOM reports displayed on the same page for comparison.

6. Use the Search box on top of the BOM reports to search for any specific site or wave in the reports.
a) Enter the name of the specific site or wave in the Search box.
b) Choose equals or contains from the drop-down list.
c) Click the Search icon to search for the required site or wave.

Licensed PIDs available in the BOM report
Provides guidelines for the licensed PIDs available in the BOM report. Lists the essential reference information regarding
new licensing PIDs introduced with each platform release.
Cisco ONP introduces new licensing PIDs with each platform release to incorporate the latest updates and features.
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Table 140: Feature History

Feature DescriptionRelease InformationFeature Name

The following new licensed PIDs for the
SMR-20 card are displayed on the
BOM page so that you can view the
price details and consider ordering.
• NCS2K-FSSMR-2LIC=

• E-NCS2K-1P-LIC=

• E-NCS2K-5P-LIC=

• E-NCS2K-10P-LIC=

Cisco ONP Release 4.2Support for NewPIDs for SMR-20Card

This table lists the licensed PIDs included in the BOM report for different Cisco ONP releases.
Table 141: Licensed PIDs added to BOM report

PIDs and descriptionPlatformCisco ONP release supported
from

• NCS2K-FSSMR-2-LIC= :
20-port FS-SMR licensed to enable
two ports

• E-NCS2K-1P-LIC= : Software
license to enable one port on
licensed 20-port FS-SMR

• E-NCS2K-5P-LIC= : Software
license to enable five ports on
licensed 20-port FS-SMR

• E-NCS2K-10P-LIC= : Software
license to enable ten ports on
licensed 20-port FS-SMR

NCS 20004.2

• NCS1K10-ATO= : NCS 1010
ATO

• SF-NCS1K10-7111K9S= :
Software license to download the
COSM NETCONF XML file for the
COSM UI.

• NCS1K4-CCMD-C= : 16-port,
C-Band Colorless Coherent
Multiplexer/Demultiplexer with an
EDFA

• NCS1K4-CCMD-L= : 16-port,
L-Band Colorless Coherent
Multiplexer/Demultiplexer with an
EDFA

NCS 1010 from Release 7.11.15.2
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PIDs and descriptionPlatformCisco ONP release supported
from

• NCS1020-SA= : NCS1020Shelf
Assembly

• NCS1020-FAN= : NCS1020Fan
for NCS 1014 Slots

• NCS1020-FAN-BLANK= : NCS
1020 Fan Blank

• CWDM-SFP-1510=: CWDM
1510 NM SFP Gigabit Ethernet and
1G/2G FC

• CWDM-SFP-1610=: CWDM
1610 NM SFP Gigabit Ethernet and
1G/2G FC

• ONS-SC-Z3-1510=: SFP -
OC48/STM16/GE, CWDM, 1510
nm, Commercial Temp

• ONS-SC-Z3-1610=: SFP -
OC48/STM16/GE, CWDM, 1610
nm, Commercial Temp

• ONS-SE-155-1510= : SFP -
OC3/STM1 CWDM, 1510 nm, EXT

NCS 1020 from Release 24.3.1
NCS 1001 from Release 7.10.1

24.3.1

NCS 1014 transponder cards from
Release 24.3.1.
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PIDs and descriptionPlatformCisco ONP release supported
from

• S-NCS1K14-L-100U= : NCS
1014 100G Client Capacity Smart
License - 400-600

• S-NCS1K14-L-100L= : NCS1014
100G Client Capacity Smart
License - 700-900

• S-NCS1K14-L-100M= : NCS
1014 100G Client Capacity Smart
License - 1T-1.2T

• NCS1K14-2.4T-K9= : Network
Convergence System 1014 2.4T
Line Card

• NCS1K14-2.4T-X-K9= :
Network Convergence System
1014 2.4T-X Line Card

• NCS1K4-OTN-XP=: NCS1004
4x DDQSFP56, 6x QSFP28, 2
CFP2 DCO OTN Xponder

• NCS1K4-OTN-XPL=:
NCS1004 OTN Xponder Licensed

• NCS1K4-1.2T-K9=: NCS1K4
12x QSFP28 2 Trunk C-Band
DWDM card

• NCS1K4-1.2T-L-K9=: NCS1K4
12x QSFP28 2 Trunk C-Band
DWDM card - Licensed

• NCS1K4-QXP-K9=: NCS1004
3.2T QSFP-DD DCO Transponder

• NCS1K4-QXP-L-K9=:
NCS1004 3.2T QSFP-DD DCO
Licensed Transponder

• NCS1K4-QXP-K9= : NCS1004
3.2T QSFP-DD DCO Transponder

• ESS-TXP-SIA3 : Essential
Coherent DWDM interface SIA
36-59 months

• ESS-TXP-SIA5 : Essential
Coherent DWDM interface SIA
60-120 months

• ESS-TXP-RTU : Essential
Coherent line card interface RTU

• ADV-TXP-SIA3 : Advance
Coherent DWDM interface SIA
36-59 months
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PIDs and descriptionPlatformCisco ONP release supported
from

ADV-TXP-SIA5 : Advance
Coherent DWDM interface SIA
60-120 months

•

• ADV-TXP-RTU : Advance
Coherent line card interface RTU

Note

This is applicable only for the newly
designed and upgraded networks.

OAS-COSM-MLCL
OneCOSMPID is added for each active
card present in the chassis. If a chassis
slot is occupied with any active card
such as SMR, 16-AD, EDFA, RAMAN,
TXP, PSM cards, OLT, ILA,
NCS1K14-2.4T-K9,
NCS1K14-2.4T-X-K9, and
NCS1K4-QXP-K9, one license is
added for each occupied slot.

NCS 2000 with chassis models M6,
M15, M2
NCS 1004
NCS 1014
NCS 1010
NCS 1020

25.1.1

Cisco Optical Network Planner | Updated March 10, 2026

| View Network Reports | 300



PIDs and descriptionPlatformCisco ONP release supported
from

These licenses are added to the BOM,
with quantities determined by the
chassis. SIA and RTU licenses are
excluded from the BOM for the
Perpetual licensing model.
• TXP: E-NCS1K14-TXP-SW

• CCMD/EDFA:
E-NCS1K14-OLS-SW

• OLT: E-NCS1010-OLT-SW

• ILA: E-NCS1010-ILA-SW

The BoM includes Software licenses
for both the Smart licensed model and
the Perpetual model, with and without
Cisco Optical Site Manager, according
to the Cisco ONP Release, for the NCS
1010 and NCS 1014 chassis. See
Table 142: Licensed PIDs added to
BOM report based on the licensemodel
on page 302.

NCS 1010 (from IOS-XR Release
24.3.1)
NCS 1014 (from IOS-XR Release
25.1.1)

26.1.1

• NCS1K_LIC _TRUNK: Only
applicable for NCS1K4-QXP-K9
card.

• NCS1k4_100G: For
NCS1K4-1.2T-K9, for each 100G
port.

• S_NCS1k4_400G: For each
400G port of
NCS1K4-2-QDD-C-K9.

• S_NCS1k4_100G_ENC: For
each ODU4 controller of the
NCS1K4-1.2T-K9 card.

• S_NCS1K4_LH_LIC: Used for
NCS1K4-2-QDD-C-K9. number of
trunk ports on that slot that has bps
between 2 and 4.

• NCS1k4_400G_REGEN:
number of ports that are configured
in regen in each slot with 200G as
the trunk rate for NCS1K4-OTN-XP
card.

NCS 1014 and NCS 1004 (from
IOS-XR Release 25.1.1)

This table shows an example for Release 25.1.1. Similar PIDs will be added based on the Release version of NCS 1010
and NCS 1014.
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Table 142: Licensed PIDs added to BOM report based on the license model

NCS 1014NCS 1010Install with COSMLicensing ModelCisco ONP
Release

SF-NCS1K14-2511K9FSF-NCS1K10-2511K9FFalseSmart Licensed25.1.1

SF-NCS1K14-2511K9SSF-NCS1K10-2511K9STrue

SF-NCS1K14-2511K9PSF-NCS1K10-2511K9PFalsePerpetual

SF-NCS1K14-2511K9TSF-NCS1K10-2511K9TTrue

Export the Salesforce BoM report
Teaches you how to export the Salesforce BoM report. Instructs you on extracting billing of materials data in Salesforce
format to streamline procurement and inventory tracking.
Cisco ONP allows you to export BoM report in Salesforce format for an analyzed network.
Follow these steps to export BoM report in Salesforce format.
Log in to the Cisco ONP web interface on page 17.
View details of layout and internal connections on page 313
1. Analyze the network. See Analyze the network on page 65.
2. Choose Export > Salesforce BOM.

The Salesforce BoM report downloads as an excel sheet.
Open the excel sheet to check the network BoM details.

View the results of analyzed network
Teaches you how to view the results of an analyzed network. Instructs you on referring to optical results to correct
non-feasible channels and optimize configurations.
Log in to the Cisco ONP web interface on page 17.

Note

You can refer to the optical results data to check and correct the optically not feasible channels. You can modify the
network properties in the Upgrade and Release Upgrademodes. After making the necessary corrections, analyze again
to update the optical results based on the new modifications.

Follow these steps to view the details of optical reports, installation parameters, traffic reports, and cabling reports.
1. Open the analyzed network for which you want to view the optical results.
2. Click the Results tab on the Cisco ONP home page.

By default, the Optical Report tab appears. Each row in the tab shows the performance of one optical path. See
Optical Report on page 305.
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Note

From Release 24.1.1, you can view the multicarrier sites highlighted in the Optical Report tab, and organized
in the Installation Report tab.

To view the optical report for any particular optical path:
a) In the network tree, expand Circuits/Waves/Media Channels and click the Ellipsis icon available in the

right side of the required optical path.
b) Click Open Results.

The Cisco ONP opens the Optical Report tab and provides the details of the selected optical path.

c) Expand the optical path to view the wave and aggregated wave information for a selected circuit.
3. From the OSNR RBW drop-down list, select the OSNR Resolution bandwidth between 0.5 nm and 0.1 nm.

The default value is 0.5 nm. You can change it in Design mode, Analyzed mode, Upgrade mode, and Release upgrade
mode. When set to 0.1 nm, the SOL G-OSNR and EOL G-OSNR values increase to 7 dB.

4. Click the Installation Parameters tab.
The Installation Parameters report specifies the values to be provisioned at installation for each site in the network.
To view the installation parameters for Automatic Node Setup (ANS) and Automatic Node Provisioning (ANP), click
the respective tabs. See Installation parameters on page 307

5. Click the Traffic Report tab.
You can view the aggregated demand channel data in the form of the traffic reports. See Traffic reports on page 309.
In Release 5.1, you can view the traffic report for all imported networks except the imported .mpz networks. To view
the traffic report for individual optical path in imported .mpz networks, you must manually search in the Search box.
To view the traffic report for any particular optical path:
a) In the network tree, expand Circuit and click the Ellipsis icon available in the right side of the required optical

path.
b) Click Open Results.

The Cisco ONP displays the traffic report for the selected optical path.

Note

By default, Optical Result appears under the Results tab. Click Traffic Report to view traffic reports.

c) Expand the optical path to view the wave information.
6. Click the Cabling Report tab. See Cabling report on page 310

You can view the patch cord connections related to internal patch connections and multishelf management. This report
is available for the networks starting from NCS 2000 system Release 12.1.0.
To view the internal patch connections for any particular site:
a) In the network tree, expand Site and click the Ellipsis icon available in the right side of the required site.
b) Click Open Cabling Report.
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The Cisco ONP opens the Cabling Report tab. By default, the IPC tab appears and provides the IPC details of
the selected site.

c) To view the internal patch connections, expand the Site.
7. Use the Search box on top of the reports to search for any specific site or wave in the reports

a) Enter the name of the specific site or wave in the Search box.
b) Choose equals or contains from the drop-down list.
c) Click the Search icon to search for the required site or wave.

8. Click Export Report to export the optical reports details in an Excel sheet.
We recommend exporting the optical report only in analyze mode. Exporting reports in upgrade and release upgrade
modes may be inaccurate.

Compare installation parameters of two networks
Teaches you how to compare installation parameters of two networks. Instructs you on identifying configuration differences
to ensure consistency across multiple deployments.
Log in to the Cisco ONP web interface on page 17.
Table 143: Feature History

Feature DescriptionRelease InformationFeature Name

This feature improves the user
experience while comparing the
installation parameters and optical
reports of two networks.

Cisco ONP Release 4.1UI Revamp of Optical Reports

Use this task to compare the installation parameters of two networks.
1. Click the Results tab on the Cisco ONP home page.
2. Click Installation Parameters.
3. Click Other Networks.
4. From the list of networks, select the network with which to compare.

FInd a new parameter called diffBy.

5. To stop comparing the two networks, click Clear.
6. Click Export Report to export the comparison report.

Compare the optical reports of two networks
Teaches you how to compare the optical reports of two networks. Instructs you on following the necessary steps to
effectively benchmark network performance and configurations.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to compare the optical reports of two networks.
1. Click the Results tab on the Cisco ONP home page.
2. Click Optical Report.
3. Click Other Networks.
4. From the list of networks, select the network with which to compare.

The optical parameters display two values.

5. To stop comparing the two networks, click Clear.
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6. Click Export Report to export the comparison report.

Optical Report
Provides guidelines for the parameters in the optical results tab. Lists the essential reference information detailing how
to filter report results for more precise data analysis.
From Release 24.3.1, you can filter the results by any column available in the report for more precise data analysis. For
reports represented as colored icons, you can use the first letter of the color (e.g., "g" for green) to filter the results.
Table 144: Optical Report

Optical Parameter

Displays the ID number of the wave and aggregatedwaves.
ID is automatically generated based on the site name.

Name

Displays the protection type of the wave.Protection
Displays whether the path type is Protected or Working path
for NCS 1001.

Protection Type

Displays an icon indicating the results summary of the
analysis that is run with Start of Life (SOL) fiber loss values:
• Green indicates success.

• Yellow indicates success with a marginal failure risk.

• Orange indicates that the channel has a higher risk of
failure.

• Red indicates failure.

SOL

Displays an icon indicating the results summary of the
analysis that is run with End of Life (EOL) fiber loss values.
The indicator shows the optical performance for the path
at the end of the fiber life:
• Green indicates success.

• Yellow indicates success with a marginal failure risk.

• Orange indicates that the channel has a higher risk of
failure.

• Red indicates failure.

EOL

Indicates a system-related error that may impact the analysis
of the design. If the indicator is red, review the messages
that are reported at the end of the analysis or determine
which units or sites have a problem.

SE

Displays the present or forecast services indication.P/F
Displays the name of the source site and side; for example,
Site 1-E.

Source

Displays whether the colorless functionality is enabled on
source ports.

Src Colorless

Displays whether the contentionless functionality is enabled
on source ports.

Src Contentionless
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Optical Parameter

Displays the name of the destination site and side; for
example, Site 1-E.

Destination

Displays whether the colorless functionality is enabled on
destination ports.

Dst Colorless

Displays whether the contentionless functionality is enabled
on destination ports.

Dst Contentionless

Displays the wavelength of the optical channel.Wavelength
Displays the band type of the optical path.Band Type

Displays the type of DWDM unit or pluggable port module
that is used at the source of the specific Optical Channel
(OCH) trail. The class of the DWDM unit is also displayed.

Src Tx Type

Displays the type of DWDM unit or pluggable port module
that is used at the destination of the specific OCH Trail. The
class of the DWDM unit is also displayed.

Dst Tx type

Displays the total span length (source to destination) for this
path in kilometers.

Span

Displays the regeneration locations.Suggested Regen Locations
Displays the bit error rate (BER) target for this channel,
based on the capability of the channel’s optical interface.
It is 1.0E-15 for the interfaces using forward error correction
(FEC) and 1.0E-12 for interfaces without FEC.

BER Target

Displays the start of life average Optical Signal to Noise
Ratio (OSNR) value at the receiver.

SOL OSNR

Displays the end of life average OSNR value at the receiver.EOL OSNR
Displays the SOL OSNR margin calculation. It is the
difference between the OSNR value at certain power of the
working point of the receiver client and the working area
boundary.

SOL OSNR margin

Displays the EOL OSNR margin calculation, which is the
difference between the OSNR value at a certain power of
the working point of the receiver client and the working area
boundary.

EOL OSNR margin

Displays the SOL average power that is received at the
destination site in dBm.

SOL RX

Displays the EOL average power that is received at the
destination site in dBm.

EOL RX

Displays the SOL power budget margin at the receiver in
decibels. It is defined as the offset between the receiver
working point and the BER curve with margin. A positive
value indicates that there are no power problems.

SOL Power Margin

Displays the EOL power budget margin at the receiver in
decibels. It is defined as the offset between the receiver
working point and the BER curve with margin. A positive
value indicates that there are no power problems.

EOL Power Margin
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Optical Parameter

Displays the SOL overloadmargin at the receiver in decibels.
A positive value indicates that there are no overload
problems.

SOL Overload

Displays the EOL overloadmargin at the receiver in decibels.
A positive value indicates that there are no overload
problems.

EOL Overload

Displays the chromatic dispersion (CD) margin of the
demand.

Residual CD

Displays the robustness to chromatic dispersion of the
receiver.

CD robustness

Displays the status of alarms if any nonlinear effect (NLE) is
present in the demand.

Single-Channel NLE Status

Provides the status of the nonlinear effect (NLE) on a
particular channel or demand due to other channels or
demands.

Multi-Channel NLE Status

Displays the minimum Guard Band (GB) requirement
between channels on the 40G CP-DQPSK MXP and 40G
CP-DQPSK ME MXP cards, and other transponders in a
mixed any-to-any connectivity.

Min GB

Displays the value of the penalties that are caused by
different filter types (OADM, ROADM, and arrayed
waveguide grating (AWG)).

Filtering Penalty

Displays the calculated total Polarization Mode dispersion
(PMD) for each circuit. If the overall PMD for the link
overcomes the maximum that is allowed, the PMD value is
displayed in a red-colored font. Themaximum allowed value
depends on the client interface. For these special cases,
the network must be manually resolved by contacting a
Cisco TAC team.

PMD

Displays the attenuation at the input of the receiver.RX Atten

Displays the attenuation at the output of the receiver.TX Atten
Displays the encryption type of the channel. Possible values
are N/A, Yes, No.

Encryption

Installation parameters
Provides guidelines for the installation parameters. Lists the essential reference information for the ANS component to
ensure a successful and accurate deployment.
This table outlines the installation parameters for the ANS component.
Table 145: ANS Parameters

DescriptionParameter

Displays the name of the siteName

Displays the line sideSide
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DescriptionParameter

Displays the rack number, shelf number, and slot position
of the card where the patch cord originates.

Position

Displays the name of the card.Unit

Displays the port number where the patch cord originates.Port

Displays the port ID.Port ID

Displays the name of the port.Port Label

Displays the name of the parameter to be set, such as RX
Power Low, PSDShape, PSD, Gain, AmpliGainRange,
AddAttenuation, DropAttenuation, Control Mode,
MinExpSpanLoss, MaxExpSpanLoss, and so on.
For the CCMD-16 LC card connected to the ports of the
OLT-E-C, the PSD is set using a specific formula and the
VOA drop attenuation is set to 0dB to have optimal RX power
for the circuits.

Parameter

Displays the name of the value to be set for the parameter.Value

Displays the measurement unit for the related installation
parameter value, such as dBm.

Measurement Unit

Indicates with a Yes or No which parameters must be
manually set using the Cisco Transport Controller (CTC)
interface.

Manual Set

This table outlines the installation parameters for the ANP component.
Table 146: ANP Parameters

DescriptionParameter

Displays the name of the site.Name

Displays the unit (slot number) of the passive units in the
shelf.

Unit ID

Displays the shelf identifier.Shelf ID

Displays the rack number.Rack Number

Displays the rack position in the shelf.Rack Position

Displays the slot position in the shelf for the card.Slot Position

Displays the card type.Equipment Type

Displays the details of the card type.Description
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Traffic reports
Provides guidelines for the traffic reports. Lists the essential reference information concerning the aggregated data of
demand channels for the analyzed network.
This table displays the aggregated data of demand channel in the traffic report for the analyzed network.
Table 147: Traffic Reports

DescriptionTraffic report

Categorizes each demand type. Each demand is further
categorized into service, trails, and sections.

Demand

Displays the sections under every service.Section

Displays the site name for the optical channel source.Src Site

Displays the band type for the optical path.Band Type

Displays the rack, shelf ID, and slot identifiers for the source
of the optical channel.

Src Position

Displays the unit name for the optical channel source.Src Card

Displays the site name for the optical channel destination.Dst Site

Displays the rack, shelf ID, and slot identifiers for the
destination of the optical channel.

Dst Position

Displays the unit name for the optical channel destination.Dst Card

Displays the client service type of the demand; for example,
OC-48.

Client Service Type

Displays the protection type of the demandProtection Type

Displays whether the demand is encrypted with values: NA,
Yes, or No.

Encryption

Displays the wavelength value of the optical channel, and
the serial number of the wavelength in the wavelength band.

Wavelength
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DescriptionTraffic report

Displays the latency time for the current circuit. This value
includes all the latency components for the circuit, including
fiber and DWDM units on the path.
• Max latency calculation formulas for optical

source:
• For both colorless and colored demands, the delay

is calculated as: (Total Length of all Fiber used in
the demand) × 5 μs

• For contentionless demands, the formula is: (Total
Length of all Fiber used in the demand + 0.001) ×
5 μs
In this instance, an extra 0.001 is added to the
overall fiber length. This adjustment is necessary
because, during simulation, virtual fibers are
internally generated when contentionless or omni
sides are involved. The span length for these virtual
fibers is designated as 0.001, aminimal value, since
the span length cannot be configured to 0.

• Max latency for transponder cards:
The maximum latency for transponder cards includes
latency caused by client rate, trunk rate, client and trunk
pluggables, and the FEC type configured on the
transponder card, in addition to the maximum latency
calculated for the optical source.

Max Latency (for NCS 2000 network)
For Circuits with Optical source, Max latency is Fiber
Latency.

Cabling report
Provides guidelines for the connections and cabling reports. Lists the essential reference information for accessing
consolidated connection details, eliminating the need to consult multiple sources.
he IPC Cabling and Patch reports are consolidated into a single view with additional columns. This streamlines connection
details and eliminates the need to access multiple sources.
This table shows patch cord connections related to internal patch connections and multishelf management.
Table 148: IPC

DescriptionParameter

Displays the name of the site.Name

Displays the source unit.Src Unit Type

Displays the rack, shelf, and slot position of the card from
which the patch cord originates.

Src Position

Displays the name of the port.Src Port Label

Displays the assigned rack number.SrcFicBay

Displays the type of shelf or the shelf name.SrcShelfName

Cisco Optical Network Planner | Updated March 10, 2026

| View Network Reports | 310



DescriptionParameter

Displays the type of shelf or the shelf name.SrcShelfNumber

Displays the unique ID assigned to the shelf. The unique ID
will be used in COSM XML to push the configuration to the
device.

SrcShelfUniqueId

Displays the rack unit position in layout.SrcRUPosition

Displays the card slot number within the shelf .SrcCardNumber

Displays the type of cable.Cable

Displays the source unit.Dst Unit Type

Displays the rack, shelf, and slot position of the card from
which the patch cord terminated.

Dst Position

Displays the name of the port.Dst Port Label

Displays the assigned rack number.DstFicBay

Displays the type of shelf or the shelf name.DstShelfName

Displays the assigned shelf number.DstShelfNumber

Displays the unique ID assigned to the shelf, which is used
in COSM XML to push the configuration to the device.

DstShelfUniqueId

Displays the rack unit position in layout.DstRUPosition

Displays the card slot number within the shelf .DstCardNumber

Indicates whether a cable connection will be automatically
generated or requires manual configuration for NCS 2000
networks.

ManuallySet/AutomaticallySet

Table 149: MSM

DescriptionParameter

Displays the name of the site.Name

Displays the source unit.Src Unit Type

Displays the rack, shelf, and slot position of the card from
which the patch cord originates.

Src Position

Displays the source unit ID.Src ID

Displays the name of the port.Src Port Label

Displays the type of cable.Cable Type

Displays the source unit.Dst Unit Type

Displays the rack, shelf, and slot position of the card from
which the patch cord terminated.

Dst Position
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DescriptionParameter

Displays the destination unit ID.Dst ID

Displays the name of the port.Dst Port Label

Indicates whether the connection relates to a present or
forecast circuit.

W/P

Confidential banner in exported reports
Provides guidelines for the confidential banner in exported reports. Lists the essential reference information detailing how
the banner secures data and maintains privacy compliance.
Table 150: Feature History

Feature DescriptionRelease InformationFeature Name

This feature indicates the confidentiality
of the reports or results generated by
Cisco ONP for a network. The
CONFIDENTIAL banner is placed in all
the exported reports. It is placed in the
first row and first cell of the Excel
sheet, followed by a blank row and the
contents of the exported report.

Cisco ONP Release 4.1Confidential Banner

Table 151: Feature History

Feature DescriptionRelease InformationFeature Name

The Confidential Banner string can be
customized as required. An admin user
can modify the banner string when the
confidentialBanner.enabled field is set
to true in the feature.properties file.

Cisco ONP Release 4.2Customizable Confidential Banner

The "CONFIDENTIAL" banner appears in all exported reports. In Excel files (.xlsx), it is located in the first cell of the first
row, followed by a blank row, and then the report contents. If the .xlsx file contains multiple sheets, the banner is included
on each sheet.
The "CONFIDENTIAL" banner is updated only when reports are exported in .xlsx format.
Server administrators can customize the "CONFIDENTIAL" banner text by modifying the
confidentialBanner.content field. To enable banner customization, theconfidentialBanner.enabled
field must be set to true in the feature.properties file. By default, this field is set to false.

Edit the Unique ID of the chassis
Teaches you how to edit the unique ID of a chassis. Instructs you on using the Layout tab to accurately manage chassis
identification within an analyzed network.
Cisco ONP allows you to edit the Unique ID (UID) of a chassis in the Layout tab for an analyzed network.
Follow these steps to edit the Unique ID (UID) of a chassis
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Log in to the Cisco ONP web interface on page 17.
1. Open the analyzed NCS 1010 network for which you want to edit the UID of the chassis.

Note

For NCS 2000 network, UID edit is available in upgrade and release upgrade modes.

2. Click the Layout tab on the Cisco ONP homepage.
3. In the graphical area, click Edit.
4. Hover over the chassis that you want to edit the UID and click Edit Unique ID.
5. Enter the UID and click Update.
The chassis UID is updated.

Export the Link Availability report
Teaches you how to export the link availability report. Instructs you on generating this report to assess network reliability
and uptime for an analyzed network.
Cisco ONP allows you to export link availability report for an analyzed network.
Follow these steps to export link availability report.
Log in to the Cisco ONP web interface on page 17.
View details of layout and internal connections on page 313
1. Analyze the network. See
2. Go to Export > Link Availability.

The downloaded excel sheet includes link availability column.

View details of layout and internal connections
Teaches you how to view the layout details and internal connections. Instructs you on obtaining critical structural insights
of an analyzed network for troubleshooting.
Log in to the Cisco ONP web interface on page 17.
Follow these steps to obtain the layout details and internal connections of an analyzed network.
1. Click the Layout tab on the Cisco ONP homepage.
2. Type the site name in the search box, or select a site from the Sites drop-down list.

The site layout is displayed with its racks and cards.
a) Hover the mouse pointer over the transponder card to view the details of the slot, the PID of the card, and the

ports.
b) Expand the Ports to view details, such as wavelength and trunk mode.
c) Hover the mouse pointer over the chassis to view the total power consumption.
COSM supports up to 50 UIDs; beyond which, the site layout displays incorrect UID for the chassis.

3. Click the IPC tab to view the internal patch connections of the selected site.
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Export Internal connections
Teaches you how to export internal connections. Instructs you on saving specific connection details to facilitate off-line
analysis and thorough network documentation.
Log in to the Cisco ONP web interface on page 17.
View details of layout and internal connections on page 313
Cisco ONP allows you to export internal fiber connections in two ways: either at site-level or network-level.
Follow these steps to export internal fiber connections.
1. Click the Ellipsis icon available in the right side of the internal fiber connection or site.
2. Click Export.

View power consumption and unit weight report
Teaches you how to view the power consumption and unit weight report. Instructs you on monitoring hardware metrics
to maintain efficient and sustainable operations.
Log in to the Cisco ONP web interface on page 17.
Table 152: Feature History

Feature DescriptionRelease InformationFeature Name

Now, you can generate the power
consumption and unit weight report for
each product ID (PID). In the layout tab,
you can see the power consumption
and unit weight values and export them
into Excel as a report for a single site
or all sites. With prior knowledge of
power consumption and weight details
for each PID, you can plan and design
an energy-efficient network.
The new options that allow you to view
and export the reports are:
• Show Typical Power

Consumption

• Show Max Power
Consumption

• Show Unit Weight

• Power Consumption &
Weight

Cisco ONP Release 5.2Power Consumption and Unit Weight
Report

The Power Consumption and Unit Weight report includes power consumption and weight details of cards and shelves at
each site.
Remember

The power consumption of the Power Supply Unit (PSU) is not included in the total power consumption for NCS 1001,
NCS 1010, NCS 1014, and NCS 1020 chassis. Determine the total power consumption for these chassis by adding
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8 percent of the aggregated power consumption of all the cards inside the chassis to account for the PSU power
consumption.

Note

To view the power consumption and weight report, upgrade and analyze the LNI network.

Follow these steps to view the power consumption and unit weight report for each site.
1. Open the analyzed network for which you want to view the power consumption and weight report.
2. Click the Layout tab on the Cisco ONP homepage.
3. Click the ellipsis icon next to Sites.

A pop-up list displays these options.
Table 153: Option descriptions

DescriptionOptions

Expands all the items in the layout tree.Expand All

Collapses all the items in the layout tree.Collapse All

Check the Show Typical Power Consumption
check box to view typical power consumption values of
each card and shelf in watts.

Show Typical Power Consumption
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DescriptionOptions

Check the Show Max Power Consumption check
box to view the power consumption values of each card
and shelf in watts.
Max Power Consumption for a shelf is the sum of cards
and modules.

Note

The total power consumption of an NCS 2000, NCS
4000, or NCS 1000 shelf changes based on AC or DC
power supply.
• For DC power supply, total power consumption of

the shelf includes all Cards, DC power module, and
fan tray.

• For AC power supply in NCS 2000 M6 only, total
power consumption of the shelf includes all cards,
fan tray, 10% of power consumed by all cards, and
5W of Cooling Unit power consumption.

Show Max Power Consumption

Check the Show Unit Weight check box to view the
weight of each card and shelf in kilograms.
The unit weight for a shelf is the sum of cards and
modules.

Show Unit Weight

4. Select the options as you require.

Export power consumption and unit weight report
Teaches you how to export the power consumption and unit weight report. Instructs you on extracting this crucial data
to optimize power planning and hardware installation.
Log in to the Cisco ONP web interface on page 17
View power consumption and unit weight report on page 314.
Follow these steps to export the power consumption and weight report of each shelf and card.
1. In the graphical area, click the download icon.

The Export pop-up list displays these options.
Table 154: Option Descriptions

Options

Provides details of the site that you selected.Current site

Provides details of all the sites.All Sites

2. Click the option as you require.
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3. Click Power Consumption & Weight to export the optical reports details in an Excel sheet.
We recommend that you export the power consumption and weight report only in the analyze mode. Exporting the
reports in the upgrade and release upgrade modes may be inaccurate.
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7 Backup and Restore Cisco ONP Database

Provides instructions for system administrators to perform, schedule, and restore
database backups for Cisco ONP. It also details how to manage database

Topics:

• Database backups performance by configuring overload notifications and manually deleting unused
network data to maintain system efficiency.• Restore the database manually

• Database overload notification levels
and user actions



Database backups
Provides a mechanism for system administrators to schedule daily, weekly, or monthly database backups on durable NFS
storage. It covers the archive types, setup requirements, manual backup procedures, scheduling methods, and restoration
processes to ensure data protection.
A database backup is a data protection mechanism that
• allows system administrators to schedule full database backups at daily, weekly, or monthly intervals,

• lets only system administrators access backup folders and perform restorations, and

• stores all backup archives on a highly durable NFS share.

Archive types

Archive types available for database backups include:
• Daily archives for the last 7 days

• Weekly archives for the last 4 weeks

• Monthly archives for the last 6 months

Note

You can change the duration for monthly archives to meet specific retention needs.

Set up database backup storage
Configure and prepare backup storage and scripts for archiving database data on a secure NFS volume.
Use this task to ensure reliable backups of database archives by preparing NFS storage and configuring backup scripts
Database archives require secure, high-durability backup storage. This task guides you through establishing a reliable
NFS storage location and preparing scripts for regular backups and restoration.
• Ensure that a highly durable 2 TB NFS storage is available to store database archives.

• Ensure that the storage is accessible from the Cisco ONP environment.

• Set up rules as defined by the Cisco ONP network and configure the appropriate Access Control List (ACL) to permit
or deny access to the storage as needed.

1. Log into the Cisco ONP server, where you have installed Cisco ONP by using the tar archive.
2. Create a folder for backup. Ideally it should be mounted on a reliable object storage such as NFS.
3. Copy backup, rotation, and setup backup scripts from ONP/images folder to the new folder created in step 2.

Example:

$ cd
$ mkdir cnp_backups
$ tree ~/cnp_backups/
/home/ciscocnp/cnp_backups/
├── backup_postgres.sh
└── rotation.sh
└── setup_backup.sh
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Ensure that all scripts have necessary permissions:

$ chmod +x backup_postgres.sh

$ chmod +x rotation.sh

$ chmod +x setup_backup.sh

$ ls -l | grep .sh

-rwxrwxr-x 1 ciscocnp ciscocnp 518 Jan 16 05:23 backup_postgres.sh

-rwxrwxr-x 1 ciscocnp ciscocnp 1412 Feb 1 05:50 rotation.sh

4. Copy restore_postgres.sh from /ONP/images/.

Backup scripts are prepared and ready to archive, rotate, and restore database files securely on your NFS storage.

Back up the Cisco ONP database
Configure and run backup scripts to safely store the Cisco ONP database files in a designated folder with timestamps.
Follow these steps to back up the Cisco ONP database.
1. Browse to the location where the backup_postgres.sh script is stored.
2. Use the bash rotation.sh command to execute the rotation.sh script.

user@server:~/cnp_backups$ bash rotation.sh

This command creates the necessary folder structure.

3. Use the bash backup_postgres.sh command to execute the script.

user@server:~/cnp_backups$ bash backup_postgres.sh

The backup file is stored in the daily backup folder (backup.daily) with the current time stamp.

Backup scheduling methods
Lists the available methods for scheduling backups and links to detailed procedures for each method.
You can schedule a backup using either of these methods:
• Using a script: Automate backup scheduling with a custom script. For the detailed task, see Schedule a backup using

script on page 321.

• Using the user interface: Schedule backups directly through the graphical interface. For the step-by-step instructions,
see Schedule a backup with Crontab on page 322.

Schedule a backup using script
Configure scripts to automate daily PostgreSQL backups and manage backup file storage.
Follow these steps to schedule the backup operation using a script.
1. Log in to the Cisco ONP server.
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2. Use the command bash rotation.sh to execute the rotation.sh script.

user@server:~/cnp_backups$ bash rotation.sh

This command creates the necessary folder structure.

3. Use the command bash setup_backup.sh to execute the setup_backup.sh script.

user@server:~/cnp_backups$ bash setup_backup.sh

The backup file is stored in the daily backup folder (backup.daily) with the current time stamp.

4. Enter the path at the user prompt to store the file.
Backup files are stored in your required file path as shown in this example.

/user-defined path/backups/backup.daily

Schedule a backup with Crontab
Configure scheduled backup operations using Crontab to automate data protection.
Follow these steps to schedule the backup operation using Crontab.
1. Log in to the Cisco ONP server.
2. Use the command sudo crontab -e to configure the Crontab job.

user@server~/cnp_backups$ sudo crontab -e

3. Update the Crontab.shscript with the required cron job entries using the Syntax to schedule the backup using
Crontab on page 325, to schedule backup operations.
This example shows the scheduling of the backup operation at 3:00 a.m daily.

0 3 * * * /home/ciscocnp/cnp_backups/backup_postgres.sh

Syntax to schedule the backup using Crontab
Describes how Crontab backup schedule syntaxes define the timing and frequency of automated backup jobs in Unix-like
systems.
Use this syntax to schedule a backup in Crontab:

m h dom mon dow

Where:
• m: Minutes (0–59)

• h: Hours (1–23)

• dom: Day of the month (1–31)

• mon: Month of the year (1–12)

• dow: Day of the week (0–6, where 0 represents Sunday)

To specify the time, you can provide exact values for the minute (m), hour (h), day of the month (dom), month (mon), and
day of the week (dow). Alternatively, you can use the wildcard character * in these fields to indicate "any value."
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Note

The backup jobs are initiated according to the system daemon's understanding of time and time zones as defined by
the cron scheduler.

Restore the database manually
Restore a database on your system after removing related Docker services.
This task is for recovering your database using a backup archive after you remove conflicting Docker services. You may
need to do this if the database becomes corrupt or you wish to revert to a previous state.
1. Check the Cisco ONP database.

$ postgres CnpDB

MongoDB shell version: 2.6.10
connecting to: CnpDB
Server has startup warnings:
2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten]
2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten] ** WARNING: Using the
XFS filesystem is strongly recommended with the WiredTiger storage engine.
2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten] ** See
http://dochub.mongodb.org/core/prodnotes-filesystem
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten]
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten] ** WARNING: Access
control is not enabled for the database.
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten] ** Read and write
access to data and configuration is unrestricted.
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten]
> show collections
NetworkEntity
SystemLog
BOM
fs.files
Users
fs.chunks
ErrorInfo
NetworkObject
UserGroups
TaskInfo
ActionGroups
Roles
>
```
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2. Remove the Cisco ONP back-end and front-end Docker services,"docker service rm cnp_cnp cnp_cnp_frontend"
and check again:

```

$ postgres CnpDB

MongoDB shell version: 2.6.10
connecting to: CnpDB
Server has startup warnings:
2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten]
2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten] ** WARNING: Using the
XFS file system is strongly recommended with the WiredTiger storage engine.

2019-01-31T12:17:39.354+0000 I STORAGE [initandlisten] ** See
http://dochub.mongodb.org/core/prodnotes-filesystem
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten]
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten] ** WARNING: Access
control is not enabled for the database.
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten] ** Read and write
access to data and configuration is unrestricted.
2019-01-31T12:17:40.013+0000 I CONTROL [initandlisten]
> show collections
>
```

3. Copy the database to the folder that is mapped to PostgresDB container's volume:

$ sudo cp backups/2019-02-01-04-29.archive /var/lib/postgresdb_cnp/

4. Restore the database and check.

$ docker exec -t cnp_postgres.1.$(docker service ps -f 'name=cnp_postgres.1'
-f 'desired-state=running' cnp_postgres -q) bash -c "postgresrestore -u
\$(cat \$MONGO_INITDB_ROOT_USERNAME_FILE) -p \$(cat
\$MONGO_INITDB_ROOT_PASSWORD_FILE) --authenticationDatabase admin --port 27017
-h localhost --db CnpDB --gzip --archive=/data/db/2019-02-01-04-29.archive"

The database is restored from the backup archive file and service access is enabled as appropriate.

Restore the database using a script
Restore the database from a backup archive using a provided shell script.
Perform a database restoration using a backup file and a shell script.
You can restore the database using a script, which is available at this location:
/ONP/Images/restore_postgres.sh

Follow these steps to restore the database using a script:
Use the command sudo bash restore_postgres.sh to restore the database

$ sudo bash restore_postgres.sh DB backup archive file path.

$ sudo bash restore_postgres.sh /backups/backup.daily/2019-05-05-23-58.archive
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The database backup is created and a confirmation prompt appears asking to delete the database.

!!! WARNING! Complete Restore Operation will replace Existing Database with
Backup Database (Recommended) !!!
Do you want Complete Restore? (Yes/No) [default - Yes]

Enter Yes to delete the database and restore the database with backup file.

Enter No to not delete the database and apply only missing data(s) from backup file.

The database is restored from the backup archive according to your prompt selection. You receive a confirmation indicating
that the restore operation is complete.

Syntax to schedule the backup using Crontab
Lists the field structure and parameters required to schedule backup jobs using Crontab.
Crontab allows you to schedule backups by specifying a set of time and date fields. Use the following syntax in your
Crontab file to define when the backup occurs:

m h dom mon dow

Where:
• m: Minutes (0-59)

• h: Hours (1-23)

• dom: Day of the month (1-31)

• mon: Month of the year (1-12)

• dow: Day of the week (0-6, where 0 represents Sunday)

To specify the time, you can provide exact values for the minute (m), hour (h), day of the month (dom), month (mon), and
day of the week (dow); alternatively, you can use the wildcard character * in these fields to indicate "any value."

Note

The backup jobs are initiated according to the system daemon's understanding of time and time zones as defined by
the cron scheduler.

Database overload notification levels and user actions
Provides details on the types of database overload notifications in Cisco Optical Network Planner, including notification
levels, behavior, and recommended user actions.
This section describes the databse overloand notification in the Cisco Optical Network Planner tool.
• Whenever the database is fully overloaded with networks, the subsequent network operations becomes slower such

as like opening a network, saving a network, etc.

• Database overload notification appears whenever these operations are performed. You can take necessary backup
of unused networks and delete them.

• These notifications are enabled by default. These can be disabled via feature.properties file.

• Two levels of warning notifications appear –Slowness Detected andCONPServer DB capacity Exceeded.
Take necessary actions appropriately.
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Modify the threshold for database notifications
Instructs administrators on how to customize performance monitoring thresholds within the configuration files. It enables
precise control over when the system triggers slow query or capacity warnings.
Use this task to modify the threshold for database notifications.
1. Open the feature.properties file.
2. Search for hibernate.slowQuery.logging.enabled and set it to false.

By default, this property is enabled.

3. Modify the properties inside the hibernate.slowQuery.logging.enabled property as follows.
DescriptionProperties

Medium-level threshold that triggers warning alerts when
database queries exceed this execution time.

hibernate.slowQuery.logging.med.threshold.ms

If a network takes more than 5 seconds to open, this
property triggers a warning alert notification.
Medium timeout value is 5 seconds. 5000 is default.

High-level threshold that triggers critical alerts when
database queries exceed this execution time.

hibernate.slowQuery.logging.high.threshold.ms

If a network takes more than 10 seconds to open, this
property triggers a critical alert notification.
Maximum timeout value is 10 seconds. 10000 is default.

Threshold for maximum network count. 5000 is default.hibernate.slowQuery.logging.min.network.count

Threshold for maximum sites count. 150000 is default.hibernate.slowQuery.logging.min.sites.count

The database notification will now appear based on the threshold values that you have set.

Manually clean the database
Configure the database by deleting outdated networks to maintain data accuracy.
Remove old networks from the database to optimize performance and ensure data is up-to-date.
This task is performed when you need to delete network entries that are no longer required, keeping the database lean
and relevant.
1. Choose File > Delete.

The Select Network(s) to Delete window opens.
2. Select the networks as follows.

DescriptionOptions

Search for the network to delete.Search bar

Select all the networks.Select All check box

Select the old networks.Check box list

3. Click Delete.
Warning message appears.

4. Click Yes.
The selected network is deleted.



A Cisco ONP UI Reference

Describes the various interface options available in the Cisco ONP application,
including the menu bar, network tree, design palette, and entity editor. It provides

Topics:

• Menu bar options and functions a comprehensive guide to navigating and managing network design elements
within the graphical environment.• Network tree elements and features

• Design Palette options This appendix chapter describes the various options available in the Cisco ONP
UI.• Entity Editor window options



Table 155: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP Release
26.1.1

UI/UX enhancement
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Feature DescriptionRelease InformationFeature Name

Cisco ONP is enhanced
with these UI/UX
designs:
• Salesforce BoM:

Choose Export >
SalesforceBoM to
get BoM report in
Salesforce format.

• Multiple network
downloads:Choose
File > Download
Networks and
select up to five
network designs to
download.

• Ageing loss support
in imported and
exported excel sheet

• Network tree
structure retention:
Network tree does
not collapse after
parameter updates.

• Populate shelves
frombottom:Enable
Populate Shelves
From Bottom
check box under
Layout at site level
to populate
equipment from the
bottom of the
shelves.

• Addition of
equipment to
restriction list: Add
equipment to
Restricted
Equipment under
System Release
at network level to
restrict the tool from
using it in network
design.

• Database clean-up:
Set
hibernate.slowQuery.logging.enabled
to true to enable
database cleanup.
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Feature DescriptionRelease InformationFeature Name

• Automatic SD:
Enable Auto at
Optical Subnet
level to enable
basic automatic
spectral density for
the selected optical
subnet.

• Enhanced tuner
mode: Added
Maximum
DataRate
Maximum
Capacity and
Maximum
DataRate Best
OSNR to calculate
results based on
maximum data rate
per maximum
capacity and best
OSNR.

• Interoperability
support for all
networks: Allows
different source and
destination card
types to interoperate.

• Link availability
report: Choose
Export > Link
Availability for an
analyzed network to
download the
network design with
link availability
values.

• Enhanced optical
source search: More
keywords are added
to the search box to
find Optical sources
based on file
parameters.

• Frequency update in
wavelength: Now
wavelength values
contain
corresponding
frequency values.
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Feature DescriptionRelease InformationFeature Name

• Editable Unique ID for
chassis in Layout tab:
Choose Edit > Edit
Unique ID to edit
the chassis UID for an
analyzed network.

This release includes
several user experience
and functionality
enhancements to the
application:
• Added color

indication at the
circuit and network
level in the network
tree to represent
optical feasibility and
overall network
performance.

• Enhanced selection
capabilities within the
network tree for more
efficient
management.

• Added version and
timestamp
information to
exported reports to
improve traceability
and documentation.

• Displayed edge labels
directly on the map
view for easier
identification and
understanding of
network topology.

• Provided users with
the ability to unlock
and modify entity
properties within the
entity editor.

• Enabled users to edit
the Effective Mode
Area parameter for
fibers, allowing for
more accurate OSNR
and power
calculations.

Cisco ONP Release
25.1.1

Enhancements and
Engineering Initiatives
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Table 156: Feature History

Feature DescriptionRelease InformationFeature Name

Cisco ONP Release
24.3.1

User Interface
Enhancements
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Feature DescriptionRelease InformationFeature Name

Cisco ONP improves the
user experience with
these user interface
enhancements:
• Maps:

• Providing an
option to increase
the workable
area.

• Switching to
zoom mode that
automatically
centers the map
on the selected
node.

• Highlighting
nodes and fibers
selected in the
network tree on
the map.

• Entity Editor:
Adding tooltips for
some of the
properties.

• Results:
• Including Raman

information in the
Fiber Details that
are exported from
Export>Fibers.

• Introducing
Export Report
button to export
Optical
Reports/BOM
differences
between two
networks in
CONP.

• Maintaining the
recent view in the
Results tab view
when switching to
theMap or BoM
tabs.

• Enabling editing of
EOL Aging Loss with
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Feature DescriptionRelease InformationFeature Name

Aging Loss [dB]
property in both the
entity editor and
Properties pane.

• Updating optical
sources with
minimum system
release information
for user visibility in
theManage
Optical Source
dialog box.

• Adding an OMNI
marker to identify the
Omni-Directional
sides in the NCS
2000 networks.

• ComponentLogs:
Streamlining log
management, this
Logs menu option
provides direct
access to critical
component logs such
as cnp Backend (BE),
ODE, GENE, and PCE
through the user
interface.
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Menu bar options and functions
Lists all menu bar options in the Cisco ONP GUI and provides a description for each.
This table lists all options available in your Cisco ONP GUI menu bar.
Table 157: Menu options and descriptions

DescriptionOptions

Performs common file operations such as New, Open, Open
Shared, Save, Save As, Share, and Delete

File

Opens Entity Editor, analyzes the network, and converts
non-SSON to SSON networks

Network

Exports reports of CPZ, sites, fibers, SRLGs, services,
waves,media channels, optical results, service aggregation,
BOM, and messages. Export allows you to download Excel
and LNI templates

Export

Imports CPZ, Excel, LNI, and MPZ to design a network in
Cisco ONP

Import

Manages Layout Templates and Optical SourcesManage

Displays log events initiated during a specific period, such
as user login, user logout, password change, and LNI -
start, failed, and completed

Logs

Monitors background tasksJob Monitor
Manages users, user groups, user roles, permissions,
system configuration, and dictionary

Control Panel

Changes the default map view and personalizes the color
code for spectrum utilization

Preferences

Displays the Cisco ONP versionHelp

Shows the last date and time you logged in to Cisco ONP
including the last login IP details

Last Login

Displays the name of the user who has currently logged in
to Cisco ONP

Username

File
Performs common file management operations, including creating, opening, saving, sharing, and deleting network designs.
It enables users to maintain and organize their network project files effectively.
The File menu includes common file options such as New, Open, and Delete.

DescriptionOptions

Creates a new network. By default, NCS 1010 is created.
To create NCS 2000 networks, change L0 Network
Platform to NCS2000. You can check the SSON
Network check box and select System Release for
NCS 2K to create an SSON network.

New
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DescriptionOptions

Opens a saved network. The network name in blue-colored
font indicates that the network is in the Design mode, and
the network name in green-colored font indicates that the
network is in the Analyze mode.

Note

If you view a blank screen when you open a network,
refresh the browser, or log in to Cisco ONP again.

Open

Opens a shared network.Open Shared
Saves a network.Save
Saves the network with a new name.Save As
Shares a network or networks.Share
Deletes a network or networks.Delete

Network
Provides tools for network design, analysis, and optimization, including mode switching and tuner functions. It allows
users to modify network properties, convert architectures, and generate critical failure or feasibility reports.
The Network menu includes options such as Entity Editor, Analyze, and SSON Convert in the design mode. It includes
options such as Entity Editor, Design, Upgrade, and Enter Plan Mode in the Analyze mode.

DescriptionOptions

Use this option to edit various properties of an element in
the network

Entity Editor

Analyzes the network after completing the designAnalyze

Converts a Non-SSON network to an SSON networkSSON Convert

Switches fromAnalyzemode to Design, Upgrade, or Release
Upgrade mode

Design

Upgrades an existing network that is in the Analyze modeUpgrade

Upgrades the NCS 2K or NCS 1010 System Release of a
network

Release Upgrade

Switches to the Plan modeEnter Plan Mode

Exits the plan modeExit Plan Mode

Enters the link rate tuner modeEnter Link Rate Tuner Mode

Opens the tuner input table to add parameters for custom
optical sources

Open Tuner Input

Runs the tuner input options to provide custom optical
source results.

Run Tuner
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DescriptionOptions

Starts fresh tuner analysisStart New

Opens the already analyzed tuner resultsOpen Tuner Result

Exits the link rate tuner modeExit Link Rate Tuner Mode

Restores failed fibers and nodesRestore

Expands the Failure Report from the bottom of the Map.
Data is populated after Restore.

Open Failure Report

Expands the Feasibility Report from the bottom of the Map.
The report displays the data regarding Auto Regen
Suggestions for channel feasibility.

Open Feasibility Report

Export
Facilitates the extraction of network data into various formats, including reports for sites, fibers, services, and bills of
materials. It supports the downloading of Excel and LNI templates for external documentation and planning.
The Export menu includes options to export reports of Sites, Fibers, Services, SRLG, Waves, Messages, and BOM.

DescriptionOptions

Export the .cpz design file of a network into your local
system.

CPZ

Exports site details such as x and y coordinates, grooming
site flag, CLLI code, site address, site type, and site name.

Sites

Exports fiber details such as length, loss to fiber, source
and destination site, source and destination edge.
From Release 24.3.1, the exported fiber details contains
the Raman information.

Fibers

Exports service details such as name, type, path, quantity,
and protection.

Services

Exports details about created SRLGs.SRLGs

Exports wave details such as Label, Source and Destination
sites, Card Type, Wavelength, Utilization, Source port,
Destination port, Demands, OTN Hops, OSNR,
OSNRMarginEOL, StatusEOL, Excluded Channels, and Path
of Wave.

Waves (Available for non-SSON network)

Exports media channel details such asMedia Channel Label,
Media Carrier Label, Source and Destination sites, Card
Type,Wavelength, Utilization, Source port, Destination port,
Demands, OTN Hops, OSNR, OSNRMarginEOL, StatusEOL,
Excluded Channels, and Path of Media channel.

Media Channels (Available for SSON network)

Exports circuits details such as Circuit Label, Carrier Label,
Source and Destination sites, Card Type, Traffic Type,
Wavelength, Utilization, Source port, Destination port,
Demands, OTN Hops, OSNR, OSNRMarginEOL, StatusEOL,
Excluded Circuits, and Path of Circuit.

Circuits (Available for NCS1010 network)
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DescriptionOptions

Shows the complete log of the analysis, including critical
errors.

Messages

Download sample Excel file that can be used as a reference
for creating networks using the Import Excel feature.

Excel

Download sample LNI file that can be used as a reference
for creating networks using the Import feature.

LNI Template

Download sample Optical Source Excel file that can be used
as a reference for creating User Defined/custom Optical
Source using theManage > Optical Sources feature.

Optical Source Template

Exports details about pricing and quantity of the network
equipment

BOM

This option is available only in the plan mode. You can add
failed fibers to a failure group.

Failure Groups

This option is available only in the plan mode. It shows the
failed fibers, total channels, failed channels, restored
channels, and fiber hotzones.

Failure Report

Exports details such as protection type, SOL, EOL, source,
and destination

Optical Results

Exports the Device Netconf XML file and COSM Netconf
file.

Device Configuration

Import
Enables the integration of external network design files, such as Excel, CPZ, and MPZ formats, into the Cisco ONP
application. It also allows for the import of live deployed network configurations to assist in accurate modeling.
The Import menu imports an Excel file, a CPZ file, or an MPZ file.

DescriptionOptions

Imports the .cpz network design files that are exported from
another Cisco ONP instance

CPZ

Imports an Excel file containing all the design parametersExcel

Imports a live deployed network by retrieving configurations
of the nodes, provided in the LNI input Excel sheet

Live

Imports the .mpz network design files from CTP to Cisco
ONP, to avoid recreating the networks that are already
created in CTP

MPZ

Manage
Manages reusable layout templates and custom optical sources to standardize design configurations. It provides access
to look-up tables for verifying optical feasibility values across different gain ranges.
You can manage layout templates and optical sources.
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DescriptionOptions

Imports reusable templates to design layout configurations
for a network

Layout Templates

Imports an optical source from your local systemOptical Sources

Displays the optical feasability values for the gain ranges of
each EDFA cards.

Look Up Table

Logs
Tracks system events and provides access to critical component logs for performance monitoring and troubleshooting.
It streamlines log management by allowing users to view login, analysis, and import activities directly through the interface.

System Logs

The System Logs option allows an admin user, or userwith USERMANAGEMENT, andNETWORKMANAGEMENTpermissions
to view at logs the events that are initiated during a specific time interval. Examples of events are user login, user logout,
password change, Live Network Import (LNI)-start, failed, completed and analysis-start, and failed.
The SYSTEM LOGS page includes the following fields:

DescriptionField

Provides the date and time of the specific eventTime Stamp

Shows the type of event, which includes user login, user logout, password
change, and so on

Event Type

Describes the event, which includes user login success, user logout success,
and so on

Description

Shows the user who has initiated specific eventsUsername

Shows the IP address of the device from where the event is initiatedEvent Source

Events that are captured in the System Logs are:

DescriptionEvent

New user sign-up for Cisco ONPSIGNUP

User log in to Cisco ONPLOGIN

User state change from Active to Inactive and the converseUSER STATE CHANGE

User role change, such as admin to planner, and so onUSER ROLE CHANGE

User log out from Cisco ONPLOGOUT

Deletion of a particular userUSER DELETION

User enters invalid login credentialsUNAUTHORIZED

Successful initiation of Live Network ImportLNI_START

Successful completion of live import of a networkLNI_COMPLETE

Cancellation of Live Network ImportLNI_CANCEL
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DescriptionEvent

Successful completion of live import of a network fromCisco
ONC

CONC_IMPORT_COMPLETE

Analysis of LNI network started successfullyANALYZE_LNI_START

Analysis of LNI network completed successfullyANALYZE_LNI_END

Starting of the network analysisANALYZE START

Completion of the network analysisANALYZE END

Cancellation of the network analysisANALYZE CANCEL

Entering the Upgrade modeUPGRADE NETWORK

Entering the Plan modePLAN_INIT

Exiting the Plan modePLAN_END

Checking for alternate paths to restore failedmedia channels
or waves

PLAN_REROUTE

Restoration of failed media channels or waves in progressPLAN_PROGRESS

Upgrading the system release of the network is in progress.RELEASE_UPGRADE_NETWORK

Component Logs

The Component Logs option allows you to access logs for multiple critical components such as cnp Backend (BE), ODE,
GENE, and PCE, directly through the user interface. This streamlines the process, eliminating the need for server access
andmanual file navigation. This enhancement simplifies logmanagement, aiding in performancemonitoring, troubleshooting,
and system insights.
The Component Logs page includes the fields:

DescriptionField

Provides the date and time of the specific eventTime Stamp

Describes the events for the selected componentLogs

Provides list of critical components to choose from. The available components
are:
• BE

• ODE

• GENE

• PCE

Component

Locates specific log entries based in the entered valueSearch

Allows you to navigate through logs page by pagePages
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Job Monitor
Monitors and manages background tasks such as network analysis and imports to ensure efficient system performance.
It allows authorized users to filter, track, and cancel ongoing processes as needed.
The Job Monitor menu checks and manages tasks running in the background.
You can access this menu if you have ADMIN, NETWORK_MANAGEMENT, or NETWORK_PLANNING role.
The JOB MONITOR page has the following options:

DescriptionOptions

Refreshes the display information.Refresh

Applies one or more of the following filter options:
Task Type: Filters the display information based on the task
type.
Select Start Date: Filters the display information based on
the start date of the task.
Select End Date: Filters the display information based on
the end date of the task.
Username: Filters the display information based on the
username.

Filter

The date on which the task is started by the user.Created Date

Name of the user who initiated the job.User Name

Name of the network on which the task is running.Network Name

The type of background task: Valid values are ANALYZE
and EPNM_IMPORT.

Task Type

The current state of the task.Messages

Enables you to cancel or stop an ongoing background task:
• The Admin can cancel any of the running background

tasks. Other valid users can cancel only their own tasks.

• If you want to cancel your ongoing network analysis,
you can open Cisco ONP at the browser in incognito
mode, or contact the Admin.

• After a task is cancelled, it gets removed from the job
monitor. You can check the status of a cancelled task
from System logs page. Click Logs to open the
System logs page.

Cancel

Removes all the completed tasks from the Job Monitor
page.

Clear all Completed Tasks
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Control Panel
Administers user accounts, roles, permissions, and system configurations to maintain secure access and operational
control. It provides the necessary tools for managing user states and password policies within the application.
Apart from designing, analyzing, and creating BOM for a network, a user with admin rights can activate, manage, and
delete users and their roles.
To navigate to the control panel page, click Control Panel.
The admin or any user with USER_MANAGEMENT role can lock, unlock an individual user account, and manually expire
the individual user password. For more information, see #unique_284.

Preferences
Customizes application settings, including default map views and color codes for spectrum utilization. It enables users
to personalize the interface to better suit their specific design and monitoring requirements.
This menu contains the General Settings option to customize Cisco ONP settings such as the default map view and
spectrum utilization percentage.

DescriptionField

Allows choosing the default map view and applying color codes for spectrum
usage percentage
• DefaultMap: Choose theDetailed orMinimalmap from the drop-down

list.

• SpectrumUtilization Percentage: Click and drag to change the color
code to indicate spectrum usage.

General Settings

Help
Displays the current version information of the Cisco ONP application. It provides users with necessary software identification
details for support and documentation purposes.
This menu provides information about the Cisco ONP version.

DescriptionField

Provides the Cisco ONP version.About
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Network tree elements and features
Lists the elements and UI features available in the network tree and their descriptions.
Table 158: Feature History

Feature DescriptionRelease InformationFeature Name

Now, you can use the Ellipsis icon at
the right side of each element in the
Network tree to perform various actions
such as Expand All, Collapse All,
Enable Multi-Select, and so on. Also,
you have multiple entity-level options
to filter the elements under the Network
tree. These enhancements make the
Network tree more intuitive.

Cisco ONP Release 5.2Network Tree Enhancements

The left pane of the Cisco ONP home page comprises a network tree. The network tree includes various network elements.
When you click each element, the respective property is displayed under the network tree. You can edit the properties.
For more information on editing the network properties, see Modify Network Properties on page 125.
From R25.1.1, the network tree provides the UI enhancements
• Default multi-select check boxes—network tree entities have the multi-select check boxes enabled by default. To

disable the multi-select check boxes, click the ellipses icon and click the Disable Multi-Select option. To enable
the multi-select option, follow the same navigation.

• Coloring indication on network tree—network tree entities display red, green, and yellow colors to indicate the optical
feasibility of the circuits and overall network.

Table 159: Network Tree Elements

DescriptionNetwork Tree Elements

Displays the name of the network.Network name

Customer premise equipment that is located in a rack within
a building.
When you click a site name in the network tree, the site will
be highlighted in orange on the map.
When multiselect is enabled, the network tree displays
checkboxes for each site, fiber, and circuit. Selecting
multiple sites from the network tree highlights the same
sites on the map.

Sites

Optical fiber connecting two sites.Fiber

A fiber couple consists of two different fibers (clockwise
and counterclockwise), one for transmission and another
for reception.

Fiber Couple
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DescriptionNetwork Tree Elements

Service is the circuit through which traffic flows between
nodes.
When you add services to the Traffic site (of the type
1K-2K-4K) in an SSON network, a DefaultGroup is created
under the Services in the network tree. You can also create
a new service group.

Services

The wave or Media channel represents a DWDM channel.
In a wave hierarchy, for each wave, there is a trail. When
you expand a trail, there is a section under each trail. The
trail is an optical path or a network section joining two traffic
nodes. It can have more than one section depending on
whether the trail has a regenerator site. For more
information on regeneration, see Regenerator sites on page
262.

Waves or Medial Channel or Circuits

Shared Risk Link Group (SRLG) is useful for routing the
protected services. If there are Fiber 1 and Fiber 2 in the
network, they are assumed to be diverse and are used as
alternates for protection purposes. If Fiber 1 and Fiber 2
are in an SRLG, they are not true alternates, and they share
the same risk of failure. Therefore, if Fiber1 fails, Fiber 2
also fails, and Fiber 2 cannot be used as a protected path.

SRLG

An optical subnet is a collection of spans with certain
associated properties. When you create a new network,
Cisco ONP automatically creates an optical subnet that is
associated to the network. At least one optical subnet must
exist for each network.

Optical subnet

Use the Search box on top of the network tree to search for any specific site, fiber, or wave in the network tree panel.
Click the Refresh icon to refresh your search.
Now, you can filter the elements available in the network tree using the Filter icon available next to the Search box. The
following table explains the various filter options available.
Table 160: Network Tree Elements

Options Available Under Each FilterFilters

Entity TypeNetwork Filter

Site Type, and DWDM Site TypeSites Filter

Source Site, Destination Site, Source Edge, Destination
Edge, and Raman

Fibers Filter

Protection Type, Source Site, Destination Site, Src
Add-Drop Type, and Dst Add-Drop Type

Services Filter

Protection Type, Source Site, Destination Site, Src
Add-Drop Type, and Dst Add-Drop Type

Waves, Medial Channel, or Circuits Filter
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Design Palette options
Provides a detailed reference to the icons, tools, features, and display modes available in the Cisco ONP Design Palette
and Intuitive Map Display. Includes information on icon functions, map modes, and latest enhancements.
Table 161: Feature History

Feature DescriptionRelease InformationFeature Name

The new intuitive map display allows
you to virtually rearrange networks for
a clutter-free view without impacting
the original design. This display
simplifies adding new nodes to
complex networks. Save the last
modified network in the new view to
retain the latest rearrangement. The
new icons in the Design Palette that
enable the intuitive display are:
• Switch to Intuitive

Arrangement/Switch to
Coordinates
Arrangement—Toggles the map
between the intuitive and original
displays.

• Rearrange nodes—Overrides
node coordinates and rearranges
the map in a presentable manner.

Cisco ONP Release 5.2Intuitive Map Display

At the right of the Cisco ONP home page, there is the design palette. You can use this design palette to create a network
design. It consists of the following six icons:

DescriptionIcons

Click this icon to toggle between Normal and Zoommodes.
Zoom Mode: Highlights the selected node and
automatically centers the map on the selected node. The
size of labels, such as fiber and service names, adjusts
according to the mode.
Normal Mode: Highlights the selected node on the map.
Autozoom is disabled. You need to manually move the map
to view the selected node if it is not visible.

Switch to Zoom Mode/ Switch to Normal Mode

Click this icon to magnify the map.Zoom In

Click this icon to minimize the map.Zoom Out

Click this icon to reset the map to its original size.Reset Zoom
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DescriptionIcons

Click this icon to toggle between the intuitive and
coordinates display. Save the last modified network in the
Intuitive view to retain the latest rearrangement. The saved
networks retain the map designs when reopened or shared
with others. When you export the network as CPZ or Excel
files, the exported files include both original and modified
or rearranged coordinate data.

Switch to Intuitive Arrangement/Switch to
Coordinates Arrangement

Click this icon to rearrange themap in a presentable fashion.Rearrange nodes

The Drawing Tool consists of the following icons:
• Traffic Site: Select this icon, and click the working

area to create traffic sites in the network.

• ROADM Site: Select this icon, and click the working
area to create ROADM sites.

• OLA Site: Select this icon, and click the working area
to create OLA sites.

• Passthrough Site: Select this icon, and click the
working area to create passthrough sites.

• Link: Click this icon, and drag and drop between sites
to create a fiber link.

• OTN Service: Click this icon to create OTN service
between sites.

• DWDM channel: Click this icon to add a wave or
medial channel between sites.

• Select: The Select icon looks similar to the cursor
tool. Click this icon to select a node, link service, and
so on.

Drawing Tool
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DescriptionIcons

Use this icon to view or hide layers such as fiber link,
service, text, and channel. The following are the four toggle
icons:
• Toggle Fiber: Click this icon to view or hide fiber link

details from the network.

• Toggle Service: Click this icon to view or hide service
details from the network.

• Toggle Wave: Click this icon to view or hide the
channel or wave details from the network.

• Toggle Text: Click this icon to view or hide the text
from the network.

• Toggle COSM associations: Click this icon to
remove or add COSM associations.

• Expand/Collapse All Demands: Click this icon to
expand the waves or media channels so that you can
view them clearly. Click this icon again to collapse the
waves and media channels to their original shape and
position.

The eye symbol in the icon indicates that you are currently
viewing the respective details.

Layers Window

The icon below the Drawing Tool is the Zoom Tool.
You can change the display of the working area by using
this function. Click the arrow to view two sliders.
• Map Fade: Move theMap Fade slider from right to

left to fade the map from the background.

• Zoom In/Out: To magnify the map, move the Zoom
in or out slider from left to right.

Zoom Tool

Click the Zoom Elements icon to view four sliders.
• Media Channel Width: Move this slider from left to

right to increase the channel width.

• Path Spread: Move this slider from left to right to
increase the space between the paths.

• Fiber Width: Move this slider from left to right to
increase the fiber width.

• Service Width: Move this slider from left to right to
increase the service width.

Zoom Elements

This icon shows the failed media channels in themap. Failed
ones are marked with a red cross mark.

Show Failed (available only in plan mode)

This icon shows the total number of impacted media
channels, demands, or services that are working or failed
in the entire network.

Traffic Monitor (available only in plan mode)
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DescriptionIcons

Click this icon to toggle between Minimal Map and Detailed
Map.
Switch to Minimal Map: Focuses on Sites and Fibers,
allowing you to view spectrum utilization, and supporting
the spectrum and path finder.
Switch to Detailed Map: Displays all network
components for a comprehensive view.

Switch to Minimal Map/Switch to Detailed Map

Entity Editor window options
Lists the operations and features available in the Entity Editor window for managing network element properties.
The Entity Editor allows you to edit various properties of an element in the network. ChooseNetwork > Entity Editor
to open the Entity Editor window.
The Entity Editor enhances some properties with descriptions in the form of tooltips.
The table lists the operations that you can perform in the Entity Editor window.

DescriptionOptions

Includes check boxes to filter the network elements
displayed under each tab:
• For the SITE tab, you can choose whether to display

OTN (only traffic node), DWDM (ROADM, OLA, or
pass-through) node, or both.

• For the FIBER tab, you can choose the fiber connecting
a particular source and destination sites.

• For theSERVICE tab, you can choose to display either
services, waves, or both.

Left pane filter

Displays all properties of the selected network element.
You can modify the properties as required.

Right pane properties

Searches for a particular network element.Search

Refreshes the list of network elements displayed under each
tab.

Refresh

Expands or collapses the network elements available in the
network tree under each tab.

Expand/Collapse
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DescriptionOptions

Selects similar network elements available in the network
tree.
For example, select a ROADM site, and click the Select
Similar icon. All ROADM sites are selected.
You can change a property in all the selected sites at the
same time.
This option allows you to identify and compare the property
difference. For example, if a property is different among
the selected sites, that property is dimmed. You can select
an option that is applied to all the selections.

Select Similar

Deselects all selections that you make under the network
tree.

Un-Select All

Deletes the selected network elements.Delete

Adds contentionless sides to NCS 2000 networks.
Contentionless functionality on a site refers to the
contentionless add/drop ability of an N-degree ROADM
node to accommodate N wavelengths of the same
frequency from a single add/drop device. For a ROADM to
be contentionless, the number of drop units have to be
equal to ROADM degrees.
• Click the ROADM site to add contentionless sides.

• Click the Add Contentionless Side icon.

• Enter an appropriate value in the Enter number of
contentionless sides field.

• Click OK.

After adding the contentionless side, you can edit the
contentionless port property of the side at the right pane.
You can select any of the values ranging from 1 to16. The
default value is 16.

Add Contentionless Sides (available only under the
Site tab for the NCS 2000 network)

Adds L-Band sides to an NCS 1010 R7.9.1 site. To add
L-Band sides,
• Click the site or side to which you want to add L-band

sides.

• Click the Add L-Band icon.

Add L-Band (available only under the Site tab for NCS
1010 site)
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DescriptionOptions

Adds omnidirectional functionality on a site.
Omnidirectional functionality on a site refers to the ability
to route channels through any of the optical degrees in a
multidegree topology during fiber cut without the need for
physical fiber reconnections. To add omnidirectional
functionality,
• Click the ROADM site to which you want to add

omnidirectional sides.

• Click the Omni-Directional icon.

• Enter the appropriate value in the Enter number of
Omni Directional sides field.

• Click OK.

Add Omni-Directional (available only under the Site
tab for the NCS 1010 network)

Clones a service or wave that is connected between two
sites. To clone a service,
• Select a wave and click Copy.

• Enter the quantity in the Clone Service/DWDM
Channel dialog box, and click OK.

–1 is added at the end of the label of the cloned wave. An
example label of a cloned wave is Site-2-Site3-1-1. The
original wave is Site-2-Site3-1. You can rename the label.
You can also clone a service in a similar way.

Copy (available only under the Service tab)

Unlocks the required entities in an analysed network for
editing.

Unlock



B Supported ROADMs, Add/Drop Cards, and Modules

Provides a comprehensive list of supported ROADMs, Add/Drop cards, and
optical modules for Cisco ONP. Engineers can use this reference to identify

Topics:

• Supported ROADMs, Add/Drop
Cards, and Modules

specific hardware components, including chassis, controllers, and passive
modules, to effectively design and maintain their optical network infrastructure.



Supported ROADMs, Add/Drop Cards, and Modules
Lists all supported ROADMs, add/drop cards, controller cards, line cards, passive optical modules, chassis, and pluggables
for the Cisco NCS 1000, 1010, 1014, 1020, 2000, and 4000 platforms. Use this as a reference to verify hardware
compatibility in your deployment.
Cisco ONP supports the following ROADM, Add/Drop cards and modules:
Table 162: NCS 2000 ROADM Cards

Product DescriptionProduct

9-port Single Module ROADM - 20—34-dB Gain - Flex SpectrumNCS2K-9-SMR34FS=

9-port Single Module ROADM - 12—24-dB Gain - Flex SpectrumNCS2K-9-SMR24FS=

9-port Single Module ROADM - 0—17-dB Gain - Flex SpectrumNCS2K-9-SMR17FS=

20-port Single Module ROADM - Switchable Gain Flex SpectrumNCS2K-20-SMRFS=

20-port SMR - Switch. Gain Flex Spectrum with Connection VerificationNCS2K-20-SMRFS-CV=

Table 163: NCS 2000 ADD/DROP Line Cards and Optical Passive Modules

Product DescriptionProduct

4- to 12-degree 16-port Contentionless Add/Drop UnitNCS2K-16-AD-CCOFS=

6-port Colorless Flex Spectrum Add/Drop MF UnitNCS2K-MF-6AD-CFS=

MPO-16 to 16xLC Fan-Out MF Unit with Integrated MonitoringNCS2K-MF-MPO-16LC=

MPO-16 to 16xLC Fan-Out with Connection VerificationNCS2K-MF-M16LC-CV=

ONS 15216 48-channel Mux/DeMux Exposed Faceplate Patch Panel Odd15216-MD-48-ODD=

ONS 15216 48-channel Mux/DeMux Exposed Faceplate Patch Panel Even15216-MD-48-EVEN=

ONS 15216 Mux/Demux Plugin Coupler/De-Interleaver Module15216-MD-48-CM=

NCS 1000 64-channel Odd Mux/Demux Patch Panel—C-bandNCS1K-MD-64-C=

NCS 1000 32chs Even Mux/Demux Patch Panel - 150GHz—C-band EnhancedNCS1K-MD-32O-CE

NCS 1000 32chs Even Mux/Demux Patch Panel - 150GHz—C-band EnhancedNCS1K-MD-32E-CE

Table 164: NCS 2000 Controller Cards and Common Equipment

Product DescriptionProduct

NCS 2006 30A DC Power FilterNCS2006-DC=

NCS 2006 1500W AC Power SupplyNCS2006-AC=

NCS 2015 Shelf Assembly - DC PowerNCS2015-SA-DC=

NCS 2015 Shelf Assembly - AC PowerNCS2015-SA-AC=

NCS 2000 Transport Node Controller, version 2NCS2K-TNCS-2-K9=
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NCS2000 Transport Node Controller with 2x OTDR/OSC, version 2NCS2K-TNCS-2O-K9=

Transport Node Controller for NCS2002, 2006, and 2015 chassisNCS2K-TNCS-K9=

NCS 2000 Transport Node Controller with 2x OTDR/OSCNCS2K-TNCS-O-K9=

Shelf Virtualization Orchestrator - LC, FullNCS2K-SVO-K9=

Protection Switching Module (PSM) card for NCS 2000NCS2K-PSM=

Table 165: NCS 2000 Series Passive Optical Modules

Product DescriptionProduct

6RU Mechanical Frame for Passive Units—14 slots with USB HubNCS2K-MF-6RU=

6RU Mechanical Frame for Passive Units—10 slots with USB HubNCS2K-MF10-6RU=

1RU Mechanical Frame—4 slotsNCS2K-MF-1RU=

4-degree Upgrade Mesh Interconnection MF UnitNCS2K-MF-UPG-4=

4-degree Upgrade Mesh Interconnect with Connection VerificationNCS2K-MF-UPG-4-CV=

Up to 5-degree Mesh Interconnection MF UnitNCS2K-MF-DEG-5=

5-degree Mesh Interconnect with Connection VerificationNCS2K-MF-DEG-5-CV=

2RU 8-degree Mesh Patch Panel—5-Add/Drop Port + MonitoringNCS2K-PPMESH8-5AD=

Table 166: NCS 4000 Chassis and NCS 1004 Line Cards

Product DescriptionProduct

NCS 4016 shelf assembly - DC PowerNCS4016-SA-DC=

NCS 4016 shelf assembly - AC PowerNCS4016-SA-AC=

NCS 4009 shelf assembly - DC PowerNCS4009-SA-DC=

NCS 4000 400G Packet/OTN/WDM—QSFP28/CFP2 line cardNCS4K-4H-OPW-QC2=

NCS 4000 24-port low rate OTN—SFP line cardNCS4K-24LR-O-S=

Network Convergence System 1004 four line card slotsNCS1004=

Table 167: NCS 1010 Line Cards, Chassis, and PSUs

Product DescriptionProduct

NCS 1010 Optical Line Terminal—C-bandNCS1K-OLT-C=

NCS 1010 Optical Line Terminal—L-bandNCS1K-OLT-L=

NCS 1010 Optical Line Terminal with Raman—C-bandNCS1K-OLT-R-C=

NCS 1010 In-Line Amplifier—C-bandNCS1K-ILA-C=
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NCS 1010 In-Line Amplifier—L-bandNCS1K-ILA-L=

NCS 1010 In-Line Amplifier with 2x Raman—C-bandNCS1K-ILA-2R-C=

NCS 1010 In-Line Amplifier with 1x Raman—C-bandNCS1K-ILA-R-C=

NCS 1010 Shelf AssemblyNCS1010-SA=

NCS 1010 DC Power Supply UnitNCS1010-DC-PSU=

NCS 1010 AC Power Supply UnitNCS1010-AC-PSU=

NCS 1010 Optical Line Terminal—C-band, enhancedNCS1K-E-OLT-C=

NCS 1010 Optical Line Terminal with Raman—C-band, enhancedNCS1K-E-OLT-R-C=

NCS 1010 Optical Line Terminal—L-band, enhancedNCS1K-E-OLT-L=

NCS 1010 In-Line Amplifier with 1x Raman—C-band, enhancedNCS1K-E-ILA-R-C=

NCS 1010 In-Line Amplifier with 2x Raman—C-band, enhancedNCS1K-E-ILA-2R-C=

NCS 1010 In-Line Amplifier with 1x Raman west facing—C-band, enhancedNCS1K-E-ILA-R-C-2=

NCS 1014 2.4T Line CardNCS1K14-2.4T-K9=

Table 168: NCS 1014 Line Cards, Chassis, and PSUs

Product DescriptionProduct

NCS 1014 Assemble to OrderNCS1K14-SYS

NCS 1014 EDFA terminal with equalizationNCS1K14-EDFA2=

NCS 1004 AC Power Supply Unit, 2.1 kWNCS1K4-AC-PSU

NCS 1004 DC Power Supply Unit, 2.1 kWNCS1K4-DC-PSU

NCS 1004 AC Power Supply Unit, 2.5 kWNCS1K4-AC-PSU-2

NCS 1004 DC Power Supply Unit, 2.5 kWNCS1K4-DC-PSU-2

Table 169: NCS 1014 Passive Modules

Product DescriptionProduct

NCS 1000 32chs Odd Mux/Demux Patch Panel - 150GHz—C-band EnhancedNCS1K-MD-32O-CE=

NCS 1000 32chs Even Mux/Demux Patch Panel - 150GHz—C-band EnhancedNCS1K-MD-32E-CE=

Table 170: NCS 1010 Passive Modules

Product DescriptionProduct

NCS 1000 shelf for four passive modulesNCS1K-BRK-SA=

NCS 1000 MTP/MPO to 8-port passive breakout moduleNCS1K-BRK-8=
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NCS 1000 MTP/MPO to 24-port colorless channels passive breakout moduleNCS1K-BRK-24=

NCS 1000 MTP/MPO to 16-port colorless channels passive breakout moduleNCS1K-BRK-16=

NCS 1000 32-channel Odd Mux/Demux Patch Panel - 150GHz—C-bandNCS1K-MD-32O-C=

NCS 1000 32-channel Even Mux/Demux Patch Panel - 150GHz—C-bandNCS1K-MD-32E-C=

NCS 1000 16-port Colorless Mux/Demux Optical Line Card—C-bandNCS1K14-CCMD-16-C

NCS 1000 16-port Colorless Mux/Demux Optical Line Card—L-bandNCS1K14-CCMD-16-L

Table 171: NCS 1020 Chassis and Modules

Product DescriptionProduct

NCS 1020 Shelf AssemblyNCS1020-SA=

NCS 1010, 1012, 1020 Controller, 112500-bps Default Console Baud RateNCS1010-CTR2-K9=
NCS 1010, 1012, 1020 Controller, 9600-bps Console Baud RateNCS1010-CTR2-B-K9=
NCS 1020 Fan for NCS 1014 SlotsNCS1020-FAN=
NCS 1020 Fan BlankNCS1020-FAN-BLANK=
Filler / Blank for NCS 1010 Slot on NCS 1012, 1020, PassiveNCS1010-FLR-P=
Filler / Blank for NCS 1010 Slot on NCS 1012, 1020, Active, with Fan slotsNCS1010-FLR-A=
Filler / Blank for Controller Slot on NCS 1012, 1020NCS1010-CTR2-FLR=
Network Convergence System 1014 Blank cardNCS1K14-BLANK=

Table 172: NCS 1001 Chassis, Modules, and Pluggables

Product DescriptionProduct

Network Convergence System 1001 line system 3 slotsNCS1001-K9=
Network Convergence System 1001 Control cardNCS1K-CNTLR2=
Network Convergence System 1001 amplifier moduleNCS1K-EDFA=
Network Convergence System 1001 protection moduleNCS1K-PSM=
Network Convergence System 1001 AC power supply unit - 2KW normal
operating temperature, 600W short term high temperature

NCS1K-2KW-AC2=

Network Convergence System 1001 DC power supply unit - 2KW normal
operating temperature, 600W short term high temperature

NCS1K-2KW-DC=

Network Convergence System 1001 line system FanNCS1K1-FAN=
SFP OC-48/STM-16/GE, CWDM, 1510 nmONS-SC-Z3-1510=
SFP OC-3/STM-1, CWDM, 1510 nm EXT; SFP Pluggable Optics ModuleONS-SE-155-1510
CWDM 1510-nm SFP; Gigabit Ethernet 1 and 2 Gb Fibre ChannelCWDM-SFP-1510
CWDM 1610-nm SFP; Gigabit Ethernet 1 and 2 Gb Fibre ChannelCWDM-SFP-1610
SFP OC-48/STM-16/GE, CWDM, 1610 nmONS-SC-Z3-1610=
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ONS Multiplexer/Demultiplexer Patch Panel Even Extended15216-MD-48-ODDE
ONS Multiplexer/Demultiplexer Patch Panel Odd Extended15216-MD-48-EVENE
ONS Coupler and Splitter15216-MD-48-CME
OSC Combiner and Splitter15216-FLD-OSC
NCS 1000 64 channels Odd Multiplexer/Demultiplexer Patch Panel-C-bandNCS1K-MD-64-C
NCS 1000 32chs Even Mux/Demux Patch Panel - 150GHz—C-band EnhancedNCS1K-MD-32E-CE



C Supported Cards and Pluggables

Outlines compatible transponder and muxponder hardware, pluggables, and
configuration settings for Cisco NCS 2000 and NCS 1010 networks. It enables

Topics:

• Supported transponder cards and
pluggables

users to verify hardware support and identify appropriate FEC, encryption, and
trunk mode parameters to ensure successful network implementation and
validation.
Table 173: Feature History

Feature DescriptionRelease InformationFeature Name

These NCS 1000
transponders are
supported:
• NCS1K14-2.4T-K9

• NCS1K14-2.4T-X-K9

• NCS1K14-2.4T-A-K9

• NCS1K4-1.2T-K9

• NCS1K4-1.2TL-K9

• NCS1K4-2-QDD-C-K9

• NCS1K4-OTN-XP-K9

• NCS1K4-QXP-K9

Cisco ONP Release
26.1.1

Support for all NCS 1000
transponders



Supported transponder cards and pluggables
Provides comprehensive tables and lists of supported transponder cards and pluggables for the NCS 2000 and NCS
1010 optical transport platforms.
Table 174: Feature History

Feature DescriptionRelease InformationFeature Name

QSFP-100G-FR-S= pluggable is
supported on the QSFP ports of the
400G-XP LC transponder card with
100GE data rate.

Cisco ONP Release 4.1Pluggable Support

The newQSFP-100G-ERL-Spluggable
enables you to design and validate
topologies for NCS 2000 R11.1.3
networks. This pluggable is supported
on the QSFP ports of the 400G-XP-LC
transponder cardwith 100GE data rate.
You can select this pluggable from the
Client Interface drop-down list at
trail level properties for the
400G-XP-LC transponder card.

Cisco ONP Release 5.1QSFP-100G-ERL-S Pluggable

Cisco ONP supports the following transponders and pluggables for NCS 2000 networks:
Table 175: Supported Transponder Cards and Pluggables for NCS 2000 Network

Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

Auto,
TRK_200G

NoYes (only
for
100GE)

• SR-1(CPAK-100G-SR10)

• SR-1(CPAK-100G-SR4)

• LR-1(CPAK-100G-LR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

SD-FEC_20• 100GE

• OTU4

200G-CK-LC
+ MR-MXP
(200G MXP
mode)

Auto,
TRK_100G

YesYes• SR-1(CPAK-100G-SR10)

• SR-1(CPAK-100G-SR4

• LR-1(CPAK-100G-LR4)

SD-FEC_20100GE200G-CK-LC
+ MR-MXP
(100G TXP
mode)

Auto,
TRK_100G

YesYes• SR-1(CPAK-100G-SR10)

• SR-1(CPAK-100G-SR4

• LR-1(CPAK-100G-LR4)

SD-EFEC100GE200G-CK-LC
+ MR-MXP
(100G TXP
mode)

Auto,
TRK_100G

YesYes• SR-1(CPAK-100G-SR10)

• SR-1(CPAK-100G-SR4

• LR-1(CPAK-100G-LR4)

SD-FEC100GE200G-CK-LC
+ MR-MXP
(100G TXP
mode)
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

Auto,
TRK_100G

YesYes• LR-1(ONS-QSFP-4*10G-MLR)

• LR-1(QSFP-4*10G-MLR)

• SR-1(QSFP-40G-SR4)

• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

SD-FEC_20• 10GE

• 10GE
LAN PHY

• OC192

• OTU2

200G-CK-LC
+ MR-MXP
(100G MXP
mode)

Auto,
TRK_100G

YesYes• LR-1(ONS-QSFP-4*10G-MLR)

• LR-1(QSFP-4*10G-MLR)

• SR-1(QSFP-40G-SR4)

• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

SD-EFEC• 10GE

• 10GE
LAN PHY

• OC192

• OTU2

200G-CK-LC
+ MR-MXP
(100G MXP
mode)

Auto,
TRK_100G

YesYes• LR-1(ONS-QSFP-4*10G-MLR)

• LR-1(QSFP-4*10G-MLR)

• SR-1(QSFP-40G-SR4)

• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

SD-FEC• 10GE
LAN PHY

• 10GE

• OC192

• OTU2

200G-CK-LC
+ MR-MXP
(100G MXP
mode)

Auto,
TRK_100G

YesYes• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• LR-1(QSFP-40G-LR4)

• DWDM(ONS-SC+-10GEPxx.x)

• SR-1(QSFP-40G-SR4)

• SR-1(QSFP-40G-SR-BD)

SD-FEC_20• 10GE

• 10GE
LAN PHY

• 40GE

200G-CK-LC
+ MR-MXP
(100G MXP
mode 2*10G
2*40G MODE)
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

Auto,
TRK_100G

YesYes• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• SR-1(QSFP-40G-SR4)

• LR-1(QSFP-40G-LR4)

• SR-1(QSFP-40G-SR-BD)

SD-EFEC• 10GE

• 40GE

200G - CK-LC
+ MR - MXP
(100G MXP
mode 2*10G
2*40G MODE)

Auto,
TRK_100G

YesYes• SR-1(ONS-SC+10G-SR)

• LR-1(ONS-SC+10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• SR-1(QSFP-40G-SR4)

• LR-1(QSFP-40G-LR4)

• SR-1(QSFP-40G-SR-BD)

SD-FEC• 10GE

• 40GE

200G - CK-LC
+ MR -MXP
(100G MXP
mode 2*10G
2*40G MODE)

Auto,
TRK_100G

NoYes for
OTU2e

• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR (ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

SD- FEC_20• 10GE

• OC192

• OTU2

• OTU2e

200G - CK-LC
+10x10G -LC

Auto,
TRK_100G

NoYes for
OTU2e

• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER (ONS-SC+-10G-ER)

• ZR (ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

SD-EFEC• 10GE

• OC192

• OTU2

• OTU2e

200G - CK-LC
+10x10G -LC

Cisco Optical Network Planner | Updated March 10, 2026

| Supported Cards and Pluggables | 360



Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

Auto,
TRK_100G

NoYes for
OTU2e

• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

SD-FEC• 10GE

• OC192

• OTU2

• OTU2e

200G-CK-LC
+ 10x10G -LC

Auto,
TRK_200G

NoYes for
100GE
and OTU2

• SR-1(CPAK-100G-SR10)

• SR-1(CPAK-100G-SR4)

• LR-1(CPAK-100G-LR4)

• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

SD- FEC_20• 100GE

• 10GE

• OC192

• OTU2

200G - CK-LC
+ MR-MXP
(200G Mxp
100G+10*10G
Mode)

Auto,
TRK_200G

YesYes• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• SR-1(QSFP-40G-SR4)

• LR-1(QSFP-40G-LR4)

• SR-1(QSFP-40G-SR-BD)

SD- FEC_20• 10GE

• 10GE
LAN PHY

• 40GE

200G-CK-LC
+ MR-MXP +
MR-MXP
(200G Mxp
4*40G +
4*10G Mode)
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

Auto,
TRK_200G

YesYes• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

• LR-1(ONS-QSFP-4*10G-MLR)

• ZR(ONS-SC+-10G-ZR)

SD- FEC_20• 10GE

• OC192

• OTU2

200G-CK-LC
+ 10x10G -LC
+ MR-MXP

Auto,
TRK_200G

YesYes• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

• LR-1(ONS-QSFP-4*10G-MLR)

• ZR(ONS-SC+-10G-ZR)

SD-FEC_20• 10GE

• OC192

• OTU2

200G-CK-LC
+ MR-MXP +
MR-MXP

Auto,
TRK_100G

NoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

EFEC,
SD-FEC_20

• 10GE

• OC192

100GS -
CK-LC +
10x10G-LC
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

FEC• 10GE

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G - LC-C
+ 10x10G-LC

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER (ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

EFEC• 10GE

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G - LC-C
+ 10x10G-LC

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER (ONS-SC+-10G-ER)

• ZR (ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

HG-FEC• 10GE

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G - LC-C
+ 10x10G-LC
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

FEC• 10GE

• 10GE
LAN PHY

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G - CK-
LC-C +
10x10G-LC

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

EFEC• 10GE

• 10GE
LAN PHY

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G
-CK-LC-C +
10x10G-LC

AutoNoNo• SR-1(ONS-SC+-10G-SR)

• LR-1(ONS-SC+-10G-LR)

• DWDM(ONS-SC+-10G-C)

• DWDM(ONS-SC+-10GEPxx.x)

• ER(ONS-SC+-10G-ER)

• ZR(ONS-SC+-10G-ZR)

• DWDM(ONS-SC+-10G-xx.x)

HG-FEC• 10GE

• 10GE
LAN PHY

• OC192

• Fiber
Channel
10G

• Fiber
Channel
8G

• OTU2

• OTU2e

100G -
CK-LC-C +
10x10G-LC
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

TRK_100G,
TRK_200G

YesYes• SR-1(QSFP-100G-SR4-S)

• LR-1(QSFP-100G-LR4-S)

• LR-1(QSFP-28-LR4)

• SR-1(QSFP-100G-SM-SR)

• SR-1(QSFP-40/100G-SRBD)

• LR-1(ONS-QSFP-4*10G-MLR)

• LR-1(QSFP-4*10G-LR)

• SR-1(QSFP-40G-SR4)

• ER(ONS-QSFP-4*10G-MER)

• LR-1(QSFP-40G-LR4)
SR-1(QSFP-40G-SR-BD

• LR-1(ONS-QC16GFC-LW)

• LR-1(ONS-QC16GFC-SW)

• LR-1(ONS-QSFP28-LR4)

• FR-1 (QSFP-100G-FR-S) (only
for 100GE)

• ER-1 (QSFP-100G-ERL-S) (only
for 100GE)

SD-FEC_25-
NO_DE

• 100GE

• 10GE
LAN PHY

• 10GE

• 40GE

• Fiber
Channel
10G

• Fiber
Channel
16G

• Fiber
Channel
8G

• OC192
/STM64

• OTU2

• OTU2e

• OTU4

400G-XP-LC
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

TRK_100G,
TRK_200G

YesYes• SR-1(QSFP-100G-SR4-S)

• LR-1(QSFP-100G-LR4-S)

• LR-1(QSFP-28-LR4)

• SR-1(QSFP-100G-SM-SR)

• SR-1 (QSFP-40/100G-SRBD)

• LR-1(ONS-QSFP-4*10G-MLR)

• LR-1(QSFP-4*10G-LR)

• SR-1(QSFP-40G-SR4)

• ER(ONS-QSFP-4*10G-MER)

• LR-1(QSFP-40G-LR4)

• SR-1(QSFP-40G-SR-BD

• LR-1(ONS-QC16GFC-LW)

• LR-1(ONS-QC16GFC-SW)

• LR-1(ONS-QSFP28-LR4)

• FR-1 (QSFP-100G-FR-S) (only
for 100GE)

• LR-1 (QSFP-100G-ERL-S) (only
for 100GE)

SD-FEC_15
-NO_DE

• 100GE

• 10GE
LAN PHY

• 10GE

• 40GE

• Fiber
Channel
10G

• Fiber
Channel
16G

• Fiber
Channel
8G

• OC192
/STM64

• OTU2

• OTU2e

• OTU4

400G-XP-LC

AutoNoNoSR-1(CPAK-100G-SR10)FEC• 100GE

• OTU4

100G-LC-C

AutoNoNoSR-1(CPAK-100G-SR10)EFEC• 100GE

• OTU4

100G-LC-C

AutoNoNoSR-1(CPAK-100G-SR10)HGFEC• 100GE

• OTU4

100G-LC-C

AutoNoNo• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

FEC• 100GE

• 40GE

• OTU4

100G -
CK-LC-C

AutoNoNo• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

EFEC• 100GE

• 40GE

• OTU4

100G -
CK-LC-C
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Trunk
Mode

Encryption
Non-SSON

Encryption
SSON

Pluggables SupportedFEC modeTraffic
Type

Transponder/
Muxponder

AutoNoNo• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

HGFEC• 100GE

• 40GE

• OTU4

100G -
CK-LC-C

Auto,
TRK_100G

NoYesSR-1(CPAK-100G-SR10)FEC100GE100GS -
CK-LC

Auto,
TRK_100G

NoYEsLR-1(CPAK-100G-LR4)EFEC100GE100GS -
CK-LC

Auto,
TRK_100G

NoYesSR-1(CPAK-100G-SR10)SD-FEC_20100GE100GS -
CK-LC

Auto,
TRK_100G

NoYes (for
100GE)

• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

FEC• 100GE

• OTU4

200G - CK-LC
(100G Mode
only)

Auto,
TRK_100G

NoYes (for
100GE)

• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

EFEC• 100GE

• OTU4

200G - CK-LC
(100G Mode
only)

Auto,
TRK_100G

NoYes (for
100GE)

• SR-1(CPAK-100G-SR4)

• SR-1(CPAK-100G-SR10)

• LR-1(CPAK-100G-LR4)

SD-FEC_20• 100GE

• OTU4

200G-CK-LC
(100G Mode
only)

Cisco ONP supports the following transponders and pluggables for NCS 1010 networks:
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Table 176: Supported Transponder Cards and Pluggables for NCS 1010 Network

TrunkModeEncryptionPluggables SupportedFEC modeTraffic
Type

Transponder /
Muxponder

Trunk
Pluggables

Client Pluggables

• Auto

• 400G

• 500G

• 600G

• 700G

• 800G

• 900G

• 1000G

• 1100G

• 1200G

No• Auto

• CIM8-C-K9

• CIM8-CE-K9

• CIM8-LE-K9

• Auto

• QDD-400G-FR4-S

• QDD-400-AOC1M

• QDD-400G-DR4-S

• QDD-4x100G-LR-S

SD_FEC_15100GE
400GE

NCS1K14-2.4T-K9

• Auto

• 400G

• 500G

• 600G

• 700G

• 800G

• 900G

• 1000G

• 1100G

• 1200G

Yes• Auto

• CIM8-LE-K9

• CIM8-C-K9

• CIM8-CE-K9

• Auto

• QDD-400G-FR4-S

• QDD-400-AOC1M

• QDD-400G-DR4-S

• QDD-400G-LR4-S

• QDD-4x100G-LR-S

• QDD-4x100G-FR-S

• QDD-2X100-LR4-S

• QDD-2X100-CWDM4-S

SD_FEC_15100GE
400GE

NCS1K14-2.4T-X-K9

• Auto

• 400G

• 500G

• 600G

• 700G

• 800G

• 900G

• 1000G

• 1100G

• 1200G

Yes• Auto

• CIM8-C-K9

• CIM8-CE-K9

• CIM8-LE-K9

• Auto

• QDD-4x100G-LR-S

• QDD-4x100G-FR-S

• QDD-400G-FR4-S

• QDD-400G-AOCxM

• QDD-400G-DR4-S

• QDD-400G-LR4-S

SD_FEC_15100GE
400GE

NCS1K14-2.4T-A-K9
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TrunkModeEncryptionPluggables SupportedFEC modeTraffic
Type

Transponder /
Muxponder

Trunk
Pluggables

Client Pluggables

• AutoYes• Auto

• QDD-400G-ZR-S

• DP04QSDD-HK9

• DP04QSDD-LK9

• DP04QSDD-HE0

• AutoOFEC
CFEC

100GENCS1K4-QXP-K9

• 100G• QSFP-100G-DR-S

• QSFP-100G-LR4-S

• QSFP-100G-LR-S

• ONS-QSFP-28-LR4

• QSFP-100G-CWDM4-S

• QSFP-100G-FR-S

• QSFP-100G-SR4-S

• 100G

• 200G

• 300G

• 400G

• QDD-4x100G-LR-S

• 400G• Auto

• QDD-400G-ZRP-S

• DP04QSDD-HK9

• DP04QSDD-LK9

• DP04QSDD-HE0

• QDD-400G-FR4-S

• QDD-400-AOC1M

• QDD-400G-DR4-S

400GE

• Auto

• Bundle:
50G –
550G

• Slice:
100G –
600G

• Muxponder:
100G –
600G

YesSame as client
pluggables
Aot applicable for
these cards:
NCS1K4-1.2T-K9,
NCS1K4-1.2TL-K9,
NCS1K4-2-QDD-C-K9

• QSFP-100G-SR4-S

• QSFP-100G-CWDM4-S

• QSFP-100G-SM-SR

• QSFP-100G-AOC-1M

• QSFP-100G-LR4-S

• QSFP-100G-CU1M

• QSFP-100G-DR-S

• QSFP-100G-FR-S

• QSFP-100G-LR-S

• ONS-QSFP28-LR4

• QSFP-40/100-SRBD

• QSFP-100G-ER4L-S

SD_FEC_15
(600G)
SD_FEC_27

100GE
OTU4

NCS1K4-1.2T-K9
and
NCS1K4-1.2TL-K9
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TrunkModeEncryptionPluggables SupportedFEC modeTraffic
Type

Transponder /
Muxponder

Trunk
Pluggables

Client Pluggables

• Auto

• 50G

• 150G

• 250G

• 350G

• 400G

• 450G

• 500G

• 550G

No• QSFP-100G-DR-S

• QSFP-100G-SM-SR

• QSFP-100G-CWDM4-S

• QSFP-100G-LR4-S

• QSFP-100G-SR4-S

• ONS-QSFP28-LR4

• QSFP-100G-AOC1M

SD_FEC_15
(600G)
SD_FEC_27

100GE
400GE
OTU4

NCS1K4-2-QDD-C-K9

• Auto

• 200G

• 300G

• 400G

NoQDD-400G-ZRP• QSFP-100G-DR-S

• QSFP-100G-SM-SR

• QSFP-100G-CWDM4-S

• QSFP-100G-LR4-S

• QSFP-100G-SR4-S

• ONS-QSFP28-LR4

• QSFP-100G-AOC1M

• QSFP-100G-ERL-S

• ONS-QSFP28-LR4

• QSFP-100G-LR-S

• QSFP-100G-FR-S

• QSFP-100G-LR-S

• QSFP-400G-DR4-S

• QSFP-400G-AOC1M

• QSFP-400G-FR4-S

• QSFP-400G-LR8-S

CFEC
OFEC

100GE
400GE

NCS1K4-OTN-XP



D Supported Optical Sources

Provides a comprehensive list of supported optical sources and pluggable
interfaces for Cisco ONP, enabling users to accurately simulate optical network

Topics:

• Supported Optical Sources feasibility. It details specific configurations for various hardware platforms to
ensure compatibility and performance across different system releases.



Supported Optical Sources
Lists optical sources supported across NCS 2000 and related network releases, including feature history and compatibility
details.
Table 177: Feature History

Feature DescriptionRelease InformationFeature Name

Optical Sources enable you to simulate the optical feasibility
of the network with the 400G and other interfaces that are
not natively modeled in Cisco ONP. The following Optical
Sources are introduced in this release:
• ONS-CFP2D-400G-C-OpticalSources-V 2.mxd

• QDD-400G-ZRP-S-OpticalSources-V2.mxd

Cisco ONP Release 4.2New Optical Source and
Pluggable Support

Cisco ONP supports the following optical sources:

Note

From Release 24.3.1, the optical sources for NCS 2000 networks are tagged with System Release to indicate from
when the optical sources support the network release.

• OpticalSources_NCS2K_400GXP-LC_NCS4K-4H-OPW-QC2 DWDM Line Card
• 400GXP_100G_25%_DE

• 400GXP_200G_15%_DE

• 100G-SD-FEC

• 400GXP_100G_15%_DE

• 200G-SD-FEC

• 400GXP_100G_15%

• 400GXP_200G_15%

• 400GXP_200G_25%DE

• NCS1004_OpticalSources_V3
• NCS1004_QPSK_SP_16QAM_200G_27%SDFEC_60GBd

• NCS1004_SP_16QAM_300G_27%SDFEC_69GBd

• NCS1004_QPSK_200G_27%SDFEC_69GBd

• NCS1004_16QAM_32QAM_400G_27%SDFEC_62GBd

• NCS1004_16QAM_400G_27%SDFEC_69GBd

• NCS1004_SP_16QAM_16QAM_300G_27%SDFEC_60GBd

• NCS1004_32QAM_500G_27%SDFEC_69GBd
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• NCS1004_L_Band_OpticalSource_v4
• NCS1004_L_200G_QPSK_27%SDFEC_69GBd

• NCS1004_L_200G_QPSK_SP_16QAM_27%SDFEC_60GBd

• NCS1004_L_300G_SP_16QAM_16QAM_27%SDFEC_60GBd

• NCS1004_L_300G_SP_16QAM_27%SDFEC_69GBd

• NCS1004_L_400G_16QAM_32QAM_27%SDFEC_62GBd

• NCS1004_L_400G_16QAM_27%SDFEC_69GBd

• NG_NCS1004_OpticalSource_V1
• NG_NCS1004_SP_16QAM_300G_27%SDFEC_69GBd

• NG_NCS1004_SP_16QAM_16QAM_300G_27%SDFEC_60GBd

• NG_NCS1004_16QAM_400G_27%SDFEC_69GBd

• NG_NCS1004_32QAM_500G_27%SDFEC_69GBd

• NG_NCS1004_QPSK_200G_27%SDFEC_69GBd

• NG_NCS1004_QPSK_SP_16QAM_200G_27%SDFEC_60GBd

• NG_NCS1004_16QAM_32QAM_400G_27%SDFEC_62GBd

• QDD and CFP2-DCO variants
• ONS-CFP2D-400G-C-OpticalSources-V2.mxd

• CFP2_200OR_TXP_FOIC2_OFEC_15_DE_ON_4Q_1S_BR63_1

• CFP2_300OR_TXP_FOIC3_OFEC_15_DE_ON_8Q_1S_BR63_1

• CFP2_400OR_TXP_FOIC4_OFEC_15_DE_ON_16Q_1S_BR63_1

• ONS-CFP2D-400G-C-OpticalSources-V2.mxd
• CFP2_300ZR+_MXP_GAUI8_OFEC_15_DE_ON_8Q_0S_BR60_1

• CFP2_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_8Q_1E_BR40_1

• CFP2_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_16Q_1E_BR30_1

• CFP2_400ZR_TXP_GAUI8_CFEC_15_DE_ON_16Q_0S_BR59_8

• CFP2_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_4Q_0S_BR60_1

• CFP2_100ZR+_TXP_GAUI2_OFEC_15_DE_ON_4Q_1S_BR30_1

• CFP2_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_4Q_1S_BR60_1

• CFP2_400ZR+_TXP_GAUI8_OFEC_15_DE_ON_16Q_1E_BR60_1

• CFP2_300ZR+_MXP_GAUI8_OFEC_15_DE_ON_8Q_1E_BR60_1

• CFP2_400ZR+_TXP_GAUI8_OFEC_15_DE_ON_16Q_0S_BR60_1

• CFP2_100OR_TXP_FOIC1_OFEC_15_DE_ON_4Q_1S_BR31_6

2 The optical source interfaces are supported for SSON networks.
3 The optical source interfaces are supported for SSON and non-SSON networks.
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• CFP2_200OR_TXP_FOIC2_OFEC_15_DE_ON_8Q_1S_BR42_1

• CFP2_200OR_TXP_FOIC2_OFEC_15_DE_ON_16Q_1E_BR31_6

• QDD-400G-ZRP-S-OpticalSources-V2.mxd
• QDD_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_4Q_1S_BR60_1

• QDD_400ZR_TXP_GAUI8_CFEC_15_DE_ON_16Q_0S_BR59_8

• QDD_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_4Q_0S_BR60_1

• QDD_400ZR+_TXP_GAUI8_OFEC_15_DE_ON_16Q_1E_BR60_1

• QDD_400ZR+_TXP_GAUI8_OFEC_15_DE_ON_16Q_0S_BR60_1

• QDD_300ZR+_MXP_GAUI8_OFEC_15_DE_ON_8Q_1E_BR60_1

• QDD_400ZR+_TXP_GAUI8_OFEC_15_DE_ON_16Q_0E_BR60_1

• QDD_300ZR+_MXP_GAUI8_OFEC_15_DE_ON_8Q_0E_BR60_1

• QDD_100ZR+_TXP_GAUI2_OFEC_15_DE_ON_4Q_1S_BR30_1

• QDD_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_16Q_1E_BR30_1

• QDD_300ZR+_MXP_GAUI8_OFEC_15_DE_ON_8Q_0S_BR60_1

• QDD_200ZR+_MXP_GAUI2_OFEC_15_DE_ON_8Q_1E_BR40_1

• From Release 24.3.1, CONP supports QDD-400G-ZR-S Optical Sources.
QDD_400ZR_TXP_GAUI8_CFEC_15_DE_ON_16Q_0S_BR59_8

• Bright ZR+ Optical Sources
• Bright-400G-FOIC4-OFEC-16QAM-1-E_BR63_14

• Bright-400G-FOIC4-OFEC-16QAM-1-S_BR63_14

• Bright-300G-FOIC3-OFEC-8QAM-1-S_BR63_14

• Bright-200G-FOIC2-OFEC-QPSK-1-S_BR63_14

• Bright-200G-FOIC2-OFEC-8QAM-1-E_BR42_09

• Bright-200G-FOIC2-OFEC-16QAM-1-E_BR31_57

• Bright-200G-FOIC2-OFEC-16QAM-1-S_BR31_57

• Bright-100G-FOIC1-OFEC-QPSK-1-S_BR31_57

• Bright-100G-FOIC1-OFEC-DQPSK-1-S_BR31_57

• Bright-400G-400ZR-CFEC-16QAM-1-S_BR59_84

• Bright-400G-400ZRP-OFEC-16QAM-1-E_BR60_14

• Bright-400G-400ZRP-OFEC-16QAM-1-S_BR60_14

• Bright-300G-300ZRP-OFEC-8QAM-1-E_BR60_14

• Bright-300G-300ZRP-OFEC-8QAM-1-S_BR60_14

• Bright-200G-200ZRP-OFEC-QPSK-1-S_BR60_14

• Bright-200G-200ZRP-OFEC-8QAM-1-E_BR40_09
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• Bright-200G-200ZRP-OFEC-16QAM-1-E_BR30_07

• Bright-100G-100ZRP-OFEC-QPSK-1-S_BR30_07

• Bright-100G-OTU4-SCFEC-DQPSK-1-S_BR27_95

• From Release 24.3.1, CONP supports the DP04QSDD-HE0 Optical Sources.
Bright_100G_100ZRP_OFEC_QPSK_1S_BR30_07

• Bright_200G_200ZRP_OFEC_16QAM_1E_BR30_07

• Bright_400G_400ZRP_OFEC_16QAM_1S_BR60_14

• Bright_200G_200ZRP_OFEC_8QAM_1E_BR40_09

• Bright_400G_400ZRP_OFEC_16QAM_1E_BR60_14

• Bright_300G_300ZRP_OFEC_8QAM_1E_BR60_14

• Bright_300G_300ZRP_OFEC_8QAM_1S_BR60_14

• Bright_200G_200ZRP_OFEC_QPSK_1S_BR60_14

• Bright_400G_400ZR_CFEC_16QAM_1S_BR59_84

Note

Delete any of the old versions of Bright ZR+ optical sources that may be present in the server. The latest list of
optical resources will be automatically loaded after Cisco ONP, Release 5.1 software is installed.

• Bright_ZRP_OpticalSources_V2
The Rx OSNR sensitivity is improved for the Bright_400G_400ZRP_OFEC_16QAM_1E_BR60_14 interface in the new
version.
The latest list of optical resources will be automatically loaded after Cisco ONP, Release 5.2 software is installed.

• From Release 25.1.1, CONP supports the CIM8 Optical Sources:
CIM8_OpticalSource_v13
• CIM8_400G_15FEC_Eth_ZR_BR108

• CIM8_400G_15FEC_Eth_ZR_BR130

• CIM8_400G_15FEC_Eth_ZR_BR88

• CIM8_500G_15FEC_Eth_ZR_BR128

• CIM8_500G_15FEC_Eth_ZR_BR88

• CIM8_600G_15FEC_Eth_ZR_BR128

• CIM8_600G_15FEC_Eth_ZR_BR98

• CIM8_700G_15FEC_Eth_ZR_BR98

• CIM8_700G_15FEC_Eth_ZR_BR128

• CIM8_800G_15FEC_Eth_ZR_BR108

• CIM8_800G_15FEC_Eth_ZR_BR118

Cisco Optical Network Planner | Updated March 10, 2026

| Supported Optical Sources | 375



• CIM8_800G_15FEC_Eth_ZR_BR128

• CIM8_800G_15FEC_Eth_ZR_BR138

• CIM8_900G_15FEC_Eth_ZR_BR118

• CIM8_900G_15FEC_Eth_ZR_BR138

• CIM8_1000G_15FEC_Eth_ZR_BR128

• CIM8_1000G_15FEC_Eth_ZR_BR138

• CIM8_1100G_15FEC_Eth_ZR_BR138

• CIM8_1200G_15FEC_Eth_ZR_BR138

• CIM8_500G_15FEC_Eth_ZR_BR138

• CIM8_600G_15FEC_Eth_ZR_BR138

• CIM8_700G_15FEC_Eth_ZR_BR138

1. Delphi_ULH_Optical_Source_v2 (new)
• Delphi-400G-ULH_OpenZR_16Q_OS_E_60_1

• Delphi-400G-ULH_OpenZR_16Q_OS_HB_60_1

• Delphi-400G-ULH_FlexO-4e_OS_65_7

• Delphi-400G-ULH_FlexO-4_MPCS_OS_69_1

• Delphi-400G-ULH_FlexO-4e_MPCS_OS_75

• Delphi-400G-ULH_FlexO-4e_MPCS_OS_78_9

• Delphi-400G-ULH_FlexO-4_MPCS_OS_87_3

• Delphi-400G-ULH_FlexO-4e_MPCS_OS_87_4

• Delphi-400G-ULH_FlexO-4e_MPCS_OS_97_9

• Delphi-400G-ULH_FlexO-4e_QPSK_NOS_OR_118_2

• Delphi-400G-ULH_OpenZR_16Q_OS_LA_60_1

• Delphi-400G-ULH_FlexO-4_MPCS_OS_100_8

Pluto_QSFP28_100G_Optical_Source_v1 (new)
• QSFP28_100G_SC_FEC_7_QPSK_BR28
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Note

NCS 1004 is supported as an optical source.

Note

The following optical source files are not supported in NCS 2000 Release 11.0:
• NCS1004_16QAM_32QAM_400G_27%SDFEC_62GBd

• NCS1004_QPSK_SP_16QAM_200G_27%SDFEC_60GB

Hence, we recommend you to upgrade the system release of the network to Release 11.1, or force the optical source
files that are supported for the Release 11.0.
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E Supported Amplifiers

Provides a comprehensive list of amplifiers compatible with Cisco ONP across
the NCS2000, NCS1010, NCS1001, and NCS1014 product series. Users can

Topics:

• Supported amplifiers reference these technical specifications to determine appropriate hardware
selections and gain parameters for their optical network configurations.



Supported amplifiers
Lists the supported amplifier models for Cisco NCS 2000, NCS 1010, NCS 1001, and NCS 1014 platforms and their
specifications.
Cisco ONPupport several amplifier models, each with unique features and descriptions. The following tables summarize
the supported devices and their specifications.
Table 178: Cisco ONP Supported NCS 2000 Amplifiers

DescriptionAmplifier

Raman Amp C-Band15454-M-RAMAN-CTP

Raman Amp C-Band15454-M-RAMAN-COP

Erbium Doped Fiber Amplifier (EDFA) that can function in
dual gain with maximum gain of 35 dB

EDFA 35 for OLA node

21dBm EDFA + Bst 26dB Span - C-BandNCS2K-EDRA2-26C

21dBm EDFA 26dB Span - C-BandNCS2K-EDRA1-26C

21dBm EDFA + Bst 35dB Span - C-BandNCS2K-EDRA2-35C

21dBm EDFA35dB Span - C-BandNCS2K-EDRA1-35C

Note

• RAMAN-CTP is supported on all nodes.

• EDRAs are supported on the OLA node.

• For ROADM and Traffic nodes, the booster amplifier and preamplifier are in-built. The booster is 20SMR-FS-BST.

Table 179: Cisco ONP Supported NCS 1010 Amplifiers

DescriptionAmplifier

Tilt Uncontrolled Range
Gain (dB)

Standard Range Gain
(dB)

Lower Range Gain (dB)

C-Band

312416OLT-C-Bst

252212OLT-C-Pre-Normal

353217OLT-C-Pre-Extended

20178ILA-C-Normal

333013ILA-C-Extended

23178ILA-R-C-Normal
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DescriptionAmplifier

Tilt Uncontrolled Range
Gain (dB)

Standard Range Gain
(dB)

Lower Range Gain (dB)

363013ILA-R-C-Extended

20178ILA-2R-C-Normal

333013ILA-2R-C-Extended

20178E-ILA-R-C-Normal

333013E-ILA-R-C-Extended

20178E-ILA-2R-C-Normal

333013E-ILA-2R-C-Extended

20178E-ILA-C-R-2-Normal

333013E-ILA-C-R-2-Extended

L-Band

32.525.517.5OLT-L-Bst

26.323.313.3OLT-L-Pre-Normal

39.336.318.3OLT-L-Pre-Extended

22.819.810.8ILA-L-Normal

35.832.815.8ILA-L-Extended

Table 180: Cisco ONP Supported NCS 1001 Amplifiers

DescriptionAmplifier

Tilt Uncontrolled
Extended Range Gain
(dB)

Standard Range Gain
(dB)

Pre Amplifier Gain (dB)

20-251-20NCS1K-EDFA-Bst
24-270-24NCS1K-EDFA-Pre - Range 1
34-2720-34NCS1K-EDFA-Pre - Range 2

Table 181: Cisco ONP Supported NCS 1014 Amplifiers

DescriptionAmplifier

Tilt Uncontrolled
Extended Range Gain
(dB)

Standard Range Gain
(dB)

Fixed Gain (dB)

--8NCS1K14-EDFA2-Bst-1 -
Range 1
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DescriptionAmplifier

Tilt Uncontrolled
Extended Range Gain
(dB)

Standard Range Gain
(dB)

Fixed Gain (dB)

--20NCS1K14-EDFA2-Bst-1 -
Range 2

24-2712-24-NCS1K14-EDFA2-Bst-2
25-280-25-NCS1K14-EDFA2-Pre -

Range 1
36-2920-26-NCS1K14-EDFA2-Pre -

Range 2



F Troubleshoot Tasks for Cisco ONP

Assists administrators in resolving configuration errors within Cisco ONP by
detailing common warning messages and their underlying causes. Users can

Topics:

• Error messages and troubleshooting
workarounds for Cisco ONP

utilize the provided workarounds to address network analysis issues, connectivity
problems, and spectral allocation failures effectively.



Error messages and troubleshooting workarounds for Cisco ONP
Lists common error messages encountered during [Product Name] configuration and describes probable causes and
workarounds for each scenario.
This table describes the common error messages that are related to Cisco ONP configuration and the workarounds:
Table 182: Troubleshooting Tasks for Cisco ONP Configuration

WorkaroundProbable Reason for the ErrorWarning Message or Error

Check and add the required number of
contentionless sides on the target
service or wave source and destination
sites.

Required contentionless sides are not
created on add/drop sites. For
protected service or wave, minimum
two contentionless sides are required
on the add/drop sites.

Cannot Route demand! Didn't find any
valid Contentionless Side.

For linear topology, change the demand
protection to unprotected.
For ring topology, ensure that at least
two nodes and fiber-disjoint paths are
available and the forced wavelength is
unconfined in the end-to-end path.
Force the required number of colorless
ports.

Disjoint path is not available for
protected demand.
Or
Forcedwavelengthmay be already used
for other demand in the same path.
Or
The number of colorless demands
created is more than the colorless ports
forced on the interfaces.

Error: No valid path from <source> to
<destination>

For linear topology, change the demand
protection to unprotected.
For ring topology, ensure that at least
two nodes and fiber-disjoint paths are
available and the forced wavelength is
unconfined in the end-to-end path.

Disjoint path is not available for
protected demand.
Or
Forcedwavelengthmay be already used
for other demands in the same path.

Error: Traffic subnet constraints
prevent routing of section.

If the Cascaded SMR flag is enabled,
create only contentionless demands on
those nodes. Else, reduce the number
of contentionless sides, colorless ports,
or colored demands that are created,
to get successful network analysis.

The number of contentionless sides,
colorless ports that are forced, and
colored demand exceed SMR-20 port
capacity.
Or
The Cascaded SMR flag is enabled, and
colored or colorless demand is created.

Error: The sum of CoDem and
Non-CoDemcolorless ports and ports
that are used for Omnidirectional and
Contentional sides cannot exceed 20
when the TYPE is SMR-20.

Change the fiber type to the one that is
supported by Cisco ONP.

The fiber connecting these sides is not
supported by Cisco ONP.

Couple between <source>.<side>
and <destination>.<side> is of invalid
type.

Connect the fiber to the nodes in the
ring network.

Any of the sites are connected to the
fiber in the Ring/Linear network.

Unconnected nodes or sites are
present in the network.

Force the correct path on the
Wave/Media Channel.

Wrong path has been forced on the
wave or media channel.

Unfeasible forcing
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WorkaroundProbable Reason for the ErrorWarning Message or Error

Clear the contents of postgresdb_cnp
folder before running the restore
command: rm -rf
/var/lib/postgresdb_cnp/*cannot

Restore database script attempts to
write data in the postgres database, but
the data with the same index is already
present.

E11000 duplicate key error
collection: CnpDB.dbchangelog
index: _id_ dup key: { : ObjectId('') }

Unlock the mentioned entity or unlock
the complete site.

There is an issue with setting up
connection in the lock mode.

Cannot complete mesh connection.

Check the path and choose the correct
primary path and secondary path fibers.
Or
Remove all the fibers that are forced to
set the Path of Wave property as
Auto.

Invalid path has been forced.Path constraints prevent routing.

Force the wavelength as per optical
subnet rule or change the optical subnet
rule.

Forced Wavelength is not part of the
Optical subnet rule.

Traffic subnet constraints prevent
routing.

Set the propertyMF Unit to Auto and
then force the template.

Template is applied when properties
such as ECU,MF Unit are forced.

MF Unit value MF1-RU is not
supported in RPT, so resetting the
value to default for <site name>.

Modify the Interlever forcing on the line
side to MD-48-CM.

In non-SSON traffic, the ROADM site
with the properties (DEG-8, SMR-9,
number of contentionless sites is equal
to 1) has 96 colored waves.
The Interlever Type is property set
to Auto or MpoCable.

Please forceMD-48-CM as Interlever
Type for {0}.

Delete the extra contentionless sides.During upgrade or Release upgrade,
colorless port is forced on SMR-9, and
more than one contentionless side is
added in the imported MPZ network.

The sum of forced CoDem and
Non-CoDem colorless ports and
colored demands can't be greater
than 9 for type SMR-9.

Check the restoration path. It must not
have any dark fiber.

Plan mode restoration fails because the
presence of dark fiber in the restoration
path makes it difficult to find it.

No Route Found.

Correct the wave such that the
wavelength is supported by the optical
subnet C-band rule.

Two fibers are occupied by a wave with
the same wavelength.
The fiber belongs to a subnet where the
wavelength is not supported. For
example, a wave with an even
wavelength is forced through a fiber
belonging to the C40 channel or C48
channel subnet rules.

Wavelength Forced {0} in this {1} is
already in use / not as per current
optical subnet channel rule.

Before you convert the site type to
traffic, modify the optical source wave
to be feasible.

ROADM sites having waves with optical
source other than 100, 200SDFEC are
converted to traffic sites.

tm.unsupported_client_pluggable.msg
=Incompatible Client Interface
forcing.
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WorkaroundProbable Reason for the ErrorWarning Message or Error

Refresh the browser and try again.Slow internet connectivity, or idle
session.

Error Message

Upload proper .MPZ file.The MPZ file that you are trying to
upload does not have a valid file
extension.

Please provide a valid .mpz network
file.

Close MPZ file in the CTP tool before
uploading it to Cisco ONP .

MPZ file remains open in the CTP tool.Failed to import mpz file, pleasemake
sure the MPZ file is not in use and
retry.

Restart the Postgres database container
or reinstall the Build.

Failed to connect to Postgres DB on
opening Control Panel tab.

Cannot connect to Server;(Password).

Fix the syntax and reapply the template.The applied layout template file has
syntax error such as extra SPACE, TAB,
missing symbols such as <, >.

Null pointer exception

Refresh the browser or log in again to
Cisco ONP.

Intermediate network disconnection.Object not found in cache.

Log in again to Cisco ONP.Idle time-outSession does not exist.

Force another wavelength that is next
to the currently forced one.

Forced wavelength is not a feasible
central wavelength based on the
configuration.

Forced/Locked wavelength is not
feasible for spectrum to be allocated
for the demand/MCH
<Site-1-Site-3-1>. Insufficient
spectrum around the forced central
wavelength.

Make sure that the alternate path has
waves associated with the fiber and has
sufficient bandwidth available.

Insufficient spectral width due to the
following reasons:
• The alternate path has no waves

(dark fiber).

• Optical parameters are not feasible.

• Wavelength dos not have sufficient
bandwidth.

Route could not be found/Alternate
path not found/<Optically not
feasible>.

Change Evolved Mesh to Off, reduce
Scalable upto degree to 8, change Site
Type to SMR-20, or Remove
contentionless or colorless forcing.

Check if it is 8 degrees, SMR-9 node
with Evolved Mesh ON and
contentionless and colorless/colored
mixed add/drop configuration.

Error: Could not find any valid flex
configuration for the traffic matrix
defined at <Site-1.A> This could be
because of configuration limitations,
invalid forcings, or equipment
restrictions.
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WorkaroundProbable Reason for the ErrorWarning Message or Error

• Enable Quick analysis.

• After successful analysis, check the
optical report and look for the waves
that require regeneration.

• Split the long haul demand between
the intermediate short distance
nodes that are equivalent to regen
site.

• Disable Quick analysis and
analyze.

Check if Quick analysis under
Network property is disabled.

Single hop path Site-1~Site-3 needs
regeneration but has no regenerator
hosting sites.

Check the source node configuration
(such as scalable upto degree, number
of colored and colorless circuits or port
forcing,and colored add/drop card
forcing).

Required Add/Drop card cannot be
placed on the source node.

Missing SOURCE TermPoint for
PceServiceRequest

Check the destination node
configuration (such as scalable upto
degree, number of colored and
colorless circuits or port forcing,and
colored add/drop card forcing).

Required Add/Drop card cannot be
placed on the destination node.

Missing DESTINATION TermPoint for
PceServiceRequest

• Check the colored add/drop forcing
and the number of colored demands
routing on the path.

• Check the number of colorless
demands, ports, and add/drop cards
forced on the path.

• Check the optical subnet defined on
the path and the type of service
used.

Spectrum allocation failed for the
mentioned service

Service allocation failed: No resource
available

Check the card type forced for the
colored circuit. Circuits with a maximum
spectrum of 75GHz can be used with
colored add/drop MD-32-ODD/EVEN.
For example, a circuit that has an
interface with rate greater than 60-bit
rate or 60GBd cannot work with 75GHz
fixed grid add/drop with 82% spectral
density. Change to colorless add/drop
BRK-24 or change to interface type
having less spectral occupancy.

Spectrum allocation failed for the
mentioned service

Service allocation failed:
[PCE-WAL00028] - No free spectrum
available to allocate circuit:
[PCE-WAL00028]
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WorkaroundProbable Reason for the ErrorWarning Message or Error

Force MF Unit as MF-4RUCheck if MF Unit is forced as MF-1RU.
Only 3 USB ports available with NCS
1010 OLT-C-R. Maximum of only 3
Passives can be connected to OLT line
cards. So, for Scalable upto degree
>25, since USB ports are not available
to connect to passive colorless
Add/Drop, error appears.

Colorless configuration is not
supported for Scalable Upto Degree
[25]

1. 1. Force L-band on all intermediate
nodes on the L-band circuit route
path.

2. 2. Try to force other available path
or add new path if spectrum is
exhausted on all available paths.

1. If it is an L-band Circuit, L-band
forcing may be missing in the
intermediate nodes.

2. Complete spectrum is utilized in the
path if forced, or on all the available
path between source and
destination.

Error: No free spectrum available to
allocate circuit

Keep only two OLA sites between
Terminal sites.

The NCS 1001 network has more than
two OLA sites between Terminal sites.

Untested System Configuration:
Number of OLA sites between
Terminal sites is more than 2. Please
contact support before deployment.
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